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Preface

The Oracle9i Net Services Administrator’s Guide provides the information you need to
understand and use Oracle Net Services and its related applications and
components.

This preface contains these topics:

■ Audience

■ Organization

■ Related Documentation

■ Conventions

■ Documentation Accessibility
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Audience
Oracle9i Net Services Administrator’s Guide is intended for the following kinds of
readers:

■ Network administrators

■ Directory server administrators

■ Database administrators

■ Decision makers

This guide is especially targeted for network administrators who are responsible for
ensuring connectivity. For network administrators, Oracle Corporation
recommends reading all of Part I for a conceptual understanding of Oracle Net
Services. In addition, read Chapter 3 in Part I and all of Part II for essential
configuration instructions. Use Part III for troubleshooting.

Directory administrators will find Chapter 3 in Part I useful in understanding how
Oracle Net Services uses a directory server. In addition, Chapter 8 and Chapter 10 in
Part II provide instructions for establishing directory usage and exporting existing
naming data to a directory server.

Database administrators should skim Chapter 1 and Chapter 2 to gain an
understanding of the big networking picture. In addition, Chapter 5 will provide an
overview of networking tools, which may be of use to the database administrator.
Database administrator will also find Chapter 7, Chapter 12, and Chapter 14 useful
in understanding how to configure Oracle9i database server features that require
listener and shared server configuration.

Decision makers will find this guide useful in understanding how Oracle Net
Services fits into the overall network architecture. Decision makers will find
Chapter 1, Chapter 2, Chapter 4, and Chapter 7 useful for explaining the basics of
Oracle Net Services.

Oracle Corporatism recommends that all readers skim Part 1, to ensure that they
have the background required to benefit from the rest of the guide.
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Organization
This document contains:

Part I, "Getting Started with Oracle Net Services"

Chapter 1, "Networking Challenges in the Internet Age"
This chapter introduces main features of Oracle Net Services, including
connectivity, centralized management, scalability, and security. In addition, Oracle
Net Services, Oracle Connection Manager, and Oracle Advanced Security products
and components are introduced.

Chapter 2, "Connectivity Concepts"
This chapter describes the concepts of service naming, connection establishment,
naming, access control, and multiplexing.

Chapter 3, "Configuration Management Concepts"
This chapter describes localized configuration and centralized configuration
methodologies.

Chapter 4, "Architecture of Oracle Net Services"
This chapter describes stack communication architecture and component
architecture.

Chapter 5, "Configuration and Administration Tools Overview"
This chapter describes Oracle Net Services products and administration tools.

Chapter 6, "Quick Start to Oracle Net Connections"
This chapter describes how to set up a basic network configuration with Oracle Net
Configuration Assistant.
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Part II, "Configuration and Administration of Oracle Net Services"

Chapter 7, "Planning the Network"
This chapter describes considerations for planning a network using Oracle Net
Services. It explains the relationships of the Oracle Net Services components, and
options to help you better manage the network.

Chapter 8, "Setting Up Directory Server Usage"
This chapter describes how to configure access to a directory server.

Chapter 9, "Configuring Naming Methods"
This chapter describes how to configure naming methods.

Chapter 10, "Exporting Naming Data to a Directory Server"
This chapter describes how export data from a tnsnames.ora  file or an Oracle
Names server to a directory server.

Chapter 11, "Configuring Profiles"
This chapter describes how to configure client and database server profiles.

Chapter 12, "Configuring and Administering the Listener"
This chapter describes how to configure the listener to accept client requests, and
how to perform common administrative tasks.

Chapter 13, "Configuring Oracle Connection Manager"
This chapter describes how to configure Oracle Connection Manager to provide
access control, multiplexed connections, and protocol conversion.

Chapter 14, "Configuring Shared Server"
This chapter describes how to configure the Oracle database server to use the
shared server connection model.

Chapter 15, "Enabling Advanced Features for Oracle Net Services"
This chapter describes how to configure advanced and optional connection features,
such as load balancing, and failover. It also explains how to configure connections
to non-Oracle database services.
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Part III, "Testing and Troubleshooting Oracle Net Services"

Chapter 16, "Establishing a Connection and Testing the Network"
This chapter describes how to start Oracle Net Services components, establish a
connection, and test a connection.

Chapter 17, "Troubleshooting Oracle Net Services"
This chapter describes procedures to troubleshoot Oracle Net Services. It includes
information on tracing and logging.

Glossary

Related Documentation
For more information, see these Oracle resources:

■ Oracle Net Services Reference Guide.

■ Oracle9i documentation set

Many books in the documentation set use the sample schemas of the seed database,
which is installed by default when you install Oracle. Refer to Oracle9i Sample
Schemas for information on how these schemas were created and how you can use
them yourself.

In North America, printed documentation is available for sale in the Oracle Store at

http://oraclestore.oracle.com/

Customers in Europe, the Middle East, and Africa (EMEA) can purchase
documentation from

http://www.oraclebookshop.com/

Other customers can contact their Oracle representative to purchase printed
documentation.

To download free release notes, installation documentation, white papers, or other
collateral, please visit the Oracle Technology Network (OTN). You must register
online before using OTN; registration is free and can be done at

http://otn.oracle.com/admin/account/membership.html
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If you already have a username and password for OTN, then you can go directly to
the documentation section of the OTN Web site at

http://otn.oracle.com/docs/index.htm

To access the database documentation search engine directly, please visit

http://tahiti.oracle.com

For additional information, see:

■ http://www.ietf.org/  for information about the Open Systems
Interconnection (OSI)

Conventions
This section describes the conventions used in the text and code examples of this
documentation set. It describes:

■ Conventions in Text

■ Conventions in Code Examples

■ Conventions for Windows Operating Systems
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Conventions in Text
We use various conventions in text to help you more quickly identify special terms.
The following table describes those conventions and provides examples of their use.

Convention Meaning Example

Bold Bold typeface indicates terms that are
defined in the text or terms that appear in
a glossary, or both.

When you specify this clause, you create an
index-organized table.

Italics Italic typeface indicates book titles or
emphasis.

Oracle9i Database Concepts

Ensure that the recovery catalog and target
database do not reside on the same disk.

UPPERCASE
monospace
(fixed-width)
font

Uppercase monospace typeface indicates
elements supplied by the system. Such
elements include parameters, privileges,
datatypes, RMAN keywords, SQL
keywords, SQL*Plus or utility commands,
packages and methods, as well as
system-supplied column names, database
objects and structures, usernames, and
roles.

You can specify this clause only for a NUMBER
column.

You can back up the database by using the
BACKUP command.

Query the TABLE_NAME column in the USER_
TABLES data dictionary view.

Use the DBMS_STATS.GENERATE_STATS
procedure.

lowercase
monospace
(fixed-width)
font

Lowercase monospace typeface indicates
executables, filenames, directory names,
and sample user-supplied elements. Such
elements include computer and database
names, net service names, and connect
identifiers, as well as user-supplied
database objects and structures, column
names, packages and classes, usernames
and roles, program units, and parameter
values.

Note: Some programmatic elements use a
mixture of UPPERCASE and lowercase.
Enter these elements as shown.

Enter sqlplus  to open SQL*Plus.

The password is specified in the orapwd  file.

Back up the datafiles and control files in the
/disk1/oracle/dbs  directory.

The department_id , department_name ,
and location_id  columns are in the
hr.departments  table.

Set the QUERY_REWRITE_ENABLED
initialization parameter to true.

Connect as oe  user.

The JRepUtil  class implements these
methods.

lowercase
italic
monospace
(fixed-width)
font

Lowercase italic monospace font
represents placeholders or variables.

You can specify the parallel_clause .

Run Uold_release .SQL  where old_
release refers to the release you installed
prior to upgrading.
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Conventions in Code Examples
Code examples illustrate SQL, PL/SQL, SQL*Plus, or other command-line
statements. They are displayed in a monospace (fixed-width) font and separated
from normal text as shown in this example:

SELECT username FROM dba_users WHERE username = ’MIGRATE’;

The following table describes typographic conventions used in code examples and
provides examples of their use.

Convention Meaning Example

[ ] Brackets enclose one or more optional
items. Do not enter the brackets.

DECIMAL ( digits  [ , precision  ])

{ } Braces enclose two or more items, one of
which is required. Do not enter the
braces.

{ENABLE | DISABLE}

| A vertical bar represents a choice of two
or more options within brackets or braces.
Enter one of the options. Do not enter the
vertical bar.

{ENABLE | DISABLE}
[COMPRESS | NOCOMPRESS]

... Horizontal ellipsis points indicate either:

■ That we have omitted parts of the
code that are not directly related to
the example

■ That you can repeat a portion of the
code

CREATE TABLE ... AS subquery ;

SELECT col1 , col2 , ... , coln  FROM
employees;

 .
 .
 .

Vertical ellipsis points indicate that we
have omitted several lines of code not
directly related to the example.

SQL> SELECT NAME FROM V$DATAFILE;
NAME
------------------------------------
/fsl/dbs/tbs_01.dbf
/fs1/dbs/tbs_02.dbf
.
.
.
/fsl/dbs/tbs_09.dbf
9 rows selected.

Other notation You must enter symbols other than
brackets, braces, vertical bars, and ellipsis
points as shown.

acctbal NUMBER(11,2);
acct    CONSTANT NUMBER(4) := 3;
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Conventions for Windows Operating Systems
The following table describes conventions for Windows operating systems and
provides examples of their use.

Italics Italicized text indicates placeholders or
variables for which you must supply
particular values.

CONNECT SYSTEM/system_password
DB_NAME =database_name

UPPERCASE Uppercase typeface indicates elements
supplied by the system. We show these
terms in uppercase in order to distinguish
them from terms you define. Unless terms
appear in brackets, enter them in the
order and with the spelling shown.
However, because these terms are not
case sensitive, you can enter them in
lowercase.

SELECT last_name, employee_id FROM
employees;
SELECT * FROM USER_TABLES;
DROP TABLE hr.employees;

lowercase Lowercase typeface indicates
programmatic elements that you supply.
For example, lowercase indicates names
of tables, columns, or files.

Note: Some programmatic elements use a
mixture of UPPERCASE and lowercase.
Enter these elements as shown.

SELECT last_name, employee_id FROM
employees;
sqlplus hr/hr
CREATE USER mjones IDENTIFIED BY ty3MU9;

Convention Meaning Example

Choose Start > How to start a program. To start the Database Configuration Assistant,
choose Start > Programs > Oracle - HOME_
NAME > Configuration and Migration Tools >
Database Configuration Assistant.

File and directory
names

File and directory names are not case
sensitive. The following special characters
are not allowed: left angle bracket (<),
right angle bracket (>), colon (:), double
quotation marks ("), slash (/), pipe (|),
and dash (-). The special character
backslash (\) is treated as an element
separator, even when it appears in quotes.
If the file name begins with \\, then
Windows assumes it uses the Universal
Naming Convention.

c:\winnt"\"system32 is the same as
C:\WINNT\SYSTEM32

Convention Meaning Example
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C:\> Represents the Windows command
prompt of the current hard disk drive.
The escape character in a command
prompt is the caret (^). Your prompt
reflects the subdirectory in which you are
working. Referred to as the command
prompt in this manual.

C:\oracle\oradata>

Special characters The backslash (\) special character is
sometimes required as an escape
character for the double quotation mark
(") special character at the Windows
command prompt. Parentheses and the
single quotation mark (’) do not require
an escape character. Refer to your
Windows operating system
documentation for more information on
escape and special characters.

C:\>exp scott/tiger TABLES=emp
QUERY=\"WHERE job=’SALESMAN’ and
sal<1600\"
C:\>imp SYSTEM/ password  FROMUSER=scott
TABLES=(emp, dept)

HOME_NAME Represents the Oracle home name. The
home name can be up to 16 alphanumeric
characters. The only special character
allowed in the home name is the
underscore.

C:\> net start Oracle HOME_NAMETNSListener

Convention Meaning Example
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ORACLE_HOME
and ORACLE_
BASE

In releases prior to Oracle8i release 8.1.3,
when you installed Oracle components,
all subdirectories were located under a
top level ORACLE_HOME directory that by
default used one of the following names:

■ C:\orant  for Windows NT

■ C:\orawin98  for Windows 98

This release complies with Optimal
Flexible Architecture (OFA) guidelines.
All subdirectories are not under a top
level ORACLE_HOME directory. There is a
top level directory called ORACLE_BASE
that by default is C:\oracle . If you
install Oracle9i release 1 (9.0.1) on a
computer with no other Oracle software
installed, then the default setting for the
first Oracle home directory is
C:\oracle\ora90 . The Oracle home
directory is located directly under
ORACLE_BASE.

All directory path examples in this guide
follow OFA conventions.

Refer to Oracle9i Database Getting Starting
for Windows for additional information
about OFA compliances and for
information about installing Oracle
products in non-OFA compliant
directories.

Go to the ORACLE_BASE\ ORACLE_
HOME\rdbms\admin  directory.

Convention Meaning Example
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Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of
assistive technology. This documentation is available in HTML format, and contains
markup to facilitate access by the disabled community. Standards will continue to
evolve over time, and Oracle Corporation is actively engaged with other
market-leading technology vendors to address technical obstacles so that our
documentation can be accessible to all of our customers. For additional information,
visit the Oracle Accessibility Program Web site at

http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation JAWS, a Windows screen
reader, may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, JAWS may not always read a line of text that
consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation This
documentation may contain links to Web sites of other companies or organizations
that Oracle Corporation does not own or control. Oracle Corporation neither
evaluates nor makes any representations regarding the accessibility of these Web
sites.
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What’s New in Oracle Net Services?

This section describes the new networking features of Oracle9i release 9.2 and
provides pointers to additional information. New features information from
previous releases is also retained to help those users migrating to the current
release.

The following sections describe the new networking features:

■ Oracle9i Release 2 (9.2) New Features in Oracle Net Services

■ Oracle9i Release 1 (9.0.1) New Features in Oracle Net Services

■ Oracle8i New Features in Oracle Net Services
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Oracle9i Release 2 (9.2) New Features in Oracle Net Services
The new features for Oracle Net Services in release 2 (9.2) include:

■ Net Service Alias Support in Directory Server

Oracle Net Manager enables you to create, modify, or delete a net service alias
to reference a net service name or database service object in Oracle Internet
Directory. In addition to exporting database objects, the Oracle Names Control
utility provides support for exporting alias objects stored in an Oracle Names
server to a directory server or indirectly to an LDAP Data Interchange Format
(LDIF) file.

■ Global Database Link Support in Directory Server

The Oracle Names Control utility provides supporting for exporting global
database link to a directory server. However, username and password
credentials are not supported.

See Also:

■ "Net Service Alias Entries" on page 3-9 for an overview of net
service alias entries

■ "Creating Net Service Aliases" on page 9-20 for instruction on
creating net service aliases

■ "Exporting Network Objects from an Oracle Names Server" on
page 10-6 for instruction on exporting aliases to a directory
server

See Also: "Exporting Network Objects from an Oracle Names
Server" on page 10-6 for instruction on exporting objects stored in
an Oracle Names server to a directory server
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■ Directory Naming Access Control

Using a new security mechanism for directory naming, you can assign a group
as the owner of the OracleNetAdmins group. The default owner is the
OracleNetAdmins group itself. By changing the ownership of this group, you
can separate the OracleNetAdmins members who manage the directory naming
entries from those users who add members to OracleNetAdmins group.

■ Trace Assistant

Oracle Net Services provides a new Trace Assistant tool that converts existing
trace file text into a more readable format.

■ Dynamic Support for Local and Remote Listener Parameters

You can use SQL statement ALTER SYSTEM SET to dynamically update the
LOCAL_LISTENER and REMOTE_LISTENER parameters. When these
parameters are dynamically updated, the PMON process registers this
information with the listener.

See Also: "Establishing Access For the OracleNetAdmins Group"
on page 8-10

See Also: "Using the Trace Assistant to Examine Trace Files" on
page 17-60

See Also: "Configuring Service Registration" on page 12-14
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Oracle9i Release 1 (9.0.1) New Features in Oracle Net Services
The new features for Oracle Net Services in release 1 (9.0.1) include:

■ Name Change to Networking Components

To provide consistency with Oracle9i, several name changes to networking
products, features, and parameters have been made in this release. The
following table maps the former product and feature names to their new names.

The following table maps the multi-threaded server (MTS) parameters and
dynamic view names to the new names associated with shared server. Except
for the MTS_MAX_SERVERSparameter, the old parameter names are maintained
for backward compatibility to Oracle8i. Oracle Corporation recommends
migrating to the new names.

Former Name New Name

multi-threaded server (MTS) shared server

Net8 Oracle Net to describe the software that
provides connectivity

Net8 Oracle Net Services to encompass Oracle
Net, the listener, and Oracle Connection
Manager

Net8 communication stack layer Oracle Net foundation layer

Net8 Configuration Assistant Oracle Net Configuration Assistant

Net8 Manager Oracle Net Manager

MTS Parameter/View Name New Shared Server Parameter/View Name

MTS_CIRCUITS initialization parameter CIRCUITS  initialization parameter

MTS_DISPATCHERS initialization parameter DISPATCHERS initialization parameter

MTS_MAX_DISPATCHERS initialization
parameter

MAX_DISPATCHERSinitialization parameter

MTS_MAX_SERVERS initialization parameter MAX_SHARED_SERVERS initialization
parameter

MTS_SERVERS initialization parameter SHARED_SERVERS initialization parameter
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■ Connection Load Balancing for Dedicated Server Configurations

Configurations that use dedicated servers can now use the connection load
balancing feature that was previously available only for shared server
configurations.

■ Multiple Oracle Context Creation in Oracle Net Configuration Assistant

The Oracle Net Configuration Assistant enables you to create multiple Oracle
Contexts to facilitate management of a complex naming structure in a directory
server.

■ Oracle Names LDAP Proxy Servers

In future releases, Oracle Names will not be supported as a centralized naming
method. As Oracle Names is deprecated in favor of directory naming with
LDAP-compliant directory servers, Oracle Names LDAP Proxy servers provide
a way for release 8.1.5 or previous clients that do not support directory naming
to use the same data as is used for directory naming. Oracle Names LDAP
Proxy servers are Oracle Names servers that have been configured to proxy for
LDAP-compliant directory servers. Upon startup, Oracle Names LDAP Proxy
servers obtain network object information from a directory server. This
provides a single point of definition for all data in a directory server and does
not require that both Oracle Names servers and directory servers be maintained
separately and simultaneously.

MTS_SESSIONS initialization parameter SHARED_SERVER_SESSIONS initialization
parameter

V$MTS view V$SHARED_SERVER_MONITOR view

See Also: "Connection Load Balancing" on page 2-9

See Also: "Configuring Directory Usage After Installation" on
page 8-6

See Also: "Exporting Network Objects from an Oracle Names
Server" on page 10-6

MTS Parameter/View Name New Shared Server Parameter/View Name



xxxviii

■ Unsupported Features

In an effort to streamline configuration decisions for the Internet, the following
subsections describe the features and the configuration file that are no longer
being supported:

■ Identix and SecurID authentication methods

■ NDS External Naming and NDS Authentication

■ Net8 OPEN

■ Prespawned dedicated servers

■ protocol.ora  file

■ SPX protocol

■ Trace Assistant

Identix and SecurID Authentication Methods

If you are using Identix or SecurID authentication methods, provided by
Oracle Advanced Security, Oracle Corporation recommends migrating to one
of the following authentication methods:

■ CyberSafe

■ RADIUS

■ Kerberos

■ SSL

Novell Directory Services (NDS) External Naming and NDS Authentication

Support for NDS as an authentication method and as an external naming
method is no longer supported. If you are using NDS as an external naming
method, Oracle Corporation recommends using directory naming instead.

See Also: Oracle Advanced Security Administrator’s Guide

See Also: "Configuring the Directory Naming Method" on
page 9-12
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Net8 OPEN

Net8 OPEN, which provided an application program interface (API) that
enabled programmers to develop both database and non-database applications,
is no longer supported.

Prespawned Dedicated Servers

Prestarted dedicated server processes are no longer supported. Instead,
configure shared server to improve scalability and system resource usage.

protocol.ora File

The protocol.ora  file is no longer supported.

Parameters in the protocol.ora  file have been merged into the sqlnet.ora
file. These parameters enable you to configure access control to the database, as
well as no delays in TCP/IP buffer flushing. These parameters include:

■ TCP.NODELAY

■ TCP.EXCLUDED_NODES

■ TCP.INVITED_NODES

■ TCP.VALIDNODE_CHECKING

If you have a protocol.ora  file in the $ORACLE_HOME/network/admin
directory on UNIX, and the ORACLE_HOME\network\admin  directory on
Windows operating systems, Oracle Net Manager, when first started,
automatically merges the protocol.ora  parameters into the sqlnet.ora
file.

There may be operating system-specific parameters in protocol.ora  that are
node specific. For this reason, Oracle Corporation recommends not sharing
sqlnet.ora  with other nodes after merging or adding these parameters.

See Also: Oracle9i Net Services Reference Guide for a description of
these parameters

See Also: Oracle operating system-specific documentation
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Protocol Support

Protocol addresses using the SPX or LU6.2 protocol must be replaced. Oracle
Net provides support for the following network protocols:

■ TCP/IP

■ TCP/IP with SSL

■ Named Pipes

Oracle8i New Features in Oracle Net Services
These Oracle Net features introduced in Oracle8i also apply to Oracle9i:

■ Client Connection Features

Client Load Balancing—When more than one listener supports a service, a
client can randomize requests to the various listeners.

Connect-Time Failover—When more than one listener supports a service, a
client can be configured to fail over the client request to a different listener if the
first listener fails.

■ Directory Naming

Network information can now be stored in a centralized LDAP-compliant
directory service, including Oracle Internet Directory and Microsoft Active
Directory.

See Also: Oracle9i Net Services Reference Guide for protocol
parameter configuration

See Also:

■ "Client Load Balancing" on page 2-9

■ "Connect-Time Failover" on page 2-8

See Also: "Directory Server Support" on page 3-4
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■ Instance Role Specification for Primary and Secondary Configurations

With the connect descriptor INSTANCE_ROLE parameter, you can specify a
connection to the primary or secondary instance of Oracle9i Real Application
Clusters and Oracle9i Real Application Clusters Guard configurations.

■ Listener Features

Service Naming—Oracle8i database services are identified by a service name
rather than an Oracle System Identifier (SID). This impacts the way connect
descriptors are defined.

Direct Hand-Off—The listener has the ability to hand off requests directly to an
shared dispatcher, without issuing a redirect message back to the client.

Service Registration—Database instances register information with the listener
during database startup.

Connection Load Balancing—The listener is able to balance the number of
active connections among various instances and shared server dispatchers for
the same service.

■ Oracle Net Configuration Assistant

Oracle Net Configuration Assistant is a post-installation tool that performs
basic configuration. After installation, it automatically configures default
configuration files.

See Also: "Specifying the Instance Role for Primary and
Secondary Instance Configurations" on page 15-25

See Also:

■ "Database Service and Database Instance Identification" on
page 2-2

■ "Service Handlers" on page 2-10

■ "Connection Load Balancing" on page 2-9

See Also: "Oracle Net Configuration Assistant" on page 5-14 and
Oracle operating system-specific installation guides
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■ Service Naming

Database services are identified by service name and instance name rather than
Oracle System Identifier (SID).

■ TCP/IP with Secure Sockets Layer (SSL) protocol

A protocol for client/server authentication over a network using TCP/IP and
the Secure Sockets Layer (SSL).

See Also: "Database Service and Database Instance Identification"
on page 2-2



Part I
 Getting Started with Oracle Net Services

Part I provides an overview of Oracle Net Services concepts, products, and tools.

This part contains the following chapters:

■ Chapter 1, "Networking Challenges in the Internet Age"

■ Chapter 2, "Connectivity Concepts"

■ Chapter 3, "Configuration Management Concepts"

■ Chapter 4, "Architecture of Oracle Net Services"

■ Chapter 5, "Configuration and Administration Tools Overview"

■ Chapter 6, "Quick Start to Oracle Net Connections"
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1
Networking Challenges in the Internet Age

This chapter describes the networking issues that your system faces in the Internet
age, and introduces the technology and products that can provide a complete
network solution.

This chapter contains the following topics:

■ What Is the Big Picture for Networking?

■ Oracle’s Solution to Networking Issues

■ A Suite of Networking Components
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What Is the Big Picture for Networking?
The e-business model creates new business requirements. To carry out electronic
business successfully, Web sites must provide reliable connectivity and 24 by 7
availability. Corporate Web sites must also address user scalability and performance
to simultaneously handle thousands of Internet connections to their data
repositories. Solutions are needed as well to provide immediate Web browser access
to existing applications and services.

Figure 1–1 shows a typical architecture in which Internet clients connect to a
company’s databases through an application Web server. The figure also shows the
intranet architecture that enables a company’s own clients to communicate with the
databases. This basic architecture will be examined further to show how Oracle
networking technologies are used throughout typical network environments.

Figure 1–1 Typical E-Commerce Architecture
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Application
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Clients

IntranetInternet
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Oracle’s Solution to Networking Issues
Oracle Net Services provides enterprise wide connectivity solutions in distributed,
heterogeneous computing environments. Oracle Net Services ease the complexities
of network configuration and management, maximize performance, and improve
network diagnostic capabilities.

This section introduces the basic networking concepts that come into play in a
typical network configuration. The topics discussed include:

■ Connectivity

■ Manageability

■ Internet and Intranet Scalability

■ Network Security

Connectivity
Oracle Net, a component of Oracle Net Services, enables a network session from a
client application to an Oracle database server. Once a network session is
established, Oracle Net acts as the data courier for both the client application and
the database server. It is responsible for establishing and maintaining the
connection between the client application and database server, as well as
exchanging messages between them. Oracle Net is able to perform these jobs
because it is located on each computer in the network.

This section discusses the following connectivity topics:

■ Client/Server Application Connections

■ Web Client Application Connections

■ Web Client Connections Without an Application Web Server



Oracle’s Solution to Networking Issues

1-4 Oracle9i Net Services Administrator’s Guide

Client/Server Application Connections
Oracle Net enables connections from traditional client/server applications to Oracle
database servers. Figure 1–2 shows how Oracle Net enables a network connection
between a client and a database server. Oracle Net is a software component that
resides on both the client and the database server. Oracle Net is layered on top of a
network protocol—rules that determine how applications access the network and
how data is subdivided into packets for transmission across the network. In this
illustration, Oracle Net communicates with the TCP/IP protocol to enable
computer-level connectivity and data transfer between the client and the database
server.

Figure 1–2 Client/Server Application Connection

Specifically, Oracle Net is comprised of the Oracle Net foundation layer, which
establishes and maintains connections, and Oracle protocol support, which maps
the foundation layer’s technology to industry-standard protocols.
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Java client applications access an Oracle database through a Java Database
Connectivity (JDBC) Driver, a standard Java interface for connecting from Java to a
relational database. Oracle offers the following drivers:

■ JDBC OCI Driver for client side use with an Oracle client installation

■ JDBC Thin Driver for client side use without an Oracle installation,
particularly with applets

These drivers use Oracle Net to enable connectivity between a client application
and an Oracle database.

Figure 1–3 shows a Java client application using a JDBC OCI driver and an Oracle
database server. The Java client application makes calls to the JDBC OCI driver
which in turn translates the JDBC calls directly into the Oracle Net layer. The client
then uses Oracle Net to communicate with an Oracle database that is also
configured with Oracle Net.

Figure 1–3 Java Application Connection

Note: The JDBC Thin driver is a 100 percent pure Java driver that
requires no client installation.

See Also: Oracle9i JDBC Developer’s Guide and Reference
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Web Client Application Connections
Internet connections from client Web browsers to an Oracle database server are
similar to client/server applications, except for the architecture.

Figure 1–4 shows the basic architecture for Web client connections, including a
client Web browser, an application Web server, and an Oracle database server. The
browser on the client communicates with the HTTP protocol to a Web server to
make a connection request. The Web server sends the request to an application
where it is processed. The application then uses Oracle Net to communicate with an
Oracle database server that also is configured with Oracle Net.

Figure 1–4 Web Client Connections through Application Web Server

The basic components have the following characteristics:

■ Hypertext Transport Protocol (HTTP)

HTTP provides the language that enables Web browsers and application Web
servers to communicate.

■ Application Web Server
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Web server.
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An application Web server can host Java applications and servlets, as shown in
Figure 1–5. Web browsers make a connection request by communicating through
HTTP to an application Web server. The application Web server sends the request to
an application or a servlet, which in turn uses a JDBC OCI or a JDBC Thin driver to
process the request. The driver then uses Oracle Net to communicate with an Oracle
database server that also is configured with Oracle Net.

Figure 1–5 Web Client Connections Through Java Application Web Server
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Web Client Connections Without an Application Web Server
Web clients that do not require an application Web server to access applications can
access the Oracle database directly, for example, by using a Java applet. In addition
to regular connections, the database can be configured to accept HTTP protocol,
FTP protocol, or WebDAV protocol connections. These protocols are used for
connections to Oracle XML DB in the Oracle9i instance.

Figure 1–6 shows two different Web clients. The first Web client makes an HTTP
connection to the database. The second Web client uses a Web browser with a JDBC
Thin driver, which in turn uses a Java version of Oracle Net called JavaNet to
communicate with the Oracle database server that is configured with Oracle Net.

Figure 1–6 Web Client Connection Scenarios

See Also: Oracle9i XML Database Developer’s Guide - Oracle XML
DB
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Manageability
Oracle Net Services offer a number of manageability features that enable you to
easily configure and manage networking components. These features are described
in the following topics:

■ Location Transparency

■ Centralized Configuration and Management

■ Quick Installation and Configuration

Location Transparency
A company can have several databases, each representing a specific type of service
for various client applications. For example, a company may have three databases,
which it uses for sales, human resources, and marketing applications. Each database
is represented by one or more services. A service is identified by a service name, for
example, sales.us.acme.com . A client uses this service name to identify the
database it needs to access. The information about the database service and its
location in the network is transparent to the client because the information needed
for a connection is stored in a repository.
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For example, in Figure 1–7, a company has three databases that clients can access.
Each database has a distinct service name: sales.us.acme.com ,
hr.us.acme.com , and mktg.us.acme.com .

1. The client uses the repository to find the information it needs for
sales.us.acme.com .

2. Once the client has the information it needs, it connects to the database.

Figure 1–7 Service Information Repository

The repository is represented by one or more naming methods. Oracle Net Services
offer several types of naming methods that support localized configuration on each
client, or centralized configuration that can be accessed by all clients in the network.
Easy-to-use graphical user interfaces enable you to manage data stored in the
naming methods.
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Centralized Configuration and Management
To manage large networking environments, administrators have to be able to easily
access a centralized repository to specify and modify the network configuration. For
this reason, the Oracle Net Services configuration can be stored in a
LDAP-compliant directory server.

Support of LDAP-compliant directory servers provides a centralized vehicle for
managing and configuring a distributed Oracle network. The directory can act as a
central repository for all information on database network components, user and
corporate policies, and user authentication and security, thus replacing clientside
and serverside localized configuration files.

All computers on the heterogeneous network can refer to the directory for
information. Figure 1–8 shows clients, other servers (such as application Web
servers) and Oracle database servers connecting to a centralized directory server.

Figure 1–8 Centralized Storage of Network Configuration with a Directory Server

See Also: "Directory Server Support" on page 3-4 for an in-depth
overview of directory server concepts
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Quick Installation and Configuration
Oracle Net Services install quickly and easily. Networking elements for the Oracle
database server and clients are preconfigured for most environments. Information
about an Oracle database service is populated in one or more naming methods. As a
result, clients and servers are ready to immediately connect when installed, giving
users the benefits of distributed computing.

Internet and Intranet Scalability
Oracle Net provides scalability features that enable you to maximize system
resources and improve performance.

Oracle’s shared server architecture increases the scalability of applications and the
number of clients that can be simultaneously connected to the database. The shared
server architecture also enables existing applications to scale up without making
any changes to the application itself.

When using shared server, clients do not communicate directly with a database’s
server process—a database process that handles a client’s requests on behalf of a
database. Instead, client requests are routed to one or more dispatchers. The
dispatchers place the client requests on a common queue. An idle shared server
process from the shared pool of server processes picks up and processes a request
from the queue. This means a small pool of server processes can serve a large
number of clients.

Figure 1–9 on page 1-13 and Figure 1–10 on page 1-14 show the basic difference
between the shared server connection model and the traditional dedicated server
connection model. In the shared server model, a dispatcher can support multiple
client connections concurrently. In the dedicated server model, there is one server
process for each client. Each time a connection request is received, a server process
is started and dedicated to that connection until completed. This introduces a
processing delay.

Shared server is ideal in configurations with a large number of connections because
it reduces the server’s memory requirements. Shared server is well suited for both
Internet and intranet environments.
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Figure 1–9 Dedicated Server Architecture
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Figure 1–10 Shared Server Architecture
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Therefore, Web applications can allow larger numbers of concurrent users to be
accommodated with existing hardware.

Figure 1–11 shows how connection pooling works. In this example, the Oracle
database server has been configured with 255 connections. One of the clients has
been idle past a specified amount of time. Connection pooling makes this
connection available to an incoming client connection, which is the 256th
connection. When the idle client has more work to do, the connection is
reestablished for that client with another client’s idle connection.

Figure 1–11 Connection Pooling
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Session Multiplexing Oracle Connection Manager, an Oracle Net Services
component, enables multiple client network sessions to be multiplexed, or
funneled, through a single network connection to a database.

Session multiplexing reduces the demand on resources needed to maintain
multiple network sessions between two processes by enabling the server to use
fewer network connection endpoints for incoming requests. This enables you to
increase the total number of network sessions that a server can handle. With
multiple Oracle Connection Managers, thousands of concurrent users can connect
to a server.

Figure 1–12 on page 1-17 shows how session multiplexing can be used in a Web
architecture. When Oracle Connection Manager is run on the same computer as an
application Web server, the application Web server can route multiple client
sessions through Oracle Connection Manager to ensure that those sessions have
continuous access to an Oracle database server. This functionality is especially
useful for Web applications where session availability and response time are major
concerns.
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Figure 1–12 Session Multiplexing
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Network Security
Data access and secure transfer of data are important considerations when
deploying Oracle. Network security is enhanced with features described in the
following topics:

■ Database Access Control

■ Enhanced Network Security Through Oracle Advanced Security

Database Access Control
Granting and denying access to a database is crucial for a secure network
environment. Oracle Net Services enable database access control using features
described in the following topics:

■ Firewall Access Control

■ Protocol Access Control
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Firewall Access Control Oracle Connection Manager can be configured to grant or
deny client access to a particular database service or a computer. By specifying
filtering rules, you can allow or restrict specific client access to a server, based on the
following criteria:

■ Source host names or IP addresses for clients

■ Destination host names or IP addresses for servers

■ Destination database service names

■ Client use of Oracle Advanced Security

Figure 1–13 shows an Oracle Connection Manager positioned between three Web
clients and an Oracle database server. Oracle Connection Manager is configured to
allow access to the first two Web clients and to deny access to the third. In order for
this configuration to work, clients require the JDBC Thin driver.

Figure 1–13 Intranet Network Access Control with Oracle Connection Manager
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Oracle Connection Manager functionality is also offered by some firewall vendors
through a software component called Oracle Net Firewall Proxy. A host computer,
called an application gateway, runs the Oracle Connection Manager software.

Figure 1–14 shows an application gateway controlling traffic between internal and
external networks and providing a single checkpoint for access control and
auditing. As a result, unauthorized Internet hosts cannot directly access the
database inside a corporation, but authorized users can still use Internet services
outside the corporate network. This capability is critical in Internet environments to
restrict remote access to sensitive data.

Figure 1–14 Internet Network Access Control with an Application Gateway
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Enhanced Network Security Through Oracle Advanced Security
Oracle Advanced Security provides network security through the features
described in the following topics:

■ Data Encryption

■ User Authentication and Single Sign-On

■ Enterprise User Security
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Data Encryption Sensitive information that travels over the Internet can be
protected by encryption. Encryption is the mutation of information into a form
readable only with a decryption key.

Figure 1–15 shows how encryption works. To ensure the security of the transaction,
the buyer wishes to purchase a company’s product over the Internet using a credit
card. The buyer’s credit card number is encrypted with an encryption key. The
encrypted credit number is sent across the network to the database. Encryption
scrambles the message, rendering it unreadable to anyone but the recipient. The
server decrypts the message with a decryption key and reads the credit card
number.

Figure 1–15 Encryption
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User Authentication and Single Sign-On Authentication is used to prove the
identity of the user. Passwords are the most common means of authentication.
Oracle Advanced Security allows for enhanced authentication through Oracle
authentication adapters that support various third-party authentication services.

Figure 1–16 shows user authentication with an Oracle database configured with an
authentication server. This architecture provides high confidence in the identity of
users in distributed environments. Having a central facility to authenticate all
members of the network (clients to servers, servers to servers, users to both clients
and servers) is one effective way to address the threat of network nodes falsifying
their identities.

Figure 1–16 User Authentication
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Single sign-on enables users to access multiple accounts and applications with a
single password. A user only needs to log on once and can then automatically
connect to any other service without having to give a username and password
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Authentication is provided through the following third-party services:

■ Secure Sockets Layer (SSL)

■ RADIUS

■ CyberSafe

■ Kerberos

■ Distributed Computing Environment (DCE)

Enterprise User Security A centralized directory server can be used to store user,
administration, and security information. This centralized configuration enables the
administrator to modify information in one location, the directory. It also lowers the
cost of administration and makes the enterprise more secure.
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Figure 1–17 shows how a directory server can be used to provide centralization of
user account, user role, and password information.

1. A database server authenticates a user by accessing information stored in the
directory.

2.-4.Once authenticated, a user can access the databases, which are configured for
enterprise user security.

Figure 1–17 Centralized Storage of Security Configuration with a Directory Server
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A Suite of Networking Components
The connectivity, manageability, scalability, and security features described in this
chapter are provided by the following components and products, which are
discussed in the following topics:

■ Oracle Net Services

■ Oracle Advanced Security

Oracle Net Services
This section describes the following components:

■ Oracle Net

■ Oracle Net Listener

■ Oracle Connection Manager

■ Networking Tools

Oracle Net
Oracle Net is a software layer that resides on the client and the Oracle database
server. It is responsible for establishing and maintaining the connection between the
client application and server, as well as exchanging messages between them, using
industry-standard protocols. Oracle Net is comprised of two software components:

■ Oracle Net foundation layer

■ Oracle protocol support

Oracle Net Foundation Layer On the client side, applications communicate with Oracle
Net foundation layer to establish and maintain connections. The Oracle Net
foundation layer, in turn, uses Oracle protocol support that is able to communicate
with an industry-standard network protocol, such as TCP/IP, to communicate with
the Oracle database server.
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Figure 1–18 illustrates the communication stack on the client.

Figure 1–18 Oracle Net on the Client

The Oracle database server side is similar to the client side as illustrated in
Figure 1–19. A network protocol sends client request information to an Oracle
protocol support layer, which then sends information to the Oracle Net foundation
layer. The Oracle Net foundation layer then communicates with the Oracle database
server to process the client request.

Figure 1–19 Oracle Net on the Server
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Oracle Net Listener
The one operation unique to the Oracle database server side is the act of receiving
the initial connection through an Oracle Net listener. The Oracle Net listener,
commonly known as the listener, brokers a client request, handing off the request
to the server. The listener is configured with a protocol address. Clients configured
with the same protocol address can send connection requests to the listener. Once a
connection is established, the client and Oracle database server communicate
directly with one another.

Figure 1–20 shows a listener accepting a connection request from a client and
forwarding that request to an Oracle database server.

Figure 1–20 Listener in a Connection Request
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Oracle Connection Manager
Oracle Connection Manager is a software component that resides on its own
computer, separate from a client or an Oracle database server. It proxies requests
destined for the database server. You can also configure Oracle Connection Manager
to multiplex sessions, control access, or convert protocols.

In its session multiplexing role, Oracle Connection Manager funnels multiple
sessions through a single transport protocol connection to a particular destination.
This reduces the demand on resources needed to maintain multiple sessions
between two processes by enabling the Oracle database server to use fewer
connection end points for incoming requests.

As an access control filter, Oracle Connection Manager controls access to Oracle
databases.

As a protocol converter, Oracle Connection Manager enables a client and an Oracle
database server that have different networking protocols to communicate with each
other.

Oracle Connection Manager functionality is also offered by some firewall vendors
through Oracle Net Firewall Proxy. A host computer, or application gateway, runs
the Oracle Connection Manager proxy software. An application gateway looks and
acts like a real server from the client’s point of view, and a real client from the
server’s point of view. The application gateway sits between the Internet and a
company’s internal network and provides middleman services to users on either
side.

See Also:

■ "Session Multiplexing" on page 1-16 for an explanation of
routing

■ "Firewall Access Control" on page 1-19 for a description of
filtering

Note: Ask your firewall vendor if its product supports Oracle Net
Firewall Proxy.
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Networking Tools
Oracle Net Services provide graphical user interface tools and command-line
utilities that enable you to easily configure, manage, and monitor the network.

Oracle Net Configuration Assistant is a tool that configures basic network
components after installation, including:

■ Listeners

■ Naming methods

■ Directory server usage

Oracle Net Manager combines configuration abilities with component control to
provide an integrated environment for configuring and managing Oracle Net
Services. With Oracle Net Manager, you can fine-tune the listener and naming
method configuration created with Oracle Net Configuration Assistant. In addition,
Oracle Net Manager offers built-in wizards and utilities that enable to you to test
connectivity, migrate data from one naming method to another, and create
additional network components.

The command-line control utilities enable you to configure, administer, and monitor
network components, such as listeners and Oracle Connection Managers.

See Also: Chapter 5, "Configuration and Administration Tools
Overview"
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Oracle Advanced Security
Oracle Advanced Security is a separately licensable product that provides a
comprehensive suite of security features for the Oracle environment. This suite of
security features protects enterprise networks and securely extends corporate
networks to the Internet. It provides a single source of integration with network
encryption and authentication solutions, single sign-on services, and security
protocols. Oracle Advanced Security integrates industry standards and delivers
unparalleled security to the Oracle network and other networks.

See Also: Oracle Advanced Security Administrator’s Guide
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2
Connectivity Concepts

This chapter explains how databases are identified and how clients access them.

This chapter contains these topics:

■ Database Service and Database Instance Identification

■ Service Accessibility

■ Enhanced Service Accessibility with Multiple Listeners

■ Service Handlers

■ Naming

See Also: Chapter 1, "Networking Challenges in the Internet Age"
for an introductory level overview of networking concepts
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Database Service and Database Instance Identification
This section contains these topics:

■ Database Services

■ Database Instances

Database Services
An Oracle database is represented to clients as a service; that is, the database
performs work on behalf of clients. A database can have one or more services
associated with it.

Figure 2–1 shows two databases, each with its own database service for intranet
clients. One service, sales.us.acme.com , enables salespersons to access the sales
database. Another service, finance.us.acme.com , enables financial analysts to
access the finance database.

Figure 2–1 One Service Per Database

The sales and finance databases are identified by service names,
sales.us.acme.com  and finance.us.acme.com  in this example. The service
name is specified by the SERVICE_NAMES parameter in the initialization parameter
file. The service name defaults to the global database name, a name comprising the
database name (DB_NAME parameter) and domain name (DB_DOMAIN parameter).
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In the case of sales.us.acme.com , sales  is the database name and
us.acme.com  is the domain name.

A database can have multiple services associated with it. Figure 2–2 shows one
database that has two different services for Web clients. One service,
book.us.acme.com , is dedicated to clients making book purchases. The other
service, soft.us.acme.com , is dedicated to clients making software purchases.

Figure 2–2 Multiple Services Associated with One Database

Having multiple services associated with one database enables the following
functionality:

■ A single database can be identified in a number of different ways by different
clients.

■ A database administrator can limit or reserve system resources. This level of
control enables better allocation of resources to clients requesting one of these
services

Note: You can change the value of SERVICE_NAMES parameter
dynamically with the SQL statement ALTER SYSTEM when the
database is running. See the Oracle9i SQL Reference for further
information about the ALTER SYSTEM statement and the Oracle9i
Database Reference for further information about the SERVICE_
NAMES parameter.
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Database Instances
A database has one or more instances. An instance is comprised of a memory area
called the System Global Area (SGA) and Oracle processes. The memory and
processes of an instance efficiently manage the associated database's data and serve
the database users.

Figure 2–3 shows two instances, sales  and finance , associated with their
respective databases.

Figure 2–3 One Instance Per Database

Like services, instances are identified by an instance name, sales  and finance  in
this example. The instance name is specified by the INSTANCE_NAME parameter in
the initialization parameter file. The instance name defaults to the Oracle System
Identifier (SID) of the instance.

Note: An instance also manages other services, such as Oracle
XML DB.
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Some hardware architectures allow multiple computers to share access to data,
software, or peripheral devices. Oracle9i Real Application Clusters can take
advantage of such architecture by running multiple instances on different
computers that share a single physical database.

Figure 2–4 shows an Oracle9i Real Application Clusters configuration. In this
example, two instances, sales1  and sales2 , are associated with one database
service, sales.us.acme.com .

Figure 2–4 Multiple Instances Associated with a Database
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Service Accessibility
To connect to a database service, clients use a connect descriptor that provides the
location of the database and the name of the database service. The following
example shows a connect descriptor that enables clients to connect to a database
service called sales.us.acme.com .

(DESCRIPTION=
  (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=1521))
  (CONNECT_DATA=
    (SERVICE_NAME=sales.us.acme.com)))

The address portion of the connect descriptor is actually the protocol address of the
listener. To connect to a database service, clients first contact a listener process that
typically resides on the database server. The listener receives incoming client
connection requests and hands these requests to the database server. Once the
connection is established, the client and database server communicate directly.

Much like a business address, the listener is configured to accept requests from
clients at a protocol address. This address defines the protocol the listener is
listening on and any other protocol specific information. For example, the listener
could be configured to listen at the following protocol address:

(DESCRIPTION=
   (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=1521)))

This example shows a TCP/IP protocol address that specifies the host of the listener
and a port number. Clients configured with this same protocol address can send
connection requests to this listener.

The connect descriptor also specifies the database service name with which clients
seek to establish a connection. The listener knows which services for which it can
handle connection requests, because an Oracle database dynamically registers this
information with the listener. This process of registration is called service
registration. It also provides the listener with information about the database
instances and the service handlers available for each instance. Service handlers act
as connection points to an Oracle database server. A service handler can be a
dispatcher or a dedicated server.

See Also:

■ "Service Handlers" on page 2-10 for a description of these
service handler types

■ "Listener Architecture" on page 4-10 for a discussion of how the
listener works with service handlers
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If connecting to a specific instance of the database is required, clients can also
specify the INSTANCE_NAME of a particular instance in the connect descriptor. This
feature can be useful if you have an Oracle9i Real Application Clusters
configuration. For example, the following connect descriptor specifies an instance
name of sales1  that is associated with sales.us.acme.com .

(DESCRIPTION=
  (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=1521))
  (CONNECT_DATA=
    (SERVICE_NAME=sales.us.acme.com)

(INSTANCE_NAME=sales1) ))

Alternatively, clients that always want to use a particular service handler type can
use a connect descriptor that specifies the service handler type. In the following
example, a connect descriptor is configured to use a dispatcher for a shared server
configuration, as indicated by (SERVER=shared) .

(DESCRIPTION=
  (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=1521))
  (CONNECT_DATA=
    (SERVICE_NAME=sales.us.acme.com)

(SERVER=shared) ))

If you want the client to use a dedicated server, you can specify
(SERVER=dedicated)  in place of (SERVER=shared) . If the SERVER parameter
is not set, then shared server configuration is assumed. However, the client will use
a dedicated server if no dispatchers are available.

When the listener receives the client request, it selects one of the service handlers
that were previously registered. Depending on the type of handler selected, the
communication protocol used, and the operating system of the database server, the
listener performs one of the following actions:

■ Hands the connect request directly off to a dispatcher.

■ Sends a redirect message back to the client with the location of the dispatcher or
dedicated server process. The client then connects directly to the dispatcher or
dedicated server process.

■ Spawns a dedicated server process and passes the client connection to the
dedicated server process.

Once the listener has completed the connection operation for the client, the client
communicates with the Oracle database server without the listener’s involvement.
The listener resumes listening for incoming network sessions.
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Enhanced Service Accessibility with Multiple Listeners
For some configurations, such as Oracle9i Real Application Clusters, multiple
listeners on multiple nodes can be configured to handle client connection requests
for the same database service. In the following example, sales.us.acme.com can
connect to sales.us.acme.com  using listeners on either sales1-server  or
sales2-server .

(DESCRIPTION=
(ADDRESS_LIST=

(ADDRESS=(PROTOCOL=tcp)(HOST=sales1-server)(PORT=1521) )
(ADDRESS=(PROTOCOL=tcp)(HOST=sales2-server)(PORT=1521) ))

  (CONNECT_DATA=
    (SERVICE_NAME=sales.us.acme.com)))

A multiple-listener configuration also enables you to leverage the following failover
and load balancing features:

■ Connect-Time Failover

■ Transparent Application Failover

■ Client Load Balancing

■ Connection Load Balancing

These features can be implemented either singly or in combination with each other.

Connect-Time Failover
The connect-time failover enables clients to connect to another listener if the initial
connection to the first listener fails. The number of listener protocol addresses
determines how many listeners are tried. Without connect-time failover, Oracle Net
attempts a connection with only one listener.

Transparent Application Failover
The Transparent Application Failover (TAF) feature is a runtime failover for
high-availability environments, such as Oracle9i Real Application Clusters and
Oracle9i Real Application Clusters Guard. TAF fails over and reestablishes
application-to-service connections. It enables client applications to automatically
reconnect to the database if the connection fails and, optionally, resume a SELECT
statement that was in progress. The reconnection happens automatically from
within the Oracle Call Interface (OCI) library.
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Client Load Balancing
The client load balancing feature enables clients to randomize connection requests
among the listeners. Oracle Net progresses through the list of protocol addresses in
a random sequence, balancing the load on the various listeners. Without client load
balancing, Oracle Net progresses through the list of protocol addresses sequentially
until one succeeds.

Connection Load Balancing
The connection load balancing feature improves connection performance by
balancing the number of active connections among multiple dispatchers. In a
single-instance environment, the listener selects the least loaded dispatcher to
handle the incoming client requests. In an Oracle9i Real Application Clusters
environment, connection load balancing also has the capability to balance the
number of active connections among multiple instances.

Due to dynamic service registration, a listener is always aware of all instances and
dispatchers regardless of their location. Depending on the load information, a
listener decides which instance and, if shared server is configured, which dispatcher
to send the incoming client request to.

In a shared server configuration, a listener selects a dispatcher in the following
order:

1. Least-loaded node

2. Least-loaded instance

3. Least-loaded dispatcher for that instance

In a dedicated server configuration, a listener selects an instance in the following
order:

1. Least loaded node

2. Least loaded instance

If a database service has multiple instances on multiple nodes, the listener chooses
the least loaded instance on the least loaded node. If shared server is configured,
then the least loaded dispatcher of the selected instance is chosen.
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Service Handlers
This section contains these topics:

■ Dispatchers

■ Dedicated Server Processes

Dispatchers
The shared server architecture uses a dispatcher process to direct client connections
to a common request queue. An idle shared server process from a shared pool of
server processes picks up a request from the common queue. This approach enables
a small pool of server processes to serve a large number of clients. A significant
advantage of the shared server model over the dedicated server model is reduced
system resources, enabling support of an increased number of users.

The listener uses the dispatcher as a type of service handler to which it can direct
client requests. When client a client request arrives, the listener performs one of the
following actions:

■ Hands the connection request directly to a dispatcher.

■ Issues a redirect message to the client, containing the protocol address of a
dispatcher. The client then terminates the network session to the listener and
establishes a network session to the dispatcher, using the network address
provided in the redirect message.

The listener uses direct hand off whenever possible. Redirect messages are used, for
example, when dispatchers are remote to the listener.
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Figure 2–5 shows the listener handing a connection request directly off to a
dispatcher.

1. The listener receives a client connection request.

2. The listener hands the connect request directly to the dispatcher.

3. The client is now connected to the dispatcher.

Figure 2–5 Direct Hand-Off to a Dispatcher
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Figure 2–6 shows the role of a dispatcher in a redirected connection.

1. The listener receives a client connection request.

2. The listener provides the location of the dispatcher to the client in a redirect
message.

3. The client connects directly to the dispatcher.

Figure 2–6 Redirected Connection to a Dispatcher
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Dedicated Server Processes
In a dedicated server configuration, the listener starts a separate dedicated server
process for each incoming client connection request dedicated to servicing the
client. Once the session is complete, the dedicated server process terminates.
Because a dedicated server process has to be started for each connection, this
configuration may require more system resources than shared server
configurations.

A dedicated server process is a type of service handler that the listener starts when
it receives a client request. To complete a client/server connection establishment,
one of the following actions occurs:

■ The dedicated server inherits the connection request from the listener.

■ The dedicated server informs the listener of its listening protocol address. The
listener passes the protocol address to the client in a redirect message and
terminates the connection. The client connects to the dedicated server directly
using the protocol address.

If the client and database server exist on the same computer, a client connection can
be passed directly to a dedicated server process without going through the listener.
The application initiating the session spawns a dedicated server process for the
connection request. This happens automatically if the application that is used to
start the database is on the same computer as the database.

Note: One of the options is selected based on the operating
system and the transport protocol.

Note: In order for remote clients to connect to dedicated servers,
the listener and the database instance must be running on the same
computer.
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Figure 2–7 shows the listener passing a client connection request to a dedicated
server process.

1. The listener receives a client connection request.

2. The listener starts a dedicated server process, and the dedicated server inherits
the connection request from the listener.

3. The client is now connected directly to the dedicated server.

Figure 2–7 Connection to a Dedicated Server Process
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Figure 2–8 shows the role of a dedicated server in a redirected connection.

1. The listener receives a client connection request.

2. The listener starts a dedicated server process.

3. The listener provides the location of the dedicated server process to the client in
a redirect message.

4. The client connects directly to the dedicated server.

Figure 2–8 Redirected Connection to a Dedicated Server Process

Client

Database
Dedicated

Server
Process

Listener
1

3

2

4
Database Instance



Naming

2-16 Oracle9i Net Services Administrator’s Guide

Naming
Users initiate a connection request by providing a connect string. A connect string
includes a username and password, along with a connect identifier. A connect
identifier can be the connect descriptor itself or a name that resolves to a connect
descriptor. One of the most common connect identifiers is a net service name, a
simple name for a service. The following examples demonstrate one connect string
that uses a complete connect descriptor as the connect identifier and another
connect string that uses net service name sales  as the connect identifier.

CONNECT
scott/tiger@(DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=sales-server1)(PORT=1521))
(CONNECT_DATA=(SERVICE_NAME=sales.us.acme.com)))

CONNECT scott/tiger@sales

When net service name sales  is used, connection processing takes place by first
mapping sales to the connect descriptor. This mapped information is stored in one
or more repositories of information that are accessed with naming methods.

The process for establishing a client session with the aid of a naming method is as
follows:

1. The client initiates a connect request by providing a connect identifier.

2. The connect identifier is resolved to a connect descriptor by a naming method.
This information is returned to the client.

3. The client makes the connection request to the address provided in the connect
descriptor.

4. A listener receives the request and directs it to the appropriate database server.

5. The connection is accepted by the database server.

Oracle Net provides support for following naming methods:

■ Local Naming

■ Directory Naming

■ Oracle Names

■ Host Naming

■ External Naming

Note: Besides connect descriptors, you can use naming methods
to map a name to a protocol address or protocol address list.
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Local Naming
The local naming method stores net service names and their connect descriptors in
a localized configuration file named tnsnames.ora .

Directory Naming
The directory naming method stores connect identifiers in a centralized
LDAP-compliant directory server to access a database service.

Oracle Names
Oracle Names uses Oracle proprietary software to store the names and addresses of
all database services on a network. Clients wishing to connect to a database server
direct their connect requests to an Oracle Names server. Oracle Names servers
resolve the name to a network address and return that information to the client.

Host Naming
The host naming method enables users to connect to an Oracle database server by
using a host name alias. Host names are mapped to the database server’s global
database name in an existing names resolution service, such as Domain Name
System (DNS), Network Information Service (NIS), or a centrally maintained set
of /etc/hosts  files.

External Naming
The external naming method stores net service names in a supported non-Oracle
naming service. These supported third-party services include:

■ NIS External Naming

■ Distributed Computing Environment (DCE) Cell Directory Services (CDS)

Note: In future releases, Oracle Names will not be supported as a
centralized naming method. Because no new enhancements are
being added to Oracle Names, consider using directory naming
instead or migrating an existing Oracle Names configuration to
directory naming, as described in Chapter 10, "Exporting Naming
Data to a Directory Server".
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3
Configuration Management Concepts

This chapter describes how configuration information for Oracle Net Services can
be stored in localized configuration files or centralized in a directory server.

The topics covered include:

■ Configuration Models

■ Localized Configuration File Support

■ Directory Server Support

■ Oracle Names Support
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Configuration Models
Configuration information can be stored in a localized configuration file or a
centralized repository, as described in the Table 3–1.

Table 3–1 Oracle Net Configuration Models

Localized Configuration File Support
Depending on the configuration model used, network computers can be configured
with the files described in Table 3–2.

Table 3–2 Oracle Net Configuration Files

Network Configuration Model Description

Localized management Network address information stored in tnsnames.ora
files on each computer in the network.

Centralized management Network address information is stored in centralized
directory services, including a LDAP-compliant directory
server or an Oracle Names server.

Note: In future releases, Oracle Names will not be
supported as a centralized naming method.

Configuration File Description

ldap.ora Located on the database server and client computers
configured for centralized management features, this file
contains parameters necessary to access a directory server.

listener.ora Located on the database server, this configuration file for the
listener includes:

■ Protocol addresses it is accepting connection requests on

■ Database and nondatabase services it is listening for

■ Control parameters used by the listener

names.ora Located on the Oracle Names server, this file includes the
location, domain information, and optional configuration
parameters for an Oracle Names server.
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Configuration files are typically created in $ORACLE_HOME/network/admin  on
UNIX operating systems and ORACLE_HOME\network\admin  on Windows
operating systems. However, configuration files can be created in a variety of
places, because Oracle Net searches for the configuration files in a variety of places.
The search order for sqlnet.ora  and ldap.ora  is as follows:

1. The directory specified by the TNS_ADMIN environment variable

If the TNS_ADMIN environment variable is not defined as a variable on
Windows NT, it may be in the registry.

2. The $ORACLE_HOME/network/admin  directory on UNIX operating systems
and the ORACLE_HOME\network\admin  directory on Windows operating
systems

The search order for cman.ora , listener.ora , names.ora , and
tnsnames.ora  is as follows:

1. The directory specified by the TNS_ADMIN environment variable

If the TNS_ADMIN environment variable is not defined as a variable on
Windows NT, it may be in the registry.

2. On UNIX operating systems, the global configuration directory

sqlnet.ora Located on client and database server computer, this file may
contain:

■ Client domain to append to unqualified service names or
net service names

■ Order of naming methods the client should use when
resolving a name

■ Logging and tracing features to use

■ Route of connections

■ Preferred Oracle Names servers

■ External naming parameters

■ Oracle Advanced Security parameters

■ Database access control parameters

tnsnames.ora Located on the clients, this file contains net service names
mapped to connect descriptors. This file is used for the local
naming method.

Configuration File Description
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For example, on Sun SPARC Solaris, this directory is /var/opt/oracle .

3. The $ORACLE_HOME/network/admin  directory on UNIX operating systems
and the ORACLE_HOME\network\admin  directory on Windows operating
systems.

Directory Server Support
Today, network information is stored in multiple systems and in multiple directory
formats. With new requirements for Internet computing and new e-business
technologies, a common repository infrastructure is needed as a foundation for
management and configuration of all data and resources. This kind of infrastructure
reduces the cost of managing and configuring resources in a network.

Support of LDAP-compliant directory servers provides a centralized vehicle for
managing and configuring a distributed Oracle network. The directory server can
replace clientside and serverside localized tnsnames.ora  files.

This section contains these topics:

■ Directory Naming Overview

■ Naming Configuration Storage in a Directory Server

■ Directory Entries

■ Adding or Modifying Entries in the Directory Server

■ Client Connections Using Directory Naming

■ Oracle Net Configuration and Directory Server Design

See Also: Oracle operating system-specific documentation
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Directory Naming Overview
Oracle Net Services use a centralized directory server as one of the primary
methods for storage of connect identifiers. Clients configured directory usage can
use the connect identifiers in their connect string. The directory server resolves the
connect identifier to a connect descriptor that is passed back to the client.

Figure 3–1 on page 3-6 shows a client resolving a connect identifier through a
directory server.

1. The client contacts the directory server to resolve a connect identifier to a
connect descriptor.

2. The directory server resolves the connect identifier and retrieves the connect
descriptor for the client.

3. The client sends the connection request to the listener, using the connect
descriptor.
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Figure 3–1 Client Using a Directory Server to Resolve a Connect Identifier

Notes:

■ Oracle Net Services directly supports Oracle Internet Directory
and Microsoft Active Directory

■ Oracle provides support for Microsoft Active Directory only on
Windows operating systems. Therefore, client computers and
the database server must also run on Windows operating
systems to access or create entries in Microsoft Active Directory.

■ Java Database Connectivity (JDBC) Drivers support directory
naming. See the Oracle9i JDBC Developer’s Guide and Reference
for further information.
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Naming Configuration Storage in a Directory Server
Directory servers store information in a tree structure called a directory
information tree (DIT). Each node in the tree is called an entry. Oracle Net Services
makes use of both the tree structure and specific entries in the tree. For example,
consider Figure 3–2.

Figure 3–2 Database Service and Net Service Name in a Directory Server

The cn=sales  and cn=db1  entries represent a net service name and a database
service, respectively. Additional entries under cn=sales  and cn=db1  contain the
connect descriptor information. These entries are not represented in the graphic.
The cn=sales  and cn=db1  entries enable clients to connect to the database using
connect strings CONNECTusername / password @sales  and CONNECT
username / password @db1.

Each entry is uniquely identified by a distinguished name (DN). The DN tells you
exactly where the entry resides in the directory server’s hierarchy. The DN for db1
is dn:cn=db1,cn=OracleContext,dc=jp,dc=acme,dc=com , and the DN for
sales  is dn:cn=sales,cn=OracleContext,dc=jp,dc=acme,dc=com . Note
that the format of a DN places the lowest component of the DIT to the left, then
moves progressively up the DIT. Each DN is made up of a sequence of relative
distinguished names (RDNs), much the way a directory path contains a sequence
of directories. In the entry for db1 , the RDN is cn=db1 . A RDN is made up of a set
of attributes. For example, in cn=db1 , cn  is one of the entry’s attributes. The
attribute, along with its value, uniquely identifies the entry.

dc=us

cn=OracleContext

cn=db1

dc=jp

dc=com

dc=acme

(DESCRIPTION=
(ADDRESS=(PROTOCOL=tcp)(HOST=db1-server)
(PORT=1521))(CONNECT_DATA=
(SERVICE_NAME=db1.jp.acme.com)))

cn=db1

cn=sales
.
.
.

.

.

.
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Notice that db1  and sales  reside under cn=OracleContext . This entry is a
special RDN called an Oracle Context. The entries under the Oracle Context
support various directory-enabled features, such as directory naming and
enterprise user security.

During directory server usage configuration, a default directory entry that contains
an Oracle Context is selected. The client uses this entry as the default location to
look up connect identifiers in the directory server. The default Oracle Context
affects the connect string. For example, if a client needs to access the db1  and
sales  entry frequently, a reasonable Oracle Context would be
dc=jp,dc=acme,dc=com . The cn=OracleContext does not have to be explicitly
specified in the connect string. If a client’s directory entry does not match the
directory entry where the service is located, then the client must specify an entry’s
absolute name in the connect string, as described in "Client Connections Using
Directory Naming" on page 3-14.

See Also: Oracle Advanced Security Administrator’s Guide for
further information about enterprise user security
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Net Service Alias Entries
In addition to database service and net service name entries, directory naming
enables you to create net service alias entries. A net service alias is an alternative
name for a net service name or database service. A net service alias entry does not
have connect descriptor information. Instead, it only references the location of the
entry for which it is an alias. When a client requests a directory lookup of a net
service alias, the directory determines that the entry is a net service alias and
completes the lookup as if it is the referenced entry. For example, in Figure 3–3, a
net service alias of db1alias  is created for a database service of db1 . When
db1alias  is used to connect to a database service, as in CONNECT
username / password @db1alias , it will actually resolve to and use the connect
descriptor information for db1 .

Figure 3–3 Net Service Alias db1alias in a Directory Server

There are several uses for using net service aliases. As shown in Figure 3–3, a net
service alias can be useful as a way for clients to refer to a net service name by
another name. Another use is to have a net service alias in one Oracle Context for a
database service or net service name in a different Oracle Context. This enables a
database service or net service name to be defined once in the directory server, but
referred to by clients that use other Oracle Contexts.

Note: Net service aliases are not supported using Microsoft Active
Directory.

cn=OracleContext

cn=db1

dc=jp
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dc=acme

cn=db1alias
(Net Service Alias Entry)
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In Figure 3–4, database service db1  resides in dc=jp,dc=acme,dc=com . A net
service alias named db1  is created in dc=us,dc=acme,dc=com . This enables
clients in both Japan and the United States to use the connect string CONNECT
username / password @db1 as opposed to clients in the United States needing to
specify CONNECTusername / password @db1.jp.acme.com .

Figure 3–4 Net Service Alias db1 in a Directory Server
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Directory Entries
DITs are commonly structured using:

■ A Domain Name Space (DNS) structure

■ A geographical and organization structure

Other structures are also permitted, but Oracle Corporation provides support for
these structures.

Figure 3–5 shows a DIT structured according to DNS domain components.

Figure 3–5 Domain Component DIT

Figure 3–6 shows a DIT structured according to country, organization, and
organizational units. This structure is commonly referred to as an X.500 DIT.

Figure 3–6 X.500 Style DIT
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Adding or Modifying Entries in the Directory Server
A database service entry is created with Database Configuration Assistant during
or after some modes of installation. Net service name and net service alias entries
can be created with Oracle Net Manager. Oracle Net Manager can also be used to
modify the Oracle Net attributes of the database service entries. Figure 3–7 shows
how Database Configuration Assistant and Oracle Net Manager interface with the
directory server.

Figure 3–7 Creating Entries in the Directory Server with Applications

Clients configured for directory server usage, as described in "Client Connections
Using Directory Naming" on page 3-14, can connect to a database using entries
created by these configuration tools.
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To use these configuration tools to add entries, an Oracle Context must exist. You
create the Oracle Context by completing directory server usage configuration using
Oracle Net Configuration Assistant. If you are using Oracle Internet Directory, then
an Oracle Context is automatically created at the root of the DIT structure. This root
Oracle Context has a complete DN of dn:cn=OracleContext . For most
deployments, you will need to create additional Oracle Contexts.

To create entries with Database Configuration Assistant or Oracle Net Manager, you
must be a member of the following groups:

■ OracleDBCreators group (cn=OracleDBCreators,cn=OracleContext... )
or the OracleContextAdmins group
(cn=OracleContextAdmins,cn=Groups,cn=OracleContext... ) to
create a database service entry with Database Configuration Assistant

■ OracleNetAdmins group (cn=OracleNetAdmins,cn=OracleContext... )
or the OracleContextAdmins group to create net service names or net service
aliases with Oracle Net Manager

The directory user that created the Oracle Context is automatically added to these
groups. Other users can be added to these groups by the directory administrator.

The OracleContextAdmins group is a super-user group for the Oracle Context.
Members of the OracleContextAdmins group can add all supported types of entries
to the Oracle Context.

See Also:

■ "Configuring the Directory Naming Method" on page 9-12 for
further information about using Oracle Net Manager

■ Oracle9i Directory Service Integration and Deployment Guide for
further information about how to register a database service
with Database Configuration Assistant
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Client Connections Using Directory Naming
Most clients only need to perform name lookups in the directory server. To perform
a lookup, the following minimum requirements must be met:

■ The client’s Oracle home must be configured for directory server usage

■ The directory server must allow anonymous authentication

Directory servers usually do this by default.

You can use Oracle Net Configuration Assistant to perform the necessary directory
server usage configuration during client installation. When directory usage
configuration completes, directory usage information is stored in an ldap.ora  file.
The client reads this file to locate the directory server and the default Oracle
Context.

In the same way they might use other naming methods, clients make connections to
a database using connect identifiers. The connect identifiers can be a database
service, net service name, or net service alias. These can be referred to by their
common names, or they can require additional directory location information. The
default Oracle Context determines how the connect identifier must be specified.

An entry may be identified in one of two ways:

■ Using the Entry’s Relative Name

■ Using the Entry’s Absolute Name

See Also: Chapter 8, "Setting Up Directory Server Usage" for
information about configuring directory server access

Note: JDBC OCI Drivers support both relative and absolute
naming. JDBC Thin Drivers support absolute naming only when
the complete DN is used. See the Oracle9i JDBC Developer’s Guide
and Reference for further information.
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Using the Entry’s Relative Name
In the following example, an entry is identified by its relative name, and the service
can be referred to by its common name. A relative name can be used if the entry is
in the same Oracle Context that was configured to be the default Oracle Context for
the client’s Oracle home.

Consider a directory server that contains an entry for a database called sales  with
a DN of dn:cn=sales,cn=OracleContext,o=acme,c=us , as shown in
Figure 3–8. If the client is configured with a default Oracle Context of
cn=OracleContext,o=acme,c=us , then the connect identifier can simply be
sales .

Figure 3–8 Relative Naming

o=acme

cn=OracleContext
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CONNECT scott/tiger@sales

Connect String=
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Using the Entry’s Absolute Name
Consider the same directory structure as shown Figure 3–8 on page 3-15, but with
the client’s Oracle home configured with a default Oracle Context of
cn=OracleContext,o=acme,c=jp .

Because the client is configured with an Oracle Context that does not match the
location of sales  in the directory server, a connect string that uses sales  does not
work. Instead, the client must specifically identify the location of sales , which can
be done in one of two ways:

■ The entry’s complete DN can be used in the connect string, for example:

CONNECTusername / password @"cn=sales,cn=OracleContext,o=acme,c=us"

Many applications do not support the use of a DN.

■ The entry can be referred to by a fully-qualified name, a name that includes the
name of the object and its location in the directory server, for example:

CONNECTusername / password @sales.acme.us

Note: JDBC Thin drivers support absolute naming only when the
complete DN is used.

See Also: "Absolute Name Specification for Directory Naming"
on page 16-9 for further information about absolute names
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Oracle Net Configuration and Directory Server Design
If you are responsible for designing directory servers for directory naming, consider
the following issues:

■ Performance

■ Security

■ Schema

Performance
Connect identifiers are stored in a directory server for all clients to access.
Depending on the number of clients, there can be a significant load on a directory
server.

During a connect identifier lookup, a name is searched under a specific Oracle
Context. Because of the scope of the lookup, you probably want users to experience
relatively quick performance so that the database connect time is not affected. Users
may begin to notice slow connect times if lookups takes more than one second.

You can resolve performance problems changing the network topology or
implementing replication.

Security
Because administrative clients can create and modify entries in the directory server,
security is essential. This section covers the following security-related topics:

■ Authentication Methods

■ Access Control Lists

See Also: Directory server vendor documentation for details on
resolving performance issues
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Authentication Methods Clients that perform lookups for information in the directory
server typically use anonymous authentication.

Clients that add or modify entries in a directory must authenticate with the
directory server. Database Configuration Assistant or Oracle Net Manager may be
used to add or modify the entries. Only authenticated users with proper privileges
can modify entries. Use one of the authentication methods listed in Table 3–3.

Table 3–3 LDAP Directory Authentication Methods

Access Control Lists Authentication is used with access control lists (ACLs) to make
decisions about whether clients can modify or add information in the directory
server. ACLs are created at the same time as the Oracle Context with Oracle Net
Configuration Assistant during directory server access configuration.

Authentication Method Description

Native Authentication The directory server uses operating system user credentials.

Simple Authentication The client identifies itself to the directory server by means of a
DN and a password, which are sent in the clear over the
network. The server verifies that the DN and password sent by
the client match the DN and password stored in the directory
server.

Strong Authentication Directories provide strong authentication by using public-key
encryption available with Secure Sockets Layer (SSL). In
public-key encryption, the sender of a message encrypts the
message with the public key of the recipient. Upon delivery, the
recipient decrypts the message using the recipient’s private key.
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ACLs specify the following:

■ The entries that the user can access

■ The authentication method used to access the entry

■ The access rights, or what the user can do with the object (read/write)

ACLs are established for a group of users. During Oracle Context creation, the
OracleDBCreators, OracleNetAdmins, and OracleContextAdmins groups are
created.

The user who creates the Oracle Context with Oracle Net Configuration Assistant is
automatically added as the first member of these groups.

Table 3–4 describes ACL requirements for these groups and anonymous users and
their relation to Oracle Net entries in the directory server.

Table 3–4 LDAP Directory User Groups

Note: Additional groups are created during Oracle Context
creation, as described in the Oracle9i Directory Service Integration and
Deployment Guide.

Group ACL Requirements

Anonymous users All Oracle Net attributes and objects in the directory server have
read access for the anonymous user. Read access of these objects for
anonymous is also applied to the Oracle Context. This enables
anonymous users to browse directory naming entries contained
within the cn=OracleContext  RDN. This does not include
objects used for enterprise user security.

Oracle Net Configuration Assistant sets up this access right during
client installation.

OracleContextAdmins
group users

Members of OracleDBCreators
(cn=OracleContextAdmins,cn=Groups,cn=OracleContext
,... ) have create, modify, and read access to all directory naming
objects. Oracle Net Configuration Assistant establishes these access
rights for this group during Oracle Context creation.

In addition to the Oracle Context creator, other users can be added
to this group by the directory administrator with Oracle Enterprise
Security Manager.
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OracleDBCreators
group users

Members of OracleDBCreators
(cn=OracleDBCreators,cn=OracleContext,... ) have create
and read access to database service objects and attributes. Oracle
Net Configuration Assistant establishes these access rights for this
group during Oracle Context creation.

In addition to the Oracle Context creator, other users can be added
to this group by the directory administrator with Oracle Enterprise
Security Manager.

See Also: Oracle Advanced Security Administrator’s Guide for further
information about the OracleDBCreators group

OracleNetAdmins
group users

Members of OracleNetAdmins
(cn=OracleOracleNetAdmins,cn=OracleContext,... )
have create, modify, and read access to directory naming objects
and attributes. Oracle Net Configuration Assistant establishes these
access rights for this group during Oracle Context creation.

In addition to the Oracle Context creator, other users can be added
to this group by the directory administrator.

See Also: "Administering the OracleNetAdmins Group" on
page 8-10 for information on adding users to the OracleNetAdmins
group

Group ACL Requirements
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Schema
Directories must be populated with the correct version of the Oracle schema before
Oracle Contexts or a database service or net service name entry can be created. The
Oracle schema defines the type of objects, called object classes, that can be stored in
the directory server and their attributes. Table 3–5 lists the object classes for
database service, net service name, and net service alias entries.

Table 3–5 Oracle Net Services LDAP Main Object Classes

Table 3–6 lists the object classes used by orclDbServer , orclNetService , and
orclNetServiceAlias .

Table 3–6 Oracle Net Services LDAP Derived Object Classes

These object classes use attributes that specify the contents of connect descriptors.

Object Class Description

orclDbServer Defines the attributes for database service entries

orclNetService Defines the attributes for net service name entries

orclNetServiceAlias Defines the attributes for net service alias entries

Object Class Description

orclNetAddress Defines a listener protocol address

orclNetAddressList Defines a list of addresses

orclNetDescription Specifies a connect descriptor containing the protocol address
of the database and the connect information to the service

orclNetDescriptionList Defines a list of connect descriptors

See Also: Oracle9i Net Services Reference Guide for further
information about these object classes and their attributes
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Oracle Names Support
Like directory naming support, Oracle Names provides a distributed naming
service to help simplify the setup and administration of global, client/server
computing networks. Directory naming uses an LDAP-compliant directory server,
which can have other functions in addition to supporting Oracle services. Oracle
Names, however, is Oracle proprietary, providing support only for Oracle services.

This section contains these topics:

■ Oracle Names Overview

■ Administrative Regions

■ Domains

■ Oracle Names As Data Repository

■ Data Stored in an Oracle Names Server

■ Organization of Network Components

■ Multiple Regions to Decentralize Administrative Responsibilities

■ Differences Between Versions of Oracle Names

■ About Discovery

Note: In future releases, Oracle Names will not be supported as a
centralized naming method. Because no new enhancements are
being added to Oracle Names, consider using directory naming or
migrating an existing Oracle Names configuration to directory
naming, as described in Chapter 10, "Exporting Naming Data to a
Directory Server". The material presented here is primarily for
reference to enable you to maintain your current Oracle Names
environment.
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Oracle Names Overview
Oracle Names establishes and maintains an integrated system of Oracle Names
servers which work together like a directory service. The system stores addresses
for all the services on a network and makes them available to clients wishing to
make a connection.

Much like a caller who uses directory assistance to locate a telephone number,
clients configured to use Oracle Names refer their connection requests to an Oracle
Names server. The Oracle Names server attempts to resolve the service name
provided by the client to a network address. If the Oracle Names server finds the
network address, it then returns that information to the client. The client can then
use that address to connect to the service.
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Figure 3–9 shows how Oracle Names works to help establish a connection between
a client and server:

1. A listener registers database service with an Oracle Names server.

2. A client seeks to locate a service on the network by contacting an Oracle Names
server to retrieve the protocol address.

3. The client transparently connects to the service.

Figure 3–9 Oracle Names

See Also: "Configuring the Oracle Names Method" on page 9-23
for configuration information
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Administrative Regions
Many networks have one central point of administration, that is, one
administrative region. With Oracle Names, an administrative region refers to a
collection of Oracle Names servers that administer services in a network. All
connect information is stored in a single data repository that has the authority to
interpret a service name. All Oracle Names servers within an administrative region
query information from this data repository. If the administrative region uses a
database for storage, there is one database for each administrative region. There can
be any number of Oracle Names servers.

Oracle Names provides support for one or more administrative regions. This
enables each data center to independently define and manage the services in its
own environment. At the same time, all service addresses remain available to all
clients across the enterprise. Oracle Names servers transparently forward client
name resolution requests in one administrative region to the region which can
service the request.

Domains
A domain is a logical group of computers and network services. Within each
domain, all names must be unique: Across domains, simple service names can be
repeated.

Any administrative region contains one or more domains. Network domains are
similar to file directories used by many operating systems in that they are
hierarchical. Unlike file systems, however, network domains may or may not
correspond to any physical arrangement of databases or other objects in a network.
They are simply name spaces developed to prevent name space conflicts.

Note: Although they appear similar, the domains of an Oracle
network are completely independent of DNS name spaces. For
convenience, you may choose to mirror the DNS directory structure
in the Oracle Names domain structure.
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Oracle Names As Data Repository
Data in Oracle Names servers is updated through continuous replication between
all the Oracle Names servers in the region or by writing to and reading from a
common Oracle database. For smaller workgroup environments, administrators can
configure Oracle Names servers to replicate data continuously among themselves.

Administrators can also choose to store the administrative region’s data in an
Oracle database, called the region database. A region database consists of tables
that store Oracle Names information. Each Oracle Names server in a given
administrative region periodically polls the region database for updated
registrations. In this way, new registrations are communicated in a timely manner to
all of the Oracle Names servers in a given administrative region. Using a region
database also relieves Oracle Names servers of the necessity to communicate
directly with each other and provides better reliability.
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Data Stored in an Oracle Names Server
Table 3–7 describes the types of data stored in an Oracle Names server.

Table 3–7 Data Stored in an Oracle Names Server

Data Description

Net service names If you register net service names with the Oracle Names
Control utility or Oracle Net Manager, an Oracle Names
server stores them. An Oracle Names server also stores
gateways to non-Oracle databases and Oracle RDB databases.

Global database names
and addresses

The Oracle Names server retrieves information about the
database, including the global database name (database name
and domain) and address, from the listener.

Global database names and addresses can be registered with
the Oracle Names server, using either the Oracle Names
Control utility or Oracle Net Manager.

Other Oracle Names
server names and
addresses

An Oracle Names server stores the names and addresses of all
other Oracle Names servers in the same administrative region.
If a network has more than one administrative region, the
Oracle Names server stores the name and address of at least
one Oracle Names server in the root administrative region and
each of the immediate subregions. You do not need to register
this information.
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Global database links Database links enable a database to communicate with
another database. The name of a database link is the same as
the global database name of the database to which the link
points. Typically, only one database link should exist for the
database.

The following types of database links can be created:

■ A private database link in a specific schema of a
database. Only the owner of a private database link can
use it.

■ A public database link for a database. All users in the
database can use it.

■ A global database link in an Oracle Names server.
Anyone in the network can use it.

Global database links, as well as username and password
credentials for them, can be registered with the Oracle Names
server using Oracle Net Manager. These global database links
may be supplemented with link qualifiers defined through
Oracle Net Manager.

Global database links can be superseded with private and
public database links created by individual users.

See Also: Oracle9i Database Administrator’s Guide for
information about the supported types of database links

Aliases An Oracle Names server stores aliases or alternative service
names for any defined net service name, database service, or
global database link. Aliases can be registered with the Oracle
Names server, using either the Oracle Names Control utility or
Oracle Net Manager.

Data Description
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Organization of Network Components
When you use Oracle Names, objects such as databases in a networked
environment need to be named in a way that ensures they are unique within the
network. The two basic models for naming objects in a network include:

■ Single Domain Model

■ Hierarchical Naming Model

Single Domain Model
The single domain naming model is useful if your network is small, and names are
not duplicated. Figure 3–10 shows a typical flat naming structure using a single
domain name, world .

Figure 3–10 Single Domain Naming Model

In this environment, database service names are automatically appended with a
.world  extension (for example, prod.world , flights.world , and so forth).

Note: In previous releases of SQL*Net and Oracle Names, a
network with only one domain would default to .world . This
convention is no required with Oracle Net Services and Oracle
Names version 8 and 9. You may, however, want to keep this
convention to be backward compatible, as well as to avoid having
to rename all your databases.
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Hierarchical Naming Model
Hierarchical naming models divide names into a hierarchical structure to allow for
future growth or greater naming autonomy. This type of naming model enables
more than one database with the same simple name in different domains.

Figure 3–11 shows a hierarchical structure of domains including root domain acme
and subdomains us.acme , europe.acme , and row.acme .

Figure 3–11 Hierarchical Naming Model

Notice in Figure 3–11 both weather  and history  are repeated, but the names
remain unique, that is, history.row.acme  and history.europe.acme .

Default Domains The default domain is the domain within which most of the client’s
name requests are conducted. This is usually the domain in which the client resides,
though it could also be another domain from which the client most often requests
services. A client can request a network service within its default domain by using
the service’s simple, unqualified name, that is, without specifying a domain name.
If a user requests a name without a "." character in it, the default domain name is
automatically appended to the database service or database link name requested.

Consider for example, a client that is configured with a default domain of
europe.acme.com . When this client makes a request for the service name wine in
Figure 3–11, the default domain name europe.acme.com  is appended to the
requested name so that the name becomes wine.europe.acme.com .
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Multiple Domains Multiple domains are related hierarchically to a root domain (the
highest-level domain in the hierarchy) in a series of parent-child relationships. For
example, under the root might be several domains, one of which is called com.
Under the com domain might be several more domains, one of which is acme.
Under the acme domain might be several domains, such as us , europe , and so
forth.

Multiple Regions to Decentralize Administrative Responsibilities
If you are using Oracle Names and your network is large or widely distributed
geographically, you may choose to have multiple administrative regions. For
example, if your network includes both the United States and Europe, you might
want to have administrative decisions about the network made locally. To
subdivide, you must delegate regions and domains from a parent to a child or
subregion.

To delegate administrative regions, you must use a hierarchical naming model in
which each administrative region controls one or more different domains.

Networks with multiple administrative regions are composed of one root
administrative region and one or more delegated administrative regions.
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Root Administrative Regions
The root administrative region contains the root domain. There can only be one root
administrative region. The root administrative region contains the following
information:

■ Oracle Names servers in the root region

■ Domains that are administered in this region: the root domain and other
domains.

■ Delegated administrative region Oracle Names servers: the domains and Oracle
Names server addresses in any alternate regions that act as direct child regions
of the root.

■ Data definitions for the root region: All of the net service names, database
service names, database links, and aliases associated with the root
administrative region.

Delegated Administrative Regions
Administrative regions can be delegated from the top of the hierarchy down to
other domains in the naming model. For example, a network with 10 domains can
have between one and10 administrative regions.

All administrative regions other than the root are hierarchically delegated directly
or indirectly from it.
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Figure 3–12 shows a network with five domains and three administrative regions:
the root, acme, and two delegated regions, row  and asia .

Figure 3–12 Delegated Administrative Regions
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Delegated Administrative Regions Under Root
All administrative regions under the root are considered delegated administrative
regions. Delegated administrative regions receive administrative responsibilities for
a domain from other regions, such as the root administrative region. A delegated
administrative region contains the following information:

■ All Oracle Names servers and domains in the region.

■ Domains and Oracle Names server addresses in any of this administrative
region’s child regions.

■ Addresses of the Oracle Names servers in the root region. Having this data
enables Oracle Names servers in delegated regions to contact any other region
(through the root region).

■ Data definitions, including all of the net service names, database service names,
database links, and aliases for all of the domains in this local (delegated)
administrative region.

Differences Between Versions of Oracle Names
Oracle Names version 8 and 9 differs significantly from earlier versions. The
differences between the versions are described in the following topics:

■ Oracle Names Version 1

■ Oracle Names Version 2

■ Oracle Names Version 8 and 9 (this release)

Oracle Names Version 1
In Oracle Names version 1, administrators configured Oracle Names servers using
Oracle Network Manager and stored all topology data in a database. All the Oracle
Names servers in a region shared the same information because they accessed the
same database.

The clients had a list of preferred Oracle Names servers specified in the
sqlnet.ora  file. This list was created by the user, listing the order of preferred
Oracle Names to contact. The first Oracle Names server in the list would be
contacted first by a client.

Preferred Oracle Names servers may still be configured.

See Also: "Configuring Connections to Non-Oracle Database
Services" on page 15-30 for configuration information



Oracle Names Support

Configuration Management Concepts 3-35

Oracle Names Version 2
In Oracle Names version 2, the administrator could choose between continuing
Oracle Names server configuration, as in version 1 or using the Dynamic Discovery
Option. The Dynamic Discovery Option was recommended only for a network with
a single region and single DNS domain. The Dynamic Discovery Option uses
well-known Oracle Names servers, which are precise names hard-coded into DNS
or the hosts  file on both the Oracle Names Server and its clients:

Oracle Names servers then become available at these well-known addresses, so
clients do not need to be told, by way of a preferred Oracle Names server list, where
to find an Oracle Names server.

If the Dynamic Discovery Option was chosen, each Oracle Names server
automatically replicated its data to all other well-known Oracle Names servers in
the administrative region. Listeners were configured to register themselves with
well-known Oracle Names servers.

Table 3–8 Well-Known Oracle Names Servers

The well-known host names for
TCP connections

The well-known computer names
for Named Pipes connections 1

1 Well-known Oracle Names server names for Named Pipes must be in all uppercase.

oranamesrvr0
oranamesrvr1
oranamesrvr2
oranamesrvr3
oranamesrvr4

ORANAMESRVR0
ORANAMESRVR1
ORANAMESRVR2
ORANAMESRVR3
ORANAMESRVR4

See Also: Oracle Names Administrator’s Guide, Release 2.0, for
configuration information
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Oracle Names Version 8 and 9 (this release)
In Oracle Names version 8 and 9, the administrator may choose between continuing
Oracle Names Server configuration as in version 1 or version 2, or using the new
functionality. Oracle Names version 8 and 9 incorporates version 2 Dynamic
Discovery Option features without the constraints of a single region and single
domain. The main features of Oracle Names version 8 and 9 include:

■ A service can register itself with any Oracle Names server it can find, and its
name and address are made available to all Oracle Names servers in the region.
Similarly, if an administrator manually registers a service to any Oracle Names
server, that service information is available to all other Oracle Names servers.
The address information is shared in one of two ways:

– Region Database: If an Oracle database is used as the registration
repository, the registration information is stored in the database and from
there is accessible to all the Oracle Names servers.

– Service Replication: In service replication, service information is stored in
the cache of an Oracle Names server and is instantly replicated to the
caches of all other Oracle Names servers.

■ A list of Oracle Names servers to contact is created on a client through a
discovery process rather than manual configuration, as described in "About
Discovery" on page 3-37.

■ A clientside process may be run to create a client cache version of the data
stored in Oracle Names servers, including database addresses and Oracle
Names server protocol addresses, as well as other service information. As a
result, the client does not have to contact an Oracle Names server for address
information, which reduces address lookup time.

■ Oracle Names version 8 and 9 does not require a database to hold topology
information. However, an administrator may choose to use one, and it is
recommended.

See Also: "Configuring the Oracle Names Method" on page 9-23
for configuration information
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About Discovery
A list of Oracle Names servers can be created that enables a client or another Oracle
Names server to contact an Oracle Names server. The process of creating the list is
called discovery.

When a client tries to discover an Oracle Names server with the Oracle Names
Control utility or Oracle Net Manager, one Oracle Names server is found first. Once
the client finds an Oracle Names server, it pings all other Oracle Names servers in
the region. A list of Oracle Names servers is then created on the client and saved to
.sdns.ora  on UNIX operating systems and sdns.ora  on Windows operating
systems. This list is sorted in order of response time.

To find the first Oracle Names server, discovery searches in the following order:

1. A preferred Oracle Names server configured in the sqlnet.ora  file

2. A well-known Oracle Names server

3. A local Oracle Names server configured with TCP/IP, port 1575

If the client is unable to find the first Oracle Names server using one of these
methods, one of the following alternate methods can be used:

■ If you are using Oracle Net Manager, you will be prompted to specify the
protocol address of an Oracle Names server

■ If you are using the Oracle Names Control utility, the utility will fail. Rerun the
command with the protocol address of a specified Oracle Names server.
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4
Architecture of Oracle Net Services

This chapter describes the architecture of Oracle Net, the listener, shared server,
dedicated server, and Oracle Connection Manager.

This chapter contains these topics:

■ Oracle Net Stack Communication Architecture

■ Listener Architecture

■ Database Server Process Architecture

■ Oracle Connection Manager Architecture

■ A Complete Architecture

See Also: Chapter 1, "Networking Challenges in the Internet Age"
for an introductory level overview of Oracle Net architecture
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Oracle Net Stack Communication Architecture
The primary function of Oracle Net is to establish and maintain connections
between a client application and an Oracle database server. Oracle Net is comprised
of several communication layers that enable clients and database servers to share,
modify, and manipulate data.

This section contains these topics:

■ Stack Communication for Client/Server Application Connections

■ Stack Communication for Java Application Connections

■ Stack Communication for Web Client Connections

Stack Communication for Client/Server Application Connections
Figure 4–1 illustrates the various layers on the client and on the database server
after a connection has been established.

Figure 4–1 Layers Used in a Client/Server Application Connection

This communication architecture is based on the Open Systems Interconnection
(OSI) model. In the OSI model, communication between separate computers occurs
in a stack-like fashion with information passing from one node to the other through
several layers of code, including:

1. Physical layer

2. Data link layer

3. Network layer
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4. Transport layer

5. Session layer

6. Presentation layer

7. Application layer

Figure 4–2 shows how Oracle Net software—Oracle Net Foundation layer and
Oracle Protocol Support—fits into the Session layer of the OSI model.

Figure 4–2 OSI Communication Layers

See Also: http://www.ietf.org/  for information about the
OSI stack
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As shown in Figure 4–1 on page 4-2, the client/server stack is comprised of the
following:

■ Client Application

■ Presentation

■ Oracle Net Foundation Layer

■ Oracle Protocol Support

■ Network Protocol

■ RDBMS

Client Application
During a session with the database, the client uses Oracle Call Interface (OCI) to
interact with the database server. OCI is a software component that provides an
interface between the client application and the SQL language the database server
understands.

Presentation
Character set differences can occur if the client and database server are running on
different operating systems. The presentation layer resolves any differences. It is
optimized for each connection to perform conversion only when required.

The presentation layer used by client/server applications is Two-Task Common
(TTC). TTC provides character set and data type conversion between different
character sets or formats on the client and database server.

At the time of initial connection, TTC is responsible for evaluating differences in
internal data and character set representations and determining whether
conversions are required for the two computers to communicate.

Oracle Net Foundation Layer
The Oracle Net foundation layer is responsible for establishing and maintaining the
connection between the client application and database server, as well as
exchanging messages between them. The Oracle Net foundation layer is able to
perform these tasks because of a technology called Transparent Network Substrate
(TNS). TNS provides a single, common interface functioning over all
industry-standard protocols. In other words, TNS enables peer-to-peer application
connectivity. In a peer-to-peer architecture, two or more computers (called nodes

See Also: Oracle Call Interface Programmer’s Guide



Oracle Net Stack Communication Architecture

Architecture of Oracle Net Services 4-5

when they are employed in a networking environment) can communicate with each
other directly, without the need for any intermediary devices.

On the client side, the Oracle Net foundation layer receives client application
requests and resolves all generic computer-level connectivity issues, such as:

■ The location of the database server or destination

■ Whether one or more protocols are involved in the connection

■ How to handle interrupts between client and database server based on the
capabilities of each

On the server side, the Oracle Net foundation layer performs the same tasks as it
does on the client side and also works with the listener to receive incoming
connection requests.

In addition to establishing and maintaining connections, the Oracle Net foundation
layer communicates with naming methods to resolve names and uses security
services to ensure secure connections.

Oracle Protocol Support
Positioned between the Oracle Net foundation layer and the network protocol layer,
the Oracle protocol support layer is responsible for mapping TNS functionality to
industry-standard protocols used in the client/server connection. This layer
supports the following network protocols:

■ TCP/IP

■ TCP/IP with SSL

■ Named Pipes
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Network Protocol
All Oracle software in the client/server connection process requires an existing
network protocol stack to establish the computer-level connection between the two
computers for the transport layer. The network protocol is responsible for
transporting data from the client computer to the database server computer, at
which point the data is passed to the serverside Oracle protocol support layer.

TCP/IP Protocol The Transmission Control Protocol/Internet Protocol (TCP/IP) is
the de facto standard communication protocol used for client/server conversation
over a network.

TCP/IP with SSL Protocol The TCP/IP with Secure Sockets Layer (SSL) protocol
enables an Oracle application on a client to communicate with remote Oracle
databases through TCP/IP and SSL. Oracle Advanced Security is required in order
to use TCP/IP with SSL.

SSL stores authentication data, such as certificates and private keys, in an Oracle
Wallet. When the client initiates a connection to the database server, SSL performs a
handshake between the two using the certificate. During the handshake, the
following processes occur:

■ The client and database server negotiate a cipher suite—a set of authentication,
encryption, and data integrity types—to apply to the messages they exchange.

■ Depending on its configuration, the database server sends its certificate to the
client in a message encrypted with the client's public key. The database server
may also send a request for the client's certificate in the same message. The
client decrypts this message by using its own private key, then verifies that the
database server's certificate bears the certificate authority's signature.

■ If required, the client may send the user's certificate to the database server. The
certificate ensures that the user's information is correct and that the public key
actually belongs to that user.

The database server checks the user's certificate to verify that it bears the certificate
authority's signature.

Named Pipes Protocol The Named Pipes protocol is a high-level interface
providing interprocess communications between clients and database servers using
distributed applications. One severside process creates the pipe, and the other
clientside process opens it by name. What one side writes, the other can read, and
vice versa. Named Pipes is specifically designed for PC LAN environments.

See Also: Oracle Advanced Security Administrator’s Guide
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Named Pipes enables client/server conversation over a network using Named
Pipes. This combination of Oracle products enables an Oracle application on a client
to communicate with remote Oracle databases through Named Pipes (if the Oracle
database is running on a host system that supports network communication using
Named Pipes).

RDBMS
Information passed from a client application across a network protocol is received
by a similar communications stack on the database server side. The process flow on
the database server side is the reverse of the process flow on the client side, with
information ascending through the communication layers.

Instead of OCI, the database server uses Oracle Program Interface (OPI). For each
statement sent from OCI, OPI provides a response. For example, an OCI request to
fetch 25 rows would elicit an OPI response to return the 25 rows once they have
been fetched.
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Stack Communication for Java Application Connections
Oracle's Java Database Connectivity (JDBC) Drivers provide Java applications
access to an Oracle database. Oracle offers two JDBC drivers.

■ JDBC OCI Driver driver is a level 2 JDBC driver which is used by client/server
Java applications. The JDBC OCI driver converts JDBC invocations to calls to
OCI which are then sent over Oracle Net to the Oracle database server.

■ JDBC Thin Driver is a level 4 driver which is used by Java applets. The JDBC
Thin driver establishes a direct connection to the Oracle database server over
Java sockets. Access to the database is assisted with a lightweight
implementation of TTC and Oracle Net.

Figure 4–3 shows the stack communication layers used by JDBC drivers.

Figure 4–3 Layers Used for Java-Client Applications

The JDBC OCI driver uses a communication stack similar to a standard
client/server communication stack. The JDBC Thin driver uses a Java
implementation of the Oracle Net foundation layer called JavaNet and a Java
implementation of TTC called JavaTTC.

See Also: Oracle9i JDBC Developer’s Guide and Reference
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Stack Communication for Web Client Connections
In addition to the TTC presentation, the Oracle database server supports many
other presentations that can be used for Web clients accessing features inside the
database. The listener facilitates this by supporting any presentation requested by
the database.

For example, Figure 4–4 shows the stack communication layers used in an HTTP or
FTP connection to Oracle XML DB in the Oracle9i instance. WebDAV connections
use the same stack communication layers as HTTP and FTP.

Figure 4–4 Layers Used in Web Client Connections

See Also: Oracle9i XML Database Developer’s Guide - Oracle XML
DB
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Listener Architecture
The database server receives an initial connection from a client application through
the listener. The listener is an application positioned on top of the Oracle Net
foundation layer. Figure 4–5 illustrates the various layers on the client and database
server during an initial connection.

Figure 4–5  Layers Used in an Initial Connection

The listener brokers client requests, handing off the requests to the Oracle database
server. Every time a client requests a network session with a database server, a
listener receives the initial request.

Each listener is configured with one or more protocol addresses that specify its
listening endpoints. Clients configured with one of these protocol addresses can
send connection requests to the listener.

Oracle Protocol
Support

Presentation - TTC

Client Application 
(uses OCI)

Network Protocol -
TCP/IP, TCP/IP 
with SSL, and 
Named Pipes

Client

Database Server

RDBMSListener

Oracle Protocol 
Support

Network Protocol -
TCP/IP, TCP/IP 
with SSL, and 
Named Pipes

Oracle Net
Foundation
Layer

Oracle Net
Foundation
Layer



Listener Architecture

Architecture of Oracle Net Services 4-11

Once a client request has reached the listener, the listener selects an appropriate
service handler to service the client’s request and forwards the client’s request to it.
The listener determines if a database service and its service handlers are available
through service registration. During service registration, the PMON process—an
instance background process—provides the listener with information about the
following:

■ Names of the database services provided by the database

■ Name of the instance associated with the services and its current and maximum
load

■ Service handlers (dispatchers and dedicated servers) available for the instance,
including their type, protocol addresses, and current and maximum load

This information enables the listener to direct a client's request appropriately
Figure 4–6 shows instances registering information with listeners. Note that it does
not represent all the information that can be registered.

Figure 4–6 Service Registration

Optionally, listening endpoints—port numbers—can be dynamically registered
with the listener. For example, with Oracle XML DB, HTTP, FTP, and WebDAV
listening endpoints are registered with the listener.
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If the listener is not running when an instance starts, PMON is not able to register
the service information. PMON attempts to connect to the listener periodically,
however, it may take up to 60 seconds before PMON registers with the listener after
it has been started. To initiate service registration immediately after the listener is
started, use the SQL statement ALTER SYSTEM REGISTER. This is especially
useful in high-availability configurations.

If a listener receives an incoming request before the respective instance has been
registered, the listener rejects the request.

Figure 4–7 on page 4-13 shows the role of a listener during connection
establishment with a browser making an HTTP connection and a client making a
TTC connection:

1. The database registers information about the services, instances, and service
handlers with the listener.

2. The client makes an initial connection with the listener.

3. The listener parses the client request and forwards it to the service handler for
the database service requested.

See Also:

■ Oracle9i SQL Reference for further information about the ALTER
SYSTEM REGISTER statement

■ Oracle9i XML Database Developer’s Guide - Oracle XML DB for
information about dynamically registering HTTP, FTP, and
WebDAV listening endpoints
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Figure 4–7 Listener Architecture

Database Server Process Architecture
Based on the service handler type registered with the listener, the listener forwards
requests to either a shared server or dedicated server process.

Shared Server Processes
Shared server processes are utilized in the shared server architecture. Figure 4–8 on
page 4-14 depicts a shared server architecture. With shared server architectures,
client processes ultimately connect to a dispatcher. The PMON process registers the
location and load of the dispatchers with the listener, enabling the listener to
forward requests to the least loaded dispatcher.

A dispatcher can support multiple client connections concurrently. Each client
connection is bound to a virtual circuit. A virtual circuit is a piece of shared
memory used by the dispatcher for client database connection requests and replies.
The dispatcher places a virtual circuit on a common queue when a request arrives.
An idle shared server picks up the virtual circuit from the common queue, services
the request, and relinquishes the virtual circuit before attempting to retrieve another
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virtual circuit from the common queue. This approach enables a small pool of
server processes to serve a large number of clients.

Figure 4–8 Shared Server Architecture
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Dedicated Server Processes
Figure 4–9 depicts a dedicated server architecture. With a dedicated server
architecture, each client process connects to a dedicated server process. The server
process is not shared by any other client.

PMON registers information about dedicated server processes with the listener.
This enables the listener to start up a dedicated server process when a client request
arrives and forward the request to it.

Figure 4–9 Dedicated Server Architecture

Note: Dedicated server architectures do not support HTTP, FTP,
or WebDAV clients. Only TTC clients are supported.
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Oracle Connection Manager Architecture
Oracle Connection Manager is a router through which a client connection request
may be sent either to its next hop or directly to the database server. Clients who
route connection requests through an Oracle Connection Manager can take
advantage of the connection multiplexing, access control, and protocol conversion
features configured on that Oracle Connection Manager.

Oracle Connection Manager has two processes:

■ CMGW process

■ CMADMIN process

The CMGW gateway process receives client connections and evaluates against a set
of rules whether to deny or allow access. If access is allowed, the gateway process
forwards the requests to the next hop, typically the database server. In addition to
allowing or denying access, the CMGW process can also multiplex or funnel
multiple client connections through a single protocol connection.

The CMGW process registers with the CMADMIN administrative process.
CMADMIN is a multi-threaded process that is responsible for all administrative
functions of Oracle Connection Manager.

Note: On Windows NT, the gateway process is represented by the
Oracle HOME_NAMECManservice, and the administrative process is
represented by the Oracle HOME_NAMECMAdmin service.
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Table 4–1 describes the detailed responsibilities of the CMGW and CMADMIN
processes.

Table 4–1 Oracle Connection Manager Processes

Process/Service Description

CMGW process on UNIX

Oracle HOME_
NAMECMan service on
Windows NT

The CMGW process is responsible for the following tasks:

■ Registering with the CMADMIN process

■ Listening for incoming connection requests. By default it listens on TCP/IP
with port 1630.

■ Initiating connection requests to listeners for clients

■ Relaying data between the client and database server

CMADMIN process on
UNIX

Oracle HOME_
NAMECMAdmin service
on Windows NT

The CMADMIN process is responsible for the following tasks:

■ Processing the CMGW registration

■ Identifying all listeners serving at least one database instance

■ Registering source route address information about the CMGW process and
listeners

■ Answering requests initiated by the Oracle Connection Manager Control utility

■ Locating Oracle Names servers

■ Monitoring registered listeners with Oracle Names servers

■ Maintaining address information in Oracle Names servers for clients

■ Periodically sending a request to Oracle Names servers to update their cache of
available services
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Figure 4–10 shows the CMGW process registering with the CMADMIN process and
the CMGW process handling client requests. Notice that the CMGW process has
denied access to the fourth client. The three client connections are then multiplexed
through a single network protocol connection to the database.

Figure 4–10 Oracle Connection Manager Architecture
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A Complete Architecture
Oracle Net provides an architectural solution that allows for greater scalability in
Internet and intranet environments.

Figure 4–11 on page 4-20 shows how multiple connections to an Oracle database
server are made more scalable with Oracle Connection Manager and a shared
server architecture. Oracle Connection Manager is used to offload some of the
network I/O of the application Web servers, and shared server is used to serve
more concurrent users.
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Figure 4–11 Scalable Architectural Solutions
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5
Configuration and Administration Tools

Overview

This chapter introduces the various administration tools of Oracle Net Services. It
discusses the main administration application, Oracle Net Manager, and describes
how to launch and navigate through it. It also introduces the command line control
utilities.

This chapter contains these topics:

■ Oracle Net Manager

■ Oracle Net Configuration Assistant

■ Oracle Net Control Utilities

■ Duties of a Network Administrator
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Oracle Net Manager
Oracle Net Manager is a graphical user interface tool that combines configuration
abilities with Oracle Names component control to provide an integrated
environment for configuring and managing Oracle Net. It can be used on either the
client or server. Oracle Net Manager is also integrated with Oracle Enterprise
Manager.

You can use Oracle Net Manager to configure the following network components:

■ Naming—Define simple names, connect identifiers, and map them to connect
descriptors to identify the network location and identification of a service.
Oracle Net Manager supports configuration of connect descriptors in local
tnsnames.ora  files, a centralized LDAP-compliant directory service, or an
Oracle Names server.

■ Naming Methods—Configure the different ways in which connect identifiers
are resolved into connect descriptors.

■ Profiles—Configure preferences for enabling and configuring Oracle Net
features on the client or server.

■ Listeners—Create and configure listeners to receive client connections.

If an Oracle Names server is configured, you can start, stop, tune, or gather statistics
for it with Oracle Net Manager.

This section introduces you to the features of Oracle Net Manager. However, the
primary documentation for using Oracle Net Manager is the accompanying online
help. This section contains these topics:

■ Starting Oracle Net Manager

■ Navigating Oracle Net Manager

■ Toolbar

■ Menus

■ Oracle Net Manager Wizards

See Also: Oracle Enterprise Manager documentation set and
online help for information about using Oracle Enterprise Manager
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Starting Oracle Net Manager
You can start Oracle Net Manager using the Oracle Enterprise Manager Console or
as an independent application.

To start Oracle Net Manager from the Oracle Enterprise Manager console, on the
Oracle Enterprise Manager console, choose Tools > Service Management > Oracle
Net Manager.

To start Oracle Net Manager as standalone application:

■ On UNIX, run netmgr  from $ORACLE_HOME/bin

■ On Windows NT, choose Start > Programs > Oracle - HOME_NAME >
Configuration and Migration Tools > Net Manager
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Navigating Oracle Net Manager
The Oracle Net Manager interface includes two panes, a toolbar, and various menu
items.

Figure 5–1 Oracle Net Manager Interface
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Panes
The Oracle Net Manager interface has two panes: the navigator pane and the right
pane.

Navigator Pane The navigator pane provides a graphical tree view of network objects
and the objects they contain, organized in hierarchies of folders. You can use the
navigator pane to view, modify, add, or delete objects in each folder.

The navigator pane functions the same way as it does in other Oracle Enterprise
Manager applications. That is, the navigator pane lets you:

■ Expand and contract folders so that you can navigate to the network object you
want to monitor or manage. Examples of objects are connect identifiers,
listeners, profiles, and Oracle Names servers.

■ Right-click an object to perform operations on the object.

When you expand a folder, you see a nested list of objects and folders. When a
object is selected, information about the object is displayed in the right pane of the
Oracle Net Manager.

The navigator pane has the following main folders:

Directory Displays connect identifiers configured in a directory server

Local Displays networking elements configured in local
configuration files:

■ Net service names in the tnsnames.ora  file

■ Listeners in the listener.ora  file

■ Profiles in the sqlnet.ora  file

Oracle Names
Servers

Displays Oracle Names servers
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Right Pane The right pane contains property sheets that enable you to configure
network components. Figure 5–2 shows the Service Attributes property sheet used
for connect identifier configuration.

Figure 5–2 Service Attributes Property Sheet

Service Attributes Property Sheet
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Toolbar
The toolbar contains buttons that correspond to the network objects in the folder
hierarchies. The toolbar buttons are enabled depending on the objects viewed or
selected in a pane. Move the mouse cursor over a toolbar button to display the
description of the button's function. The toolbar buttons are:

Create
This button creates new connect identifiers, listeners, and Oracle Names servers
objects under the Directory or Local > Service Naming, Listeners, and Oracle
Names Servers folders.

Delete
This button deletes connect identifier and listener objects under the Directory or
Local > Service Naming and Listeners folders.

Verify Connectivity
This button verifies the connectivity of a selected connect identifier to an Oracle
database service. During a connectivity test, a connection to a database service is
made by using connect descriptor information stored in a directory server or a
tnsnames.ora  file.

Help
The Help button opens the Oracle Net Manager online help.
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Menus
You use Oracle Net Manager menus to perform actions, such as testing connectivity
to an Oracle database, and to open wizards and dialog boxes. The following list
describes the items available under each menu.

File Menu
The File menu has the following menu items:

Edit Menu
The Edit menu has the following menu items:

Open Network
Configuration

Opens the local configuration files

Save Network
Configuration

Saves the current configuration settings to the default location

Save As Saves the current configuration settings to a nondefault
location

Revert to Saved
Configuration

Does not save any of the current configuration settings.
Instead, retrieves the last saved configuration

Exit Closes the Oracle Net Manager

Create Creates new connect identifiers, listeners, and Oracle Names
servers objects under the Directory or Local > Service
Naming, Listeners, and Oracle Names Servers folders.

Delete Deletes connect identifier and listener objects under the
Directory or Local > Service Naming and Listeners folders.

Rename Renames a network object



Oracle Net Manager

Configuration and Administration Tools Overview 5-9

Command Menu
The Command menu has the following menu items:

Directory The Directory submenu contains the following menu items:

■ Change Current Context: Enables you to change the
current Oracle Context. The Oracle Context is a subtree in
the directory that stores Oracle entries, including database
services and net service names for use with
directory naming. When a new Oracle Context is selected,
objects in the navigator's Oracle Net Configuration >
Directory or Local > Service Naming folder display for
the new Oracle Context.

■ Set Authentication: Enables you to set authentication
credentials to the directory server

■ Import Net Service Names: Launches the Directory
Server Migration Wizard. This wizard imports net service
names stored in a tnsnames.ora  file to a directory
server.

Test Service Connects to a database service using connect descriptor
information stored in a directory server or a tnsnames.ora
file

Discover Oracle
Names Servers

Finds Oracle Names servers. Once the client finds an Oracle
Names server, it queries for all other Oracle Names servers in
the domain. Based on the Oracle Names servers found, a list
of Oracle Names servers is created on the client. The list is
created in order of response time.

See Also: "About Discovery" on page 3-37

Reload All Names
Servers

The Oracle Names server checks immediately for data
changes in its administrative region. If there are changes, the
Oracle Names server reloads all stored data.
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Help Menu
The Help menu has the following menu items:

Oracle Net Manager Wizards
The Oracle Net Manager wizards provide step-by-step guidance for tasks that
require many steps. The wizards simplify complex tasks by guiding you through
the task in manageable steps. The wizards are not intended to provide all
configuration options. Once you have completed a task with a wizard, use other
components of Oracle Net Manager to modify the configuration.

The following topics describe the Oracle Net Manager wizards:

■ Net Service Name Wizard

■ Directory Server Migration Wizard

■ Names Wizard

Contents Opens Oracle Net Manager online help

About Oracle Net
Manager

Opens a window that displays the Oracle Net Manager
version number and copyright information
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Net Service Name Wizard
The Net Service Name Wizard guides you through creating a basic net service name
in a directory server or a tnsnames.ora  file.

To start the Net Service Name Wizard to create net service names:

1. In the navigator pane, choose Directory or Local > Service Naming.

2. Choose plus (+) from the toolbar, or choose Edit > Create from the menu bar.

Figure 5–3 Opening Page of the Net Service Name Wizard

See Also: Create a Net Service Name topic in the Oracle Net
Manager online help for detailed information about using the Net
Service Name Wizard to create a net service name. To access this
topic in the online help, choose Local or Directory > Service
Naming > How To in the online help, and then select Create a Net
Service Name.
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Directory Server Migration Wizard
If a tnsnames.ora  file already exists, its net service names can be exported to a
directory server with the Directory Server Migration Wizard.

To start the Directory Server Migration Wizard, choose Command > Directory >
Import Net Service Names in the Oracle Net Manager menu bar.

Figure 5–4 Opening Page of the Directory Server Migration Wizard

See Also: "Exporting Net Service Names from a tnsnames.ora
File" on page 10-2
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Names Wizard
The Names Wizard guides you through creating and configuring an Oracle Names
server.

To start the Net Service Name Wizard to create an Oracle Names server:

1. In the navigator pane, choose Oracle Names Servers.

2. Choose plus (+) from the toolbar, or choose Edit > Create from the menu bar.

Figure 5–5 Welcome Page of the Names Wizard

See Also: "Task 3: Create an Oracle Names Server" on page 9-25
for more information about the Names Wizard

Note: In future releases, Oracle Names will not be supported as a
centralized naming method. Because no new enhancements are
being added to Oracle Names, consider using directory naming or
migrating an existing Oracle Names configuration to directory
naming, as described in Chapter 10, "Exporting Naming Data to a
Directory Server".



Oracle Net Configuration Assistant

5-14 Oracle9i Net Services Administrator’s Guide

Oracle Net Configuration Assistant
Oracle Net Configuration Assistant is provided primarily to configure basic
network components during installation, including:

■ Listener names and protocol addresses

■ Naming methods the client will use to resolve connect identifiers to connect
descriptors

■ Net service names in a tnsnames.ora  file

■ Directory server usage

Oracle Net Configuration Assistant runs automatically during software installation,
as described in your Oracle installation guide.

It can also be run after installation in standalone mode to configure naming method
usage, the listener, net service names in the tnsnames.ora  file, and directory
server usage in a similar way that is provided during installation.

To start Oracle Net Configuration Assistant:

■ On UNIX, run netca  from $ORACLE_HOME/bin.

■ On Windows NT, choose Start > Programs > Oracle - HOME_NAME >
Configuration and Migration Tools > Net Configuration Assistant.

Figure 5–6 Opening Page of the Oracle Net Configuration Assistant

See Also: Oracle Net Configuration Assistant online help
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Table 5–1 describes the configuration options in the Welcome page:

Table 5–1 Oracle Net Configuration Assistant

Option Description

Listener configuration Choose this option to create modify, delete, or rename a listener.

Naming Methods
configuration

Choose this option to configure this computer to resolve connect identifiers to
connect descriptor through one or more of following naming methods:

■ Local naming

■ Directory naming

■ Oracle Names

■ Host naming

■ Network Information Service

■ Cell Directory Service

Local Net Service Name
configuration

Choose this option to create, modify, delete, rename, or test connectivity of a
connect descriptor stored in a local tnsnames.ora  file.

Directory Usage configuration Choose this option to configure a directory server for directory-enabled
features.
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Oracle Net Control Utilities
Oracle Net provides the following tools to help you start, stop, configure, and
control each network component:

■ Listener Control Utility

■ Oracle Connection Manager Control Utility

■ Oracle Names Control Utility

Listener Control Utility
The Listener Control utility enables you to administer the listener. The basic syntax
for this utility is as follows:

lsnrctl command [ listener_name ]

For example, the following command starts a listener named lsnr :

lsnrctl START lsnr

You can also issue Listener Control utility commands at the LSNRCTL> program
prompt. To obtain the prompt, enter lsnrctl  with no arguments at the operating
system command line. When you run lsnrctl , the program is started. You can
then enter the necessary commands from the program prompt.

For example:

lsnrctl
LSNRCTL> START lsnr

See Also: Oracle9i Net Services Reference Guide for further
information about the Listener Control utility



Oracle Net Control Utilities

Configuration and Administration Tools Overview 5-17

Oracle Connection Manager Control Utility
The Oracle Connection Manager Control utility enables you to administer an Oracle
Connection Manager. The basic syntax for this utility follows:

cmctl command [ process_type ]

where process_type is the name of the Oracle Connection Manager process. The
choices are as follows:

■ cman for both the CMGW process (gateway process) and the CMADMIN
process (administrative process)

■ cm for the CMGW process

■ adm for the CMADMIN process

For example, the following command starts both the CMGW and the CMADMIN
processes:

cmctl START cman

You can also issue Oracle Connection Manager utility commands at the CMCTL>
program prompt. To obtain the prompt, enter cmctl  with no arguments at the
operating system command line. When you run cmctl , the program is opened. You
can then enter the necessary commands from the program prompt.

For example:

cmctl
CMCTL> START cman

See Also:

■ "Oracle Connection Manager Architecture" on page 4-16 for an
overview of the Oracle Connection Manager processes

■ Oracle9i Net Services Reference Guide for a complete listing of
Oracle Connection Manager Control utility commands
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Oracle Names Control Utility
The Oracle Names Control utility enables you to administer an Oracle Names
server. The basic syntax for this utility follows:

namesctl command [ arguments ]

For example, the following command starts Oracle Names server configured in the
local node’s names.ora  file:

namesctl START

You can also issue Oracle Names Control utility commands at the NAMESCTL>
program prompt. To obtain the prompt, enter namesctl  with no arguments at the
operating system command line. When you run namesctl , the program is started.
You can then enter the necessary commands from the program prompt.

For example:

namesctl
NAMESCTL> START

See Also: Oracle9i Net Services Reference Guide for further
information about the Oracle Names Control utility
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Duties of a Network Administrator
Network configuration and administration tasks are described throughout this
guide. Table 5–2 lists the common tasks, the tools associated with them, and points
you to the topic in the guide that describes the task.

Table 5–2 Common Administrative Tasks for Administering Oracle Net Services

Task Tools to Perform Task See Also

Configuring Directory Server for
Oracle Net Usage

Configure directory server usage. Oracle Net Configuration
Assistant

Chapter 8, "Setting Up Directory
Server Usage" on page 8-1

Add users to the OracleNetAdmins
group.

Oracle Net Configuration
Assistant

"Adding Users To the
OracleNetAdmins Group" on
page 8-12

Authenticate with the directory. Oracle Net Manager Choose Directory > Service Naming >
How To > Change the Oracle Context
in the online help

Change the Oracle Context. Oracle Net Manager Choose Directory > Service Naming >
How To > Set Authentication
Credentials in the online help

Configuring Naming Methods

Configure the local naming method. Oracle Net Configuration
Assistant

Oracle Net Manager

"Configuring the Local Naming
Method" on page 9-5

Configure the directory naming
method.

Oracle Net Configuration
Assistant

Oracle Net Manager

"Configuring the Directory Naming
Method" on page 9-12
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Configure the Oracle Names method.

Note: In future releases, Oracle Names
will not be supported as a centralized
naming method. Instead, consider
using directory naming or migrating
an existing Oracle Names
configuration to directory naming, as
described in Chapter 10, "Exporting
Naming Data to a Directory Server".

Oracle Net Manager "Configuring the Oracle Names
Method" on page 9-23

Configure the host naming method. Oracle Net Manager "Configuring the Host Naming
Method" on page 9-60

Configure external naming methods. Oracle Net Manager "Configuring External Naming
Methods" on page 9-64

Migrating to Directory Naming

Export from tnsnames.ora  files Oracle Net Manager "Exporting Net Service Names from a
tnsnames.ora File" on page 10-2

Export from Oracle Names Oracle Names Control utility "Exporting Network Objects from an
Oracle Names Server" on page 10-6

Configuring Profiles

Prioritize naming methods. Oracle Net Manager

Oracle Net Configuration
Assistant

"Prioritizing Naming Methods" on
page 11-5

Configure a default domain that is
automatically appended to any
unqualified net service name.

Oracle Net Manager

Oracle Net Configuration
Assistant

"Configuring a Default Domain for
Clients" on page 11-3

Route connection requests. Oracle Net Manager

Oracle Net Configuration
Assistant

"Routing Connection Requests" on
page 11-7

Configure authentication methods
available with Oracle Advanced
Security.

Oracle Net Manager "Configuring Oracle Advanced
Security" on page 11-13

Choose Oracle Advanced Security >
How To in the online help

See Also: Oracle Advanced Security
Administrator’s Guide

Task Tools to Perform Task See Also
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Configuring Listeners

Configure listening protocol addresses. Oracle Net Manager

Oracle Net Configuration
Assistant

"Configuring Listening Protocol
Addresses" on page 12-6

Configure dynamic service
registration.

Automatic "Configuring Service Registration" on
page 12-14

Configure static service registration. Oracle Net Manager "Configuring Static Service
Information" on page 12-10

Administering Listeners

Start and stop listeners. Listener Control utility "Starting and Stopping the Listener" on
page 12-22

View registered information. Listener Control utility "Monitoring Runtime Behavior" on
page 12-22

Configuring Oracle Connection
Manager

Configure session multiplexing. Manual configuration "Enabling Session Multiplexing" on
page 13-13

Configure access control. Manual configuration "Enabling Access Control" on
page 13-14

Configure protocol conversion
support.

Manual configuration "Enabling Protocol Conversion
Support" on page 13-15

Configuring Oracle Names Servers

Configure Oracle Names LDAP proxy
servers.

Oracle Names Control utility

Oracle Net Manager

"Configuring Oracle Names LDAP
Proxy Servers" on page 10-17

Create Oracle Names servers. Oracle Names Control utility

Oracle Net Manager

"Task 3: Create an Oracle Names
Server" on page 9-25

Create a list of preferred Oracle Names
servers.

Oracle Net Manager "Configuring Preferred Oracle Names
Servers" on page 11-11

Register objects with Oracle Names
servers.

Oracle Names Control utility

Oracle Net Manager

"Task 7: Register Data with the Oracle
Names Server" on page 9-25

Delegate domains to delegated
administrative regions.

Oracle Names Control utility

Oracle Net Manager

"Task 8: Delegate Domains to
Delegated Administrative Regions" on
page 9-53

Task Tools to Perform Task See Also
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Specify domain hints. Manual configuration "Task 9: Specify Domain Hints to
Forward Requests to Remote Oracle
Names Servers" on page 9-55

Administering Oracle Names Servers

Start and stop Oracle Names servers,
as well as gather statistics

Oracle Names Control utility Oracle9i Net Services Reference Guide

Oracle Net Manager Choose Oracle Names Servers > How
To > Administer an Oracle Names
Server in the online help

Remove an Oracle Names server. Oracle Names Control utility

Oracle Net Manager

"Removing an Oracle Names Server"
on page 9-58

Task Tools to Perform Task See Also
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6
Quick Start to Oracle Net Connections

This chapter is designed to help novice users set up and test a simple but common
configuration—one between a client application and a database over a TCP/IP
network.

This chapter contains these topics:

■ Prerequisites to Establishing Connectivity

■ Task 1: Confirm Network Availability

■ Task 2: Start the Listener and the Database Server

■ Task 3: Configure the Client to Use a Net Service Name

■ Task 4: Connect to the Database
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Prerequisites to Establishing Connectivity
The tasks in this quick start show a TCP/IP connection between a client computer
and a database server. The following about the database server and client
computers is assumed:

■ Database Server Computer

– It is running on the same network as the client

– An Oracle database is installed

– TCP/IP protocol support is installed

– A listener is configured

■ Client Computer

– It is running on the same network as the database server

– Oracle Client is installed

– TCP/IP protocol support is installed
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Task 1: Confirm Network Availability
Before using Oracle Net to connect a client computer to a database server, confirm
that the client computer can successfully communicate with the database server
computer. Evaluating network connectivity can eliminate network-based errors.

To confirm network connectivity:

1. Confirm that the database server computer can communicate with itself with a
loopback test.

A loopback test is a connection from the database server back to itself. Many
network protocols provide a means of testing network connections. The utility
PING can be used for TCP/IP network.

In a TCP/IP network, each computer has a unique IP address. A name
resolution service, such as Domain Name System (DNS), can be used to map
the IP address of a computer with its host name. If a name resolution service is
not used, then the mapping is typically stored in a centrally maintained file
called hosts . This file is located in the /etc  directory on UNIX and the
\winnt  directory on Windows NT. For example, an entry for a database server
computer named sales-server  may look like the following:

#IP address of server     host name       alias
144.25.186.203            sales-server    sales.us.acme.com

To use PING, enter the following at the command line:

ping database_server_host

The database_server_host  is the host name of the database server
computer. For example:

ping sales-server

If the loopback was unsuccessful, try using the IP address of the database
server. For example:

ping 144.25.186.203

2. Verify the client computer can successfully communicate with the database
server computer.

This varies according to the network protocol. For TCP/IP, you can use PING,
FTP or TELNET utilities. If the client computer cannot reach the server, verify
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that the network cabling and network interface cards are correctly connected.
Contact your network administrator to correct these problems.

Task 2: Start the Listener and the Database Server
The listener and database server must be running in order for the database server to
receive connections.

1. Start the listener with the Listener Control utility. From the command line,
enter:

lsnrctl
LSNRCTL> START [ listener_name ]

where listener_name  is the name of the listener defined in the
listener.ora  file. It is not necessary to identify the listener if you are using
the default listener, named LISTENER.

A status message indicating that the listener has started successfully displays.

2. Start the database:

a. Start SQL*Plus without connecting to the database:

sqlplus /nolog

b. Connect to the database as SYSDBA:

SQL> CONNECTusername / password  as sysdba

For example, SYSTEM/MANAGER is a SYSDBA user.

c. Enter the STARTUP command, specifying the database name and full path
of the parameter file:

SQL> STARTUPdatabase_name  pfile= file

If you do not specify the PFILE  option, the Oracle database uses the
standard initialization parameter file located in the $ORACLE_
BASE/admin/ db_name/pfile/ sid  directory on UNIX platforms, and
ORACLE_BASE\admin\ db_name\pfile\ sid  directory on Windows NT.
If you do not specify a database name, then the database uses the value of
the DB_NAME parameter specified in the initialization parameter file.

See Also:  Oracle9i Database Administrator’s Guide for further
information about starting the database
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3. Confirm that database service registration with the listener has completed.
From the Listener Control utility, enter:

LSNRCTL> SERVICES [ listener_name ]

The SERVICES command lists the services supported by the database, along
with at lease one available service handler.

Task 3: Configure the Client to Use a Net Service Name
Once network connectivity has been verified, you can use Oracle Net
Configuration Assistant to create a net service name, a simple name for the
database service. The net service name resolves to the connect descriptor, that is,
the network address of the database and the name of the database service. The
client will use the net service name to connect to the database.

The following example shows the net service name sales  mapped to a connect
descriptor for a database called sales.us.acme.com . A client can use sales
mapped to connect to sales.us.acme.com .

sales=
 (DESCRIPTION=
   (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=1521))
   (CONNECT_DATA=
     (SERVICE_NAME=sales.us.acme.com)))

To configure a client with a net service name:

1. Start Oracle Net Configuration Assistant.

The Welcome page appears.

2. Select Local Net Service Name Configuration.

3. Click Next.

The Net Service Name Configuration page appears.

4. Click Add, and then click Next.

The Net Service Name Configuration, Database Version page appears:

See Also: "SERVICES Command" on page 12-25

See Also: "Oracle Net Configuration Assistant" on page 5-14
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5. If the destination service is an Oracle9i or Oracle8i database, then select
Oracle8i or later database or service. If destination service is an Oracle8 release
8.0 database, then select Oracle8 release 8.0 database or service.

6. Click Next.

The Net Service Name Configuration, Service Name appears.

7. Enter the name that identifies the database.

The service name is defined during database creation. If you are unsure what
the service name is, ask the Database Administrator who created the database.

8. Click Next.

The Net Service Name Configuration, Select Protocols page appears.

9. Select the protocol on which the listener is configured to listen. Note that this
protocol must also be installed on the client. The listener is configured to listen
on TCP/IP by default.

10. Click Next.

The page appropriate for the selected protocol appears.

11. Enter the appropriate protocol parameters for the selected protocol in the fields
provided, and then click Next.

The Net Service Name Configuration, Test page appears.

12. Click Yes perform a test.

During a test, Oracle Net Configuration Assistant contacts the remote database
service, establishes a connection, and ends contact.

A successful test results in the following message:

Connecting...Test successful.

If the test fails, it can be because the:

■ Default username (scott ) and password (tiger ) are not valid

■ Protocol address information does not match the listener information

■ Listener is not running

■ Destination database service is down
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Depending on your diagnosis of the problem, perform one of the following
tasks:

■ Click Change Login to change the username and password for the
connection.

■ Click Back to review protocol address information.

■ Start the listener or database on the server, as described in "Task 2: Start the
Listener and the Database Server" on page 6-4.

13. Click Next.

The Net Service Name Configuration, Net Service Name page appears.

14. Accept the default net service name or enter another net service name in the
Net Service Name field. The name you enter should be unique to the client.

15. Click Next.

The Net Service Name Configuration, Another Net Service Name page appears.

16. Click No, and then click Next.

The Net Service Name Configuration, Configuration Done page appears.

17. Click Next, and then click Finish.

Task 4: Connect to the Database
From the client computer, connect to the database server as follows.

1. Start SQL*Plus:

sqlplus

2. Connect to the database as follows:

CONNECTusername / password @net_service_name

where username  and password  are the database user and password, and
net_service_name  is the net service name that you created in "Task 3:
Configure the Client to Use a Net Service Name" on page 6-5.
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Part II
 Configuration and Administration of

Oracle Net Services

Part II describes how to set up and configure Oracle Net Services.

This part contains these chapters:

■ Chapter 7, "Planning the Network"

■ Chapter 8, "Setting Up Directory Server Usage"

■ Chapter 9, "Configuring Naming Methods"

■ Chapter 10, "Exporting Naming Data to a Directory Server"

■ Chapter 11, "Configuring Profiles"

■ Chapter 12, "Configuring and Administering the Listener"

■ Chapter 13, "Configuring Oracle Connection Manager"

■ Chapter 14, "Configuring Shared Server"

■ Chapter 15, "Enabling Advanced Features for Oracle Net Services"
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7
Planning the Network

Oracle Net Services provide a variety of options to help you design and manage
networks that are both flexible and easy to use. With Oracle Net Services enhanced
scalability and manageability features, you can develop a network to support a
wide range of environments, whether they be simple workgroups or large mission
critical enterprises.

This chapter describes considerations for planning a network using Oracle Net
Services. It explains the relationships of the network products, and options for
expanding and better managing your future network.

This chapter contains these topics:

■ Deploying a Network Inside an Organization

■ Deploying a Network for the Internet

■ Naming Considerations

■ Performance Considerations
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Deploying a Network Inside an Organization
As Figure 7–1 shows, an internal network often has a diverse client makeup.
Besides traditional clients that need access to the database servers, Web clients also
need access. The type and number of clients, as well as other networking issues,
affect the types of features to consider deploying.

Figure 7–1 Internal Network Layout
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This section addresses deployment considerations for an internal network in terms
of the following categories:

■ Scalability

■ Availability

■ Naming Methods

■ JDBC Drivers

■ Security

■ Tuning and Performance

Scalability
For an organization with hundreds or thousands of clients, scalability is of the
utmost importance. Oracle Net Services offer a number of features that can improve
database server scalability, including shared server, connection pooling, and
session multiplexing.

Shared Server
With a shared server architecture, a small pool of server processes can serve a large
number of clients. This reduces the server’s memory requirements. Connection
pooling and session multiplexing features are enabled through shared server.

Connection Pooling
Connection pooling enables the database server to time-out protocol connections
and to use those connections to service an active session.

Session Multiplexing
Session multiplexing, available with Oracle Connection Manager, enables multiple
client sessions to funneled through a single protocol connection.

Together, these features increase the total number of client sessions the server can
handle.
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The following table summarizes the relative advantages of using connection
pooling and session multiplexing and provides recommendations for using them in
the network.

Table 7–1 Connection Pooling and Session Multiplexing

Feature Advantages Disadvantages Recommended for

Connection
Pooling

■ Reduces the number of network
resources used for each process

■ Supports larger client
populations

■ Maximizes the number of
client/server sessions over a
limited number of process
connections

■ Optimizes network traffic and
network resource utilization,
such as network connection
bandwidth

■ Enables identification and
monitoring of real users

■ Enables middle-tier application
Web servers or applications that
need to access backend database
to support additional services,
such as Oracle9i Application
Server

■ Requires only a single transport
for clients with multiple
applications

■ Requires only a single network
connection for database links

Database sessions should use
the IDLE_TIME  resource
parameter.

Networks where many
clients run interactive
"high think/search time"
applications such as
messaging and OLAP
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Availability
Availability to the database is crucial for any internal network. Multiple listeners
can be configured to handle client connection requests for the same database
service. This is especially ideal in an Oracle9i Real Application Clusters
configuration, where each instance has a listener associated with it. Multiple listener
configurations enable you to utilize connect-time failover and connection load
balancing features.

Connect-Time Failover
Connect-time failover enables clients to request a different listener (usually on a
different node) if the first listener fails.

Client Load Balancing
Client load balancing enables clients to randomize requests to the multiple listeners
(usually on different nodes).

These features can be used together or separately. Together, they ensure access to
the database and distribute the load so as not to overburden a single listener.

Session
Multiplexing

■ Limits the number of network
resources used for each process

■ Supports large client populations

■ Maximizes the number of
client/server sessions over a
limited number of process
connections

■ Optimizes resource utilization

■ Enables identification and
monitoring of real users

■ Enables mid-tier applications to
support additional services

■ Requires only a single transport
for clients with multiple
applications

■ Requires only a single network
connection for database links

■ Provides support for pre-Oracle8
clients

Clients must connect to
Oracle Connection Manager.

Networks where
continuous connectivity
is required.

Feature Advantages Disadvantages Recommended for
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Naming Methods
Selecting the appropriate naming method for mapping names to connect
descriptors depends upon the size of the organization.

For a small organization with only a few databases, use host naming to store names
in an existing names resolution service, or local naming to store names in
tnsnames.ora  file on the clients.

For large organizations with several databases, use directory naming to store
names in a centralized LDAP-compliant directory server.

JDBC Drivers
Java client applications access an Oracle database through a Java Database
Connectivity (JDBC) Driver—a standard Java interface for connecting from Java to
a relational database. Oracle Corporation offers the following drivers:

■ OCI driver for clientside and application Web server use with an Oracle client
installation

■ Thin driver for clientside use without an Oracle installation, particularly with
applets

Security
Internal network should be inside a firewall.

See Also: "Naming Considerations" on page 7-10 for further
information about selecting a naming method

See Also: Oracle Advanced Security Administrator’s Guide for
further information about providing security for the internal
network
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Tuning and Performance
Oracle Net Services offers a number of features that can help reduce round-trip time
across the network, increase listener performance, and reduce the number of
protocols used.

Session Data Unit (SDU) Size
Before sending data across the network, Oracle Net buffers and encapsulates data
into the session data unit (SDU). Oracle Net sends the data stored in this buffer
when the buffer is full, flushed, or when database server tries to read data. When
large amounts of data are being transmitted or when the message size is consistent,
adjusting the size of the SDU buffers can improve performance, network utilization,
or memory consumption. You can deploy SDU at the client, the application Web
server, and the database server.

Listener Queue Size
If you anticipate receiving a large number of connection requests for a listening
process, you can increase the size of the listener queue.

Protocol Conversion
The database only needs to be configured to listen on one protocol address, even
though clients may use other protocols. Oracle Connection Manager provides a
protocol conversion feature that enables a client and database server configured
with different networking protocols to communicate with one another.
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Deploying a Network for the Internet
As Figure 7–2 shows, an Internet network is usually consists of Web clients that
access firewall-protected application Web servers, that then connect to a database.
An Internet network has many of the same requirements as an internal network, but
it also has its own unique set of requirements. This section examines both
requirements.

Figure 7–2 Internet Network Layout
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Scalability
Like an internal network, scalability can be improved in an Internet network with
shared server, connection pooling, and session multiplexing features configured on
the database server. Session multiplexing can also be configured on the application
Web server tier. This can help offload some of the network I/O of the application
Web servers, increasing throughput.

Availability
Availability to the database is crucial for any Internet network with a firewall. It is
important to deploy at least two Oracle Connection Manager firewalls or Oracle Net
Firewall Proxies in the event that one firewall goes down.

Naming Methods
For an Internet network, configure the application Web servers needed to connect to
the databases with the local naming method.

JDBC Drivers
Java applications that reside on the application Web server require the JDBC OCI
driver.

Security
Security in an Internet network is crucial to control access to the database.

Access Control
Granting and denying access to the a database is crucial for a secure network
environment. Access control can be configured through a firewall or on the
database. Oracle Connection Manager can be configured to act as a firewall,
granting or denying clients access to a particular database service or a computer
based on a set of filtering rules. The database can also be configured with
parameters in the sqlnet.ora file to specify that clients using a particular protocol
are allowed or denied access.

See Also: "Naming Considerations" on page 7-10 for further
information about selecting a naming method
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Tuning and Performance
The performance and tuning features described in "Tuning and Performance" on
page 7-7 can also be deployed for an Internet network.

Naming Considerations
Table 7–2 summarizes the relative advantages and disadvantages of each naming
method and provides recommendations for using them in the network.

Table 7–2 Naming Methods: Advantages and Disadvantages

Naming Method Advantages/Disadvantages Recommended for:

Local Naming Advantages:

■ Provides a relatively straightforward
method for resolving net service name
addresses

■ Resolves net service names across
networks running different protocols

Disadvantage: Requires local configuration
of all net service name and address changes

Simple distributed networks with a
small number of services that change
infrequently.

Directory Naming Advantages:

■ Centralizes network names and
addresses in a single place, facilitating
administration of name changes and
updates. This eliminates the need for an
administrator to make changes to what
potentially could be hundreds or even
thousands of clients.

■ Directory stores names for other
services.

■ Tools provide simple configuration.

Disadvantage: Requires access to a directory
server

Large, complex networks (over 20
databases) that change on a frequent
basis.
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Oracle Names Advantage: Centralizes network names and
addresses in a single place, facilitating
administration of name changes and
updates. For example, whenever a change is
made to an existing server or a new server is
added to the network, the change is made
only once on one Oracle Names server. This
eliminates the need for an administrator to
make changes to what potentially could be
hundreds or even thousands of clients.

Disadvantages:

■ Oracle Names stores network names
and addresses for Oracle services only

■ Requires additional setup and
administration of Oracle Names servers

Note: In future releases, Oracle Names will
not be supported as a centralized naming
method. Instead, consider using directory
naming or migrating an existing Oracle
Names configuration to directory naming, as
described in Chapter 10, "Exporting Naming
Data to a Directory Server".

Large, complex networks (over 20
databases) that change on a frequent
basis.

Host Naming Advantages:

■ Requires minimal user configuration.
The user can provide only the name of
the host to establish a connection.

■ Eliminates the need to create and
maintain a local names configuration file
(tnsnames.ora )

Disadvantage: Available only in a limited
environment, as indicated in the
Recommended for column

Simple TCP/IP networks that meet the
criteria listed:

■ Your client and server are
connecting using TCP/IP.

■ The host name is resolved through
an IP address translation
mechanism such as Domain Name
Services (DNS), Network
Information Services (NIS), or a
centrally maintained TCP/IP
hosts  file.

■ No Oracle Connection Manager
features are requested.

Naming Method Advantages/Disadvantages Recommended for:
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Performance Considerations
This section covers performance considerations. It includes the following topics:

■ Listener Queue Size

■ Session Data Unit Size for Data Transfer Optimization

■ Persistent Buffer Flushing for TCP/IP

Listener Queue Size
If you anticipate receiving a large number of connection requests for a listening
process (such as a listener, Oracle Connection Manager, or Oracle Names server)
over TCP/IP, Oracle Net enables you to configure the listening queue to be higher
than the system default.

External Naming Advantage: Enables administrators to load
Oracle net service name into their native
name service using tools and utilities with
which they are already familiar

Disadvantage: Requires a third-party
naming services that cannot be administered
using Oracle Net products

Networks with existing name services.

Naming Method Advantages/Disadvantages Recommended for:
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Session Data Unit Size for Data Transfer Optimization
Tuning your application to reduce the number of round trips across the network is
the best way to improve your network performance. If this is done, it is also
possible to optimize data transfer by adjusting the size of the session data unit
(SDU).

The SDU is a buffer that Oracle Net uses to place data into before transmitting it
across the network. Oracle Net sends the data in the buffer either when requested or
when it is full.

Table 7–3 outlines considerations for modifying the size of the SDU.

Table 7–3 SDU Considerations

Persistent Buffer Flushing for TCP/IP
Under certain conditions for some applications using TCP/IP, Oracle Net packets
may not get flushed immediately to the network. Most often, this behavior occurs
when large amounts of data are streamed. The implementation of TCP/IP itself is
the reason for the lack of flushing, causing unacceptable delays. To remedy this
problem, specify no delays in the buffer flushing process.

Modify SDU size when: Do not modify SDU size when:

■ The data coming back from the server
is fragmented into separate packets

■ You are on a wide area network
(WAN) that has long delays

■ The packet size is consistently the
same

■ Large amounts of data are returned

■ The application can be tuned to avoid
the delays listed in the Modify SDU
size when column

■ You have a higher speed network
where the effect of the data
transmission is negligible

■ Your requests return small amounts of
data from the server

See Also: Oracle9i Net Services Reference Guide for further
information about the TCP.NODELAY parameter
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Planning Summary
Table 7–4 summarizes many of the options you may have chosen as you planned
your network.

Table 7–4 Oracle Net Feature Summary

Feature See Also

Scalability Features

Connection Pooling "Enabling Connection Pooling" on page 14-8

Session Multiplexing "Enabling Session Multiplexing" on page 13-13

Shared Server "Configuring Shared Server with the DISPATCHERS Parameter"
on page 14-2

Availability Features

Client Load Balancing "Configuring Address List Parameters" on page 15-4

Connect-Time Failover "Configuring Address List Parameters" on page 15-4

Naming Method
Features

Directory Naming "Configuring the Directory Naming Method" on page 9-12

Host Naming "Configuring the Host Naming Method" on page 9-60

Local Naming "Configuring the Local Naming Method" on page 9-5

Oracle Names "Configuring the Oracle Names Method" on page 9-23

JDBC Drivers Oracle9i JDBC Developer’s Guide and Reference

Security Features

Access Control "Enabling Access Control" on page 13-14 to configure Oracle
Connection Manager

"Configuring Database Access Control" on page 11-8 to
configure access control parameters in sqlnet.ora

Tuning and Performance
Features

Listener Queue Size "Starting and Stopping the Listener" on page 12-22

Protocol Conversion "Enabling Protocol Conversion Support" on page 13-15

SDU Size "Configuring Session Data Unit" on page 15-28
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8
Setting Up Directory Server Usage

This chapter explains how to configure access to an LDAP-compliant directory
server.

This chapter contains these topics:

■ Directory Configuration Overview

■ Configuring Directory Usage During Installation

■ Configuring Directory Usage After Installation

■ Administering the OracleNetAdmins Group

See Also: "Directory Server Support" on page 3-4 for an overview
of directory server support of Oracle Net Services
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Directory Configuration Overview
Many Oracle products have features that use an LDAP-compliant directory server
to centrally store entries. Examples of features that use a directory are Oracle Net
directory naming and Oracle Advanced Security enterprise user. If you want to
use these features, you must establish a directory server for them, as well as enable
your computers to use the directory server.

Directory server usage can be configured during or after installation, as described in
the following sections:

■ Configuring Directory Usage During Installation

■ Configuring Directory Usage After Installation

Configuring Directory Usage During Installation
Oracle Universal Installer launches Oracle Net Configuration Assistant during
software installation. Oracle Net Configuration Assistant enables you to configure
usage of a directory server. Directory server usage configuration varies depending
upon the installation mode you selected during installation, as described in these
topics:

■ Directory Usage Configuration During a Custom Installation on the Database
Server

■ Directory Usage Configuration During a Client Installation
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Directory Usage Configuration During a Custom Installation on the Database Server
After a Custom installation on the database server, Oracle Net Configuration
Assistant prompts you to configure usage to a directory server. Directory server
usage configuration enables:

■ Database Configuration Assistant, which runs after Oracle Net Configuration
Assistant during installation, to register a database service entry in the directory
server

■ You to use Oracle Net Manager to create net service names and net service
aliases in the directory server, as well as to modify Oracle Net attributes of the
database service entry

■ The database server to look up database service, net service name, and net
service alias entries in the directory server

During directory server usage configuration, Oracle Net Configuration Assistant
prompts you to:

■ Select the type of directory server, that is, Oracle Internet Directory or Microsoft
Active Directory

■ Identify the location of the directory server

■ Select the default Oracle Context from which the database server can look up,
create, and modify directory naming entries

Note: Directory usage configuration is not performed during a
Enterprise Edition or Standard Edition installation on the database
server. For these installation types, Oracle Net Configuration
Assistant can be run in standalone mode. See "Configuring
Directory Usage After Installation" on page 8-6 for details.
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If an Oracle Context does not exist, then Oracle Net Configuration Assistant
prompts you to create one. During Oracle Context creation, you are prompted for
directory administrator authentication credentials. If the Oracle Context is created
successfully, then the authenticated user is added to the following groups:

■ OracleContextAdmins
(cn=OracleContextAdmins,cn=Groups,cn=OracleContext,... )

As a member of OracleContextAdmins, a user has full privileges for the entire
Oracle Context.

■ OracleDBCreators (cn=OracleDBCreators,cn=OracleContext,... )

As a member of OracleDBCreators, a user can use Database Configuration
Assistant to register a database service entry.

■ OracleNetAdmins (cn=OracleNetAdmins,cn=OracleContext,... )

As a member of OracleNetAdmins, a user can use Oracle Net Manager to
create, modify, and delete net service names and net service aliases, as well as
modify Oracle Net attributes of database services.

A directory administrator can add other users to these groups.

During directory usage configuration, Oracle Net Configuration Assistant verifies
that the Oracle schema was created. The Oracle schema defines the Oracle entries
and their attributes. If the schema does not exist or is an older release, then you are
prompted to create or upgrade it. During Oracle schema creation, you are prompted
for authentication credentials.

When directory usage configuration completes, directory usage configuration
information is stored in an ldap.ora  file. You are then prompted to select naming
methods. You can select directory naming.

After Oracle Net Configuration Assistant completes configuration, Database
Configuration Assistant creates the database. The service name of the database is
automatically created under the Oracle Context.

Note: Additional groups are created during Oracle Context
creation, as described in the Oracle9i Directory Service Integration and
Deployment Guide.
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Directory Usage Configuration During a Client Installation
During client installation, Oracle Net Configuration Assistant prompts you to
configure the use of a directory server for enabling directory naming. If directory
server usage is not configured, then the client cannot use directory naming to look
up connect identifier entries in the directory.

During directory server usage configuration, Oracle Net Configuration Assistant
prompts you to:

■ Specify the type of directory server

■ Identify the location of the directory server

■ Select a default Oracle Context from which the client can look up directory
naming entries

During directory usage configuration, Oracle Net Configuration Assistant verifies
that the Oracle schema was installed. If the Oracle schema or Oracle Context was
not configured by the database server, then you cannot complete directory server
usage configuration on the client.

When directory usage configuration completes, Oracle Net Configuration Assistant
stores the directory usage configuration information in the ldap.ora  file.

For Standard Edition and Enterprise Edition installations, Oracle Net Configuration
Assistant automatically configures directory naming as a naming method. For a
Custom installation, you are prompted to select naming methods after directory
usage configuration completes. You can select directory naming.

See Also:

■ "Adding Users To the OracleNetAdmins Group" on page 8-12
to add users to the NetAdmins group

■ Oracle9i Directory Service Integration and Deployment Guide for
further information about how to register a database service
with Database Configuration Assistant

■ Oracle Advanced Security Administrator’s Guide for further
information about adding users to the OracleDBCreators group

■ Oracle operating system-specific installation guide

See Also: "Directory Naming Method Configuration Steps" on
page 9-13
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Configuring Directory Usage After Installation
You can configure directory usage with Oracle Net Configuration Assistant at any
time.

To configure directory server usage:

1. Start Oracle Net Configuration Assistant.

The Welcome page appears.

2. Select Directory Service Usage Configuration, and then click Next.

The Directory Usage Configuration page appears.

See Also: "Oracle Net Configuration Assistant" on page 5-14
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The Directory Usage Configuration page options are described in Table 8–1.

Table 8–1 Directory Usage Configuration Page in Oracle Net Configuration Assistant

Option Description

Select the directory server
you want to use

Select this option to enable this computer’s Oracle home to use a directory
server that is already configured for Oracle directory usage. This option is
intended for clients to use directory naming.

Once configuration is complete, the software in the Oracle home can then look
up entries in the directory server. This option prompts you to:

■ Select the type of directory server

■ Identify the location of the directory server

■ Select a default Oracle Context from which this client can look up
directory naming entries

Note: If no Oracle schema or Oracle Context exists, then you cannot complete
usage configuration using this option. You must first use the Select the
directory server you want to use, and then configure the directory server for
Oracle usage option to create the Oracle schema or Oracle Context.
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Select the directory server
you want to use, and
configure the directory server
for Oracle usage.

Select this option to configure a directory server for Oracle directory-enabled
features and enable the Oracle home to use that directory. This option is
intended for administrators to first configure the directory for Oracle features.

Once configuration is complete, the software in the Oracle home can then look
up entries in the directory server. This option prompts you to:

■ Select the type of directory server

■ Identify the location of the directory server

■ Select or enter a location in the directory server that contains an Oracle
Context from which this computer can look up, create, or modify
directory naming entries

If an Oracle Context does not exist under the selected location, then Oracle Net
Configuration Assistant prompts you to create one. Likewise, if the Oracle
schema does not exist or is an older release, you are prompted to create or
upgrade it. During the creation or upgrade of an Oracle schema or Oracle
Context, you are prompted for directory administrator authentication
credentials. To create an Oracle Context, the following must exist in the
directory server:

■ Current release of the Oracle schema

■ A directory entry under which you want the Oracle Context to be created

If the Oracle Context is created successfully, then the authenticated user is
added to the following groups:

■ OracleContextAdmins
(cn=OracleContextAdmins,cn=Groups,cn=OracleContext,... )

■ OracleDBCreators
(cn=OracleDBCreators,cn=OracleContext,... )

■ OracleNetAdmins (cn=OracleNetAdmins,cn=OracleContext,... )

See Also:

■ Directory server vendor documentation for directory entry configuration
instructions

■ Oracle9i Directory Service Integration and Deployment Guide for further
information about all the additional groups created during Oracle Context
creation

■ "Adding Users To the OracleNetAdmins Group" on page 8-12 to add
users to the OracleNetAdmins group

■ Oracle Advanced Security Administrator’s Guide for further information
about adding users to the OracleDBCreators group

Option Description
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3. Select the appropriate option, and then follow the prompts in the wizard and
online help to complete directory server usage configuration.

Create additional or upgrade
existing Oracle Context

Select this option to create an additional Oracle Context in the directory, or
upgrade the Oracle Context to the current release.

To create an Oracle Context, the following must exist in the directory server:

■ Current release of the Oracle schema

■ A directory entry under which you want the Oracle Context to be created

During the creation or upgrade of an Oracle Context, you are prompted for
directory administrator authentication credentials.

If the Oracle Context is created successfully, then the authenticated user is
added to the following groups:

■ OracleContextAdmins
(cn=OracleContextAdmins,cn=Groups,cn=OracleContext,... )

■ OracleDBCreators
(cn=OracleDBCreators,cn=OracleContext,... )

■ OracleNetAdmins (cn=OracleNetAdmins,cn=OracleContext,... )

Create or upgrade the Oracle
Schema

Select this option to create the Oracle schema in the directory, or upgrade the
Oracle schema to the current release. During Oracle schema creation or
upgrade, you are prompted for authentication credentials.

Option Description
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Administering the OracleNetAdmins Group
Members of OracleNetAdmins
(cn=OracleOracleNetAdmins,cn=OracleContext,... ) have create, modify,
and read access to Oracle Net objects and attributes. Oracle Net Configuration
Assistant establishes these access rights for this group during Oracle Context
creation.

This section contains the following topics:

■ Establishing Access For the OracleNetAdmins Group

■ Adding Users To the OracleNetAdmins Group

■ Removing Users From the OracleNetAdmins Group

Establishing Access For the OracleNetAdmins Group
The owner of the OracleNetAdmins group can perform the following functions:

■ Add or delete members from the OracleNetAdmins group

■ Add or delete groups which are owners of the OracleNetAdmins group

By default, the owner of the OracleNetAdmins group is the OracleNetAdmins
group itself. This means that any member of the OracleNetAdmins group can add
or delete other members from the OracleNetAdmins group. If you prefer that
another group other than OracleNetAdmins add or delete other OracleNetAdmins
members, you can change the owner attribute of the OracleNetAdmins group to
another group.

The owner cannot be an individual user entry, such as cn=scott , but must be a
group entry, where the group entry is one comprised of the LDAP schema object
classes GroupOfUniqueNames  and orclPriviledgeGroup .

Note: Members of the OracleContextAdmins groups can also add
and delete members of the OracleNetAdmins group. See the
Oracle9i Directory Service Integration and Deployment Guide.
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To add a group as an owner of an OracleNetAdmins group:

1. Create an LDAP Data Interchange Format (LDIF) file:

a. Specify the group you want to add as an owner.

You can use the following sample LDIF file. Enter the appropriate
distinguished name (DN) for cn=OracleNetAdmins  and the DN of the
group that you want to add.

dn: cn=OracleNetAdmins,cn=OracleContext,...
    changetype: modify
    add: owner
    owner: < DN of group to add >

b. Optionally, specify the group to delete as an owner.

dn: cn=OracleNetAdmins,cn=OracleContext,...
    changetype: modify
    add: owner
    owner: < DN of group to add >

For example, the following LDIF syntax changes the ownership from the
OracleNetAdmins group to another group named
cn=AcmeSecurityAdmins . The group can be either be inside or outside
the Oracle Context; in this case, it is outside the Oracle Context.

dn: cn=OracleNetAdmins,cn=OracleContext,...
     changetype: modify
     add: owner
     owner: cn=AcmeSecurityAdmins

dn: cn=OracleNetAdmins,cn=OracleContext,...
     changetype: modify
     delete: owner
     owner: cn=OracleNetAdmins,cn=OracleContext,...
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2. Use the following ldapmodify  syntax to delete the user:

ldapmodify -h directory_host  -p port  -D binddn  -w password  -f ldif_file

Table 8–2 ldapmodify Arguments

Adding Users To the OracleNetAdmins Group
To add a user to the OracleNetAdmins group with ldapmodify :

1. Create an LDIF file that specifies that you want to add a user to the
OracleNetAdmins group.

You can use the following sample LDIF file. Use the appropriate DN for
cn=OracleNetAdmins  and the user that you want to add.

dn: cn=OracleNetAdmins,cn=OracleContext,...
changetype: modify
add: uniquemember
uniquemember: < DN of user being added to group >

2. Enter the following ldapmodify  syntax to add a user:

ldapmodify -h directory_host  -p port  -D binddn  -w password  -f ldif_file

Argument Description

-h directory_host Specify the directory server host.

-p port Specify the listening TCP/IP port for the directory server. If
you do not specify this option, the default port (389) is used.

-D binddn Specify the directory administrator or user DN.

-w password Specify the password for the directory administrator or
directory user.

-f ldif_file Specify the input file name.
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Removing Users From the OracleNetAdmins Group
To remove a user from the OracleNetAdmins group with ldapmodify :

1. Create an LDIF file that specifies that you want to add a user to the
OracleNetAdmins group.

You can use the following sample LDIF file. Enter the appropriate DN for
cn=OracleNetAdmins  and the user that you want to delete.

dn: cn=OracleNetAdmins,cn=OracleContext,...
changetype: modify
delete: uniquemember
uniquemember: < DN of user being deleted from group >

2. Use the following ldapmodify  syntax to delete the user:

ldapmodify -h directory_host  -p port  -D binddn  -w password  -f ldif_file
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9
Configuring Naming Methods

This chapter describes how to configure connectivity information for client
connections to the database server.

This chapter contains these topics:

■ Naming Method Configuration Overview

■ About Connect Descriptors

■ Configuring the Local Naming Method

■ Configuring the Directory Naming Method

■ Configuring the Oracle Names Method

■ Configuring the Host Naming Method

■ Configuring External Naming Methods

See Also: "Naming" on page 2-16 for an overview of naming
methods
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Naming Method Configuration Overview
To connect to a service, clients use a connect identifier in the connect string to
connect to a service. The connect identifier can be a connect descriptor or a simple
name that maps to a connect descriptor. The connect descriptor contains:

■ Network route to the service, including the location of the listener through a
protocol address

■ Service name of an Oracle9i or Oracle8i database or Oracle System Identifier
(SID) of an Oracle release 8.0 database

A simple name is resolved to a connect descriptor by a naming method. Naming
method configuration consists of the following steps:

1. Select a naming method.

2. Map connect descriptors to simple names.

3. Configure clients to use the naming method.

About Connect Descriptors
A connect descriptor is comprised of one or more protocol addresses of the listener
and connect data information for the destination service.

The following example shows a connect descriptor mapped to simple name called
sales :

sales=
 (DESCRIPTION=
  (ADDRESS= (PROTOCOL=tcp)(HOST=sales-server)(PORT=1521))
  (CONNECT_DATA=
     (SERVICE_NAME=sales.us.acme.com)))

The ADDRESS section contains the listener protocol address, and the CONNECT_
DATA section contains the destination service information. In this example, the
destination service is a database service named sales.us.acme.com .
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When creating a connect descriptor to an Oracle9i or Oracle8i database service, you
must identify the service with the SERVICE_NAME parameter. Optionally, you can
identify an instance with the INSTANCE_NAME parameter, as shown in the
following:

sales=
 (DESCRIPTION=
  (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=1521))
  (CONNECT_DATA=

(SERVICE_NAME=sales.us.acme.com)
(INSTANCE_NAME=sales) ))

The values for these parameters come from the SERVICE_NAMES (with an S) and
INSTANCE_NAME parameters in the initialization parameter file. The SERVICE_
NAMESparameter in the initialization parameter file is typically the global database
name, a name comprising the database name and domain name, entered during
installation or database creation. For example, sales.us.acme.com  has a
database name of sales  and a domain of us.acme.com . The INSTANCE_NAME
parameter in the initialization parameter file is defaulted to the SID entered during
installation or database creation.

When creating a connect a descriptor for an Oracle release 8.0 or version 7 database,
you identify the service with the SID parameter. The following example shows a
connect descriptor for an Oracle release 8.0 database with a SID of sales :

sales=
 (DESCRIPTION=
  (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=1521))
  (CONNECT_DATA=

(SID=sales) ))

See Also: "Database Service and Database Instance Identification"
on page 2-2
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Naming Methods
Table 9–1 describes the naming methods that Oracle Net supports.

Table 9–1 Naming Methods

Naming Method Description

Local Naming Resolves a net service name stored in a tnsnames.ora  file stored on a client

Local naming is most appropriate for simple distributed networks with a small
number of services that change infrequently.

See Also: "Configuring the Local Naming Method" on page 9-5

Directory Naming Resolves a database service name, net service name, or net service alias stored in a
centralized LDAP-compliant directory server

See Also: "Configuring the Directory Naming Method" on page 9-12

Oracle Names Resolves a database or alias objects stored in an Oracle Names server

See Also: "Configuring the Oracle Names Method" on page 9-23

Note: In future releases, Oracle Names will not be supported as a centralized naming
method.

Host Naming Enables users to connect to an Oracle server by using a host name alias. Host names
are mapped to a connect descriptor in an existing names resolution service or a
centrally-maintained set of /etc/hosts  files.

No client configuration is required to take advantage of this feature. This method is
recommended for simple TCP/IP environments.

See Also: "Configuring the Host Naming Method" on page 9-60

External Naming Resolves service information stored in an a third-party naming service

See Also: "Configuring External Naming Methods" on page 9-64

See Also: "Naming" on page 2-16
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Configuring the Local Naming Method
The local naming method adds net service names to the tnsnames.ora  file. Each
net service name maps to a connect descriptor. The example a net service name
mapped to a connect descriptor:

sales=
(DESCRIPTION=
  (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=1521))
  (CONNECT_DATA=
     (SERVICE_NAME=sales.us.acme.com)))

In this example, the net service name sales  is mapped to the connect descriptor
contained in DESCRIPTION. DESCRIPTION contains the protocol address and
identifies the destination database service.

You can configure local naming during or after installation, as described in these
topics:

■ Configuring the tnsnames.ora File During Installation

■ Configuring the tnsnames.ora File After Installation
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Configuring the tnsnames.ora File During Installation
Oracle Net Configuration Assistant enables you to configure net service names for
clients. Oracle Universal Installer launches Oracle Net Configuration Assistant after
software installation. The configuration varies depending on the installation mode.

Typical or Minimal Installation
Oracle Net Configuration Assistant prompts you to configure net service names in
the tnsnames.ora  file to connect to an Oracle database service.

Custom Installation
Oracle Net Configuration Assistant prompts you to select naming methods to use. If
Local is selected, then Oracle Net Configuration Assistant prompts you to configure
net service names in a tnsnames.ora  file to connect to an Oracle database service.

Configuring the tnsnames.ora File After Installation
You can add net service names to the tnsnames.ora  file at any time. To configure
the local naming method, perform the following tasks:

Task 1: Configure Net Service Names

Task 2: Configure TNSNAMES as the First Naming Method

Task 3: Distribute Configuration

Task 4: Configure the Listener

Task 5: Connect to the Database

Task 1: Configure Net Service Names

To configure with the local naming method, use either of the following tools:

■ Oracle Net Manager

■ Oracle Net Configuration Assistant

Note: The underlying network connection must be operational
before attempting to configure connectivity with Oracle Net.
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Oracle Net Manager To configure net service names in the tnsnames.ora  file with
Oracle Net Manager:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Local > Service Naming.

3. Click plus (+) from the toolbar, or choose Edit > Create from the menu bar.

The Welcome page of the Net Service Name Wizard appears.

4. Enter any name in the Net Service Name field.

You can qualify the net service name with the client’s domain. The net service
name is automatically domain qualified if the sqlnet.ora  file parameter
NAMES.DEFAULT_DOMAIN is set.

5. Click Next.

The Protocol page appears.

6. Select the protocol on which the listener is configured to listen. Note that this
protocol must also installed on the client.

7. Click Next.

The Protocol Settings page appears.

8. Enter the appropriate parameter information for the selected protocol in the
fields provided.

9. Click Next.

The Service page appears.

See Also: "Starting Oracle Net Manager" on page 5-3

See Also: "Configuring a Default Domain for Clients" on
page 11-3

See Also: Oracle9i Net Services Reference Guide for protocol
parameter settings
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10. Select a release, enter a destination service, and optionally, select a database
connection type.

If the destination service is Oracle9i or Oracle8i database, then select Oracle8i
or later, and enter a service name in the Service Name field. If destination
service is an Oracle release 8.0 database, then select Oracle8 or Previous, and
enter an Oracle System Identifier for an instance in the Database SID field.

Oracle Corporation recommends that you use the default setting of Database
Default for the connection type. If shared server is configured in the
initialization parameter file, you can select Dedicated Server to force the
listener to spawn a dedicated server, bypassing shared server configuration. If
shared server is configured in the initialization parameter file and you want to
guarantee the connection always uses shared server, select Shared Server.

11. Click Next.

The Test page appears.

12. Click Test to verify that the net service name works, or click Finish to save your
configuration and dismiss the Net Service Name Wizard.

See Also: "About Connect Descriptors" on page 9-2 for further
information about the service name string to use

See Also: Chapter 14, "Configuring Shared Server" for further
information about shared server configuration
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If you click Test, then Oracle Net connects to the database server by using the
connect descriptor information you configured. Therefore, the database and the
listener must be running for a successful test. If they are not, see "Starting
Oracle Net Services Components" on page 16-2 to start components before
testing. During testing, a Connection Test dialog box appears, providing status
and test results. A successful test results in the following message:

The connection test was successful.

If the test was successful, click Close to dismiss the Connect Test dialog box,
and proceed to Step 13.

If the test was not successful:

a. Ensure that the database and listener are running, and then click Test.

b. Click Change Login to change the username and password for the
connection, and then click Test.

13. Click Finish to save your configuration and dismiss the Net Service Name
Wizard.

See Also:

■ "Creating a List of Listener Protocol Addresses" on page 15-2 to
configure multiple protocol addresses

■ "Configuring Advanced Connect Data Parameters" on
page 15-7 to configure additional CONNECT_DATA options
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Oracle Net Configuration Assistant To configure net service names in the
tnsnames.ora file with Oracle Net Configuration Assistant:

1. Start Oracle Net Configuration Assistant.

The Welcome page appears.

2. Select Local Net Service Name Configuration, and then click Next.

The Net Service Name Configuration page appears.

3. Click Add, and then click Next.

The Net Service Name Configuration, Database Version page appears.

4. If the destination service is an Oracle9i or Oracle8i database, then select
Oracle8i or later database or service. If destination service is an Oracle8 release
8.0 database, then select Oracle8 release 8.0 database or service.

5. Click Next.

6. Follow the prompts in the wizard and online help to complete net service name
creation.

Task 2: Configure TNSNAMES as the First Naming Method
Configure local naming as the first method specified in the NAMES.DIRECTORY_
PATH parameter in the sqlnet.ora  file. This parameter specifies the order of
naming methods Oracle Net uses to resolve connect identifiers to connect
descriptors.

To specify local naming as the first naming method:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Local > Profile.

3. From the list in the right pane, select Naming.

4. Click the Methods tab.

5. From the Available Methods list, select TNSNAMES, and then click the
right-arrow button.

See Also: "Oracle Net Configuration Assistant" on page 5-14

See Also: "Starting Oracle Net Manager" on page 5-3
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6. From the Selected Methods list, select TNSNAMES, and then use the Promote
button to move the selection to the top of the list.

7. Choose File > Save Network Configuration.

The sqlnet.ora  file updates with the NAMES.DIRECTORY_PATH parameter,
listing tnsnames  first:

NAMES.DIRECTORY_PATH=(tnsnames, onames, hostname)

Task 3: Distribute Configuration
After one client is configured, it is best simply to copy the tnsnames.ora  and
sqlnet.ora  configuration files to the same location on the other clients. This
ensures that the files are consistent. Alternatively, you can use Oracle Net Manager
or Oracle Net Configuration Assistant on every client.

Task 4: Configure the Listener
Ensure that the listener (located on the server) is configured to "listen on" the same
protocol address you configured for the net service name. By default, the listener
should already be configured for the TCP/IP protocol on port 1521.

Task 5: Connect to the Database
Clients can connect to the database using the following syntax:

CONNECTusername / password @net_service_name

See Also: Chapter 12, "Configuring and Administering the
Listener" for listener configuration details
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Configuring the Directory Naming Method
With the directory naming method, connect identifiers are mapped to connect
descriptors contained in an LDAP-compliant directory server, including Oracle
Internet Directory and Microsoft Active Directory. A directory provides central
administration of database services and net service names, making it easier to add
or relocate services.

A database service entry is created with Database Configuration Assistant during
installation; net service name and net service alias entries can be created with
Oracle Net Manager. To modify Oracle Net attributes of a database service entry
and the net service name entries, use Oracle Net Manager.

Clients configured to access the directory can use these entries to connect to the
database.

This section contains these topics:

■ Directory Naming Method Configuration Steps

■ Modifying Connectivity Information for Database Service Entries

■ Creating Net Service Aliases
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Directory Naming Method Configuration Steps
To configure the directory naming method, perform the following tasks:

Task 1: Configure Directory Usage on Server and Clients

Task 2: Create Net Service Name Entries (Optional)

Task 3: Configure LDAP as the First Naming Method

Task 4: Configure the Listener

Task 5: Connect to the Database

Task 1: Configure Directory Usage on Server and Clients
Before a database service or net service name can be added to a directory, you must
complete directory usage configuration. You can configure directory server usage
during or after installation.

See Also: Chapter 8, "Setting Up Directory Server Usage" for
further information about configuring directory server usage
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Task 2: Create Net Service Name Entries (Optional)

You can configure clients to use a net service name rather than the database service
entry created by Database Configuration Assistant.

To create a net service name in a directory server:

1. Start Oracle Net Manager on a computer that has been configured with
directory access for a server:

2. In the navigator pane, expand Directory > Service Naming.

3. Click plus (+) from the toolbar, or choose Edit > Create from the menu bar.

The Welcome page of the Net Service Name Wizard appears.

4. Enter any name in the Net Service Name field.

5. Click Next.

The Protocol page appears.

6. Select the protocol on which the listener is configured to listen. Note that this
protocol must also installed on the client.

7. Enter the appropriate parameter information for the selected protocol in the
fields provided.

Notes:

■ Only users that are members of either the OracleNetAdmins or
OracleContextAdmins group can create net service name
entries in a directory. To add or remove users from the
OracleNetAdmins group, see "Adding Users To the
OracleNetAdmins Group" on page 8-12.

■ You can export existing net service names from a
tnsnames.ora file or an Oracle Names server. See Chapter 10,
"Exporting Naming Data to a Directory Server".

See Also: "Starting Oracle Net Manager" on page 5-3

See Also: Oracle9i Net Services Reference Guide for protocol
parameter settings
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8. Click Next.

The Service page appears.

9. Select a release, enter a destination service, and optionally, select a database
connection type.

If the destination service is Oracle9i or Oracle8i database, then select Oracle8i
or later, and enter a service name in the Service Name field. If destination
service is an Oracle release 8.0 database, then select Oracle8 or Previous, and
enter an Oracle System Identifier for an instance in the Database SID field.

Oracle Corporation recommends that you use the default setting of Database
Default for the connection type. If shared server is configured in the
initialization parameter file, you can select Dedicated Server to force the
listener to spawn a dedicated server, bypassing shared server configuration. If
shared server is configured in the initialization parameter file and you want to
guarantee the connection always uses shared server, select Shared Server.

10. Click Next.

The Test page appears.

See Also: "About Connect Descriptors" on page 9-2 for further
information about the service name string to use

See Also: Chapter 14, "Configuring Shared Server" for further
information about shared server configuration
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11. Click Test to verify that the net service name works, or click Finish to save your
configuration and dismiss Net Service Name Wizard.

If you click Test, then Oracle Net connects to the database server by using the
connect descriptor information you configured. Therefore, the database and the
listener must be running for a successful test. If they are not, see "Starting
Oracle Net Services Components" on page 16-2 to start components before
testing. During testing, a Connection Test dialog box appears, providing status
and test results. A successful test results in the following message:

The connection test was successful.

If the test was successful, click Close to dismiss the Connect Test dialog box,
and proceed to Step 12.

If the test was not successful:

a. Ensure that the database and listener are running, and then click Test.

b. Click Change Login to change the username and password for the
connection, and then click Test.

12. Click Finish to save your configuration and dismiss the Net Service Name
Wizard.

See Also:

■ "Creating a List of Listener Protocol Addresses" on page 15-2 to
configure multiple protocol addresses

■ "Configuring Advanced Connect Data Parameters" on
page 15-7 to configure additional connect data options
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Task 3: Configure LDAP as the First Naming Method
Configure directory naming as the first method specified in the
NAMES.DIRECTORY_PATH parameter in the sqlnet.ora  file. This parameter
specifies the order of naming methods Oracle Net uses to resolve connect identifiers
to connect descriptors.

To specify directory naming as the first naming method:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Local > Profile.

3. From the list in the right pane, select Naming.

4. Click the Methods tab.

5. From the Available Methods list, select LDAP, and then click the right-arrow
button.

6. From the Selected Methods list, select LDAP, and then use the Promote button
to move the selection to the top of the list.

7. Choose File > Save Network Configuration.

The sqlnet.ora  file updates with the NAMES.DIRECTORY_PATH parameter,
listing ldap  first:

NAMES.DIRECTORY_PATH=(ldap, tnsnames, onames, hostname)

Task 4: Configure the Listener
Ensure that the listener (located on the server) is configured to listen on the same
protocol address configured for the net service name. By default, the listener is
configured to listen on the TCP/IP protocol, port 1521.

See Also: "Starting Oracle Net Manager" on page 5-3

See Also: Chapter 12, "Configuring and Administering the
Listener" for listener configuration details
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Task 5: Connect to the Database
Clients that are configured with a default directory entry that matches the directory
location of the database service or net service name can connect to the database
using the following syntax:

CONNECTusername / password @connect_identifier

Clients that are configured with a default directory entry that does not match the
entry’s directory location cannot use the connect identifier in the connect string.
Instead, these connections require the entry’s distinguished name or its absolute
name.

See Also:

■ "Connect Identifier and Connect Descriptor Syntax
Characteristics" on page 16-9 for connect identifier syntax rules

■ "Absolute Name Specification for Directory Naming" on
page 16-9 for absolute name usage
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Modifying Connectivity Information for Database Service Entries

When database registration with the directory completes, Database Configuration
Assistant creates a database service entry in the directory. By default, this entry
contains network route information that includes the location of the listener
through a protocol address. You can re-create this information, if it has been
removed, or modify the existing network route information.

To create or modify network route information for a database service:

1. Start Oracle Net Manager on a computer that has been configured with
directory access for a server:

2. In the navigator pane, expand Directory > Service Naming.

3. Select the database service. The right pane displays the current destination
service name.

4. In the Address Configuration box, click plus (+).

A new Address tab appears.

5. Select a protocol, and then enter the appropriate parameter information for the
selected protocol in the fields provided.

6. In the right pane, click Apply.

Note:

■ Only users that are members of either the OracleNetAdmins or
OracleContextAdmins group can modify network information
for a database service in a directory. To add or remove users
from these groups, see "Adding Users To the OracleNetAdmins
Group" on page 8-12.

■ You can export existing database service objects from an Oracle
Names server. See Chapter 10, "Exporting Naming Data to a
Directory Server".

See Also: "Starting Oracle Net Manager" on page 5-3

See Also: Oracle9i Net Services Reference Guide for protocol
parameter settings
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Creating Net Service Aliases

Net service aliases in a directory server enable clients to refer to a database service
or a net service name by an alternative name. For example, a net service alias of
salesalias can be created for a net service name of sales . When salesalias is
used to connect to a database, as in CONNECT scott/tiger@salesalias , it will
actually resolve to and use the connect descriptor information for sales .

There are two main uses of net service aliases:

■ Use a net service alias as a way for clients to refer to a database service or net
service name by another name.

■ Use a net service alias in one Oracle Context for a database service or net
service name in a different Oracle Context. This enables a database service or
net service name to be defined once in the directory server, but referred to by
clients that use other Oracle Contexts.

To create a net service alias:

1. In the navigator pane, expand Directory > Service Naming > Aliases.

2. Click plus (+) from the toolbar, or choose Edit > Create from the menu bar.

Notes:

■ Only users that are members of either the OracleNetAdmins or
OracleContextAdmins group can create or modify net service
alias entries in a directory. To add or remove users from the
OracleNetAdmins group, see "Adding Users To the
OracleNetAdmins Group" on page 8-12.

■ To create or access net service aliases, ensure that the Oracle
home is upgraded to 9.2.

■ You can export existing alias objects from an Oracle Names
server. See Chapter 10, "Exporting Naming Data to a Directory
Server".

■ Net service aliases are not supported using Microsoft Active
Directory.

See Also: "Net Service Alias Entries" on page 3-9 for an overview
of net service aliases



Configuring the Directory Naming Method

Configuring Naming Methods 9-21

The Create Alias dialog box appears.

3. In the Net Service Alias field, enter a name for the alias.

4. In the Net Service Name or Database Service box, enter the following
information about the database service or net service name:

5. Click Create.

Oracle Context Specify the Oracle Context of the database service or net
service name by selecting one from the list or entering one
in the field.

Name Specify the DN of the database service or net service
name by selecting one from the list or entering one in the
field.
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The Aliases folder updates with the created net service alias.
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Configuring the Oracle Names Method

Oracle Names simplifies the setup and administration of global, client/server
computing networks. Oracle Names makes network address and database link
information available to all nodes throughout the network. Each database server
network address is identified with a simple service name. Client applications then
can request a database connection with that name rather than a lengthy address.
Oracle Names shields users and applications from changes to the network
infrastructure. It provides for centralized administration of network service names.

Configuring Oracle Names involves these tasks:

Task 1: Consider Oracle Names Options

Task 2: Install Necessary Components

Task 3: Create an Oracle Names Server

Task 4: Configure Clients and Database Servers To Use Oracle Names Servers

Task 5: (Optional) Configure Client Caches

Task 6: Configure the Listener

Task 7: Register Data with the Oracle Names Server

Task 8: Delegate Domains to Delegated Administrative Regions

Task 9: Specify Domain Hints to Forward Requests to Remote Oracle Names
Servers

Task 10: Connect to the Database

Note: In future releases, Oracle Names will not be supported as a
centralized naming method. Because no new enhancements are
being added to Oracle Names, consider using directory naming or
migrating an existing Oracle Names configuration to directory
naming, as described in Chapter 10, "Exporting Naming Data to a
Directory Server". The material presented here is primarily for
reference to enable you to maintain your current Oracle Names
environment.

See Also: Oracle9i Database Migration for the procedures for
upgrading previous release of Oracle Names to 9i
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Task 1: Consider Oracle Names Options
Prior to creating an Oracle Names server, you must decide whether:

■ You need service registration data replicated continuously among Oracle
Names servers, or want all Oracle Names servers within a region to store their
registration data in an Oracle database.

■ You need support for one or more administrative region. An administrative
region is a collection of Oracle Names servers in one or more domains, a
grouping of network objects, such as databases. Networks with multiple
administrative regions must have one root administrative region and one or
more delegated administrative regions. Delegated administrative regions
contain the domains and Oracle Names server addresses in any alternate
regions which act as direct child regions of the root.

Task 2: Install Necessary Components
Ensure that the following are installed:

■ Oracle Names on its own computer that is designated as the Oracle Names
server

■ Oracle Net Services on the clients

■ Oracle Net Services on the database server

See Also: "Oracle Names Support" on page 3-22

Important: The Oracle Universal Installer does not install the
$ORACLE_HOME/network/names  directory on UNIX operating
systems. This directory is necessary for successful configuration. If
it does not exist, you must manually create it.
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Task 3: Create an Oracle Names Server
How an Oracle Names server is created depends upon how you want region data
stored. You can have the data:

■ Stored in tables, called a region database, in an Oracle database accessible to
Oracle Names servers

When information is added to an Oracle Names server, the information is
stored in the database and in the Oracle Names server checkpoint files. If the
database is unavailable, the information in these files is used.

■ Saved to checkpoint files and replicated among Oracle Names servers

When information is added to an Oracle Names server, the information is
stored in checkpoint files, and then replicated to the other Oracle Names
servers.

By default, the checkpoint files are stored in $ORACLE_HOME/network/names  on
UNIX operating systems, and ORACLE_HOME\network\names  on Windows NT.
Table 9–2 describes the checkpoint files.

Table 9–2 Oracle Names Checkpoint Files

Checkpoint File Name Description

ckpcfg.ora Contains a backup copy of the configuration parameters stored in
the ONRS_CONFIG table in the region database

ckpcch.ora Contains all current non-authoritative data that has been
retrieved and cached from remote regions and has not expired yet

ckptop.ora  and
ckpdom.ora

These files contain all authoritative data for the region. The
ckptop.ora  file defines the domains in the administrative
region and the Oracle Names servers authoritative for each
domain. The ckdom.ora  file contains the authoritative data for
each domain.

If the Oracle Names server uses a region database, then these files
serve as a copy of the region data in the tables as of the last
reload. This data is used when the Oracle Names server starts if
the database is inaccessible.

If the Oracle Names server is not using the database, these files
are its only persistent storage and are loaded by the Oracle
Names server at startup. The Oracle Names server considers the
data in these file to be current if there are no other Oracle Names
servers in the region. The files are kept current as of the last
update to the region.
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The following sections cover both modes, as well as a default Oracle Names server
that requires no configuration:

■ Default Oracle Names Server

■ Create Tables in a Database

■ Checkpoint Files/Replicated Updates

Whichever method you select, Oracle Corporation recommends that you create
more than one Oracle Names server for the network, in case one should go down.

Default Oracle Names Server
An Oracle Names server can run without any configuration. Its name defaults to
ONAMES_host  if its name is configured in the names.ora  file. The protocol
address defaults to TCP/IP, port 1575 on the local host.

If the NAMES.DOMAINS parameter is not configured in the names.ora  file, the
Oracle Names server assumes authority for the root domain.

If you would like to use this Oracle Names server, proceed to "Task 2: Discover
Oracle Names Servers" on page 9-37.

Create Tables in a Database
To store service data in an Oracle database, perform the following tasks:

■ Task 1: Configure the Database Server

■ Task 2: Create Oracle Names Servers

■ Task 3: Start the Oracle Names Server
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Task 1: Configure the Database Server To configure the database server:

1. Start the database if it is not currently running; otherwise, go to Step 2.

2. Connect to the database as the SYSTEM user:

SQL> CONNECT system/ password

where password  is MANAGER for the SYSTEM user account by default.

3. Create a user that can create tables.

a. Create user. In the following example syntax, the default tablespace is
users  and the temporary tablespace is temp :

CREATE USERuser
IDENTIFIED BY password
DEFAULT TABLESPACE users
TEMPORARY TABLESPACE temp;

b. Grant the user the ability to connect to the database:

GRANT CREATE SESSION TOuser ;

c. Grant the user the ability to update tables in the users  tablespace:

GRANT RESOURCE users TO user ;

d. Grant the ability to create synonyms in the user's schema:

GRANT CREATE SYNONYM TOuser ;

4. Run the namesini.sql  script located in $ORACLE_HOME/network/admin
on UNIX operating systems and ORACLE_HOME\network\admin\names  on
Windows NT. This script creates the tables needed by Oracle Names to store
information. Optionally, run namesupg.sql  to upgrade old tables.

SQL> CONNECTuser / password
SQL> @oracle_home /network/admin/namesini.sql;

See Also: "Task 4: Start the Database" on page 16-6

See Also: Oracle9i Database Administrator’s Guide for further
information about creating users
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Task 2: Create Oracle Names Servers For each computer where Oracle Names is
installed and where you want an Oracle Names server, create an Oracle Names
server from Oracle Net Manager.

1. Start Oracle Net Manager.

2. In the navigator pane, expand Oracle Names Servers.

3. Click plus (+) from the toolbar, or choose Edit > Create from the menu bar.

The Names Wizard starts.

The wizard guides you through the creation and configuration process,
prompting for:

■ A unique Oracle Name Server name

■ A protocol address for the Oracle Names server

If you select TCP/IP, then Oracle Corporation recommends using the
default and officially registered port of 1575 for the Oracle Names server.

■ A choice to store information in a database or replicate information among
Oracle Names servers

(Click Use a region database.)

■ A protocol address for a database’s listener

If you select TCP/IP, then Oracle Corporation recommends using the
default and officially registered port of 1521 for the listener.

■ Database user ID, password, and service name or SID

■ Whether or not this Oracle Names server is in the root administrative
region

If you specify that this Oracle Names server is in the root administrative region,
configuration completes.

If you specify that this Oracle Names server is not in the root administrative
region, it assumes that this Oracle Names server is in a delegated
administrative region. The wizard then prompts you for the local
administrative region’s domain name and the address of an Oracle Names
server in the root administrative region before completing.

See Also: "Starting Oracle Net Manager" on page 5-3
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When the wizard completes, the following message appears:

A Names Server, onames_server, has been created with
default settings. Use the Configure Server section to
modify the default configuration.

4. Choose File > Save Network Configuration.

5. Repeat Steps 2 through 4 to create additional Oracle Names servers in a region.
Oracle Net Manager does not support creation of multiple Oracle Names
servers on one computer.

Oracle Net Manager creates a names.ora  file with the following settings:

■ Oracle Names server name (NAMES.SERVER_NAME)

■ Oracle Names server listening protocol address (NAMES.ADDRESSES)

■ Database information (NAMES.ADMIN_REGION)

■ Root administrative region information (NAMES.DOMAIN_HINTS)

■ Domains in this administrative region (NAMES.DOMAINS)

The names.ora  file is created in the $ORACLE_HOME/network/admin  directory
on UNIX operating systems and the ORACLE_HOME\network\admin  directory on
Windows NT.
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A names.ora  file follows with annotations of content:

#Oracle Names server name. The name should include the name of the domain
this Oracle Names server is in.
NAMES.SERVER_NAME=namesvr2.us.acme.com

#Oracle Names server listening protocol address
NAMES.ADDRESSES=
 [(ADDRESS_LIST=]
  (ADDRESS=(PROTOCOL=tcp)(HOST=namesrv2-server)(PORT=1575))
  [(ADDRESS=...))][)]

#Database repository information
NAMES.ADMIN_REGION=
  (REGION=
    (DESCRIPTION=
      (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=1521))
      (CONNECT_DATA=
        (SERVICE_NAME=sales.us.acme.com))
    (USERID=system)
    (PASSWORD= password )
    (NAME=local_region)
    (REFRESH=86400)
    (RETRY=60)
    (EXPIRE=600))

#If an Oracle Names server is in a delegated administrative region, identify
the address of an Oracle Names server in the root administrative region.
NAMES.DOMAIN_HINTS=
  (HINT_DESC=
   (HINT_LIST=
     (HINT=
      (NAME=namesvr1)
      (ADDRESS=(PROTOCOL=tcp)(HOST=namesvr1-server)(PORT=1575))

# Specify the domain controlled by this region and the time to live (TTL).
If this is the root administrative region, specify NAME=(null) or NAME=. to
identify the root domain.
NAMES.DOMAINS=
 (DOMAIN=
   (NAME=us.acme.com)
   (MIN_TTL=86400))
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Administering Multiple Domains
If you want the region to administer more than one domain, specify the additional
domains in the NAMES.DOMAINS parameter with Oracle Net Manager:

1. In the navigator pane, expand Oracle Names Servers.

2. Select the Oracle Names server.

3. From the list in the right pane, select Configure Server.

4. Click the Domains tab.

5. Enter the domain name in the Domain Name field and time-to-live
information, and then click Add.

6. Repeat Step 5 for each additional domain.

7. Choose File > Save Network Configuration.

In the following example, NAMES.DOMAINS contains a listing for the root (value of
null), com, acme.com , and hq.acme.com  domains. all the domain precedent to
hq.acme.com  must be defined in order to define hq.acme.com .

NAMES.DOMAINS=
 (DOMAIN_LIST=
  (DOMAIN=
    (NAME=)
    (MIN_TTL=86400))
  (DOMAIN=
    (NAME=com)
    (MIN_TTL=86400))
  (DOMAIN=
    (NAME=acme.com)
    (MIN_TTL=86400))
  (DOMAIN=
    (NAME=hq.acme.com)
    (MIN_TTL=86400)))

See Also: Oracle9i Net Services Reference Guide for names.ora  file
parameters
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Task 3: Start the Oracle Names Server To start the Oracle Names server, use either
Oracle Net Manager or Oracle Names Control utility:

Use Oracle Net Manager... Use Oracle Names Control utility...

1. In the navigator pane, expand Oracle
Names Servers.

2. Select the Oracle Names server.

3. From the list in the right pane, select
Manage Server.

4. Click the Control tab.

5. Click Start.

6. Click Apply.

The following message appears:

Server started successfully.

On Windows NT, a service called
Oracle HOME_NAMENamesonames_
server  is created.

From the operating system command line,
enter:

namesctl

If the following error messages appear,
ignore them.

NNL-00024: warning: no preferred names
servers in SQLNET.ORA
NNL-00018: warning: could not contact
default name server

NAMESCTL> START

The START command loads the Oracle
Names server into memory and tells it to
begin executing. At startup, the Oracle
Names server loads its configuration and
data.

On Windows NT, a service called
Oracle HOME_NAMENamesonames_server
is created
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Checkpoint Files/Replicated Updates
To replicate data among Oracle Names server in checkpoint files, perform these
tasks:

■ Task 1: Create an Oracle Names Server

■ Task 2: Discover Oracle Names Servers

Task 1: Create an Oracle Names Server For each computer where Oracle Names is
installed and where you want an Oracle Names server, create an Oracle Names
server from Oracle Net Manager:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Oracle Names Servers.

3. Click plus (+) from the toolbar, or choose Edit > Create from the menu bar.

The Names Wizard starts.

The wizard guides you through the creation and configuration process,
prompting you for:

■ A unique Oracle Name Server name

■ A listening protocol address for the Oracle Names server

If you select TCP/IP, then Oracle Corporation recommends using the
default and officially registered port of 1575 for the Oracle Names server.

■ A choice to store information in a database or replicate information among
Oracle Names servers

(Click Don’t use a region database.)

■ Verification that this is the first Oracle Names server in the region

If this is not the first Oracle Names server in the region, the wizard then
prompts you to discover the other Oracle Names servers or to specify the
address of another Oracle Names server in the region.

■ Verification that this Oracle Names server is in the root administrative
region

If you specify that this Oracle Names server is in the root administrative region,
configuration completes.

If you specify that this Oracle Names server is not in the root administrative
region, it assumes that this Oracle Names server is in a delegated
administrative region. The wizard then prompts you for the local

See Also: "Starting Oracle Net Manager" on page 5-3
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administrative region’s domain name and the address of an Oracle Names
server in the root administrative region before completing.

When the wizard completes, the following message appears:

A Names Server, onames_server, has been created with
default settings. Use the Configure Server section to
modify the default configuration.

4. Choose File > Save Network Configuration.

5. Repeat Steps 2 through 4 to create additional Oracle Names servers in a region.
Oracle Net Manager does not support creation of multiple Oracle Names
servers on one computer.

Oracle Net Manager creates a names.ora  file with the following settings:

■ Oracle Names server name (NAMES.SERVER_NAME)

■ Oracle Names server listening protocol address (NAMES.ADDRESSES)

■ Root administrative region information (NAMES.DOMAIN_HINTS)

■ Domains in this administrative region (NAMES.DOMAINS)

The names.ora  file is created in the $ORACLE_HOME/network/admin  directory
on UNIX operating systems and the ORACLE_HOME\network\admin  directory on
Windows NT.
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A names.ora  file follows with annotations of content:

#Oracle Names server name. The name should include the name of the domain
this Oracle Names server is in.
NAMES.SERVER_NAME=namesvr2.us.acme.com

NAMES.ADDRESSES=
 [(ADDRESS_LIST=]
  (ADDRESS=(PROTOCOL=tcp)(HOST=namesrv2-server)(PORT=1575))
  [(ADDRESS=...))]
 [)]

#If an Oracle Names server is in a delegated administrative region, identify
the address of an Oracle Names server in the root administrative region.
NAMES.DOMAIN_HINTS=
  (HINT_DESC=
   (HINT_LIST=
     (HINT=
      (NAME=namesrv1)
      (ADDRESS=(PROTOCOL=tcp)(HOST=namesrv1-svr)(PORT=1575))

# Specify the domain controlled by this region and the time to live (TTL).
If this is the root administrative region, you must have NAME= (null) to
identify the root domain properly.
NAMES.DOMAINS=
  (DOMAIN=
    (NAME=us.acme.com)
    (MIN_TTL=86400))

See Also: Oracle9i Net Services Reference Guide for names.ora file
parameters
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Administering Multiple Domains
If you want the region to administer more than one domain, specify the additional
domains in the NAMES.DOMAINS parameter with Oracle Net Manager:

1. In the navigator pane, expand Oracle Names Servers.

2. Select the Oracle Names server.

3. From the list in the right pane, select Configure Server.

4. Click the Domains tab.

5. Enter the domain name in the Domain Name field and time-to-live
information, and then click Add.

6. Repeat Step 5 for each additional domain.

7. Choose File > Save Network Configuration.

In the following example, NAMES.DOMAINS contains a listing for the root (value of
null), com, acme.com , and hq.acme.com  domains. all the domain precedent to
hq.acme.com  must be defined in order to define hq.acme.com .

NAMES.DOMAINS=
 (DOMAIN_LIST=
  (DOMAIN=
    (NAME=)
    (MIN_TTL=86400))
  (DOMAIN=
    (NAME=com)
    (MIN_TTL=86400))
  (DOMAIN=
    (NAME=acme.com)
    (MIN_TTL=86400))
  (DOMAIN=
    (NAME=hq.acme.com)
    (MIN_TTL=86400)))



Configuring the Oracle Names Method

Configuring Naming Methods 9-37

Task 2: Discover Oracle Names Servers After all the Oracle Names servers are created,
have each Oracle Names server, except the first one in the region, discover the other
Oracle Names servers in a region.

To discover other Oracle Names servers, use either Oracle Net Manager or Oracle
Names Control utility:

Use Oracle Net Manager... Use Oracle Names Control utility...

1. Start the first Oracle Names server in the region:

a. In the navigator pane, expand Oracle Names
Servers.

b. Select the Oracle Names server.

c. From the list in the right pane, select Manage
Server.

d. Click the Control tab.

e. Click Server Operations, and then click Start.

f. Click Apply to start the Oracle Names server.
The following message appears:

Server started successfully.

2. From the second Oracle Names server, discover the
first Oracle Names server. Choose Command >
Discover Oracle Names Servers. The following
message appears:

Discovered Oracle Names Server in the
region. Please exit the tool and start
again.

The Discover command produces an .sdns.ora
file in $ORACLE_HOME/network/names on UNIX
operating systems or a sdns.ora  file in ORACLE_
HOME\network\names  on Windows. This file
contains the names and addresses of the Oracle
Names servers.

If an Oracle Names server does not respond, a
dialog prompts you for another Oracle Names
server address. If you know the network address
of a particular Oracle Names server, enter it.

3. Start the second Oracle Names server, following
Step 1.

4. For each Oracle Names server added to the region,
repeat Steps 2-3.

1. Start the first Oracle Names server in the region:

namesctl
NAMESCTL> START

2. From the second Oracle Names server, discover
the first Oracle Names server.

namesctl
NAMESCTL> REORDER_NS

The REORDER_NS command produces an
.sdns.ora  file in $ORACLE_
HOME/network/names  on UNIX operating
systems or a sdns.ora  file in ORACLE_
HOME\network\names  on Windows. This file
contains the name and address of the first Oracle
Names server.

If an Oracle Names server cannot be found, and
you know the network address of a particular
Oracle Names server, enter the address at the
prompt. For example:

NAMESCTL> REORDER_NS
(ADDRESS=(PROTOCOL=tcp)(HOST=mail-server)(
PORT=1575))

3. Start the second Oracle Names server in the
region:

NAMESCTL> START

4. Connect to the first Oracle Names server in the
region, and query for the second Oracle Names
server to make sure it has registered itself.

NAMESCTL> QUERYonames_server

5. For each Oracle Names server added to the
region, repeat Steps 2-4.

See Also: "About Discovery" on page 3-37
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Task 4: Configure Clients and Database Servers To Use Oracle Names Servers
To configure client and database server computers to use Oracle Names servers:

1. Create a list of Oracle Names servers to contact, using one of the following
methods:

■ Create a static list of preferred Oracle Names server in the sqlnet.ora
file, as described in "Configuring Preferred Oracle Names Servers" on
page 11-11.

■ Discover Oracle Names servers by dynamically creating an .sdns.ora file
in $ORACLE_HOME\network\names  on UNIX operating systems, and
sdns.ora  file in ORACLE_HOME\network\names  on Windows operating
systems. This file contains the order of names and addresses of the Oracle
Names server(s) to contact. Client computers read this file to find the
addresses of Oracle Names servers to contact.

Preferred Oracle Names servers take precedence over the Oracle Names servers
configured in the .sdns.ora  or sdns.ora  file.

See Also: "About Discovery" on page 3-37 for a description of
discovery
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To create an .sdns.ora  file or an sdns.ora  file, use either Oracle Net
Manager or Oracle Names Control utility:

Use Oracle Net Manager... Use Oracle Names Control utility...

1. Start Oracle Net Manager.

See Also: "Starting Oracle Net
Manager" on page 5-3

2. Choose Command > Discover
Oracle Names Servers.

The following message appears:

Discovered Oracle Names Server
in the region. Please exit the
tool and start again.

The Discover command produces an
.sdns.ora  file in $ORACLE_
HOME/network/names  on UNIX
operating systems or a sdns.ora
file in ORACLE_
HOME\network\names  on
Windows. This file contains the
names and addresses of the Oracle
Names server(s). This file is read to
find the addresses of Oracle Names
servers.

If an Oracle Names server does not
respond, a dialog prompts you for
another Oracle Names server
address. If you know the network
address of a particular Oracle Names
server, enter it.

Discover the other Oracle Names servers:

namesctl
NAMESCTL> REORDER_NS

The REORDER_NS command produces an
.sdns.ora  file in $ORACLE_
HOME/network/names  on UNIX
operating systems or a sdns.ora  file in
ORACLE_HOME\network\names  on
Windows. This file contains the names and
addresses of the Oracle Names server(s).
This file is read to find the addresses of
Oracle Names servers.

If an Oracle Names server cannot be found,
and you know the network address of a
particular Oracle Names server, enter the
address at the prompt. For example:

NAMESCTL> REORDER_NS
(ADDRESS=(PROTOCOL=tcp)(HOST=mail-ser
ver)(PORT=1575))
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2. If you want Oracle Names to be the first method to reconcile net service names,
set the NAMES.DIRECTORY_PATH parameter in the sqlnet.ora  file in the
following manner:

a. In the navigator pane, expand Local > Profile.

b. From the list in the right pane, select Naming.

c. Click the Methods tab.

d. From the Available Methods list, select ONAMES, and then click the
right-arrow.

e. From the Selected Methods list, select ONAMES, and then use the
Promote button to move the selection to the top of the list.

f. Choose File > Save Network Configuration.

The sqlnet.ora  file should contain an entry that lists onames first in the
NAMES.DIRECTORY_PATH parameter:

NAMES.DIRECTORY_PATH=(onames, tnsnames, hostname)



Configuring the Oracle Names Method

Configuring Naming Methods 9-41

3. You may configure additional features for clients that use Oracle Names.
Table 9–3 describes the client sqlnet.ora  file settings for Oracle Names.

Table 9–3 Client Settings In sqlnet.ora for Oracle Names

Oracle Net Manager
Field

sqlnet.ora Parameter Description

Default Domain NAMES.DEFAULT_DOMAIN Indicates the domain name space from which the
client most often requests an Oracle Names server.
When set, this name is automatically appended to
any unqualified name in an Oracle Names request.
Oracle Net sets the default domain to NULL by
default.

Maximum Wait Each
Attempt

NAMES.INITIAL_RETRY_
TIMEOUT

Specifies how long a client waits for a response from
an Oracle Names server before reiterating the request
to another Oracle Names server. Oracle Net waits for
15 seconds by default.

Attempts Per Names
Server

NAMES.REQUEST_RETRIES Specifies the number of times a client attempts to
iterate through the list of Oracle Names servers
before allowing the operation to fail. Oracle Net
attempts to iterate through the list of Oracle Names
servers once before allowing the operation to fail by
default.

Maximum Open
Connections

NAMES.MAX_OPEN_
CONNECTIONS

Specifies how many connections an Oracle Names
client may have open at one time. Oracle Net enables
a client to have 10 connections open at any one time
by default. This default value should be sufficient for
almost all situations.

Initial Preallocated
Requests

NAMES.MESSAGE_POOL_
START_SIZE

Enables you to preallocate an initial number of
messages in a client’s message pool. These messages
may be used for future requests to Oracle Names
servers. Oracle Net allocates 10 messages in the pool
by default. This default value should be sufficient for
almost all situations.
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To add or configure these features:

a. In the navigator pane, expand Local > Profile.

b. From the list in the right pane, select Naming.

c. Click the Oracle Names tab.

d. Enter data for the options indicated in the table on the previous page.

e. Choose File > Save Network Configuration.

Task 5: (Optional) Configure Client Caches
To avoid clients sending requests to Oracle Names server for name lookups, you
can create a client cache process local to the client. A client cache:

■ Optimizes response time for clients by putting their most frequently referenced
name and address definitions closer to them

■ Reduces the request load on existing Oracle Names servers

The most optimal environment for the client cache is a large multiuser computer
where the users are running a particular Oracle client application. Clients on a
single-user computer with wide-ranging interests in the databases will also derive
some benefit from a cache.

A client cache involves running a local Oracle Names cache process on the client.
The client cache has no authoritative data but uses the discovery list file
(.sdns.ora  or sdns.ora ) to find Oracle Names server in the local region.
Requests from clients are forwarded to the Oracle Names server, and the results are
cached by the cache process so that subsequent requests for that object can be
answered directly by the cache process

In a sense, the client cache is a client version of the Oracle Names server. The client
cache is distinguished from an Oracle Names server in the following ways:

■ It is not authoritative for any administrative region

■ It uses a protocol address that is local to the computer. By default this address
is(ADDRESS=(PROTOCOL=ipc)(KEY=onames)) .

■ Its parameter are configured in the sqlnet.ora  file rather than the
names.ora  file

■ Different executable named onrsd  that is smaller in size and functionality
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Creating a Client Cache
To create and start a client cache:

1. Ensure discovery of Oracle Names servers has been performed, as described in
"Task 4: Configure Clients and Database Servers To Use Oracle Names Servers"
on page 9-38. The information gathered during discovery is used for the client’s
cache.

2. (Optional) Configure additional parameters in the sqlnet.ora  file.

The client cache does not require anything beyond what is usually present in
sqlnet.ora  file or the discovery list file (.sdns.ora  or sdns.ora ).
However, many of the parameters from names.ora  file can also be set in
sqlnet.ora  for the client cache.

3. Create and start the client cache on the client.

namesctl
NAMESCTL> START_CLIENT_CACHE

On Windows NT, the client cache may also be started through the Control
Panel:

a. Select Services icon in the Control Panel window.

b. Select the Oracle HOME_NAMEClientCache  service.

c. Click Start.

d. In the Services window, click Close.

The START_CLIENT_CACHE command starts a client cache process. The client
cache process finds a list of the local Oracle Names servers in static list of
preferred Oracle Names server in the sqlnet.ora  file or in the discovery list
file (.sdns.ora  or sdns.ora ) the first time it runs. Afterwards, it relies on its
cache checkpoint file if restarted. Once the client cache has contact with the
local region server(s), it will begin to cache data on all local servers, various
foreign servers, and all the data it has been asked to find.

See Also: Oracle9i Net Services Reference Guide for names.ora file
parameters for more information about names.ora  file parameters
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Administering a Client Cache
Once configuration is complete, administration for a client cache is essentially the
same as it ia for an Oracle Names server, that is, you can use the Oracle Names
Control utility commands to control and administer the client cache.

Starting and Stopping the Client Cache In terms of starting and stopping, the
client cache behaves essentially the same as an Oracle Names server, except that is
usually accessible locally through an IPC protocol address.

Starting the client cache requires the START_CLIENT_CACHE command rather than
the START command.

Stopping the client cache requires specifying the protocol address of the client cache
with the SET SERVER command or the STOP command:

namesctl
NAMESCTL> SET SERVER (ADDRESS=(PROTOCOL=ipc)(KEY=onames))
NAMESCTL> STOP

namesctl
NAMESCTL> STOP (ADDRESS=(PROTOCOL=ipc)(KEY=onames))

On Windows NT, stopping the Oracle HOME_NAMEClientCache  service stops
caching for all Oracle Names servers.

Verifying the Client Cache is Working To verify that the client cache is working,
query an Oracle Names server from the client as follows:

namesctl
NAMESCTL> SET SERVERonames_server

If the client cache process does not find an Oracle Names server, every query it
receives will fail with the following error message:

NNC-00419: authoritative server is unreachable

See Also: Oracle9i Net Services Reference Guide for a complete list
of administrative commands
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The STATUS command shows how many requests the client cache has received,
how many of those were forwarded, and how many items are cached. For example:

namesctl
NAMESCTL> STATUS
     Version banner is "Oracle Names Client Cache for Solaris: Version 9.0...

     Server name:                              ""
     Server has been running for:              2 minutes 39.92 seconds
     Request processing enabled:               yes
     Request forwarding enabled:               yes
     Requests received:                        53
     Requests forwarded:                       2
     Foreign data items cached:                4
  ...

Task 6: Configure the Listener
If you are not using your operating system’s primary protocol, configure the
listener with listening protocol addresses.

See Also: Chapter 12, "Configuring and Administering the
Listener" for listener configuration details
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Task 7: Register Data with the Oracle Names Server
As described in Table 3–7 on page 3-27, an Oracle Names server stores many kinds
of information, including database locations, Oracle Names server locations, net
service names, aliases, and global database links. If you would like to store any of
the following kinds of information, you must register it using either Oracle Net
Manager or the Oracle Names Control utility:

■ Net Service Names

■ Global Database Links and Database Qualifiers

■ Aliases

Registration needs to occur with only one Oracle Names server in an administrative
region. The other Oracle Names servers see the information if data is stored in a
region database, or the information is propagated to other Oracle Names if you
chose not to use a region database.

After registering these kinds of information, you should query them, as described in
"Testing Network Objects with Oracle Net Manager or Oracle Names Control
Utility" on page 16-25.

Net Service Names
Oracle Corporation advises creating a net service name for each service. If a net
service name is not created, a user trying to connect to a database service must pass
the database service name to make a connection. Rather than provide this
information to your end users, create a net service name for the service.
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To create a net service name, use either Oracle Net Manager or Oracle Names
Control utility:

Use Oracle Net Manager... Use Oracle Names Control utility...

1. Start Oracle Net Manager.

See Also: "Starting Oracle Net Manager" on
page 5-3

2. In the navigator pane, expand Oracle Names
Servers.

3. Select an Oracle Names server.

4. From the list in the right pane, select Manage Data.

5. Click the Net Service Names tab.

6. Click Add.

7. Enter the net service name in the Service Name
field.

You can qualify the net service name with the
client’s domain. The net service name is
automatically domain qualified if the sqlnet.ora
file parameter NAMES.DEFAULT_DOMAIN is set.

8. Select the protocol the listener is configured to listen
on.

9. Enter the appropriate protocol information for the
selected protocol in the fields provided.

See Also: Oracle9i Net Services Reference Guide for
protocol parameter settings

Note: Additional addresses can be created by
choosing plus (+) at the bottom of the Address tab.

10. Enter a destination service. If the destination service
is an Oracle9i or Oracle8i database, then enter the
service name in the Service Name field. If
destination service is prior to Oracle8i, then select
Oracle8 Release 8.0 Compatible Identification, and
enter its SID in the SID field.

Note: If you want to configure advanced CONNECT_
DATA options besides the destination service, click
Advanced.

11. Click Execute.

12. Choose File > Save Network Configuration.

From the operating system command prompt, enter:

namesctl
NAMESCTL> REGISTERnet_service_name  -d
(description=[(address_list=](address=
...)(connect_data=(service_name|sid=...)))[)]

For example, to register a net service name of sales
with a default TCP/IP protocol address, enter the
following:

NAMESCTL> REGISTER sales -d
(DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=sale
s-server)(PORT=1521))(CONNECT_DATA=(SERVICE_
NAME=sales.us.acme.com)))

You can qualify the net service name with the client’s
domain. The net service name is automatically
domain qualified if the sqlnet.ora  file parameter
NAMES.DEFAULT_DOMAIN is set.

Note: The connect descriptor cannot contain any
spaces.
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If you have been using local naming as your configuration method and want to
migrate to an Oracle Names configuration, you can upload the net service name
information used in the tnsnames.ora  file to an Oracle Names server. To load
information from a local naming configuration file into an Oracle Names server, use
either Oracle Net Manager or Oracle Names Control utility:

See Also:

■ "About Connect Descriptors" on page 9-2 for more information
about connect descriptors

■ "Configuring a Default Domain for Clients" on page 11-3 for
information about the NAMES.DEFAULT_DOMAIN parameter

■ Oracle9i Net Services Reference Guide for more information about
protocol syntax needed for address information

Use Oracle Net Manager... Use Oracle Names Control utility...

1. Start Oracle Net Manager.

See Also: "Starting Oracle Net Manager"
on page 5-3

2. In the navigator pane, expand Oracle
Names Servers.

3. Select an Oracle Names server.

4. From the list in the right pane, select
Manage Data.

5. Click the Net Service Names tab.

6. Click Load.

7. Enter the path for your current master
local naming configuration file in the File
field.

8. Click Execute.

9. Choose File > Save Network
Configuration.

From the operating system command line,
enter:

namesctl
NAMESCTL> LOAD_TNSNAMES tnsnames.ora
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Global Database Links and Database Qualifiers
A global database link that is the same as the global database name is
automatically registered with an Oracle Names server. Any client in the network
can use a global database link to access an object in a database. For example, if the
global database name is sales.us.acme.com , a global database link of
sales.us.acme.com  is created and registered with an Oracle Names server. A
client can then use sales.us.acme.com  to perform a SELECT statement on a
table, for example:

SQL> SELECT * FROM emp@sales.us.acme.com

Unless you want to specify username and password credentials, no additional
configuration is required to use the default global database link. To define a
username and password for the default global database link, or create a new global
database link:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Oracle Names Servers.

3. Select an Oracle Names server.

4. From the list in the right pane, select Manage Data.

5. Click the Links tab.

6. Select Add.

7. Enter the global database link in the DB Link Name field.

8. Enter valid username and password credentials for the database in the User
and Password fields.

9. Choose Execute.

10. If you want to use a link qualifier, see "Adding Link Qualifiers" on page 9-50.

11. Choose File > Save Network Configuration.

See Also: Oracle9i Database Administrator’s Guide for further
information about how database links are used

See Also: "Starting Oracle Net Manager" on page 5-3

Note: If the GLOBAL_NAMES initialization parameter has been set
to true  in the initialization parameter file, the name entered must
be the same as the global database name.
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Adding Link Qualifiers
While one global database link for each database is recommended, there is no limit
on the number of link qualifiers that may be added. Link qualifiers are appended
to global database links to a provide alternate settings for the database username
and password credentials. For example, a link qualifier of fieldrep  can be
appended to sales.us.acme.com . A connection to a remote database with the
global database link and link qualifier would be:

SQL> SELECT * FROM emp@sales.us.acme.com@fieldrep

Link qualifiers are primarily for older Oracle database environments where
multiple database links are used to get to the different schemas in the database.
Rather than use multiple database links, multiple link qualifiers can be created for a
database link. Multiple link qualifiers enable the global database links to comply
with the GLOBAL_NAMES=true setting in the initialization parameter file. This
setting checks to ensure that the global database link (between the @ signs) is the
same as the global database name.

To create a global link qualifier for a global database link, use Oracle Net Manager.
The Oracle Names Control utility does not support creation of link qualifiers.

1. Follows Steps 1 through 8 in the procedure in "Global Database Links and
Database Qualifiers" on page 9-49.

2. Click DB Qualifiers.

3. Click Create Qualifier.

The Database Qualifier dialog box appears:

4. Enter a name for the link qualifier, valid username and password credentials,
and then click OK.
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The link qualifier is added to the DB Qualifiers list box:

5. Repeat Steps 3 and 4 for each link qualifier you want to add.

6. Click Execute.

7. Choose File > Save Network Configuration.
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To verify that a global database link and link qualifier is working correctly, perform
a SELECT statement on a table the user is authorized for:

SQL> SELECT * FROM table @db_link ;
SQL> SELECT * FROM table @db_link @link_qualifier ;

For example:

SQL> SELECT * FROM EMP@sales.us.acme.com;
SQL> SELECT * FROM EMP@sales.us.acme.com@fieldrep;

Aliases
You can create aliases for almost any type of object stored in an Oracle Names
server. An alias is an alternative name for an object. It stores the name of the object
it is referencing. When a client requests a lookup of an alias, Oracle Names
completes the lookup as if it was actually the entry it is the referenced. For example,
an alias of db1alias  can be created for an object named db1 . When db1alias  is
used to connect to a database service, as in CONNECT scott/tiger@db1alias , it
will actually resolve to and use the connect descriptor information for db1 .

There are two main uses of aliases:

■ Use an alias as a way for clients to refer to a network object by another name.

■ Use an alias in one domain for an object in another domain. This enables that
database service or net service name to be defined once in Oracle Names, but
used out of other domains

To create an alias, use Oracle Net Manager:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Oracle Names Servers.

3. Select an Oracle Names server.

4. From the list in the right pane, select Manage Data.

5. Click the Aliases tab.

6. Select Add.

7. Enter the alias in the Alias field and the actual name of the object in the
Canonical Name field.

See Also: Oracle9i Database Administrator’s Guide

See Also: "Starting Oracle Net Manager" on page 5-3
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8. Click Execute.

9. Choose File > Save Network Configuration.

Task 8: Delegate Domains to Delegated Administrative Regions
Each Oracle Names server is responsible for being able to forward a client request
to:

■ At least one domain level down the domain hierarchy toward an object’s
authoritative administrative region

■ The root administrative region if the requested object is another branch of the
Oracle Names hierarchy

If delegated administrative regions are configured, the upper-level administrative
region must delegate subdomains to the delegated administrative regions. If
domain delegation is not done, then the Oracle Names servers in the upper-level
administrative region assume authority over all subdomains.
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To delegate a domain, use either Oracle Net Manager or Oracle Names Control utility:

Use Oracle Net Manager... Use Oracle Names Control utility...

1. Start Oracle Net Manager.

See Also: "Starting Oracle Net Manager" on
page 5-3

2. In the navigator pane, expand Oracle Names
Servers.

3. Select an Oracle Names server in the upper-level
region.

4. From the list in the right pane, select Manage
Data.

5. Click the Topology tab.

6. Click Delegate Domain.

7. Enter the name of the subdomain in the Domain
Name field.

8. Enter the Oracle Names server that serves the
domain in the Names Server Name field, and its
protocol address in the Names Server Address
field.

See Also: Oracle9i Net Services Reference Guide for
more information about protocol syntax needed
for address information

9. Click Execute.

10. Choose File > Save Network Configuration.

Create and register an alias with the Oracle Names
server:

namesctl
NAMESCTL> DELEGATE_DOMAINdomain onames_server
(ADDRESS=...)

Note: The protocol address cannot contain any
spaces.

See Also: Oracle9i Net Services Reference Guide for
more information about protocol syntax needed for
address information

For example, to delegate domain us.acme.com
serviced by namesrv3.us.acme.com , enter the
following:

NAMESCTL> DELEGATE_DOMAIN us.acme.com
namesrv3.us.acme.com
(ADDRESS=(PROTOCOL=tcp)(HOST=namesrv3-server)(
PORT=1575))



Configuring the Oracle Names Method

Configuring Naming Methods 9-55

Task 9: Specify Domain Hints to Forward Requests to Remote Oracle Names Servers
A domain hint contains the name of the domain and at least one address of an
Oracle Names server in that domain. This enables an Oracle Names server to
forward the client requests to a specific address, reducing network traffic.

It is necessary for all Oracle Names servers in delegated administrative regions to
be configured with a domain hint to an Oracle Names server in the root
administration region. This enables an Oracle Names server to forward requests
anywhere outside their own subtrees, because all name lookups can be found by
forwarding through the root. If a domain hint to the root administrative region is
not specified, then the local Oracle Names server will be unable to forward requests
to other regions.

If you want to forward requests directly to other administrative regions, configure
additional domain hints. Without additional hints, initial requests to remote regions
will route through the root Oracle Names server in the region. Domain data will be
cached for all regions in the forward chain by all Oracle Names servers in the
forward chain. Subsequent requests may then be sent directly to the appropriate
region.

To configure a domain hint, manually configure the names.ora  file with the
NAMES.DOMAIN_HINTS parameter. The syntax for this parameter follows:

NAMES.DOMAIN_HINTS=
 (HINT_DESC=
   (HINT_LIST=
    (HINT=(NAME= onames_server )(ADDRESS=...)))
   (DOMAIN_LIST=
    (DOMAIN= domain )))

The HINT_LIST  specifies the list of Oracle Names servers to forward the initial set
of queries for the domains listed in the DOMAIN_LIST. A hint contains the name
and address of an Oracle Names server in the remote administrative region. The
Oracle Names server caches the results of those queries in its memory. If the queries
fail, the Oracle Names servers listed in the HINT_LIST  will not be cached and the
local Oracle Names server continues to run without information about the root
administrative region. The HINT_LIST  should include enough Oracle Names
servers to guarantee that the local Oracle Names server can resolve the query for
the root or other Oracle Names servers.

Note: Specify the root domain with a dot (.) or a null value.
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Example: Domain Hint for the Root Administrative Region
In the following example, NAMES.DOMAIN_HINTS contains a domain hint for
Oracle Names server rootsvr.com that is located in the root domain of the remote
administrative region. The DOMAIN parameter is left null, meaning that the hint is
for the root domain.

NAMES.DOMAIN_HINTS=
 (HINT_DESC=
   (HINT_LIST=
    (HINT=
      (NAME=rootsvr.com)
      (ADDRESS=(PROTOCOL=tcp)(HOST=root-server)(PORT=1575))))
   (DOMAIN_LIST=
    (DOMAIN=)))

When the local Oracle Names server is started:

1. It reads the NAMES.DOMAIN_HINTS parameter. For each domain listed in the
DOMAIN_LIST, it calls the Oracle Name server listed in the HINT_LIST  and
queries for all Oracle Names servers in the domain.

2. Based on the time-to-live (TTL) of the answer, the local Oracle Names server
sets up queries that are automatically issued before the remote Oracle Names
server data expires.
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Example: Domain Hint for Multiple Oracle Names Servers
The following example shows a hint to query two domains, the root domain and
the us.acme.com  domain, for Oracle Names servers rootsvr.com  and
namesvr.us.acme.com .

NAMES.DOMAIN_HINTS=
 (HINT_DESC=
   (HINT_LIST=
    (HINT=
     (NAME=rootsvr.com)
     (ADDRESS=(PROTOCOL=tcp)(HOST=root-server)(PORT=1575)))
    (HINT=
     (NAME=namesrv.us.acme.com)
     (ADDRESS=(PROTOCOL=tcp)(HOST=hr-server)(PORT=1575))))
   (DOMAIN_LIST=
    (DOMAIN=)
    (DOMAIN=us.acme.com)))

In this query, the local Oracle Names server:

1. Sends a query for the root administrative region, using the addresses given in
the HINT.

2. Sends a query for the us.acme.com  domain, using the same addresses from
the HINT descriptor.

Task 10: Connect to the Database
Clients can connect to the database using the following syntax:

CONNECTusername / password @net_service_name
CONNECTusername / password @database_service
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Removing an Oracle Names Server
To remove an Oracle Names server:

1. Undefine an Oracle Names server and its authoritative domain with the Oracle
Names Control utility’s UNREGISTER_NS command. From the command line,
enter:

namesctl
NAMESCTL> UNREGISTER_NS {onames_server }{ domain }

For example, to unregister a Oracle Names server named namesrv1  in domain
us.acme.com , enter the following:

NAMESCTL> UNREGISTER_NS  namesrv1.us.acme.com us.acme.com

2. If it is running, stop the Oracle Names server. Use either Oracle Net Manager or
the Oracle Names Control utility.

3. Remove the names.ora  file from the $ORACLE_HOME/network/admin
directory on UNIX or the ORACLE_HOME\network\admin  directory on
Windows NT.

4. Remove the ckp*.ora  file. By default the checkpoint files are stored in the
$ORACLE_HOME/network/names  directory on UNIX and the ORACLE_
HOME\network\names  directory on Windows NT.

5. Reconfigure clients and the database server with the correct list of Oracle
Names servers to contact, as well as the preferred naming method.

Use Oracle Net Manager... Use Oracle Names Control utility...

1. Start Oracle Net Manager.

See Also: "Starting Oracle Net Manager"
on page 5-3

2. In the navigator pane, expand Oracle
Names Servers.

3. Select the Oracle Names server.

4. From the list in the right pane, select
Manage Server.

5. Click the Control tab.

6. Click Stop, and then click Apply to stop
the Oracle Names server.

From the command line, enter:

namesctl
NAMESCTL> STOP
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6. Restart Oracle Net Manager.

See Also:

■ "Task 4: Configure Clients and Database Servers To Use Oracle
Names Servers" on page 9-38 for instructions on discovering
Oracle Names server and selecting the preferred naming
method

■ "Configuring Preferred Oracle Names Servers" on page 11-11
for instructions on working with the NAMES.REFERRED_
SERVERS parameter in the sqlnet.ora  file

See Also: "Starting Oracle Net Manager" on page 5-3
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Configuring the Host Naming Method
In environments where simple connectivity is desired, host naming can eliminate
the need for service name lookup in the tnsnames.ora files. However, for large or
complex environments where advanced features such as connection pooling,
external procedure calls, or Heterogeneous Services, which require additional
connect information, are desired, host naming is not suitable. In these cases, another
naming method is recommended.

The host naming method is available for TCP/IP network environments only. With
host naming, clients use the server’s global database name in their connect string to
connect to the database. The global database name is equivalent to a host name or
an alias in an existing name resolution service.

Clients can connect to a server using the alias if:

■ You are connecting to an Oracle database service with Oracle Net Services
software installed

■ Your client and server are connecting over a TCP/IP protocol

■ All names are resolved through an IP address translation mechanism such as
Domain Name System (DNS), or a centrally maintained TCP/IP hosts  file

■ No advanced features like Oracle Connection Manager or security are
requested or required
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To configure the host naming method, perform these tasks:

Task 1: Configure the Listener with the Global Database Name

Task 2: Configure HOSTNAME as the First Naming Method

Task 3: Set Up Host Name Resolution Environment

Task 4: Connect to the Database

Task 1: Configure the Listener with the Global Database Name
The global database name must be registered with the listener. How this
registration takes place depends upon the release of the database.

Oracle9i or Oracle8i
If the database can find the listener, information about the database is automatically
registered with the listener, including the global database name. The listener is
found if:

■ The default listener named LISTENER running on TCP/IP on port 1521 is
running

■ The LOCAL_LISTENER parameter is set in the initialization file

If the database cannot find the listener, the listener.ora  file must be configured
with the GLOBAL_DBNAME parameter, as described in "Oracle8 Release 8.0 or
Previous".

Oracle8 Release 8.0 or Previous
If the database is an Oracle8 release 8.0 database or Oracle7 database, database
information is registered with the listener through the listener.ora  file. For
these database, statically configure the SID_LIST_ listener_name  section to
include the GLOBAL_DBNAME parameter, as shown next:

SID_LIST_listener=
(SID_LIST=
 (SID_DESC=
  (GLOBAL_DBNAME=sales.us.acme.com)
  (SID_NAMe=db1)
  (ORACLE_HOME=/u01/app/oracle/8.0.5))

See Also: "Configuring Static Service Information" on page 12-10



Configuring the Host Naming Method

9-62 Oracle9i Net Services Administrator’s Guide

Task 2: Configure HOSTNAME as the First Naming Method
Configure host naming as the first method specified in the NAMES.DIRECTORY_
PATH parameter in the sqlnet.ora  file. This parameter specifies the order of
naming methods Oracle Net can use to resolve connect identifiers to connect
descriptors.

To specify host naming as the first naming method:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Local > Profile.

3. From the list in the right pane, select Naming.

4. Click the Methods tab.

5. From the Available Methods list, select HOSTNAME, and then click the
right-arrow button.

6. From the Selected Methods list, select HOSTNAME, and then use the Promote
button to move the selection to the top of the list.

7. Choose File > Save Network Configuration.

The sqlnet.ora  file updates with the NAMES.DIRECTORY_PATH parameter,
listing hostname  first:

NAMES.DIRECTORY_PATH=(hostname, tnsnames)

Task 3: Set Up Host Name Resolution Environment
The global database name must be resolved through an IP address translation
mechanism, such as DNS, NIS, or a centrally-maintained TCP/IP host file,
/etc/hosts .

For example, if a global database name of sales.us.acme.com  for a database
exists on a computer named sales-server , the entry in the /etc/hosts  file
would look like the following:

#IP address of server     host name       alias
144.25.219.146            sales-server    sales.us.acme.com

Note that the domain section of the global database name must match the network
domain.

See Also: "Starting Oracle Net Manager" on page 5-3
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Task 4: Connect to the Database
Clients can connect to the database using the alias. Using the example in "Task 3: Set
Up Host Name Resolution Environment", the client can use sales.us.acme.com
in the connect string:

CONNECTusername / password @sales.us.acme.com

If the client and server are in the same domain of us.acme.com , the client needs to
enter only sales  in the connect string.
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Configuring External Naming Methods
External naming refers to the method of resolving a net service name, stored in a
non-Oracle naming service, to a network address. External naming services include:

■ Network Information Service (NIS)

■ Distributed Computing Environment (DCE) Cell Directory Service (CDS)

Network Information Service (NIS)
Organizations and corporations already using NIS as part of their systems
infrastructure have the option to store net service names and addresses in NIS,
using NIS external naming.

When a user gives a command such as

sqlplus scott/tiger@payroll

(where payroll is an Oracle service) NIS external naming on the node running the
client program (or database server acting as a client program) contacts an NIS
server located somewhere in the network, and passes the net service name to the
NIS server. The NIS server resolves the net service name into a Oracle Net address
and returns this address to the client program (or server acting as a client program).
The client program then uses this address to connect to the Oracle database.

A computer that acts as an NIS server runs a program called ypserv , which
handles name requests. The ypserv  program stores different types of data in
special files called maps. For example, passwords are stored in a map called
passwd.byname . Oracle database service names are stored in a map called
tnsnames .

When a user issues a connect string, NIS external naming uses an RPC call to
contact the ypserv  program and passes the Oracle net service name payroll  and
the name of the map—tnsnames.  The ypserv  program looks in the tnsnames
map for the name payroll  and its corresponding value, which is the address for
the net service name. The address is returned to the client, and the client program
(or server acting as a client program) uses this address to contact the database
server.
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Task 1: Configure NIS Servers to Support the NIS External Naming
Before configuring servers to support the NIS external naming, make sure that NIS
is configured and running on the NIS servers that need to resolve Oracle database
net service names. Consult your NIS documentation for specifics.

Adding the "tnsnames" Map to the Existing Set of NIS Maps To add the tnsnames  map to
the existing set of NIS maps:

1. Create a tnsnames.ora  file, as specified in "Configuring the Local Naming
Method" on page 9-5.

2. Convert the contents of the tnsnames.ora  file to a tnsnames  map using the
tns2nis  program.

For example, run tns2nis  on the command line with one argument:

tns2nis tnsnames.ora

The tns2nis  program reads the tnsnames.ora  file from the current
directory. (If tnsnames.ora  file is not located in the current directory, you can
use a full path name to specify its location—for example,
/etc/tnsnames.ora  or $ORACLE_
HOME/network/admin/tnsnames.ora ).

The "tnsnames" map is then written into the current working directory.

3. Copy tnsnames  to the NIS server, if it is not already there.

Note: Keep a copy of the tnsnames.ora  file, preferably in
$ORACLE_HOME/network/admin  directory. You may need to use
this file again later to load net service names into the NIS map.

Note: The tns2nis  program is supplied with NIS External
Naming on the Oracle Universal Installer tape or disk.
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4. Install the tnsnames  map using makedbm, which is an NIS program.

The makedbm program converts the tnsnames  map into two files that the NIS
server can read. The location of these files is operating system specific.

For example, to generate and install a tnsnames map on Sun SPARC Solaris, as
root enter the following at the command line

# makedbm tnsnames /var/yp/’domainname’/tnsnames

Verifying that the "tnsnames" Map Has Been Properly Installed You can test the NIS server
to see if the map has been installed properly by typing a command with the format:

ypmatch net_service_name tnsnames

For example, you might enter:

ypmatch payroll.com tnsnames

This returns the length of the address (in characters) followed by the address; for
example:

99 (description=(address=(protocol=tcp)
 (host=garlic)(port=1999)))
 (connect_data=(service_name=dirprod)))

Note: This step should be performed by the person in charge of
NIS administration.

See Also: Oracle operating system-specific documentation for
details
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Task 2: Configure Clients
To configure clients, configure NIS as the first method specified in the
NAMES.DIRECTORY_PATH parameter in the sqlnet.ora  file. This parameter
specifies the order of naming methods Oracle Net can use to resolve connect
identifiers to connect descriptors.

1. Start Oracle Net Manager.

2. In the navigator pane, expand Local > Profile.

3. From the list in the right pane, select Naming.

4. Click the Methods tab.

5. From the Available Methods list, select NIS, and then click the right-arrow
button.

6. In the Selected Methods list, select NIS, and then use the Promote button to
move the selection to the top of the list.

7. Choose File > Save Network Configuration.

The sqlnet.ora  file updates with the NAMES.DIRECTORY_PATH parameter,
listing nis  first:

NAMES.DIRECTORY_PATH=(nis, hostname, tnsnames)

Distributed Computing Environment (DCE) Cell Directory Service (CDS)

See Also: "Starting Oracle Net Manager" on page 5-3

See Also: Oracle Advanced Security Administrator’s Guide for
instructions about how to configure Cell Directory Services (CDS)
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10
 Exporting Naming Data to a Directory

Server

This chapter explains how to export data stored in a tnsnames.ora  file or an
Oracle Names server to an LDAP-compliant directory server.

This chapter contains these topics:

■ Exporting Net Service Names from a tnsnames.ora File

■ Exporting Network Objects from an Oracle Names Server

See Also: "Directory Server Support" on page 3-4 for an overview
of directory server support of Oracle Net Services
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Exporting Net Service Names from a tnsnames.ora File
If a tnsnames.ora  file already exists, its net service names can be exported to a
directory server. The export is performed for one domain at a time.

The tasks to export data from a tnsnames.ora  file are as follows:

Task 1: Create Structure in Directory Server

Task 2: Create Oracle Contexts

Task 3: Configure Directory Server Usage

Task 4: Export Objects To a Directory Server

Note: These tasks assume that you have a directory server
installed and running.
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Task 1: Create Structure in Directory Server
In the directory server, create the directory information tree (DIT) with the
structure in which you want to import net service names. Create the structure
leading up to the top of the Oracle Context.

For example, if the tnsnames.ora file supports a domain structure acme.com and
you want to replicate this domain in the directory, create domain component entries
of dc=com and dc=acme  in the directory, as depicted in Figure 10–1.

Figure 10–1 acme.com in Directory Server

You can replicate the domain structure you currently use with tnsnames.ora , or
you can develop an entirely different structure. Introducing an entirely different
structure can change the way in which clients enter the net service name in the
connect string. Therefore, Oracle Corporation recommends considering relative and
absolute naming issues prior to changing the structure.

See Also:

■ Directory server vendor documentation for directory entry
configuration instructions

■ "Client Connections Using Directory Naming" on page 3-14

dc=acme

dc=com
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Task 2: Create Oracle Contexts
Create an Oracle Context under each DIT location that you created in Task 1. The
Oracle Context has a relative distinguished name (RDN) of cn=OracleContext .
The Oracle Context stores network object entries, as well as other entries for other
Oracle components. In Figure 10–2, cn=OracleContext  is created under
dc=acme,dc=com .

To create the Oracle Context, you must use Oracle Net Configuration Assistant. to
create a DIT structure that looks similar to the one in Figure 10–2.

Figure 10–2 Oracle Context

Task 3: Configure Directory Server Usage
If not already done as a part of creating the Oracle Contexts, configure the Oracle
home for directory server usage. The Oracle home you configure should be the one
that will perform the export.

See Also:

■ Chapter 3, "Configuration Management Concepts" for further
information about the Oracle Context

■ "Configuring Directory Usage After Installation" on page 8-6
for instructions on creating an Oracle Context

See Also: Chapter 8, "Setting Up Directory Server Usage" for
further information about configuring directory server usage

dc=acme

cn=OracleContext

dc=com
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Task 4: Export Objects To a Directory Server
To export net service names contained in a tnsnames.ora  file to a directory:

1. Start Oracle Net Manager.

2. If the tnsnames.ora  file you want to export is not the one loaded into Oracle
Net Manager, then use File > Open Network Configuration to select the
tnsnames.ora  file to export to the directory.

3. Choose Command > Directory > Export Net Service Names from the menu
bar.

The Directory Server Migration Wizard starts.

4. Click Next.

If net service names with multiple domain were detected in the tnsnames.ora
file, then the Select Domain page appears. Continue to Step 5.

If the net service names are not domain qualified, the Select Net Service Names
page appears. Skip to Step 6.

5. Select the network domain whose net service names you want to export, and
then click Next.

The Select Net Service Names page appears.

6. Select the net service names from the list to export, and then click Next.

The Select Destination Context page appears.

7. In the Select Destination Context page, perform the following:

a. From the Directory Naming Context list, select the directory entry that
contains the Oracle Context. The directory naming context is part of a
directory subtree that contains one or more Oracle Contexts.

b. From the Oracle Context list, select the Oracle Context to which you want
to export the selected net service names.

c. Click Next.

The Directory Server Update page appears with the status of the export
operation.

8. Click Finish to dismiss the Directory Server Migration Wizard.

See Also: "Starting Oracle Net Manager" on page 5-3
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Exporting Network Objects from an Oracle Names Server
Database and alias objects stored in an Oracle Names server can be exported
directly to a directory server or indirectly to an LDAP Data Interchange Format
(LDIF) file, which can then be used to load the directory server. When exporting the
database objects, only the address record (A.SMD) is exported. The address record
contains the connect descriptor information for the database object. Database
objects are exported as net service names. Aliases are exported as net service
aliases.

Data is exported from a specified domain. Any subdomains within the region can

This section contains the following topics:

■ Client Release Restriction

■ Database Server Release Restrictions

■ Exporting Data to a Directory Server

■ Configuring Oracle Names LDAP Proxy Servers

■ Considerations for Dissimilar DIT Structures

■ Considerations for Net Service Aliases

Notes:

■ Net service aliases are not supported using Microsoft Active
Directory.

■ Because database objects are exported as net service names, the
username and password credentials for a global database link
or link qualifier is not exported with the address information.
In the same way you used global database links in Oracle
Names, you can use a net service name from a directory to
access an object in a database. However, the net service name
will behave as a connected user database link.
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Client Release Restriction

Release 8.1.6 or Later Clients
New client installations with directory server usage configuration can use directory
naming entries when the following tasks are completed:

1. Data is exported to a directory server.

2. Directory naming is selected as a naming method.

However, only clients that are upgraded to 9.2 can use net service alias entries.

To export data for newer client configurations, follow the procedure in "Exporting
Data to a Directory Server" on page 10-8.

Release 8.1.6 or Previous Clients
For release 8.1.6 or later clients without directory server usage or pre-release 8.1.6
clients that do not support directory naming, you have two configuration choices.
You can:

■ Continue to use Oracle Names servers

If you continue to use Oracle Names servers, data stored in Oracle Names
servers and directory server must be maintained and synchronized separately.

■ Configure Oracle Names servers as Oracle Names LDAP Proxy servers

Oracle Names LDAP Proxy servers are Oracle Names servers that have been
configured to proxy for directory servers. Upon startup, Oracle Names LDAP
Proxy servers obtain network object information from the directory server. This
provides a single point of definition for all data in the directory server and does
not require that data in both Oracle Names server and directory server be
maintained separately and simultaneously.

See Also:

■ "Global Database Links and Database Qualifiers" on page 9-49
for information about using global database links

■ Oracle9i Database Administrator’s Guide for information about
the supported types of database link users

■ Oracle Advanced Security Administrator’s Guide for information
about configuring database links in a directory
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To export data for older client configurations, follow the procedures in both
"Exporting Data to a Directory Server" on page 10-8 and "Configuring Oracle
Names LDAP Proxy Servers" on page 10-17.

Database Server Release Restrictions
To export global database links to a directory server, ensure that the database is
release 2 (9.2). Otherwise, you must configure Oracle Names LDAP Proxy servers,
as described in "Configuring Oracle Names LDAP Proxy Servers" on page 10-17.

Exporting Data to a Directory Server
The tasks to export data from an Oracle Names server are as follows:

Task 1: Create Structure in Directory Server

Task 2: Create Oracle Contexts

Task 3: Configure Directory Server Usage

Task 4: Obtain List of Objects to Export

Task 5: Export Objects To a Directory Server

Note: These tasks assume that a directory server is installed and
running and the Oracle Names Control utility (namesctl )
executable is release 9.2. You can also use a release 9.1, release 8.1.6
or release 8.1.7 namesctl  executable to perform export tasks.
However, the DUMP_ALIAS command is only available for release
9.2. In addition, instructions for using the DUMP_LDAP command
differ from release 8i and release 9i releases.

If you are using release 8.1, see the Net8 Administrator’s Guide for
that release.
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Task 1: Create Structure in Directory Server
In the directory server, create the DIT with the structure in which you want to
import Oracle Names objects. Create the structure leading up to the top of the
Oracle Context.

For example, if Oracle Names has a domain structure acme.com  and you want to
replicate this domain in the directory, create domain component entries dc=com
and dc=acme  in the directory, as depicted in Figure 10–3.

Figure 10–3 acme.com in Directory Server

You can replicate the domain structure you currently use with Oracle Names, or
you can develop an entirely different structure. Introducing an entirely different
structure will change the way in which clients enter the connect identifier in the
connect string. Therefore, Oracle Corporation recommends that you consider the
relative and absolute naming issues prior to changing the structure.

Important: If you plan to use Oracle Names LDAP Proxy servers
that support multiple administrative regions, Oracle Corporation
recommends mirroring the current Oracle Names domain structure
in the directory DIT structure. Using a different structure may
require modifying the topology defined for the Oracle Names
LDAP Proxy servers. Support for topology modification is not
currently provided. The following constitutes a topology change:

■ Addition or removal of any Oracle Names servers, as well as
modification of an Oracle Names server’s name or protocol
address

■ Modification of domain definitions for an administrative region
or its delegated administrative regions

See Also:

■ Directory server vendor documentation for directory entry
configuration instructions

■ "Client Connections Using Directory Naming" on page 3-14

dc=acme

dc=com
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Task 2: Create Oracle Contexts
Create an Oracle Context with Oracle Net Configuration Assistant under each DIT
location that you created in Task 1. The Oracle Context has a RDN of
cn=OracleContext . Oracle Contexts may be required for the root domain and
each of its delegated domains. If you are using Oracle Internet Directory, you can
use the Oracle Context created at the root of the DIT structure. This root Oracle
Context has a complete DN of dn:cn=OracleContext . For most deployments,
you will need to create additional Oracle Contexts.

In Figure 10–4, cn=OracleContext  is created under dc=acme,dc=com .

Figure 10–4 Oracle Context

Task 3: Configure Directory Server Usage
If not already done as a part of creating the Oracle Contexts, configure the Oracle
home for directory server usage. The Oracle home you configure should be the one
that will perform the export.

See Also:

■ Chapter 3, "Configuration Management Concepts" for further
information about the Oracle Context

■ "Configuring Directory Usage After Installation" on page 8-6
for instructions on creating an Oracle Context

See Also: Chapter 8, "Setting Up Directory Server Usage" for
further information about configuring directory server usage

dc=acme

cn=OracleContext

dc=com
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Task 4: Obtain List of Objects to Export
Determine the Oracle Names domain structure and the objects within that structure.
The Oracle Names Control utility offers commands described in Table 10–1 to help
you with this task.

Table 10–1 Oracle Names Control Utility Structural Commands

Command Description

LIST_DOMAINS Lists all of the authoritative domains

See Also: LIST_DOMAINS command in Oracle9i Net Services
Reference Guide

LIST_DELEGATED Lists all of the delegated domains

See Also: LIST_DELEGATE command in Oracle9i Net Services
Reference Guide

LIST_OBJECTS Lists all of the authoritative network objects

See Also: LIST_OBJECTS command in Oracle9i Net Services
Reference Guide
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Task 5: Export Objects To a Directory Server
The Oracle Names Control utility enables you to export network objects from a
domain into the directory server using the DUMP_LDAP and DUMP_ALIAS
commands.

Use the DUMP_LDAP command to export names and addresses of database objects.
Use the DUMP_ALIAS command to export net service aliases. You can export these
objects directly to a directory server or indirectly to an LDIF file, which can then be
used to the load the exported objects to the directory server.

To run the DUMP_LDAP and DUMP_ALIAS commands.

1. Run the DUMP_LDAP command from an authoritative Oracle Name server for
the domain.

The syntax to export data directly to a directory server is as follows:

namesctl
NAMESCTL> DUMP_LDAP [source ] [ destination ] [ options ] {-h host }
{-p port } {-D user_dn } {-w password }

The syntax to export data to a LDIF file is as follows:

namesctl
NAMESCTL> DUMP_LDAP [source ] [ destination ] [ options ] {-f [ filename ]}

2. Run the DUMP_ALIAS command:

The syntax to export data directly to a directory server is as follows:

namesctl
NAMESCTL> DUMP_ALIAS [source ] [ destination ] [ options ] {-h host }
{-p port } {-D user_dn } {-w password }

The syntax to export data to a LDIF file is as follows:

namesctl
NAMESCTL> DUMP_ALIAS [source ] [ destination ] [ options ] {-f [ filename ]}

See Also: DUMP_LDAP and DUMP_ALIAS commands in Oracle9i
Net Services Reference Guide for a description of the arguments

Note: The generated LDIF file can later be loaded into the
directory server with the ldapadd  command or the ldapmodify
command with the add option. See your directory server’s vendor
documentation for syntax usage.
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If the directory server’s DIT structure has been designed to match the current
Oracle Names structure, review the following examples to understand how to
export data. These examples demonstrate the use of the DUMP_LDAP command.
These examples also can be applied to net services aliases, except the DUMP_ALIAS
command must be used in place of the DUMP_LDAP command.

■ Example 1: Exporting Data from a Single Domain to the Same DIT Node

■ Example 2: Exporting Data from a Domain Tree to a Similar DIT

See Also:

■ "Considerations for Dissimilar DIT Structures" on page 10-25
for examples of exporting data to a dissimilar DIT structure

■ "Considerations for Net Service Aliases" on page 10-33 for
limitations of the DUMP_ALIAS command
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Example 1: Exporting Data from a Single Domain to the Same DIT Node

Figure 10–5 shows an Oracle Names domain structure of acme.com . It contains a
database object called db . The DIT has been designed with domain entries that
match the Oracle Names domain structure. With this DIT structure, db.acme.com
can be exported to cn=OracleContext,dc=acme,dc=com .

Figure 10–5 Single Domain Export to the Same DIT Node

Either of the following syntaxes exports data from Oracle Names to the configured
DIT structure:

NAMESCTL> DUMP_LDAP acme.com (dn:dc=acme,dc=com) -f sample.ldif
NAMESCTL> DUMP_LDAP acme.com -f sample.ldif

In the first line of syntax, the destination distinguished name (DN), excluding
cn=OracleContext , is explicitly specified. It is not necessary to specify the
destination DN, as shown in the second line of syntax, because the destination DIT
structure is domain based and matches the domain model used in Oracle Names.
Note that cn=OracleContext  is automatically inserted.

The database object db is exported to cn=OracleContext,dc=acme,dc=com and
has a DN location of cn=db,cn=OracleContext,dc=acme,dc=com .

dc=acme

cn=OracleContext

cn=db

dc=com

acme

com

DIT
Structure

Oracle Names
Structure

db
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Example 2: Exporting Data from a Domain Tree to a Similar DIT

Data can be exported from a root domain and its delegated domains in Oracle
Names to a directory server that uses a similar DIT in one step rather than one
domain at a time.

Figure 10–6 shows an Oracle Names structure that contains a root domain of
acme.com  and delegated domains of sales.acme.com  and dev.acme.com .
Database objects db , orders , and widgets  reside in acme.com ,
sales.acme.com  and dev.acme.com , respectively. The directory server’s DIT is
similar to the Oracle Names domain structure.

Figure 10–6 Root and Subdomain Domain Export to Similar DIT

sales dev

acme

com

db

orders widgets

dc=sales dc=dev

cn=OracleContext cn=OracleContext

cn=orders cn=widgets

dc=acme

dc=com

Oracle Names 
Structure

DIT
Structure

cn=db

cn=OracleContext
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The following syntax exports data from the acme.com  root domain and its
delegated domains to the configured DIT structure:

NAMESCTL> DUMP_LDAP acme.com -R -f sample.ldif

The following table shows how database objects in acme.com , sales.acme.com ,
and dev.acme.com  are mapped to DNs in the directory server.

Database Object in Oracle
Names

New DN in Directory Server

db.acme.com dn:cn=db,cn=OracleContext,dc=acme,dc=com

orders.sales.acme.com dn:cn=orders,cn=OracleContext,dc=sales,
dc=acme,dc=com

widgets.dev.acme.com dn:cn=widgets,cn=OracleContext,dc=dev,
dc=acme,dc=com
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Configuring Oracle Names LDAP Proxy Servers
If you are not ready to upgrade clients to a version that supports directory naming,
you must use Oracle Names LDAP Proxy servers. Oracle Names LDAP Proxy
servers enable these clients to look up data in the directory server.

Generally, client configurations do not require modification. However, if the
directory server’s DIT structure does not match the Oracle Names domain
structure, you must also reconfigure the NAMES.DEFAULT_DOMAIN parameter in
the sqlnet.ora  file to point to the new domain structure.

The tasks to create Oracle Names LDAP Proxy servers are as follows:

Task 1: Upgrade Oracle Names Servers to 9i

Task 2: Start Oracle Names Servers

Task 3: Populate the Directory Server

Task 4: Configure Oracle Names Servers as Proxies

Task 5: Run the Oracle Names LDAP Proxy Servers

Task 1: Upgrade Oracle Names Servers to 9i
Upgrade all Oracle Names servers within a region to 9i. Releases prior to 9i do not
support Oracle Names LDAP Proxy servers.

See Also: "Configuring a Default Domain for Clients" on
page 11-3 for instructions

See Also: Oracle9i Database Migration
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Task 2: Start Oracle Names Servers
Start each of the Oracle Names servers to generate the cktop.ora  file. Use either
Oracle Net Manager or the Oracle Names Control utility.

Starting with release 9.0, an Oracle Names server creates a ckptop.ora  file in
$ORACLE_HOME/network/names on UNIX and ORACLE_HOME\network\names
on Windows NT, or in the file specified by the names.ora  file parameter
NAMES.TOPOLOGY_CHECKPOINT_FILE. This file contains topology data that
defines the domains in the administrative region and the Oracle Names servers that
have authority for them. Specifically, topology data consists of definitions for all
parent domains and Oracle Names servers in the region. The Oracle Names servers
use this information to understand the structure of the domain tree.

Oracle Names LDAP Proxy servers require the generated ckptop.ora  file. If the
Oracle Names structure has multiple administrative regions, Oracle Corporation
recommends mirroring the current Oracle Names domain structure in the directory
DIT structure. Using a different structure may require modifying the topology
defined for the Oracle Names LDAP Proxy servers. Support for topology
modification is not currently supported. The following constitutes a topology
change:

■ Addition or removal of any Oracle Names servers, as well as modification of an
Oracle Names server’s name or protocol address

■ Modification of domain definitions for an administrative region or its delegated
administrative regions

Use Oracle Net Manager... Use Oracle Names Control utility...

1. In the navigator pane, expand Oracle
Names Servers.

2. Select the Oracle Names server.

3. From the list in the right pane, select
Manage Server.

4. Click the Control tab.

5. Click Start, and then click Apply to
generate the topology data.

From the command line, enter:

namesctl
NAMESCTL> START
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Task 3: Populate the Directory Server
If you have not already done so, populate the directory:

1. Create the DIT in the directory structure.

2. Create Oracle Contexts in the directory under the root domain and each of its
delegated domains.

3. Configure each Oracle Names server within a region with directory usage
settings in the ldap.ora  file.

To do this, select the Select the directory server you want to use option in
Oracle Net Configuration Assistant.

4. Export data from Oracle Names under the appropriate Oracle Contexts in the
directory server. Use either the procedure described in "Exporting Data to a
Directory Server" on page 10-8 or an alternate external method.

See Also: "Task 1: Create Structure in Directory Server" on
page 10-9

See Also: "Configuring Directory Usage After Installation" on
page 8-6 for instructions on creating an Oracle Context

See Also: Chapter 8, "Setting Up Directory Server Usage"
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Task 4: Configure Oracle Names Servers as Proxies
Configure each Oracle Names server within a region to load directory server
information from a specific DN.

To configure Oracle Names servers as proxy servers:

1. Stop each Oracle Names server. Use either Oracle Net Manager or the Oracle
Names Control utility.

2. Set the NAMES.ADMIN_REGION parameter in the names.ora  file to the
directory server’s DN or read the directory server’s DN from an LDIF input file.

The syntax for an Oracle Names LDAP Proxy server to load the data from a
directory server is as follows:

NAMES.ADMIN_REGION=
  (REGION=
    (TYPE=ldap)
   [(USERID= user_dn )]
   [(PASSWORD= password )]
    [(HOST= host )]
    [(PORT= port )]
    [(TIMEOUT= time )]
   [(SUBTREE_LIST=]
     [(SUBTREE=(BASE= base_DN)[(SCOPE=sub|one))]
     [(SUBTREE=(BASE= base_DN)[(SCOPE=sub|one))]
   [)])

Values from equivalent ldap.ora  file parameters are used as defaults for the
USER, HOST, and SUBTREE (with SCOPE=one) parameters.

Use Oracle Net Manager... Use Oracle Names Control utility...

1. In the navigator pane, expand Oracle
Names Servers.

2. Select the Oracle Names server.

3. From the list in the right pane, select
Manage Server.

4. Click the Control tab.

5. Click Stop, and then click Apply to stop
the Oracle Names server.

From the command line, enter:

namesctl
NAMESCTL> STOP
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Set the NAMES.ADMIN_REGION subparameter as follows:

Table 10–2 Subparameters of the NAMES.ADMIN_REGION Parameter for LDAP

Subparameter Description

TYPE Specify that the Oracle Names LDAP Proxy server is to load data directly from a
directory server.

USERID (Optional) This entry is necessary if data is restricted.

Specify a directory user with read privileges in the form of a DN. For example,
c=us,o=acme,ou=admin,cn=scott  is the DN for an administrator named Scott.

Note: Do not prefix the DN with dn :

PASSWORD (Optional) This entry is required if data is restricted.

Specify the password for the directory user.

HOST (Optional) Specify the directory server host name.

PORT (Optional) Specify the listening TCP/IP port for the directory server.

TIMEOUT (Optional) Specify the time limit in seconds that the Oracle Names LDAP Proxy
server can spend performing a search of directory objects. This time limit cannot be
greater than the time limit set for searches in the directory server. By default, the
time limit is set to 10 seconds, which is sufficient for most searches.

See Also: "Increasing Search Size Limit" on page 17-19 for instructions for increasing
the time limit of ldapsearch

SUBTREE_LIST |
SUBTREE

(Optional) Use the SUBTREE parameter to specify the DN. Use the SUBTREE_LIST
parameter if there are multiple DNs. The SUBTREE parameter supports the
following subparameters:

BASE—Specify a subtree location in the DIT from which the Oracle Names Proxy
server should load data. The location is specified as a DN of a LDAP directory entry.
The Oracle Names Proxy loads directory naming data from one or more Oracle
Contexts located in the subtree following the entry specified.

Note: Do not prefix the DN with "dn :". For example, (BASE=dn:dc=com)  is not
acceptable.

SCOPE—Specifies where the Oracle Names Proxy server looks for directory data to
load.

one  (default) specifies that the Oracle Names Proxy server look only in one
Oracle Context directly following the entry specified in the BASE parameter

sub  specifies the Oracle Names Proxy server look in all the Oracle Contexts in
the subtree following the entry specified in the BASE parameter.
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The following example shows an Oracle Names LDAP Proxy server configured to
load the data from an Oracle Context that is directly under the DN
dc=acme,dc=com  and all Oracle Contexts under the DN subtree
dc=us,dc=acme,dc=com .

NAMES.ADMIN_REGION=
 (REGION=
   (TYPE=LDAP)
    (HOST=ldap-server)
    (PORT=389)
    (SUBTREE_LIST=
       (SUBTREE=(BASE=dc=acme,dc=com))
       (SUBTREE=(BASE=dc=us,dc=acme,dc=com)(scope=sub))))

The syntax for an Oracle Names LDAP Proxy server to load the data from an LDIF
file is as follows:

NAMES.ADMIN_REGION=
  (REGION=
    (TYPE=ldif)
   [(FILE= ldif_file )]))

Table 10–3 Subparameters of the NAMES.ADMIN_REGION Parameter for LDIF

The following example shows an Oracle Names LDAP Proxy server configured to
load data from LDIF file onames.ldif .

NAMES.ADMIN_REGION=
  (REGION=
   (TYPE=LDIF)
   (FILE=/private/eminer/nn/9i/proxy/onames.ldif))
The following LDIF file excerpt shows a DN of
cn=sales,cn=OracleContext,dc=acme,dc=com  and

Subparameter Description

TYPE Specify that the Oracle Names LDAP Proxy server is to use
data from an LDIF file.

FILE Specify the input LDIF file name.

See Also: Directory server vendor documentation for LDIF
file creation information
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cn=hr,cn=OracleContext,dc=acme,dc=com for net service names sales
and hr .

dn: cn=sales,cn=OracleContext,dc=us,dc=acme,dc=com
objectclass: top
objectclass: orclNetService
cn: sales
orclNetDescString:
(DESCRIPTION=(ADDRESS_
LIST=(ADDRESS=(PROTOCOL=tcp)(Host=sales-server)(Port=1521)))(CONNECT_
DATA=(SERVICE_NAME=sales.us.acme.com)))

dn: cn=hr,cn=OracleContext,dc=us,dc=acme,dc=com
objectclass: top
objectclass: orclNetService
cn: hr
orclNetDescString:
(DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(COMMUNITY=TCP_
COMMUNITY)(PROTOCOL=tcp)(Host=hr-server)(Port=1521)))(CONNECT_DATA=(SERVICE_
NAME=hr.us.acme.com)))

The following LDIF file excerpt shows a DN of
cn=mysales,cn=OracleContext,dc=acme,dc=com  for net service alias
mysales .

dn: cn=mysales,cn=oracleContext,dc=acme,dc=com
objectclass: top
objectclass: alias
objectclass: orclNetServiceAlias
cn: mysales
aliasedobjectname: cn=mysales,cn=OracleContext,dc=us,dc=acme,dc=com
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Task 5: Run the Oracle Names LDAP Proxy Servers
Run each of the Oracle Names servers with the new configuration. Use either
Oracle Net Manager or the Oracle Names Control utility.

Use Oracle Net Manager... Use Oracle Names Control utility...

1. In the navigator pane, expand Oracle
Names Servers.

2. Select the Oracle Names server.

3. From the list in the right pane, select
Manage Server.

4. Click the Control tab.

5. Click Start, and then click Apply.

From the command line, enter:

namesctl
NAMESCTL> START

See Also: "Oracle Names LDAP Proxy Server Error Reporting" on
page 17-19 region load operation troubleshooting advice
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Considerations for Dissimilar DIT Structures
If the directory server’s DIT structure has been designed with a DIT that is
dissimilar to the current Oracle Names domain structure, review the following
examples to understand how to export data. These examples demonstrate the use of
the DUMP_LDAP command. Examples 1 through 3 also can be applied to net service
aliases, except the DUMP_ALIAScommand must be used in place of the DUMP_LDAP
command.

■ Example 1: Exporting Data from a Single Domain to a Non-DC Node

■ Example 2: Exporting Data from a Domain Tree to a Non-DC DIT

■ Example 3: Exporting Data from Multiple Domains to One DIT Node

■ Example 4: Reorganizing a Tree Structure During an Export

See Also: "Considerations for Net Service Aliases" on page 10-33
for limitations of the DUMP_ALIAS command
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Example 1: Exporting Data from a Single Domain to a Non-DC Node
Figure 10–7 shows an Oracle Names domain structure of acme.com . It contains a
database object called db . The directory server has been designed with a DIT of
cn=OracleContext,o=acme,c=us .

Figure 10–7 Single Domain Export to One DIT Node

The following syntax exports data from the acme.com  domain to the configured
DIT structure:

NAMESCTL> DUMP_LDAP acme.com (dn:c=us,o=acme) -f sample.ldif

Because the DIT is different from the Oracle Names structure, the destination DN
must be explicitly specified. cn=OracleContext is automatically pre-appended to
the left of the destination DN; you do not need to explicitly specify
cn=OracleContext  in the DN.

o=acme

cn=OracleContext

cn=db

c=us

acme

com

DIT
Structure

Oracle Names
Structure

db
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Example 2: Exporting Data from a Domain Tree to a Non-DC DIT
Data can be exported from an Oracle Names administrative region to a directory
server that uses a dissimilar DIT. RDNs in the destination DN must be specified
without a value for the delegated domains.

Figure 10–8 shows an Oracle Names structure that contains a root domain of
acme.com  and delegated domains of sales.acme.com  and dev.acme.com .
Database objects of db , orders , and widgets  reside in acme.com ,
sales.acme.com  and dev.acme.com , respectively. The directory server’s DIT
has a top-level structure of o=acme,c=us  that correlates to acme.com  in Oracle
Names. The subtrees, ou=sales  and ou=dev , correlate to the sales.acme.com
and dev.acme.com  delegated domains in Oracle Names.

Figure 10–8 Root and Subdomain Domain Export to Dissimilar DIT

sales dev

acme

com

db

orders widgets

ou=sales ou=dev

cn=OracleContext cn=OracleContext

cn=orders cn=widgets

o=acme

c=us

Oracle Names 
Structure

DIT
Structure

cn=db

cn=OracleContext
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The following syntax exports data from the acme.com  root domain and its
delegated domains to the configured DIT structure:

NAMESCTL> DUMP_LDAP acme.com (dn:ou,o=acme,c=us) -R -f sample.ldif

Note that organizational unit (ou) contains no value, so that the sales  and dev
subdomain of acme.com  in the source region can be mapped to an ou .

The following table shows how database objects in acme.com , sales.acme.com ,
and dev.acme.com  are mapped to DNs in the directory server. All objects are
exported to cn=OracleContext  RDNs in the directory server.

If acme.com contained a subdomain of mktg.dept.acme.com , network objects in
that subdomain would not be exported. This is because the destination DN
template ou,o=acme,c=us  permits only one level of delegated domains. In order to
export objects from mktg.dept.acme.com , the following syntax would be
required:

NAMESCTL> DUMP_LDAP acme.com (dn:ou,ou,o=acme,c=us) -f sample.ldif

This syntax enables up to two levels of delegated domains to be exported. By
adding additional attributes, you can specify any level of depth.

Database Object in Oracle
Names

New DN in Directory Server

db.acme.com dn:cn=db,cn=OracleContext,o=acme,c=us

orders.sales.acme.com dn:cn=orders,cn=OracleContext,ou=sales,
o=acme,c=us

widgets.dev.acme.com dn:cn=widgets,cn=OracleContext,ou=dev,
o=acme,c=us
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Example 3: Exporting Data from Multiple Domains to One DIT Node
Data can be exported from multiple domains to one node in the destination DIT.

Figure 10–9 shows an Oracle Names structure that contains a root domain of
acme.com  and delegated domains of sales.acme.com  and dev.acme.com .
Database objects of db , orders , and widgets  reside in acme.com ,
sales.acme.com  and dev.acme.com , respectively. The directory server’s DIT
has a structure of o=IS,c=uk  that contains no subtrees that correlate to the Oracle
Names delegated domains.

Figure 10–9 Root and Subdomain Domain Export to One DIT Node

All data can be exported from the root domain and the delegated domains to
cn=OracleContext,o=IS,c=uk  in the DIT with the following syntax:

NAMESCTL> DUMP_LDAP acme.com (dn:o=IS,c=uk) -R -f sample.ldif

sales dev

acme

com

db

orders widgets

cn=orders

cn=db

cn=widgets

o=IS

cn=OracleContext

c=uk

Oracle Names 
Structure

DIT
Structure
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The following table shows how database objects in acme.com , sales.acme.com ,
and dev.acme.com  are mapped to DNs in the directory server. All objects are
exported to cn=OracleContext  RDNs in the directory server.

If one of the delegated domains contained a database object named db , it would not
be exported. This is because the db  database object’s name would conflict with the
db  object exported from db.acme.com .

Example 4: Reorganizing a Tree Structure During an Export
In the previous examples, you saw how data can be exported to a non-DC DIT and
how data can be exported from multiple domains to a one node in the DIT. This
example combines these two types of exports to demonstrate how to export data to
a DIT with a very different structure.

Figure 10–10 on page 10-31 shows an Oracle Names structure that contains a root
domain of acme.com  and four delegated domains, each of which contains at least
one database object. The directory server’s DIT has a top-level structure of
dc=acme,dc=com  that correlates to the acme.com  domain in Oracle Names. The
two subtrees, dc=intranet  and dc=storefront , are unrelated to the delegated
domains in Oracle Names.

Database Object in Oracle
Names

New DN in Directory Server

db.acme.com dn:cn=db,cn=OracleContext,o=IS,c=uk

orders.sales.acme.com dn:cn=orders,cn=OracleContext,o=IS,c=uk

widgets.dev.acme.com dn:cn=widgets,cn=OracleContext,o=IS,c=uk
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Figure 10–10 Multiple Domain Export to Two Subtrees
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In order to export data from the Oracle Names domain structure to the DIT, each
domain must be exported separately:

DUMP_LDAP IS.acme.com (dn:dc=intranet,dc=com,dc=acme) -f sample.ldif
DUMP_LDAP hr.acme.com (dn:dc=intranet,dc=com,dc=acme) -f sample.ldif
DUMP_LDAP warehouse.acme.com (dn:dc=storefront,dc=com,dc=acme) -f sample.ldif
DUMP_LDAP sales.acme.com (dn:dc=storefront,dc=com,dc=acme) -R -f sample.ldif

The first two DUMP_LDAP commands export database objects to
cn=Oraclecontext,dc=intranet,dc=acme,dc=com . The last two DUMP_
LDAP commands export database objects to
cn=Oraclecontext,dc=storefront,dc=acme,dc=com . The -R  option in the
DUMP_LDAP sales.acme.com  command enables the database objects to be
exported from sales.acme.com , europe.sales.acme.com , and
pacific.sales.acme.com .

The following table shows how database objects in the Oracle Names domains are
mapped to DNs in the directory server. All objects are exported to
cn=OracleContext  RDNs in the directory server.

Database Object in Oracle Names New DN in Directory Server

revenue.is.acme.com dn:cn=revenue,cn=OracleContext,dc=intra,dc=acme,
dc=com

expense.is.acme.com dn:cn=expense,cn=OracleContext,dc=intra,dc=acme,
dc=com

emp.hr.acme.com dn:cn=emp,cn=OracleContext,dc=intra,dc=acme,dc=com

inventory.warehouse.com dn:cn=inventory,cn=OracleContext,dc=storefront,
dc=acme,dc=com

customer.sales.acme.com dn:cn=customer,cn=OracleContext,dc=storefront,
dc=acme,dc=com

clients.europe.sales.acme.com dn:cn=clients,cn=OracleContext,dc=storefront,
dc=acme,dc=com

orders.pacific.sales.acme.com dn:cn=orders,cn=OracleContext,dc=storefront,
dc=acme,dc=com
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Considerations for Net Service Aliases
Using the DUMP_ALIAS command is similar to the DUMP_LDAP command, except
for the following limitations:

■ The command does not verify that the object the alias is referencing exists in the
directory

If an alias is exported and the object it is referencing is not exported, then the
DUMP_ALIAS command exports the alias without verifying that the referenced
object exists.

■ The command should use the same destination as applied to the object the net
service alias is referencing

If an alias and the object it is referencing are exported with different
destinations, then the net service alias will not contain the correct name for the
object it is referencing. This can occur in a case of tree rearrangement.

Figure 10–11 on page 10-34 illustrates this point. It shows an Oracle Names
structure with a root domain of acme.com  that contains aliases of ordersalias ,
dbalias , and widgetsalias . These aliases reference objects
orders.sales.acme.com , db.acme.com , and widgets.dev.acme.com ,
respectively. The directory’s DIT structure is rearranged. Data that was in the
sales  domain is exported to marketing  and data in dev  is exported to RandD.
However, the net services aliases remain in o=acme,c=us .



Exporting Network Objects from an Oracle Names Server

10-34 Oracle9i Net Services Administrator’s Guide

Figure 10–11 Unsupported Alias Export

The following syntax exports objects db , orders , and widgets :

NAMESCTL> DUMP_LDAP acme.com (dn:o=acme,c=us) -f sample.ldif
NAMESCTL> DUMP_LDAP dev.acme.com (dn:ou=RandD,o=acme,c=us) -f sample.ldif
NAMESCTL> DUMP_LDAP sales.acme.com (dn:ou=marketing,o=acme,c=us) -f sample.ldif
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The following table shows how database objects in the Oracle Names domains are
mapped to DNs in the directory server:

The following command exports aliases ordersalias , dbalias , and
widgetsalias  and the data for the referenced objects to o=acme,c=us :

NAMESCTL> DUMP_ALIAS acme.com (dn:ou,o=acme,c=us) -R -f sample.ldif

The following table shows how aliases and data for reference objects are mapped to
DNs in the directory server. It also describes what happens when a client attempts
to look up of one of the net service aliases in the directory.

Database Object in Oracle
Names

New DN in Directory Server

db.acme.com dn:cn=db,cn=OracleContext,o=acme,c=us

orders.sales.acme.com dn:cn=orders,cn=OracleContext,ou=marketing,o=acme,c=us

widgets.dev.acme.com dn:cn=widgets,cn=OracleContext,ou=RandD,o=acme,c=us

Alias Name Oracle Names Directory Server

dbalias

Alias Object Location in
Oracle Names

dbalias.acme.com

Net Service Alias DN in Directory Server

dn:cn=dbalias,cn=OracleContext,o=acme,c=us

Alias Data in Oracle Names

db.acme.com

Alias Data in Directory Server

dn:cn=db,cn=OracleContext,o=acme,c=us

Lookup Result with dbalias

Because the data of dbalias  points to cn=db,cn=OracleContext,o=acme,c=us , the correct
location of the object db , the net service alias works.

ordersalias

Alias Object Location in
Oracle Names

ordersalias.acme.com

Net Service Alias DN in Directory Server

dn:cn=ordersalias,cn=OracleContext,o=acme,c=us

Alias Data in Oracle Names

orders.sales.acme.com

Alias Data in Directory Server

dn:cn=orders,cn=OracleContext,ou=sales,o=acme,c=us

Lookup Result with ordersalias

Because the data of ordersalias  points to
cn=orders,cn=OracleContext,ou=sales,o=acme,c=us  rather than
cn=orders,cn=OracleContext,ou=marketing,o=acme,c=us , ordersalias  fails to locate
object orders .
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widgetsalias

Alias Object Location in
Oracle Names

widgetsalias.acme.com

Net Service Alias DN in Directory Server

dn:cn=widgetsalias,cn=OracleContext,o=acme,c=us

Alias Data in Oracle Names

widgets.dev.acme.com

Alias Data in Directory Server

dn:cn=widgets,cn=OracleContext,ou=dev,o=acme,c=us

Lookup Result with widgetsalias

Because the data of widgetsalias  points to
cn=widgets,cn=OracleContext,ou=dev,o=acme,c=us  rather than
cn=widgets,cn=OracleContext,ou=RandD,o=acme,c=us , widgetsalias  fails to locate object
widgets .

Alias Name Oracle Names Directory Server
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11
 Configuring Profiles

This chapter describes how to configure client and server configuration parameters
in profiles. A profile is a collection of parameters that specifies preferences for
enabling and configuring Oracle Net features on the client or database server. A
profile is stored and implemented through the sqlnet.ora  file.

This chapter contains these topics:

■ Profile Configuration Overview

■ Configuring Client Attributes for Names Resolution

■ Configuring Database Access Control

■ Configuring Advanced Profile Information

■ Configuring Preferred Oracle Names Servers

■ Configuring External Naming Methods

■ Configuring Oracle Advanced Security
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Profile Configuration Overview
You can use a profile to:

■ Specify the client domain to append to unqualified names

■ Prioritize naming methods

■ Enable logging and tracing features

■ Route connections through specific processes

■ Configure parameters for external naming

■ Configure Oracle Advanced Security

■ Use protocol-specific parameters to restrict access to the database

Profile Configuration During Installation
Oracle Universal Installer launches Oracle Net Configuration Assistant after
software installation on the client and server. Oracle Net Configuration Assistant
configures the following:

■ Default network domain

The computer's network domain is automatically selected as the default
domain. This domain is appended to any unqualified net service name given in
the connect string, and then compared to net service names stored in a
tnsnames.ora  file or Oracle Names server. For example, if the client
tnsnames.ora  file contains a net service name of sales.us.acme.com , the
user can enter the following connect string:

CONNECT scott/tiger@sales

sales  gets searched as sales.us.acme.com .

■ The order of the naming methods the computer will use to resolve a connect
identifier to a connect descriptor

Configuration with the Oracle Net Configuration Assistant during installation
results in the following entries in the sqlnet.ora  file:

NAMES.DEFAULT_DOMAIN=us.acme.com
NAMES.DIRECTORY_PATH=(onames, tnsnames)

NAMES.DEFAULT_DOMAIN specifies the network domain, and
NAMES.DIRECTORY_PATH specifies the priority order of the naming methods to
use to resolve connect identifiers.
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If the installed configuration is not adequate, you can use Oracle Net Manager to
enhance the sqlnet.ora  configuration.

Configuring Client Attributes for Names Resolution
The following sections describe available client configuration options:

■ Configuring a Default Domain for Clients

■ Prioritizing Naming Methods

■ Routing Connection Requests

Configuring a Default Domain for Clients
In environments where the client often requests names from a specific domain, it is
appropriate to set a default domain in the client sqlnet.ora  file with the
NAMES.DEFAULT_DOMAIN parameter.

When a default domain is set, it is automatically appended to any unqualified net
service name given in the connect string, and then compared to net service names
stored in a tnsnames.ora  file or Oracle Names server.

For example, if the client tnsnames.ora  file contains a net service name of
sales.us.acme.com , the user can enter the following connect string:

CONNECT scott/tiger@sales

In this example, sales  gets searched as sales.us.acme.com .

If the connect string includes the domain extension, such as in CONNECT
scott/tiger@sales.us.acme.com , the domain is not appended. If a net
service name in a tnsnames.ora  file or Oracle Names server is not domain
qualified and this parameter is set, the net service name must be entered with a dot
("."). For example, if domain is set to us.acme.com  and the client tnsnames.ora
file contains a net service name of sales , the user would enter the following
connect string:

CONNECT scott/tiger@sales.

Note: During installation, Oracle Net Configuration Assistant sets
the default domain to your client’s network domain.
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To specify a default domain:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Local > Profile.

3. From the list in the right pane, select Naming.

4. Click the Oracle Names tab.

5. In the Default Domain field, enter the domain.

6. Choose File > Save Network Configuration.

The sqlnet.ora  file should contain an entry that looks like the following:

NAMES.DEFAULT_DOMAIN=us.acme.com

See Also: "Starting Oracle Net Manager" on page 5-3
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Prioritizing Naming Methods
After naming methods are configured, as described in Chapter 9, "Configuring
Naming Methods", they must be prioritized. The naming method at the top of the
list is used first to resolve a connect identifier. If the first naming method in the list
is unable to resolve the connect identifier, then the second method in the list is used.

To specify the order of naming methods:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Local > Profile.

3. From the list in the right pane, select Naming.

4. Click the Methods tab.

Table 11–1 describes the naming method values listed in the Methods tab.

Table 11–1 Naming Method Values

See Also: "Starting Oracle Net Manager" on page 5-3

Naming Method
Value

Description

TNSNAMES

local naming method

Set to resolve a net service name through the tnsnames.ora
file on the client.

See Also: "Configuring the Local Naming Method" on page 9-5

LDAP

directory naming
method

Set to resolve a database service name, net service name, or net
service alias through a directory server.

See Also: "Configuring the Directory Naming Method" on
page 9-12

ONAMES

Oracle Names
method

Set to resolve net service names or database service names
through a Oracle Names server.

See Also: "Configuring the Oracle Names Method" on
page 9-23

HOSTNAME

host naming method

Set to resolve a host name alias through an existing names
resolution service or a centrally-maintained set of /etc/hosts
files.

See Also: "Configuring the Host Naming Method" on page 9-60
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5. Select naming methods from the Available Methods list, and then click the
right-arrow button.

The selected naming methods move to the Selected Methods list.

6. Order the naming methods according to the order in which you want Oracle
Net to try to resolve the net service name or database service name. Select a
naming method in the Selected Methods list, and then click Promote or
Demote to move the selection up or down in the list.

7. Choose File > Save Network Configuration.

The sqlnet.ora  file updates with the NAMES.DIRECTORY_PATH parameter:

NAMES.DIRECTORY_PATH=(ldap, tnsnames)

CDS

Cell Directory
Services (CDS)
external naming
method

Set to resolve an Oracle database name in a Distributed
Computing Environment (DCE) environment.

See Also: Oracle Advanced Security Administrator’s Guide

NIS

Network Information
Service (NIS) external
naming method

Set to resolve service information through an existing NIS.

See Also: "Network Information Service (NIS)" on page 9-64

Naming Method
Value

Description
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Routing Connection Requests
Clients and servers acting as clients can be configured so connection requests are
directed to a specific process at all times. Table 11–2 describes the sqlnet.ora  file
settings that you can set to route connection requests.

Table 11–2 Routing Settings in sqlnet.ora

To route connection requests:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Local > Profile.

3. From the list in the right pane, select General.

4. Click the Routing tab.

5. Select the preferred way that you want connection requests routed.

6. Choose File > Save Network Configuration.

Oracle Net Manager
Option sqlnet.ora File Parameter Description

Always Use Dedicated
Server

USE_DEDICATED_SERVER Use to force the listener to spawn a dedicated
server for all network sessions from this client. It
does this by adding (SERVER=dedicated ) to the
CONNECT_DATA section of connect descriptors.
Connections from this client use dedicated servers,
even if shared server is configured.

Prefer Connection Manager
Routing

USE_CMAN Use to send the client to an Oracle Connection
Manager whenever possible. If no Oracle
Connection Manager protocol addresses are
available, connections are routed through any
available listener protocol address.

Note: If you are using Oracle Connection Manager
with Oracle Names, this option must be set on
clients and Oracle Names servers.

See Also: "Starting Oracle Net Manager" on page 5-3

See Also: Table 11–2 for a description of the fields and options
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Configuring Database Access Control
You can configure the sqlnet.ora  file to allow access to some clients and deny
access to others. Table 11–3 describes the available settings.

Table 11–3 Access Control Settings in sqlnet.ora

To configure database access control:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Local > Profile.

3. From the list in the right pane, select General.

4. Click the Access Rights tab.

5. Select the Check TCP/IP client access rights option.

6. In the Clients excluded from access and Clients allowed to access fields, enter
either a host name or an IP address for a client that you wish to include or
exclude, using commas to delimit entries placed on the same line.

Oracle Net Manager
Field/Option

sqlnet.ora File Parameter Description

Check TCP/IP client
access rights

TCP.VALIDNODE_
CHECKING

Use to specify whether to screen access to the
database.

If this field is selected, Oracle Net Manager checks the
parameters TCP.EXCLUDED_NODES and
TCP.VALIDNODE_CHECKING to determine which
clients to allow access to the database. If this field is
deselected, Oracle Net Manager does not screen
clients.

Clients excluded from
access

TCP.EXCLUDED_NODES Use to specify which clients using the TCP/IP
protocol are denied access to the database.

Clients allowed to
access

TCP.INVITED_NODES Use to specify which clients using the TCP/IP
protocol are allowed access to the database.

See Also: "Starting Oracle Net Manager" on page 5-3
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Configuring Advanced Profile Information
Table 11–4 describes the advanced sqlnet.ora  file settings that you can set.

Table 11–4 Advanced Settings in sqlnet.ora

Oracle Net Manager
Field/Option

sqlnet.ora File Parameter Description

TNS Time Out Value SQLNET.EXPIRE_TIME Use to specify a specify the time interval, in seconds,
to send a probe to verify that client/server
connections are active. Setting a value greater than 0
ensures that connections are not left open indefinitely,
due to an abnormal client termination. If the probe
finds a terminated connection, or a connection that is
no longer in use, it returns an error, causing the server
process to exit. This setting is intended for the
database server, which typically handles multiple
connections at any one time.

Limitations on using this terminated connection
detection feature are:

■ It is not allowed on bequeathed connections.

■ Though very small, a probe packet generates
additional traffic that may downgrade network
performance.

■ Depending on which operating system is in use,
the server may need to perform additional
processing to distinguish the connection probing
event from other events that occur. This can also
result in downgrading network performance.

Client Registration ID SQLNET.CLIENT_
REGISTRATION

Use to specify a unique identifier for a client. This
identifier is passed to the listener with any connection
request. The identifier can be any string up to 128
characters long.
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To set advanced features for clients:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Local > Profile.

3. From the list in the right pane, select General.

4. Click the Advanced tab.

5. Enter the values for the fields/options you want to set.

6. Choose File > Save Network Configuration.

Turn Off UNIX Signal
Handling

BEQUEATH_DETACH Use to turn on or off UNIX signal handling.

Since the client application spawns a server process
internally through the Bequeath protocol as a child
process, the client application becomes responsible for
cleaning up the child process when it completes.
When the server process completes its connection
responsibilities, it becomes a defunct process. Signal
handlers are responsible for cleaning up these defunct
processes. Setting this parameter configures the client
profile to pass this process to the UNIX init process by
disabling signal handlers.

Disable Out-of-Band
Break

DISABLE_OOB Use to turn on or off out of band breaks.

If deselected or set to off , enables Oracle Net to send
and receive "break" messages using urgent data
provided by the underlying protocol.

If selected or set to on , disables the ability to send and
receive "break" messages using urgent data provided
by the underlying protocol. Once enabled, this feature
applies to all protocols used by this client.

See Also: Oracle operating system-specific
documentation to determine if the protocol supports
urgent data requests. TCP/IP is an example of a
protocol that supports this feature.

See Also: "Starting Oracle Net Manager" on page 5-3

See Also: Table 11–4 for a description of the fields and options

Oracle Net Manager
Field/Option

sqlnet.ora File Parameter Description
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Configuring Preferred Oracle Names Servers
If you are using Oracle Names as a naming method, you can specify the name and
address of preferred Oracle Names servers to take precedence over any other
available Oracle Names server addresses. Oracle Net routes name resolution
requests to each preferred Oracle Names Server until a response is received.

Preferred Oracle Names servers are an alternative to using the Discover Oracle
Names Servers command in Oracle Net Manager or using the Oracle Names
Control utility REORDER_NS command. These commands create a list of Oracle
Names servers based on what is available throughout the network and ranks them
in the order of fastest response time. Preferred Oracle Names servers override any
other Oracle Names servers found during the discovery process. Once you have
initially discovered an Oracle Names server, you may want to delete preferred
Oracle Names servers.

To specify a preferred Oracle Names server:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Local > Profile.

3. From the list in the right pane, select Preferred Oracle Names Servers.

4. Click New.

A Preferred Server tab appears.

5. Choose the protocol and enter the requested protocol address information for
an Oracle Names server configured on that protocol address.

6. Repeat Steps 4 and 5 for each additional Oracle Names server you want added
to the list.

See Also:

■ "Differences Between Versions of Oracle Names" on page 3-34
for a description of how Oracle Names server lists are created

■ "Task 4: Configure Clients and Database Servers To Use Oracle
Names Servers" on page 9-38 for information about discovering
Oracle Names servers

See Also: "Starting Oracle Net Manager" on page 5-3

See Also: Oracle9i Net Services Reference Guide for protocol
parameter settings
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7. Choose File > Save Network Configuration.

The sqlnet.ora  file updates with the NAMES.PREFERRED_SERVERS
parameter:

NAMES.PREFERRED_SERVERS=
  (ADDRESS=(PROTOCOL=tcp)(HOST=namesrv1)(PORT=1575))

Configuring External Naming Methods
Configure required client parameters needed for the NIS external naming or the
CDS external naming method in the profile. Table 11–5 describes the sqlnet.ora
file external naming settings that you can set.

Table 11–5 External Naming Methods Settings in sqlnet.ora

To configure external naming method parameters:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Local > Profile.

3. From the list in the right pane, select Naming.

4. Enter a value in the appropriate field for the external naming method you are
using.

5. Choose File > Save Network Configuration.

Note: The preferred Oracle Names servers must match the Oracle
Names listening protocol addresses configured in the names.ora
file with the NAMES.ADDRESSES parameter.

Oracle Net Manager Field sqlnet.ora File Parameter Description

Cell Name NAMES.DCE.PREFIX Enter a valid DCE cell name (prefix).

Meta Map NAMES.NIS.META_MAP Specify the map, a special file that contains the
database service name.

See Also: "Starting Oracle Net Manager" on page 5-3
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Configuring Oracle Advanced Security
Oracle Advanced Security enables data encryption and integrity checking,
enhanced authentication, single sign-on, and support for DCE. Oracle Advanced
Security also provides centralized user management on LDAP-compliant directory
servers and certificate-based single sign-on; this functionality relies on the Secure
Sockets Layer (SSL).

To configure a client or server to use Oracle Advanced Security features:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Local > Profile.

3. From the list in the right pane, select Oracle Advanced Security.

Each Oracle Advanced Security tab page enables you to configure a separate set
of parameters.

4. Select or edit options as applicable.

5. Choose File > Save Network Configuration.

See Also: "Starting Oracle Net Manager" on page 5-3

See Also:

■ Choose the Help button on the particular tab page

■ Oracle Advanced Security procedural topics in the Oracle Net
Manager online help. To access these topics in the online help,
choose Oracle Advanced Security > How To in the online help

■ Oracle Advanced Security Administrator’s Guide for further
information about configuration
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12
Configuring and Administering the Listener

The listener is a separate process that runs on the database server computer. It
receives incoming client connection requests and manages the traffic of these
requests to the database server. This chapter describes how to configure the listener
to accept client connections.

 This chapter contains these topics:

■ Listener Configuration Overview

■ Listener Configuration During Installation

■ Customizing Listener Configuration

■ Configuring Service Registration

■ Listener Administration

See Also:

■ Chapter 2, "Connectivity Concepts" for a description of how the
listener is used during an initial connection request

■ Chapter 4, "Architecture of Oracle Net Services" for an
architectural overview of the listener
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Listener Configuration Overview

A listener is configured with one or more listening protocol addresses, information
about supported services, and parameters that control its runtime behavior. The
listener configuration is stored in a configuration file named listener.ora .

Because all of the configuration parameters have default values, it is possible to
start and use a listener with no configuration. This default listener has a name of
LISTENER, supports no services upon startup, and listens on the following TCP/IP
protocol address:

(ADDRESS=(PROTOCOL=tcp)(HOST=host_name )(PORT=1521))

Supported services, that is, the services to which the listener forwards client
requests, can be configured in the listener.ora  file or this information can be
dynamically registered with the listener. This dynamic registration feature is called
service registration and is used by Oracle9i or Oracle8i instances. The registration is
performed by the PMON process—an instance background process—of each
database instance that has the necessary configuration in the database initialization
parameter file. Dynamic service registration does not require any configuration in
the listener.ora  file.

Note: A version 9 listener is required for an Oracle9i database.
Previous versions of the listener are not supported for use with an
Oracle9i database. However, it is possible to use a version 9 listener
with previous versions of the Oracle database.

See Also: "Listener Architecture" on page 4-10
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Service registration offers the following benefits:

■ Simplified configuration

Service registration reduces the need for the SID_LIST_ listener_name
parameter setting, which specifies information about the databases served by
the listener, in the listener.ora  file.

■ Connect-time failover

Because the listener always knows the state of the instances, service registration
facilitates automatic failover of the client connect request to a different instance
if one instance is down.

In a static configuration model, a listener would start a dedicated server upon
receiving a client request. The server would later find out that the instance is
not up, causing an "Oracle not available " error message.

■ Connection load balancing

Service registration enables the listener to forward client connect requests to the
least loaded instance and dispatcher or dedicated server. Service registration
balances the load across the service handlers and nodes.

Oracle Enterprise Manager tools require static service configuration in the
listener.ora  file.

Note: The SID_LIST_ listener_name  parameter is still
required if you are using Oracle Enterprise Manager to manage the
database.

See Also:

■ "Listener Architecture" on page 4-10

■ "Configuring Service Registration" on page 12-14

■ "Configuring Address List Parameters" on page 15-4

■ "Configuring Connection Load Balancing" on page 15-10
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Listener Configuration During Installation
Oracle Universal Installer launches Oracle Net Configuration Assistant during
software installation. Oracle Net Configuration Assistant enables you to configure
the listening protocol address and service information for an Oracle database.

During an Enterprise Edition or Standard Edition installation on the database
server, Oracle Net Configuration Assistant automatically configures a listener with
a name of LISTENER that has a TCP/IP listening protocol address for the Oracle
database. During a Custom installation, Oracle Net Configuration Assistant
prompts you to configure a listener name and a protocol address of your choice.

Additionally, a listening IPC protocol address for external procedure calls is
automatically configured, regardless of the installation type.

Oracle Net Configuration Assistant also automatically configures service
information for the Oracle database and the external procedures in the
listener.ora  file.

Note: While service information is not required in the
listener.ora  file, Oracle Net Configuration Assistant assumes
that you are using Oracle Enterprise Manager to monitor the
database. Oracle Enterprise Manager requires this information to
discover the database.
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Figure 12–1 shows a listener.ora file sample. The LISTENER entry defines the
listening protocol address for a listener named LISTENER, and the SID_LIST_
LISTENER entry provides information about the services supported by the listener
LISTENER.

Figure 12–1 Example listener.ora File

LISTENER=
  (DESCRIPTION=
    (ADDRESS_LIST=
      (ADDRESS=(PROTOCOL=tcp)(HOST=sale-server)(PORT=1521))
      (ADDRESS=(PROTOCOL=ipc)(KEY=extproc))))
SID_LIST_LISTENER =
  (SID_LIST=
    (SID_DESC=
      (GLOBAL_DBNAME=sales.us.acme.com)
      (ORACLE_HOME=/oracle9i)
      (SID_NAME=sales))
    (SID_DESC=
      (SID_NAME=plsextproc)
      (ORACLE_HOME=/oracle9i)
      (PROGRAM=extproc)))

See Also: Oracle9i Net Services Reference Guide for further
information about identifying listeners by unique names and
creating multiple listener entries in the listener.ora  file
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Customizing Listener Configuration
If the default or installed configuration is not adequate for a particular
environment, you can use Oracle Net Manager to customize the listener.ora
configuration.

This section contains these configuration topics:

■ Configuring Listening Protocol Addresses

■ Configuring Access to Oracle JServer

■ Configuring Static Service Information

■ Configuring Password Authentication for the Listener

Configuring Listening Protocol Addresses
To configure additional protocol addresses for the listener:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Local > Listeners.

3. Select a listener.

If a listener has never been created:

a. Click plus (+) from the toolbar, or choose Edit > Create.

The Choose Listener Name dialog box appears.

b. Enter a unique listener name in the Listener Name field.

c. Click OK.

4. From the list in the right pane, select Listening Locations.

5. Click Add Address.

See Also: "Starting Oracle Net Manager" on page 5-3

Note: If a listener.ora  file has been configured, but the
listener has never been started with the Listener Control utility, the
Listeners folder does not display a listener. If this occurs, exit
Oracle Net Manager, start the listener, as described in "Starting
Oracle Net Services Components" on page 16-2, and start Oracle
Net Manager again.
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A new Address tab appears.

6. Select a protocol, and then enter the appropriate parameter information for the
selected protocol in the fields provided.

When configuring the listener to listen on TCP/IP, you should enter the default
port of 1521. If you do not, you must configure the LOCAL_LISTENER
parameter in the initialization parameter file and resolve the listener name
through a naming method.

If the computer has more than one IP address and you want the listener to listen
on all available IP addresses, configure TCP/IP or TCP/IP with SSL and enter
the host name of the computer in the Host field.

7. Repeat Steps 5 and 6 for additional protocols.

8. Choose File > Save Network Configuration.

See Also: Oracle9i Net Services Reference Guide for protocol
parameter settings

See Also:

■ Oracle9i Net Services Reference Guide for further information
about protocol addresses and TCP/IP privileged ports

■ "Registering Information with a Nondefault Listener" on
page 12-15
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Configuring Access to Oracle JServer
Clients access Enterprise JavaBeans (EJBs) and Common Object Request Broker
Architecture (CORBA) applications, provided with the Oracle JServer option, in an
Oracle8i database over an Inter-Orb Protocol (IIOP) connection. IIOP is an
implementation of General Inter-Orb Protocol (GIOP) over TCP/IP. To support
access to CORBA and EJB, you configure the listener with a protocol address with
port 2481 for TCP/IP or port 2482 for TCP/IP with SSL.

To configure a protocol address for Oracle JServer in an Oracle8i database:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Local > Listeners.

3. Select a listener.

4. From the list in the right pane, select Listening Locations.

5. Click Add Address.

A new Address tab appears.

6. Select the TCP/IP or TCP/IP with SSL protocol from the Protocol list.

7. Enter the host name of the database in the Host field.

8. Enter port 2481 for TCP/IP in the Port field, or enter port 2482 for TCP/IP with
SSL in the Port field.

9. Click Statically dedicate this address for JServer connections.

10. Choose File > Save Network Configuration.

The listener.ora  file updates with the following:

listener=
 (DESCRIPTION_LIST=
  (DESCRIPTION=
   (ADDRESS=(PROTOCOL=tcp)(HOST=sales1-server)(PORT=2481))
   (PROTOCOL_STACK=
     (PRESENTATION=giop)
     (SESSION=raw))))

See Also: "Starting Oracle Net Manager" on page 5-3

See Also: Oracle8i Enterprise JavaBeans Developer’s Guide and
Reference for complete instructions for configuring client
connections to EJB and CORBA applications
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Handling Large Volumes of Concurrent Connection Requests
If you expect the listener to handle large volumes of concurrent connection requests,
then you can specify a listener queue size for its TCP/IP listening endpoints. To
specify the listener queue size, specify the QUEUESIZE parameter at the end of the
protocol address with its value set to the expected number of concurrent requests.
For example:

Figure 12–2 listener.ora File with Queue Size

LISTENER=
 (DESCRIPTION=
  (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=1521) (QUEUESIZE=20) ))

Note: The default number of concurrent connection requests is
system specific. Following are the defaults for Sun SPARC Solaris
and Windows NT:

■ Sun SPARC Solaris: 5

■ Windows NT 4.0 Workstation: 5

■ Windows NT 4.0 Server: 50
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Configuring Static Service Information
In order for the listener to accept client connect requests to an Oracle8 release 8.0 or
Oracle7 database, the listener.ora  file must be configured with information
about the database. Static configuration is also required for other services, such as
external procedures, Heterogeneous Services, and some management tools,
including Oracle Enterprise Manager.

For Oracle9i and Oracle8i databases, the listener uses the dynamic information
about the database and instance it has received through service registration before
using statically configured information.

Table 12–1 describes static service settings that you can set in the listener.ora
file.

Table 12–1 Service Settings in listener.ora

Oracle Net Manager
Field

listener.ora File
Parameter

Description

SID SID_NAME Use to specify the Oracle System Identifier (SID) of
the instance. You can obtain the SID value from the
INSTANCE_NAME parameter in the initialization
parameter file.

Global Database Name GLOBAL_DBNAME Use to specify the global database name of the service.
The global database name is comprised of the database
name and database domain name. You can obtain the
GLOBAL_DBNAME value from the SERVICE_NAMES
parameter, or from the DB_NAME and DB_DOMAIN
parameters in the initialization parameter file.

Oracle Home Directory ORACLE_HOME On UNIX, this setting is optional. Use it specify the
Oracle home location of the instance. Without this
setting, the listener assumes its Oracle home for the
instance.

On Windows NT, this settings is ignored. The Oracle
home specified by the ORACLE_HOME parameter in
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID
of the Windows NT registry is used.

Important: If you are using connect-time failover or Transparent
Application Failover (TAF), such as in an Oracle9i Real
Application Cluster environment, Oracle Corporation recommends
not setting the GLOBAL_DBNAME parameter.
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To statically configure the listener:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Local > Listeners.

3. Select a listener.

4. From the list in the right pane, select Database Services.

5. Click Add Database.

See Also:

■ Chapter 15, "Enabling Advanced Features for Oracle Net
Services" for more information about statically configuring the
listener for external procedures and Heterogeneous Services

■ Oracle Enterprise Manager Configuration Guide for further
information about Oracle Enterprise Manager

See Also: "Starting Oracle Net Manager" on page 5-3
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A new Database tab appears.

6. Enter the global database name, location of the Oracle home directory, and the
SID of the instance in the appropriate fields.

7. Choose File > Save Network Configuration.

For example, an excerpt of a listener.ora file statically configured for a database
service called sales.us.acme.com  looks like this:

SID_LIST_listener=
(SID_LIST=
 (SID_DESC=
  (GLOBAL_DBNAME=sales.us.acme.com)
  (SID_NAME=sales)
  (ORACLE_HOME=/u01/app/oracle/9i)))

See Also: Table 12–1 on page 12-10 for a description of the fields
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Configuring Password Authentication for the Listener

It is important to provide security through a password for the listener. With a
password, privileged operations, such as saving configuration changes or stopping
the listener, used from the Listener Control utility will require a password.

Use the Listener Control utility’s CHANGE_PASSWORD command or the Oracle Net
Manager to set or modify an encrypted password in the PASSWORDS_listener_
name parameter in the listener.ora  file. If the PASSWORDS_listener_name
parameter is set to an unencrypted password, you must manually remove it from
the listener.ora  file prior to modifying it. If the unencrypted password is not
removed, you will be unable to successfully set an encrypted password.

To set or modify an encrypted password with Oracle Net Manager:

1. In the navigator pane, expand Local > Listeners.

2. Select a listener.

3. From the list in the right pane, select General Parameters.

4. Select the Authentication tab.

5. Click Require a Password for Listener Operations.

6. Enter the password in the Password field, and re-enter it in the Confirm
Password field.

7. Choose File > Save Network Configuration.

To set a new encrypted password with the CHANGE_PASSWORD command, issues
the following commands from the Listener Control utility:

LSNRCTL>CHANGE_PASSWORD
Old password: <enter>
New password: password
Reenter new password: password
LSNRCTL>SAVE_CONFIG

Note: If you are administering the listener remotely over an
insecure network and require maximum security, configure the
listener with a secure protocol address that uses the TCP/IP with
SSL protocol. If the listener has multiple protocol addresses, ensure
that the TCP/IP with SSL protocol address is listed first in the
listener.ora  file.
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Bold denotes user input. The password is not displayed when entered.

To modify an encrypted password with the CHANGE_PASSWORD command:

LSNRCTL>CHANGE_PASSWORD
Old password: password
New password: password
Reenter new password: password
LSNRCTL>SAVE_CONFIG

Configuring Service Registration
Dynamic service registration is configured in the database initialization file. It does
not require any configuration in the listener.ora  file. However, listener
configuration must be synchronized with the information in the database
initialization file.

This section contains the following configuration topics related to service
registration:

■ Configuring Service Registration

■ Registering Information with the Default, Local Listener

■ Registering Information with a Nondefault Listener

■ Registering Information with a Remote Listener

■ Configuring a Naming Method

See Also: Oracle9i Net Services Reference Guide for further
information about the CHANGE_PASSWORD command
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Configuring Service Registration
To ensure service registration works properly, the initialization parameter file
should contain the following parameters:

■ SERVICE_NAMES for the database service name

■ INSTANCE_NAME for the instance name

For example:

SERVICE_NAMES=sales.us.acme.com
INSTANCE_NAME=sales

The SERVICE_NAMES defaults to the global database name, which is comprised of
the values from the DB_NAME and DB_DOMAIN parameters in the initialization
parameter file.

Registering Information with the Default, Local Listener
By default, the PMON process registers service information with its local listener on
the default local address of TCP/IP, port 1521. As long as the listener configuration
is synchronized with the database configuration, PMON can register service
information with a nondefault local listener or a remote listener on another node.
Synchronization is simply a matter of specifying the protocol address of the listener
in the listener.ora  file and the location of the listener in the initialization
parameter file.

Registering Information with a Nondefault Listener
If you want PMON to register with a local listener that does not use TCP/IP, port
1521, configure the LOCAL_LISTENER parameter in the initialization parameter file
to locate the local listener.

For a shared server environment, you can alternatively use the LISTENER attribute
of the DISPATCHERS parameter in the initialization parameter file to register the
dispatchers with a nondefault local listener. Because both the LOCAL_LISTENER
parameter and the LISTENER attribute enable PMON to register dispatcher
information with the listener, it is not necessary to specify both the parameter and
the attribute if the listener values are the same.

See Also: Oracle9i Database Reference for further information about
the SERVICE_NAMES and INSTANCE_NAME parameters
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Set the LOCAL_LISTENER parameter as follows:

LOCAL_LISTENER=listener_alias
Set the LISTENER attribute as follows:

DISPATCHERS="(PROTOCOL=tcp)(LISTENER=listener_alias )"

listener_alias  is then resolved to the listener protocol addresses through a
naming method, such as a tnsnames.ora  file on the database server.

For example, if the listener is configured to listen on port 1421 rather than port 1521,
you can set the LOCAL_LISTENER parameter in the initialization parameter file as
follows:

LOCAL_LISTENER=listener1

Using the same listener example, you can set the LISTENER attribute as follows:

DISPATCHERS="(PROTOCOL=tcp)(LISTENER=listener1)"

You can then resolve listener1  in the local tnsnames.ora  as follows:

listener1=
 (DESCRIPTION=
  (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=1421)))

Notes:

■ To dynamically update the LOCAL_LISTENER parameter, use
the SQL statement ALTER SYSTEM SET:

ALTER SYSTEM SET LOCAL_LISTENER=’listener_alias ’

If you set the parameter to null with the statement that follows,
then the default local address of TCP/IP, port 1521 is assumed.

ALTER SYSTEM SET LOCAL_LISTENER=’’

See the Oracle9i SQL Reference for further information about the
ALTER SYSTEM SET statement.

■ The LISTENER attribute overrides the LOCAL_LISTENER
parameter. As a result, the SQL statement ALTER SYSTEM SET
LOCAL_LISTENER does not affect the setting of this attribute.
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To register information with another local listener:

1. Configure the listener.ora  file with the protocol address of the local
listener.

2. Configure the LOCAL_LISTENER parameter in the initialization parameter file
to locate the local listener. If you are using shared server, you can also use the
LISTENER attribute of the DISPATCHERS parameter in the initialization
parameter file.

3. Resolve the listener name alias for the LOCAL_LISTENER or the LISTENER
setting through a tnsnames.ora  file or an Oracle Names server.

Registering Information with a Remote Listener
Registration to remote listeners, such as in the case of Oracle9i Real Application
Clusters, can be configured for shared server or dedicated server environments.

If you want PMON to register with a remote listener, configure the REMOTE_
LISTENER parameter in the initialization parameter file to locate the remote
listener.

For a shared server environment, you can alternatively use the LISTENER attribute
of the DISPATCHERS parameter in the initialization parameter file to register the
dispatchers with any listener. Because both the REMOTE_LISTENER parameter and
the LISTENER attribute enable PMON to register dispatcher information with the
listener, it is not necessary to specify both the parameter and the attribute if the
listener values are the same.

Set the REMOTE_LISTENER parameter as follows:

REMOTE_LISTENER=listener_alias

Set the LISTENER attribute as follows:

DISPATCHERS="(PROTOCOL=tcp)(LISTENER=listener_alias )"

listener_alias  is then resolved to the listener protocol addresses through a
naming method, such as a tnsnames.ora  file on the database server.

See Also: "Configuring Listening Protocol Addresses" on
page 12-6

See Also: "Configuring a Naming Method" on page 12-20
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For example, if separate listeners are configured to listen on port 1521 on servers
sales1-server  and sales2-server , you can set the REMOTE_LISTENER
parameter in the initialization file for the instance on host sales1-server  as
follows:

REMOTE_LISTENER=listener_sales2

You can set the REMOTE_LISTENER parameter in the initialization file for the
instance on host sales2-server  as follows:

REMOTE_LISTENER=listener_sales1

You can then resolve listener_sales2  in the local tnsnames.ora  on
sales1-server  as follows:

listener_sales2=
 (DESCRIPTION=
   (ADDRESS=(PROTOCOL=tcp)(HOST=sales2-server)(PORT=1521)))

Likewise, you can resolve listener_sales1  in the local tnsnames.ora  on
sales2-server  as follows:

listener_sales1=
 (DESCRIPTION=
   (ADDRESS=(PROTOCOL=tcp)(HOST=sales1-server)(PORT=1521)))

If shared server is configured, you can set the DISPATCHERS parameter in the
initialization parameter file as follows:

DISPATCHERS="(PROTOCOL=tcp)(LISTENER=listeners_sales)"

You can then resolve listener_sales  in the local tnsnames.ora  as follows:

listeners_sales=
 (DESCRIPTION=
   (ADDRESS=(PROTOCOL=tcp)(HOST=sales1-server)(PORT=1521))
   (ADDRESS=(PROTOCOL=tcp)(HOST=sales2-server)(PORT=1521)))
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To register information with remote listener:

1. Configure the listener.ora  file with the protocol addresses of the remote
listeners.

2. In a shared server environment, configure the LISTENER attribute of the
DISPATCHERS parameter or the REMOTE_LISTENER parameter in the
initialization parameter file. In a dedicated server environment, configure the
REMOTE_LISTENER parameter in the database initialization parameter file.

3. Resolve the listener name alias for the LISTENER or the REMOTE_LISTENER
setting through a tnsnames.ora  file or an Oracle Names server.

Notes:

■ To dynamically update the REMOTE_LISTENER parameter, use
the SQL statement ALTER SYSTEM SET:

ALTER SYSTEM SET REMOTE_LISTENER=’listener_alias ’

If you set the parameter to null with the statement that follows,
then PMON de-registers information with the remote listener
with which it had previously registered information.

ALTER SYSTEM SET REMOTE_LISTENER=’’

See the Oracle9i SQL Reference for further information about the
ALTER SYSTEM SET statement.

■ The LISTENER attribute overrides the REMOTE_LISTENER
parameter. As a result, the SQL statement ALTER SYSTEM SET
REMOTE_LISTENER does not affect the setting of this attribute.

See Also: "Configuring Listening Protocol Addresses" on
page 12-6

See Also: "Configuring a Naming Method"
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Configuring a Naming Method
The listener name alias specified for the LOCAL_LISTENER parameter, REMOTE_
LISTENER parameter, or LISTENER attribute can be resolved through one of the
following naming methods:

■ tnsnames.ora File

■ Oracle Names Server

tnsnames.ora File
A net service name entry should be created for the protocol address without the
CONNECT_DATA section of the connect descriptor. Oracle Net Manager does not
enable you to configure a tnsnames.ora  file without the CONNECT_DATA
information. Therefore, Oracle Corporation recommends that you manually modify
the tnsnames.ora  file.

For example, if LOCAL_LISTENER is set to listener1  and listener1  uses
TCP/IP on port 1421, the entry in the tnsnames.ora  file would be:

listener1=
  (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=1421))

Oracle Names Server
An entry for the listener alias name can be made to an Oracle Names server through
Oracle Net Manager:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Oracle Names Servers.

3. Select the Oracle Names server.

Note: Multiple addresses are supported, but connect-time failover
and client load balancing features are not supported.

See Also: Chapter 15, "Enabling Advanced Features for Oracle
Net Services" for further information about multiple address
configuration

See Also: "Starting Oracle Net Manager" on page 5-3
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4. From the list in the right pane, select Manage Data.

5. Click the Advanced tab.

6. Click Add, enter the listener alias name in the Name field, A.SMDrecord type in
the Type field, and enter the address in the Value field, for example:

(ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=2481))

7. Choose File > Save Network Configuration.

Listener Administration
Once the listener is configured, the listener can be administered with the Listener
Control utility. This section describes some of the common administrative tasks for
the listener, including the following topics:

■ Starting and Stopping the Listener

■ Monitoring Runtime Behavior

■ Monitoring Log Files

See Also: Oracle9i Net Services Reference Guide for a complete
listing of all the Listener Control utility commands and the Oracle
Net Manager online help contents
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Starting and Stopping the Listener

STOP Command
To stop the listener from the command line, enter:

lsnrctl STOP [ listener_name ]

where listener_name  is the name of the listener defined in the listener.ora
file. It is not necessary to identify the listener if you are using the default listener,
named LISTENER.

START Command
To start the listener from the command line, enter:

lsnrctl START [ listener_name ]

where listener_name  is the name of the listener defined in the listener.ora
file. It is not necessary to identify the listener if you are using the default listener,
named LISTENER.

In addition to starting the listener, the Listener Control utility verifies connectivity
to the listener.

Monitoring Runtime Behavior
The STATUS and SERVICES commands provide information about the listener.
When entering these commands, follow the syntax as shown for the STOP and
START commands.

STATUS Command
The STATUS command provides basic status information about a listener, including
a summary of listener configuration settings, the listening protocol addresses, and a
summary of services registered with the listener.

Note: You can also obtain the status of a listener through the
Oracle Enterprise Manager Console. See the Oracle Enterprise
Manager Administrator’s Guide for further information.
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The STATUS command generates output with the sections described in Table 12–2.

Table 12–2 Listener Control Utility STATUS Command

Output Section Description

STATUS of the LISTENER Specifies the following:

■ Name of the listener

■ Version of listener

■ Start time and up time

■ Tracing level

■ Logging and tracing configuration settings

■ listener.ora  file being used

■ Whether a password is set in listener.ora  file

■ Whether the listener can respond to queries from an
SNMP-based network management system

Listening Endpoints Summary Lists the protocol addresses the listener is configured to listen on

Services Summary Displays a summary of the services registered with the listener and
the service handlers allocated to each service

Service Identifies the registered service

Instance Specifies the name of the instance associated with the service along
with its status and number of service handlers associated with the
service

Status can be one of the following:

■ A READY status means that the instance can accept
connections.

■ A BLOCKED status means that the instance cannot accept
connections.

■ A READY/SECONDARY status means that this is a secondary
instance in an Oracle9i Real Application Clusters
primary/secondary configuration and is ready to accept
connections.

■ An UNKNOWN status means that the instance is registered
statically in the listener.ora  file rather than dynamically
with service registration. Therefore, the status is non known.
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Figure 12–3 shows example output of the STATUS command.

Figure 12–3 Listener Control Utility’s STATUS Command Output

Connecting to (DESCRIPTION=(ADDRESS=(PROTOCOL=ipc)(KEY=net)))
STATUS of the LISTENER
------------------------
Alias                     LISTENER
Version                   TNSLSNR for Solaris: Version 9.2.0.1.0 -
Development
Start Date                15-JAN-2002 20:22:00
Uptime                    0 days 0 hr. 5 min. 22 sec
Trace Level               support
Security                  OFF
SNMP                      OFF
Listener Parameter File   /oracle9i/admin/listener.ora
Listener Log File         /oracle9i/network/log/listener.log
Listener Trace File       /oracle9i/network/trace/listener.trc
Listening Endpoints Summary...
  (DESCRIPTION=(ADDRESS=(PROTOCOL=ipc)(KEY=net)))
  (DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=1521)))
  (DESCRIPTION=(ADDRESS=(PROTOCOL=tcps)(HOST=sales-server)(PORT=2484)))

Services Summary...
Service "sales.us.acme.com" has 1 instance(s).
  Instance "sales", status READY, has 3 handler(s) for this service...
Service "hr.us.acme.com" has 1 instance(s).
  Instance "hr", status READY, has 2 handler(s) for this service...
The command completed successfully
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SERVICES Command
The SERVICES command provides detailed information about the services and
instances registered and the service handlers allocated to each instance.

The SERVICES command generates output with the sections described in
Table 12–3.

Table 12–3 Listener Control Utility SERVICES Command

Output Section Description

Service Identifies the registered service

Instance Specifies the name of the instance associated with the service

The status field indicates if the instance is able to accept connections.

■ A READY status means that the instance can accept connections.

■ A BLOCKED status means that the instance cannot accept connections.

■ A READY/SECONDARYstatus means that this is a secondary instance in an
Oracle9i Real Application Cluster primary/secondary configuration and
is ready to accept connections.

■ An UNKNOWN status means that the instance is registered statically in the
listener.ora  file rather than dynamically with service registration.
Therefore, the status is non known.

 Handlers Identifies the name of the service handler. Dispatchers are named D000
through D999. Dedicated servers have a name of DEDICATED.

This section also identifies the following about the service handler:

■ established : The number of client connections this service handler has
established

■ refused : The number of client connections it has refused

■ current : The number of client connections it is handling, that is, its
current load

■ max: The maximum number of connections for the service handler, that is,
its maximum load

■ state : The state of the handler:

- A READY state means that the service handler can accept new
connections.

- A BLOCKED state means that the service handler cannot accept new
connections.

Following this, additional information about the service handler displays, such
as whether the service handler is a dispatcher, a local dedicated server, or a
remote dedicated server on another node.
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Figure 12–4 shows example output of the SERVICES command.

Figure 12–4 Listener Control Utility’s SERVICES Command Output

Connecting to (DESCRIPTION=(ADDRESS=(PROTOCOL=ipc)(KEY=net)))
Services Summary...
Service "sales.us.acme.com" has 1 instance(s).
  Instance "sales", status READY, has 3 handler(s) for this service...
    Handler(s):
      "DEDICATED" established:0 refused:0 state:ready
         LOCAL SERVER
      "D000" established:0 refused:0 current:0 max:10000 state:ready
         DISPATCHER <machine: sales-server, pid: 1689>
         (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=52414))
      "D001" established:0 refused:0 current:0 max:10000 state:ready
         DISPATCHER <machine: sales-server, pid: 1691>
         (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=52415))
Service "hr.us.acme.com" has 1 instance(s).
  Instance "hr", status READY, has 2 handler(s) for this service...
    Handler(s):
      "DEDICATED" established:0 refused:0 state:ready
         LOCAL SERVER
      "D000" established:0 refused:0 current:0 max:10000 state:ready
         DISPATCHER <machine: sales-server, pid: 11326>
         (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=58361))
The command completed successfully

This output shows that two database services, sales.us.acme.com  and
hr.us.acme.com , are registered with the listener.

Client connection requests to sales.us.acme.com  are handled by two
dispatchers named D000 and D001 and one dedicated server. All handlers have a
status of ready , indicating that they are ready to receive connections.

Client connection requests to hr.us.acme.com  are handled by one dispatcher
named D001 and one dedicated server.
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Monitoring Log Files
When you notice any of the following conditions, review and monitor the listener
log file for the following:

■ Long connection establishment times

■ Connectivity problems and refusals

■ Unexpected shutdown of the listener that could indicate a denial-of-service
attack

See Also: "Analyzing Listener Log Files" on page 17-33
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13
 Configuring Oracle Connection Manager

This chapter describes how to configure Oracle Connection Manager features.

This chapter contains these topics:

■ Oracle Connection Manager Configuration Overview

■ Configuring Oracle Connection Manager

■ Enabling Oracle Connection Manager Features

Note: Oracle Connection Manager is available for installation
with Oracle9i Enterprise Edition.

See Also:

■ Chapter 1, "Networking Challenges in the Internet Age" for an
introductory level overview of Oracle Connection Manager
concepts

■ Chapter 4, "Architecture of Oracle Net Services" for an
architectural overview of Oracle Connection Manager
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Oracle Connection Manager Configuration Overview
Oracle Connection Manager is a proxy server, an intermediate server that forwards
connection requests to the database server or to other proxy servers. It has three
primary functions:

■ Session multiplexing

■ Access control

■ Protocol conversion

Session multiplexing—You can quickly configure Oracle Connection Manager to
funnel multiple client sessions through a network connection to a shared server
destination.

Access control—You can use rule-based configuration to filter out certain client
requests and accept others.

Protocol conversion—Oracle Connection Manager accepts connection requests in
any protocol that Oracle supports.

Configuring Oracle Connection Manager
Configuring Oracle Connection Manager is a three-part process:

1. Configure the cman.ora file on the Oracle Connection Manager computer. This
file specifies listening endpoints for the server, the route path for Oracle
Connection Manager, access control rules, and Oracle Connection Manager
performance parameters.

2. Configure clients with the protocol addresses of Oracle Connection Manager
and the listener.

3. (Optional) Configure the database server for session multiplexing.

This section contains these topics:

■ Configuring the Oracle Connection Manager Computer

■ Configuring Clients for Oracle Connection Manager

■ Configuring the Oracle Database Server for Oracle Connection Manager
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Configuring the Oracle Connection Manager Computer

To configure the Oracle Connection Manager computer, you can define four types of
parameters in the cman.ora  file:

■ Listening endpoint list for the CMGW gateway process

■ Listening endpoint list for the CMADMIN administrative process

■ Access control rule list

■ Parameter list

The cman.ora file is located in the $ORACLE_HOME/network/admin directory on
UNIX and in the ORACLE_HOME\network\admin  directory on Windows NT.
Figure 13–1 shows an example cman.ora  file.

Figure 13–1 Example cman.ora File

CMAN=
  (ADDRESS=(PROTOCOL=tcp)(HOST=proxysvr)(PORT=1630))
  (ADDRESS=(PROTOCOL=tcps)(HOST=144.25.22.217)(PORT=2484))
CMAN_ADMIN=
  (ADDRESS=(PROTOCOL=tcp)(HOST=proxysvr)(PORT=1830))
CMAN_RULES=
  (RULE=(SRC=206.62.226.32/27)(DST=sales-server)(SRV=*)(ACT=accept)))
CMAN_PROFILE=
  (PARAMETER_LIST=
   (LOG_LEVEL=2)
   (TRACING=on))

Note: Oracle Net Manager does not support configuration of the
cman.ora  file, so changes must be made manually.
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Listening Endpoint Lists (CMAN and CMAN_ADMIN)
The listening endpoint list specifies protocol addresses for the gateway and
administrative processes. The gateway process, CMGW, uses the CMAN parameter
and the administrative process, CMADMIN, uses the CMAN_ADMIN parameter.

Both processes can be configured with multiple protocol addresses. In Figure 13–1
on page 13-3, the CMGW process has two protocol addresses. The first address
shown is the default listening protocol address of TCP/IP, port 1630:

(ADDRESS=(PROTOCOL=tcp)(HOST=proxysvr)(PORT=1630))

The second is the protocol address of Oracle Connection Manager if TCP/IP with
Secure Sockets Layer (SSL) is used:

(ADDRESS=(PROTOCOL=tcps)(HOST=144.25.22.217)(PORT=2484))

Access Control Rule List (CMAN_RULES)
The access control rule list specifies which connections are accepted, rejected, or
dropped.

(RULE=(SRC=206.62.226.32/27)(DST=sales-server)(SRV=*)(ACT=accept)

In the previous example, src=206.62.226.32/27  designates the IP address of
the client, or source. DST=sales-server  designates the destination host name.
The abbreviation ACT stands for "action"—that is, accept, reject, or drop.

Parameter List (CMAN_PROFILE)
The parameter list set attributes for an Oracle Connection Manager.

Note: Enter at least one rule; otherwise the default option "reject"
is overridden and all connections are accepted.

See Also: Oracle9i Net Services Reference Guide for a complete list
of parameters and their default and allowed values
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Configuring Clients for Oracle Connection Manager
To route clients to the database server through Oracle Connection Manager,
configure either the tnsnames.ora  file or the directory server with a connect
descriptor that specifies protocol addresses of Oracle Connection Manager and the
listener. Take note of the following:

■ If using Oracle Names servers, Oracle Connection Manager automatically
registers the protocol address for Oracle Connection Manager with the Oracle
Names server. In order for Oracle Names servers to send requests to Oracle
Connection Manager, USE_CMAN=true must be set in the sqlnet.ora  file on
computers where each Oracle Names server resides. To set this parameter,
follow the procedure in "Routing Connection Requests" on page 11-7.

■ If using a tnsnames.ora  file or a directory, the protocol addresses and the
SOURCE_ROUTE parameter must be set. To configure the local or directory
naming methods for Oracle Connection Manager, perform these tasks:

"Task 1: Configure an Oracle Connection Manager Protocol Address" on
page 13-5

"Task 2: Configure a Listener Protocol Address" on page 13-7

Task 1: Configure an Oracle Connection Manager Protocol Address
To configure a protocol address for Oracle Connection Manager:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Directory or Local > Service Naming.

3. Click plus (+) from the toolbar, or choose Edit > Create.

The Welcome page of the Net Service Name Wizard appears.

4. Enter any name in the Net Service Name field.

5. Click Next.

The Protocol Settings page appears.

6. Select the protocol on which Oracle Connection Manager is configured to listen
on. By default this protocol is TCP/IP.

7. Click Next.

See Also: "Starting Oracle Net Manager" on page 5-3
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The Protocol Settings page appears.

8. Enter the appropriate parameter information for the selected protocol in the
fields provided. If you are using TCP/IP, the default port to use is 1630.

9. Click Next.

The Service page appears.

10. Select a release and then enter the name of destination database service.

If the destination service is and Oracle9i or Oracle8i database, select Oracle8i or
later, and enter a service name in the Service Name field. If destination service
is an Oracle release 8.0 database, select Oracle8 or Previous, and enter an
Oracle System Identifier (SID) for an instance in the Database SID field.

11. Click Next.

12. Click Finish to save your configuration and dismiss Net Service Name Wizard.

The new net service name and the Oracle Connection Manager protocol address
is added to the Service Naming folder.

See Also: Oracle9i Net Services Reference Guide for protocol
parameter settings

See Also: "About Connect Descriptors" on page 9-2 for further
information about setting the service name string

Note: Do not click Test, because a connection cannot be tested at
this point.
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Task 2: Configure a Listener Protocol Address
After the Oracle Connection Manager protocol address is specified, create an
address for the listener, so that the Oracle Connection Manager can connect to the
server.

To configure the protocol address for the listener:

1. In the Oracle Net Manager, select the net service name that you created in "Task
1: Configure an Oracle Connection Manager Protocol Address" on page 13-5.

Notice that the Oracle Connection Manager protocol address is displayed in the
Address 1 tab:

2. In the Address Configuration box, click plus (+).

A new Address tab displays.
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3. Select a protocol configured for the listener, and then enter the appropriate
parameter information for that protocol. If you are using TCP/IP, the default
port number to use is 1521:

4. In the Address Configuration box, click Advanced.

See Also: Oracle9i Net Services Reference Guide for further
information about protocol addresses and parameters
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The Address List Options dialog box appears:

5. Select Use each address in order until destination reached, and then click OK.

This option sets SOURCE_ROUTE=on. It tells the client to connect to the first
protocol address, the Oracle Connection Manager, and from the first protocol
address to the second protocol address, the listener.

6. Choose File > Save Network Configuration.

Note: If you specify the addresses of two or more Oracle
Connection Managers in the connect descriptor, you can manually
include parameters for load balancing and connect-time failover.
See Oracle9i Net Services Reference Guide for examples of how to
configure multiple listeners for load balancing and failover.



Configuring Oracle Connection Manager

13-10 Oracle9i Net Services Administrator’s Guide

Figure 13–2 shows a comparison of a typical tnsnames.ora  file and a
tnsnames.ora  file with an entry to use Oracle Connection Manager. Oracle
Connection Manager entries are shown in boldface text.

Figure 13–2 tnsnames.ora File with and without Oracle Connection Manager

sales=
   (DESCRIPTION=
      (ADDRESS=
         (PROTOCOL=tcp)
         (HOST=sales-server)
         (PORT=1521))
      (CONNECT_DATA=
             (SERVICE_NAME=sales.us.acme.com)))

sales=
   (DESCRIPTION=

(SOURCE_ROUTE=yes)
(ADDRESS=

(PROTOCOL=tcp)
(HOST=cman-server)
(PORT=1630))

      (ADDRESS=
         (PROTOCOL=tcp)
         (HOST=sales-server)
         (PORT=1521))
      (CONNECT_DATA=
         (SERVICE_NAME=sales.us.acme.com)))

tnsnames.ora File Element Description

SOURCE_ROUTE=yes This entry creates a source route of protocol
addresses through an Oracle Connection Manager
to the destination database.

(ADDRESS=
   (PROTOCOL=tcp)
   (HOST=cman-server)
   (PORT=1630))
(ADDRESS=
   (PROTOCOL=tcp)
   (HOST=sales-server)
   (PORT=1521))

The first protocol address enables the client to
connect to Oracle Connection Manager. From
here, the Oracle Connection Manager connects to
the database service through a second protocol
address.
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Figure 13–3 depicts a client using TCP/IP to connect to Oracle Connection Manager,
and Oracle Connection Manager using TCP/IP with SSL to connect to a database
server.

Figure 13–3 tnsnames.ora File Configured for Protocol Conversion Support

sales=
   (DESCRIPTION=

(SOURCE_ROUTE=yes)
(ADDRESS=

(PROTOCOL=tcp)
(HOST=cman-server)
(PORT=1521))

      (ADDRESS=
            (PROTOCOL=tcps)
            (HOST=sales-server)
            (PORT=1521))
      (CONNECT_DATA=
            (SERVICE_NAME=sales.com)))
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Configuring the Oracle Database Server for Oracle Connection Manager
Configuring the database server involves optionally configuring the server for
session multiplexing.

To enable Connection Manager to take advantage of session multiplexing, set the
DISPATCHERS parameter in the initialization parameter file with the attributes
PROTOCOL and MULTIPLEX.

DISPATCHERS="(PROTOCOL=tcp)(MULTIPLEX=on)"

Enabling Oracle Connection Manager Features
This section contains these topics:

■ Enabling Session Multiplexing

■ Enabling Access Control

■ Enabling Protocol Conversion Support

The first feature is enabled using the parameter DISPATCHERS in the initialization
parameter file, the second and third using the parameters RULE_LIST and CMAN
parameters in the cman.ora  file.

See Also:

■ "Enabling Session Multiplexing" on page 13-10 for
configuration details.

■ Chapter 14, "Configuring Shared Server" for more information
about configuring shared server.



Enabling Oracle Connection Manager Features

Configuring Oracle Connection Manager 13-13

Enabling Session Multiplexing
Once the attributes PROTOCOL and MULTIPLEX have been added to the parameter
DISPATCHERS in the initialization parameter file, enabling session multiplexing is
simply a matter of ensuring that MULTIPLEX is set to on  or to an equivalent value.

You can set different levels of multiplexing, as the Table 13–1 shows.

Table 13–1 Session Multiplexing Levels

See Also: "Enabling Session Multiplexing" on page 13-13

Attribute Description

PROTOCOL (PRO or
PROT)

The network protocol for which the dispatcher generates a
listening endpoint.

MULTIPLEX (MUL or
MULT)

Used to enable session multiplexing

If 1, on , yes , true , or both  is specified, then multiplexing is
enabled for both incoming and outgoing network sessions.

If in  is specified, then multiplexing is enabled for incoming
network sessions from the client.

If out  is specified, then multiplexing is enabled for outgoing
network sessions.

If 0, no , off , or false  is specified, then multiplexing is
disabled for both incoming and outgoing network sessions.

Note: You can configure the DISPATCHERS parameter using the
Database Configuration Assistant.
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Enabling Access Control
Oracle Connection Manager includes a feature that enables you to control client
access to designated database servers in a TCP/IP environment. By specifying
certain filtering rules, you can allow or restrict specific clients access to a database
server.

To configure access control:

1. Manually create a cman.ora  file, if one does not already exist.

2. Add the parameter CMAN_RULES with the following subparameters:

     (CMAN_RULES=
       (RULE_LIST=
        (RULE=(SRC= source_host )
              (DST= destination_host )
              (SRV= service )
              (ACT=accept | reject | drop))))

3. Add the following parameters for each rule described in Table 13–2 as needed.

Table 13–2 Per-Rule Parameters

You can define multiple rules in the RULE_LIST. The action (ACT) in the first
matched RULE is applied to the connection request. If no rules are defined, all
connections are accepted.

Parameter Description

SRC Specify the source host name or IP address of the client.

DST Specify the destination host name or IP address of the
database server.

SRV Specify the service name of the Oracle9i or Oracle8i
database (obtained from the SERVICE_NAME parameter in
the initialization parameter file) or SID value of the
pre-release 8.1 database (obtained from the ORACLE_SID
environment variable or registry value).

ACT Specify to accept, reject, or drop incoming requests based on
the preceding three parameters.

See Also: Oracle9i Net Services Reference Guide for default values
and allowed values of Oracle Connection Manager parameters
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In the following example, client computer client1-pc  is denied access to the
service sales.us.acme.com , but client 144.25.23.45  is granted access to the
service db1 .

(RULE_LIST=
  (RULE=(SRC=client1-pc)(DST=sales-server)(SRV=sales.us.acme.com)(ACT= reject ))
  (RULE=(SRC=144.25.23.45)(DST=144.25.187.200)(SRV=db1)(ACT= accept )))

Enabling Protocol Conversion Support
Oracle Connection Manager provides support for protocol conversion, enabling
clients and a database server configured with different network protocols to
communicate with each other. An Oracle Connection Manager can listen on any
protocol that Oracle supports.

Without this kind of support, a client that uses Named Pipes cannot connect to a
database server that uses TCP/IP. If Oracle Connection Manager is configured for
TCP/IP, the client can connect to Oracle Connection Manager using Named Pipes,
and Oracle Connection Manager can connect to the database server using TCP/IP.

As the following example shows, the cman.ora must be configured with a protocol
address for each protocol that the client uses. Sample addresses for three protocols
are shown—TCP/IP, Named Pipes, and TCP/IP with SSL.

(CMAN=
  (ADDRESS=(PROTOCOL=tcp)(HOST=proxysvr1)(PORT=1630)))
  (ADDRESS=(PROTOCOL=nmp)(SERVER=proxysvr_pc)(PIPE=cmanpipe)))
  (ADDRESS=(PROTOCOL=tcps)(HOST=144.25.22.217)(PORT=2484)))

By default, Oracle Connection Manager accepts client connection requests at the
following default protocol address:

CMAN=(ADDRESS=(PROTOCOL=tcp)(HOST=anyhost )(PORT=1630))

To configure protocol conversion:

1. Manually create a cman.ora  file, if one does not already exist.

2. Add protocol addresses for each of the protocols that the client uses in the CMAN
parameter:

CMAN=
 (ADDRESS=( protocol_address_information ))
 (ADDRESS=( protocol_address_information ))

See Also: Oracle9i Net Services Reference Guide for further
information about protocol addresses and parameters
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14
Configuring Shared Server

The shared server architecture enables a database server to allow many user
processes to share very few server processes, so the number of users that can be
supported is increased. With shared server, many user processes connect to a
dispatcher. The dispatcher directs multiple incoming network session requests to a
common queue. An idle shared server process from a shared pool of server
processes picks up a request from the queue. This means a small pool of server
processes can serve a large number of clients.

This chapter describes how to configure shared server. It contains these topics:

■ Configuring Shared Server with the DISPATCHERS Parameter

■ Enabling Connection Pooling

■ Allocating Resources

■ Using Shared Server on Clients

■ Overriding Shared Server on Clients

See Also:

■ Oracle9i Database Administrator’s Guide for further information
about shared server configuration

■ Oracle9i Database Performance Tuning Guide and Reference for
further information about tuning shared server parameters
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Configuring Shared Server with the DISPATCHERS Parameter
To enable a shared server configuration, set the DISPATCHERS parameter in the
database initialization parameter file.

After setting this parameter, restart the instance to enable shared server
configuration. Set DISPATCHERS as follows:

DISPATCHERS="(attribute =value )"

One of the following attributes is required to enable shared server:

■ ADDRESS (ADD or ADDR)

■ DESCRIPTION (DES or DESC)

■ PROTOCOL (PRO or PROT)

Table 14–1 Required Attributes of the DISPATCHERS Parameter

Note: Database Configuration Assistant enables you to configure
this parameter.

Attribute Description

ADDRESS (ADD or ADDR) Specify the network protocol address of the endpoint on which
the dispatchers listen.

DESCRIPTION (DES or
DESC)

Specify the network description of the endpoint on which the
dispatchers listen, including the network protocol address. The
syntax is as follows:

(DESCRIPTION=(ADDRESS=...))

PROTOCOL (PRO or
PROT)

Specify the network protocol for which the dispatcher generates
a listening endpoint. For example:

(PROTOCOL=tcp)

See Also: Oracle9i Net Services Reference Guide for further
information about protocol address syntax
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The following attributes are optional:

■ CONNECTIONS (CON or CONN)

■ DISPATCHERS (DIS or DISP)

■ LISTENER (LIS or LIST)

■ MULTIPLEX (MUL or MULT)

■ POOL (POO)

■ SERVICE (SER or SERV)

■ SESSIONS (SES or SESS)

■ TICKS (TIC or TICK)

Table 14–2 Optional Attributes of the DISPATCHERS Parameter

Attribute Description

CONNECTIONS (CON or
CONN)

Specify the maximum number of network connections to allow
for each dispatcher.

The default is operating system specific. For example, 1024 is the
default for Sun SPARC Solaris and Windows NT.

DISPATCHERS (DIS  or
DISP)

Specify the initial number of dispatchers to start. The default is
1.
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LISTENER (LIS  or
LIST )

Specify an alias name for the listeners with which the PMON
process registers dispatcher information. Set the alias to a name
which is resolved through a naming method.

The LISTENER attribute overrides the LOCAL_LISTENER and
REMOTE_LISTENER initialization parameters. The LISTENER
attribute only needs to be specified if its value is different from
the values specified by the LOCAL_LISTENER and REMOTE_
LISTENER parameters. Note that the LOCAL_LISTENER
parameter has a default value of TCP/IP, port 1521.

See Also: "Configuring Service Registration" on page 12-14 for
further information about the LOCAL_LISTENER and REMOTE_
LISTENER parameters

Important: Resolve the listener alias through a naming method,
such as a tnsnames.ora  file on the database server or an
Oracle Names server.

For example, if the listener alias name is listener_sales with
two listening endpoints of port 1521, and the chosen naming
method is the local naming method, the entry in the
tnsnames.ora  file would look like the following:

listener_sales=
(DESCRIPTION=
   (ADDRESS=(PROTOCOL=tcp)(HOST=sales1-server)(PORT=1521))
   (ADDRESS=(PROTOCOL=tcp)(HOST=sales2-server)(PORT=1521)))

MULTIPLEX (MUL or
MULT)

Use to enable the Oracle Connection Manager session
multiplexing feature.

If 1, on , yes , true , or both  is specified, then session
multiplexing is enabled for both incoming and outgoing
network sessions.

If in  is specified, then session multiplexing is enabled for
incoming network sessions from clients.

If out  is specified, then session multiplexing is enabled for
outgoing network sessions.

If 0, no , off , or false  is specified, then session multiplexing is
disabled for both incoming and outgoing network connections.

See Also: "Enabling Session Multiplexing" on page 13-13

Attribute Description
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POOL (POO) Use to enable connection pooling.

If a number is specified, enables connection pooling for both
incoming and outgoing idle network connections. The number
specified is the timeout in ticks for both incoming and outgoing
idle network connections.

If on , yes , true , or both  is specified, enables connection
pooling for both incoming and outgoing idle network
connections. A default timeout of 10 ticks is used for both
incoming and outgoing idle network connections.

If in  is specified, connection pooling is enabled for incoming
idle network connections and the default timeout of 10 ticks is
used for incoming idle network connections. in  can also be
assigned a timeout in ticks value, such as (in=20 ). If the
numeric value of a specified timeout is 0 or 1, then the default
value of 10 ticks is used.

If out  is specified, connection pooling is enabled for outgoing
idle network connections and the default timeout of 10 ticks is
used for outgoing network connections. out  can also be
assigned a timeout in ticks value, such as (out=20 ). If the
numeric value of a specified timeout is 0 or 1, then the default
value of 10 ticks is used.

If no , off , or false  is specified, then connection pooling is
disabled for both incoming and outgoing network connections.

See Also:

■ "Connection Pooling" on page 1-14

■ "Enabling Connection Pooling" on page 14-8

■ TICKS (TIC or TICK)  attribute

SERVICE (SER or SERV) Specify the service names the dispatchers register with the
listeners. If no values are specified, then service names specified
with the SERVICE_NAMES initialization parameter are used.

SESSIONS (SES or
SESS)

Specify the maximum number of network sessions to allow for
each dispatcher.

The default is operating system specific. Most operating systems
have a default of 16 KB.

Attribute Description
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Setting the Initial Number of Dispatchers
The number of dispatchers started at instance startup is controlled by the
DISPATCHERS attribute.

The appropriate number of dispatchers for each instance depends upon the
performance you want from your database, the host operating system limit on the
number of connections for each process, which is operating system dependent, and
the number of connections required for each network protocol.

Calculating the Initial Number of Dispatchers
Once you know the number of possible connections for each process for the
operating system, calculate the initial number of dispatchers to create during
instance startup, for each network protocol, using the following formula.

number                 maximum number of concurrent sessions
of           = CEIL   (—————————————————————————————————————)
dispatchers                connections for each dispatcher

CEIL represents the number roundest to the next highest whole integer.

TICKS (TIC  or TICK ) Specify the length of a network tick in seconds. A tick is the
amount of time it takes for a message to be sent and processed
from the client to the database server or from the database
server to the client. The value set is multiplied with the POOL
timeout value to get the total connection pool timeout.

The default is 15 seconds. For a fast network, Oracle
Corporation recommends a tick size of ~1 second. For a slow
network, Oracle Corporation recommends a tick size of ~3-4
seconds.

Note: Unlike the number of shared server processes, the number
of dispatchers does not change automatically. The number of
dispatchers can be explicitly changed with the SQL statement
ALTER SYSTEM. You can change the number of dispatchers in this
manner up to a maximum limit specified by the MAX_
DISPATCHERSparameter. See the Oracle9i SQL Reference for further
information about the ALTER SYSTEM statement and the Oracle9i
Database Performance Tuning Guide and Reference for further
information about the DISPATCHERS parameter.

Attribute Description
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Example: Initial Number of Dispatchers
Assume a system that has:

■ 4000 users concurrently connected through TCP/IP and supports 1,000
connections for each process

■ 2,500 sessions concurrently connected through TCP/IP with SSL and supports
1,000 connections for each process

In this case, the DISPATCHERS attribute for TCP/IP should be set to a minimum of
four dispatchers and TCP/IP with SSL should be set to a minimum of three
dispatchers:

DISPATCHERS="(PROTOCOL=tcp)(DISPATCHERS=4)(CONNECTIONS=1000)"
DISPATCHERS="(PROTOCOL=tcps)(DISPATCHERS=4)(CONNECTIONS=1000)""

Depending on performance, you may need to adjust the number of dispatchers.

Example: Dispatcher Address with IP Address
To force the IP address used for the dispatchers, set the following:

DISPATCHERS="(ADDRESS=(PROTOCOL=tcp)(HOST=144.25.16.201))
(DISPATCHERS=2)"

This starts two dispatchers that listen on host 144.25.16.201. Note that Oracle Net
dynamically selects the TCP/IP port for the dispatcher.
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Example: Dispatcher Address with PORT
To force the exact location of the dispatchers, add the PORT as follows:

DISPATCHERS="(ADDRESS=(PROTOCOL=tcp)
(HOST=144.25.16.201)(PORT=5000))(DISPATCHERS=1)"
DISPATCHERS="(ADDRESS=(PROTOCOL=tcp)
(HOST=144.25.16.201)(PORT=5001))(DISPATCHERS=1)"

Enabling Connection Pooling
Connection pooling is a resource utilization feature that enables you to reduce the
number of physical network connections to a dispatcher. This is achieved by
sharing or pooling a set of connections among the client processes.

To configure connection pooling, set the DISPATCHERS parameter in the
initialization parameter file with the POOL attribute and the following optional
attributes:

■ CONNECTIONS (CON or CONN)

■ SESSIONS (SES or SESS)

■ TICKS (TIC or TICK)

Refer to the example in "Example: Initial Number of Dispatchers" on page 14-7.
Connection pooling can allow each dispatcher 1,000 connections and 4,000 sessions
for TCP/IP and 2,500 sessions for TCP/IP with SSL. This reduces the configuration
to one dispatcher for each protocol, as shown in the following:

DISPATCHERS="(PROTOCOL=tcp)(DISPATCHERS=1)(POOL=on)(TICK=1)
(CONNECTIONS=1000)(SESSIONS=4000)"

DISPATCHERS="(PROTOCOL=tcps)(DISPATCHERS=1)(POOL=on)(TICK=1)
(CONNECTIONS=1000)(SESSIONS=2500)"

Note: You can specify multiple DISPATCHERS in the initialization
file, but they must be adjacent to each other.

See Also: "Connection Pooling" on page 1-14
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Allocating Resources
An Oracle database can be represented by multiple service names. Because of this, a
pool of dispatchers can be allocated exclusively for clients requesting a particular
service. This way, the mission critical requests may be given more resources and,
thus, in effect increase their priority.

For example, the following initialization parameter file sample shows two
dispatchers. The first dispatcher services requests for clients requesting
sales.us.acme.com.  The other dispatcher services requests only for clients
requesting adminsales.us.acme.com .

SERVICE_NAMES=sales.us.acme.com
INSTANCE_NAME=sales
DISPATCHERS="(PROTOCOL=tcp)"
DISPATCHERS="(PROTOCOL=tcp)(SERVICE=adminsales.us.acme.com)"

Using Shared Server on Clients
If shared server is configured and a client connection request arrives when no
dispatchers are registered, the requests can be handled by a dedicated server
process (configured in the listener.ora  file). If you want a particular client
always to use a dispatcher, configure (SERVER=shared)  in the connect data
portion of the connect descriptor. For example:

sales=
(DESCRIPTION=
  (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=1521))
  (CONNECT_DATA=
     (SERVICE_NAME=sales.us.acme.com)

(SERVER=shared) ))

If a dispatcher is not available, the client connection request is rejected.

See Also: "Configuring Advanced Connect Data Parameters" on
page 15-7 to set the SERVER parameter
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Overriding Shared Server on Clients
If the database is configured for shared server and a particular client requires a
dedicated server, you can configure the client to use a dedicated server in one of the
following ways:

■ A net service name can be configured with a connect descriptor that contains
(SERVER=dedicated)  in the CONNECT_DATA section. For example:

sales=
(DESCRIPTION=
  (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=1521))

(CONNECT_DATA=
     (SERVICE_NAME=sales.us.acme.com)

(SERVER=dedicated) ))

■ The client profile (sqlnet.ora  file) can be configured with USE_DEDICATED_
SERVER=on. This adds (SERVER=dedicated)  to the CONNECT_DATA section
of the connect descriptor the client uses.

Note: If USE_DEDICATED_SERVER is set to on , then existing
(SERVER=value )  entries in connect descriptors are overwritten
with (SERVER=dedicated) .

See Also:

■ "Configuring Advanced Connect Data Parameters" on
page 15-7 to set the SERVER parameter

■ "Routing Connection Requests" on page 11-7 to set the USE_
DEDICATED_SERVER parameter
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15
Enabling Advanced Features for Oracle Net

Services

This chapter describes how to configure advanced features of Oracle Net Services,
including advanced connect data parameters, load balancing, failover, and
connections to non-database services.

This chapter contains these topics:

■ Configuring Advanced Network Address and Connect Data Information

■ Configuring Connection Load Balancing

■ Configuring Transparent Application Failover

■ Configuring Session Data Unit

■ Configuring Connections to Non-Oracle Database Services
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Configuring Advanced Network Address and Connect Data Information
This section contains the following advanced connect descriptor topics:

■ Creating a List of Listener Protocol Addresses

■ Configuring Address List Parameters

■ Configuring Advanced Connect Data Parameters

Creating a List of Listener Protocol Addresses
A database service may be accessed by more than one network route, or protocol
address. In the following example, sales.us.acme.com  can connect to
sales.us.acme.com  using listeners on either sales1-server  or
sales2-server .

sales.us.acme.com=
 (DESCRIPTION=

(ADDRESS_LIST=
(ADDRESS=(PROTOCOL=tcp)(HOST=sales1-server)(PORT=1521) )
(ADDRESS=(PROTOCOL=tcp)(HOST=sales2-server)(PORT=1521) ))

  (CONNECT_DATA=
    (SERVICE_NAME=sales.us.acme.com)))

To add a network protocol address to an existing net service name or database
service:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Directory or Local > Service Naming.

3. Select either a net service name or a database service.

The right pane displays the current destination service and address list.

4. In the Address Configuration box, click plus (+).

See Also: "Starting Oracle Net Manager" on page 5-3
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A new Address tab appears:

5. Select the protocol and enter appropriate address information.

6. Order the protocol addresses according to where they should be in the protocol
address list with the left-arrow and right-arrow buttons. Unless multiple
address options are configured, the first address in the list is contacted.

7. If you are making these changes to the Local folder, choose File > Save
Network Configuration.

See Also: Oracle9i Net Services Reference Guide for details about
protocol address parameters

See Also: "Configuring Address List Parameters" on page 15-4 for
address list options
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Configuring Address List Parameters
When a database service is accessible by multiple listener protocol addresses,
specify the order in which the addresses are to be used. The addresses can be
chosen randomly or tried sequentially.

When multiple protocol addresses have been configured for a net service name or
database service, you can configure the parameters described in Table 15–1.

Table 15–1 Address List Parameters

Parameter Description

SOURCE_ROUTE
(Source Routing)

When set to on , instructs Oracle Net to use each address in the
order presented until the destination reached. This parameter is
required when reaching the destination requires more than one
address stop. This parameter is used to enable connections to
Oracle Connection Manager.

See Also: "Configuring Clients for Oracle Connection Manager"
on page 13-6

FAILOVER
(Connect-Time
Failover)

At connect time, instructs Oracle Net to fail over to a different
listener if the first listener fails when set to on . The number of
addresses in the list determines how many addresses are tried.
When set to off , instructs Oracle Net to try one address.
Connect-time failover is turned on  by default for multiple
address lists (ADDRESS_LIST), connect descriptors
(DESCRIPTION), and multiple connect descriptors
(DESCRIPTION_LIST).
Important: Oracle Corporation recommends not setting the
GLOBAL_DBNAME parameter in the SID_LIST_ listener_name
section of the listener.ora  file. A statically configured global
database name disables connect-time failover.

LOAD_BALANCE(Client
Load Balancing)

When set to on , instructs Oracle Net to progress through the list
of protocol addresses in a random sequence, balancing the load
on the various listeners. When set to off , instructs Oracle Net to
try the addresses sequentially until one succeeds.

Client load balancing is turned on  by default for multiple
connect descriptors (DESCRIPTION_LIST).

Note: It is not possible to set client load balancing or connect-time failover
with source routing. While connect-time failover and client load balancing
select an address from a list, source routing connects to each address in the
list sequentially.
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Implementation of these parameter depends on the naming method used.
Table 15–2 describes the tools to configure connect-time failover or client load
balancing. Source routing involves other configuration that goes beyond the scope
of this section.

Table 15–2 Address List Configuration for Naming Method Types

To configure connect-time failover or client load balancing:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Directory or Local > Service Naming.

3. Select either a net service name or a database service.

The right pane displays the current destination service and address list.

4. In the Address Configuration box, click Advanced.

See Also: "Configuring Clients for Oracle Connection Manager"
on page 13-5 for more information about configuring clients for
source routing

Naming Method Tool to Configure Address List Options

Local Naming Use Oracle Net Manager.

See Also: The procedure that follows

Directory Naming Use Oracle Net Manager.

See Also: The procedure that follows

Oracle Names Use either the Oracle Names Control utility’s REGISTER
command or Oracle Net Manager.

See Also: "Task 7: Register Data with the Oracle Names Server"
on page 9-46

See Also: "Starting Oracle Net Manager" on page 5-3
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The Address List Options dialog box appears:

Table 15–3 describes the Address List Options dialog box options.

Table 15–3 Address List Options Dialog Box

5. Select one of the address list options, and then click OK.

6. If you are making these changes to the Local folder, choose File > Save
Network Configuration.

Option Parameter Setting

Try each address, in order, until one
succeeds

For release 8.1 and 9i clients,
FAILOVER=on

For pre-release 8.1 clients, SOURCE_
ROUTE=off

Try each address, randomly, until one
succeeds

Note: This option is not enabled if Use
Options Compatible with Net8 8.0 Clients is
selected.

LOAD_BALANCE=on

FAILOVER=on

Try one address, selected at random

Note: This option is not enabled if Use
Options Compatible with Net8 8.0 Clients is
selected.

LOAD_BALANCE=on

Use each address in order until destination
reached

SOURCE_ROUTE=on

Use only the first address

Note: This option is not enabled if Use
Options Compatible with Net8 8.0 Clients is
selected.

LOAD_BALANCE=off

FAILOVER=off

SOURCE_ROUTE=off
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The following example shows a tnsnames.ora  file configured for client load
balancing:

sales.us.acme.com=
 (DESCRIPTION=
  (ADDRESS_LIST=

(LOAD_BALANCE=on)
   (ADDRESS=(PROTOCOL=tcp)(HOST=sales1-server)(PORT=1521))
   (ADDRESS=(PROTOCOL=tcp)(HOST=sales2-server)(PORT=1521)))
  (CONNECT_DATA=
    (SERVICE_NAME=sales.us.acme.com)))

The following example shows a tnsnames.ora  file configured for connect-time
failover:

sales.us.acme.com=
 (DESCRIPTION=
  (ADDRESS_LIST=

(LOAD_BALANCE=off)
(FAILOVER=ON)

   (ADDRESS=(PROTOCOL=tcp)(HOST=sales1-server)(PORT=1521))
   (ADDRESS=(PROTOCOL=tcp)(HOST=sales2-server)(PORT=1521)))
  (CONNECT_DATA=(SERVICE_NAME=sales.us.acme.com)))

Configuring Advanced Connect Data Parameters
The CONNECT_DATAsection of a connect descriptor defines the destination database
service. In the following example, SERVICE_NAME defines a service called
sales.us.acme.com :

sales.us.acme.com=
 (DESCRIPTION=
   (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=1521))

(CONNECT_DATA=
    (SERVICE_NAME=sales.us.acme.com) ))
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Besides the service name, you can optionally configure the connect data information
with the parameters described in Table 15–4.

Table 15–4 Advanced Connect Data Settings

Oracle Net Manager
Field/Option

tnsnames.ora File
Parameter

Description

Instance Name INSTANCE_NAME Use to identify the database instance to access.

The instance name can be obtained from the INSTANCE_NAME
parameter in the initialization parameter file.

Note: This parameter is not enabled if Use Oracle8i Release 8.0
Compatible Identification is checked.

See Also: "About Connect Descriptors" on page 9-2

Session Data Unit
Size

SDU To optimize the transfer rate of data packets being sent across
the network, you can specify the session data unit (SDU) size
to change the performance characteristics having to do with the
packets sent across the network.

See Also: "Configuring Session Data Unit" on page 15-28

Use for
Heterogeneous
Services

HS If you want an Oracle database server to access a non-Oracle
system through Heterogeneous Services, turn this option on.

See Also: "Configuring Oracle Net Services for Oracle
Heterogeneous Services" on page 15-37

Oracle Rdb Settings

Oracle RDB
Database

RDB_DATABASE Specify the file name of the Oracle Rdb database.

See Also: "Configuring Oracle Net Services for an Oracle Rdb
Database" on page 15-40

Type of Service TYPE_OF_SERVICE Specify the type of service to use for the Oracle Rdb database.

See Also: "Configuring Oracle Net Services for an Oracle Rdb
Database" on page 15-40

Global Database
Name

GLOBAL_NAME Use to identify an Oracle Rdb database.

See Also: "Configuring Oracle Net Services for an Oracle Rdb
Database" on page 15-40
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Implementation of these parameter depends on the naming method used.
Table 15–5 describes the tools to configure connect-time failover or client load
balancing. Source routing involves other configuration that goes beyond the scope
of this section.

Table 15–5 Connect Data Configuration for Naming Method Types

To configure advanced CONNECT_DATA parameters for either a net service name or
a database service:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Directory or Local > Service Naming.

3. Select either a net service name or a database service.

The right pane displays the current destination service and address list.

4. In the Service Identification box, click Advanced.

See Also: "Configuring Clients for Oracle Connection Manager"
on page 13-5 for more information about configuring clients for
source routing

Naming Method Tool to Configure Multiple Address Options

Local Naming Use Oracle Net Manager.

See Also: The procedure that follows

Directory Naming Use Oracle Net Manager.

See Also: The procedure that follows

Oracle Names Use either the Oracle Names Control utility’s REGISTER
command or Oracle Net Manager.

See Also: "Task 7: Register Data with the Oracle Names Server"
on page 9-46

See Also: "Starting Oracle Net Manager" on page 5-3
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The Advanced Service Options dialog box appears:

5. Enter fields or select options as appropriate, and then click OK.

6. If you are making these changes to the Local folder, choose File > Save
Network Configuration.

Configuring Connection Load Balancing
The connection load balancing feature improves connection performance by
balancing the number of active connections among multiple dispatchers. In an
Oracle9i Real Application Clusters environment, connection load balancing also
has the capability to balance the number of active connections among multiple
instances.

Because the PMON process can register with remote listeners, a listener can always
be aware of all instances and dispatchers, regardless of their location. Depending on
the load information, a listener decides which instance and, if shared server is
configured, which dispatcher to send the incoming client request to.

In a shared server configuration, a listener selects a dispatcher in the following
order: 1) least loaded node, 2) least loaded instance, and 3) least loaded dispatcher
for that instance. In a dedicated server configuration, a listener selects an instance
in the following order: 1) least loaded node, and 2) least loaded instance.

If a database service has multiple instances on multiple nodes, the listener selects
the least loaded instance on the least loaded node. If shared server is configured,
then the least loaded dispatcher of the selected instance is chosen.

See Also: Table 15–4 on page 15-8 for a description of the fields
and options
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To enable connection load balancing, the initialization parameter file must contain
the following parameters:

■ SERVICE_NAMES for the database service name

■ INSTANCE_NAME for instance name

■ DISPATCHERS to enable shared server configuration and specify the
dispatchers used by the instance

An Oracle9i Real Application Clusters environment requires that the dispatchers on
each instance be cross registered with the other listeners on the other nodes. This is
achieved by the use of the LISTENER attribute of the DISPATCHERS parameter.

See Also:

■ "Registering Information with a Remote Listener" on
page 12-17 for complete information about cross registration

■ Oracle9i Database Reference for complete information about the
SERVICE_NAMES and INSTANCE_NAME parameters

■ Chapter 14, "Configuring Shared Server" for complete
information about the LISTENER attribute

Note: For optimum connection load balancing results, the
instances that belong to the same database service should be on
equivalent hardware and software configurations.
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Example: Connection Load Balancing for Shared Server Configuration
Figure 15–1 shows an Oracle9i Real Application Clusters shared server database
with two instances, sales1  and sales2 , of the same service,
sales.us.acme.com . The instances sales1  and sales2  reside on computers
sales1-server  and sales2-server , respectively. sales1  has one dispatcher
and sales2  has two dispatchers. Listeners named listener  run on nodes 1 and
2, respectively. The listener  attribute in the DISPATCHERS parameter has been
configured to allow for service registration of information to both listeners.

Figure 15–1 Load Balancing Environment for a Shared Server Configuration

dispatcher2 dispatcher3

sales2

dispatcher1

sales1

listener listener

sales1-server sales2-server

SERVICE_NAMES=sales.us.acme.com
INSTANCE_NAME=sales1
DISPATCHERS=(PROTOCOL=tcp) 
  (DISPATCHERS=1) (LISTENER=listeners_sales)

SERVICE_NAMES=sales.us.acme.com
INSTANCE_NAME=sales2
DISPATCHERS=(PROTOCOL = tcp) 
  (DISPATCHERS=2) (LISTENER=listeners_sales)
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The listeners_sales  value in (LISTENER=listeners_sales)  can be then
resolved through a local tnsnames.ora  file on the both servers as follows:

listeners_sales=
 (DESCRIPTION=
   (ADDRESS=(PROTOCOL=tcp)(HOST=sales1-server)(PORT=1521))
   (ADDRESS=(PROTOCOL=tcp)(HOST=sales2-server)(PORT=1521)))

Based on the environment, the following actions occur. The numbered actions
correspond to the arrows shown in Figure 15–2 on page 15-14:

1. PMON processes for instances sales1 and sales2 register with both listeners.
The listeners are updated on the load of the instances and dispatchers
dynamically. The following load information is registered:

The load average on sales2-server  (400) is less than the load average on
sales1-server  (600). This can happen if more processing is required on
sales1-server . The number of connections to sales1  (200) is the same as
that of its only dispatcher, dispatcher1 . The number of connections on
sales2  (300) is the sum of the connections on its two dispatchers,
dispatcher2  (100) and dispatcher3  (200). Therefore, sales2  has more
connections than sales1 . In this example, sales2-server  is the least loaded
node, sales2  is the least loaded instance, and dispatcher2  is the least
loaded dispatcher.

sales1-server sales2-server

1 Minute Node Load Average 600 400

sales1 sales2

Number of Connections to Instance 200 300

dispatcher1 dispatcher2 dispatcher 3

Number of Connections to Dispatchers 200 100 200
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2. The client sends a connect request.

A connect descriptor is configured to try each protocol address randomly until
one succeeds:

sales.us.acme.com=
 (DESCRIPTION=
  (LOAD_BALANCE=on)
  (FAILOVER=on)
  (ADDRESS=(PROTOCOL=tcp)(HOST=sales1-server)(PORT=1521))
  (ADDRESS=(PROTOCOL=tcp)(HOST=sales2-server)(PORT=1521))
  (CONNECT_DATA=(SERVICE_NAME=sales.us.acme.com)))

The listener on sales1-server  was randomly chosen to receive the client
connect request.

The listener on sales1-server  compares the load of the instances sales1
and sales2 . The comparison takes into account the load on nodes
sales1-server and sales2-server , respectively. Since sales2-server is
less loaded than sales1-server , the listener selects sales2-server  over
sales1-server .

3. The listener compares the load on dispatchers dispatcher2  and
dispatcher3 . Because dispatcher2  is less loaded than dispatcher3 , the
listener redirects the client connect request to dispatcher2 .

4. The client connects directly to dispatcher2 .

Figure 15–2 Load Balancing Example for a Shared Server Configuration

Client

dispatcher1

sales1

dispatcher2 dispatcher3

sales2

listener

sales.us.acme.com

2

4
1

CONNECT scott/tiger@
sales.us.acme.com

listener

3

1
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Example: Connection Load Balancing for Dedicated Server Configuration
Figure 15–3 shows an Oracle9i Real Application Clusters dedicated server database
with two instances, sales1  and sales2 , of the same service,
sales.us.acme.com . The instances sales1  and sales2  reside on computers
sales1-server  and sales2-server , respectively. Listeners named listener
run on nodes 1 and 2, respectively. The REMOTE_LISTENER parameter has been
configured to allow for service registration of information to both listeners.

Figure 15–3 Load Balancing Environment for a Dedicated Server Configuration

sales2sales1

listener listener

sales1-server sales2-server

SERVICE_NAMES=sales.us.acme.com
INSTANCE_NAME=sales1
REMOTE_LISTENER=listener_sales2

SERVICE_NAMES=sales.us.acme.com
INSTANCE_NAME=sales2
REMOTE_LISTENER=listener_sales1
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The listener_sales2  value in (REMOTE_LISTENER=listener_sales2)  can
be then resolved through a local tnsnames.ora  file on the sales1-server  as
follows:

listener_sales2=
 (DESCRIPTION=
   (ADDRESS=(PROTOCOL=tcp)(HOST=sales2-server)(PORT=1521)))

The listener_sales1  value in (REMOTE_LISTENER=listener_sales1)  can
be then resolved through a local tnsnames.ora  file on the sales2-server  as
follows:

listener_sales1=
 (DESCRIPTION=
   (ADDRESS=(PROTOCOL=tcp)(HOST=sales1-server)(PORT=1521)))

Based on the environment, the following actions occur. The numbered actions
correspond to the arrows shown in Figure 15–4 on page 15-17:

1. PMON processes for instances sales1 and sales2 register with both listeners.
The listeners are updated on the load of the instances dynamically. The
following load information is registered:

In this example, sales2-server  is the least loaded node and sales2  is the
least loaded instance.

2. The client sends a connect request.

sales1-server sales2-server

1 Minute Node Load
Average

450 200

sales1 sales2

Number of Connections to
Instance

200 150
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A connect descriptor is configured to try each protocol address randomly until
one succeeds:

sales.us.acme.com=
 (DESCRIPTION=
  (LOAD_BALANCE=on)
  (FAILOVER=on)
  (ADDRESS=(PROTOCOL=tcp)(HOST=sales1-server)(PORT=1521))
  (ADDRESS=(PROTOCOL=tcp)(HOST=sales2-server)(PORT=1521))
  (CONNECT_DATA=(SERVICE_NAME=sales.us.acme.com)))

The listener on sales1-server  was randomly chosen to receive the client
connect request.

The listener on sales1-server  compares the load of the instances sales1
and sales2 . The comparison takes into account the load on nodes
sales1-server and sales2-server , respectively. Since sales2-server is
less loaded than sales1-server , the listener selects sales2-server  over
sales1-server .

3. The listener on sales1-server  redirects the client connect request to
dispatcher2 .

4. The client connects to the listener on sale2-server . The listener starts a
dedicated server process, and the dedicated server process inherits the
connection request from the listener.

Figure 15–4 Load Balancing Example for a Dedicated Server Configuration
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sales1

sales2

listener

sales.us.acme.com
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Configuring Transparent Application Failover

TAF instructs Oracle Net to fail over a failed connection to a different listener. This
enables the user to continue to work using the new connection as if the original
connection had never failed.

TAF involves manual configuration of a net service name that includes the
FAILOVER_MODE parameter included in the CONNECT_DATA section of the connect
descriptor.

This sections covers the following topics:

■ What TAF Restores

■ TAF Database Configurations

■ FAILOVER_MODE Parameters

■ TAF Implementation

■ TAF Verification

What TAF Restores
TAF automatically restores some or all of the following elements associated with
active database connections. Other elements, however, may need to be embedded in
the application code to enable TAF to recover the connection.

Client-Server Database Connections
TAF automatically reestablishes the connection using the same connect string or an
alternate connect string that you specify when configuring failover.

Users’ Database Sessions
TAF automatically logs a user in with the same user ID as was used prior to failure.
If multiple users were using the connection, then TAF automatically logs them in as
they attempt to process database commands. Unfortunately, TAF cannot
automatically restore other session properties. These properties can, however, be
restored by invoking a callback function.

Note: Transparent Application Failover (TAF) is available with
Oracle9i Enterprise Edition.
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Executed Commands
If a command was completely executed upon connection failure, and it changed the
state of the database, TAF does not resend the command. If TAF reconnects in
response to a command that may have changed the database, TAF issues an error
message to the application.

Open Cursors Used for Fetching
TAF allows applications that began fetching rows from a cursor before failover to
continue fetching rows after failover. This is called "select" failover. It is
accomplished by re-executing a SELECT statement using the same snapshot,
discarding those rows already fetched and retrieving those rows that were not
fetched initially. TAF verifies that the discarded rows are those that were returned
initially, or it returns an error message

Active Transactions
Any active transactions are rolled back at the time of failure because TAF cannot
preserve active transactions after failover. The application instead receives an error
message until a ROLLBACK is submitted.

Serverside Program Variables
Serverside program variables, such as PL/SQL package states, are lost during
failures; TAF cannot recover them. They can be initialized by making a call from the
failover callback.

See Also: Oracle Call Interface Programmer’s Guide
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TAF Database Configurations
TAF works with the following database configurations to effectively mask a
database failure:

■ Oracle9i Real Application Clusters

■ Oracle9i Real Application Clusters Guard

■ Replicated systems

■ Standby databases

■ Single instance Oracle database

See Also:

■ Oracle9i Real Application Clusters Setup and Configuration

■ Oracle9i Data Guard Concepts and Administration
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FAILOVER_MODE Parameters
The FAILOVER_MODEparameter must be included in the CONNECT_DATAsection of
a connect descriptor. FAILOVER_MODE can contain the subparameters described in
Table 15–6.

Table 15–6 Subparameters of the FAILOVER_MODE Parameter

FAILOVER_MODE
Subparameter

Description

BACKUP Specify a different net service name for backup connections. A
backup should be specified when using preconnect  to
pre-establish connections.

TYPE Specify the type of failover. Three types of Oracle Net failover
functionality are available by default to Oracle Call Interface
(OCI) applications:

■ session : Set to failover the session. If a user's connection is
lost, a new session is automatically created for the user on
the backup. This type of failover does not attempt to recover
selects.

■ select : Set to enable users with open cursors to continue
fetching on them after failure. However, this mode involves
overhead on the client side in normal select operations.

■ none : This is the default. No failover functionality is used.
This can also be explicitly specified to prevent failover from
happening.

METHOD Determines how fast failover occurs from the primary node to
the backup node:

■ basic : Set to establish connections at failover time. This
option requires almost no work on the backup server until
failover time.

■ preconnect : Set to pre-established connections. This
provides faster failover but requires that the backup
instance be able to support all connections from every
supported instance.

RETRIES Specify the number of times to attempt to connect after a
failover. If DELAY is specified, RETRIES defaults to five retry
attempts.

DELAY Specify the amount of time in seconds to wait between connect
attempts. If RETRIES is specified, DELAY defaults to one second.
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TAF Implementation

Depending on the FAILOVER_MODE parameters, you can implement TAF in a
number of ways. Oracle recommends the following methods:

■ Example: TAF with Connect-Time Failover and Client Load Balancing

■ Example: TAF Retrying a Connection

■ Example: TAF Pre-Establishing a Connection

Example: TAF with Connect-Time Failover and Client Load Balancing
Implement TAF with connect-time failover and client load balancing for multiple
addresses. In the following example, Oracle Net connects randomly to one of the
protocol addresses on sales1-server  or sales2-server . If the instance fails
after the connection, the TAF application fails over to the other node’s listener,
reserving any SELECT statements in progress.

sales.us.acme.com=
 (DESCRIPTION=

(LOAD_BALANCE=on)
(FAILOVER=on)

  (ADDRESS=
       (PROTOCOL=tcp)
       (HOST=sales1-server)
       (PORT=1521))
  (ADDRESS=
       (PROTOCOL=tcp)
       (HOST=sales2-server)
       (PORT=1521))
  (CONNECT_DATA=
     (SERVICE_NAME=sales.us.acme.com)

(FAILOVER_MODE=
(TYPE=select)
(METHOD=basic)) ))

Note: Oracle Net Manager does not provide support for TAF
parameters. These parameters must be manually added.

Important: Do not set the GLOBAL_DBNAME parameter in the
SID_LIST_ listener_name  section of the listener.ora . A
statically configured global database name disables TAF.



Configuring Transparent Application Failover

Enabling Advanced Features for Oracle Net Services 15-23

Example: TAF Retrying a Connection
TAF also provides the ability to automatically retry connecting if the first connection
attempt fails with the RETRIES and DELAY parameters. In the following example,
Oracle Net tries to reconnect to the listener on sales1-server . If the failover
connection fails, Oracle Net waits 15 seconds before trying to reconnect again.
Oracle Net attempts to reconnect up to 20 times.

sales.us.acme.com=
 (DESCRIPTION=
  (ADDRESS=
       (PROTOCOL=tcp)
       (HOST=sales1-server)
       (PORT=1521))
  (CONNECT_DATA=
     (SERVICE_NAME=sales.us.acme.com)

(FAILOVER_MODE=
(TYPE=select)
(METHOD=basic)
(RETRIES=20)
(DELAY=15)) ))

Example: TAF Pre-Establishing a Connection
A backup connection can be pre-established. The initial and backup connections
must be explicitly specified. In the following example, clients that use net service
name sales1.us.acme.com  to connect to the listener on sales1-server  are
also preconnected to sales2-server . If sales1-server  fails after the
connection, Oracle Net fails over to sales2-server , preserving any SELECT
statements in progress. Likewise, Oracle Net preconnects to sales1-server  for
those clients that use sales2.us.acme.com  to connect to the listener on
sales2-server .

sales1.us.acme.com=
 (DESCRIPTION=
  (ADDRESS=
       (PROTOCOL=tcp)
       (HOST=sales1-server)
       (PORT=1521))
  (CONNECT_DATA=
     (SERVICE_NAME=sales.us.acme.com)
     (INSTANCE_NAME=sales1)

(FAILOVER_MODE=
(BACKUP=sales2.us.acme.com)
(TYPE=select)
(METHOD=preconnect)) ))
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sales2.us.acme.com=
 (DESCRIPTION=
  (ADDRESS=
       (PROTOCOL=tcp)
       (HOST=sales2-server)
       (PORT=1521))
  (CONNECT_DATA=
     (SERVICE_NAME=sales.us.acme.com)
     (INSTANCE_NAME=sales2)

(FAILOVER_MODE=
(BACKUP=sales1.us.acme.com)
(TYPE=select)
(METHOD=preconnect)) ))

TAF Verification
You can query FAILOVER_TYPE, FAILOVER_METHOD, and FAILED_OVERcolumns
in the V$SESSION view to verify that TAF is correctly configured.

Use the V$SESSION view to obtain information about the connected clients and
their TAF status. For example, query the FAILOVER_TYPE, FAILOVER_METHOD,
and FAILED_OVER columns to verify that you have correctly configured TAF as in
the following SQL statement:

SELECT MACHINE, FAILOVER_TYPE, FAILOVER_METHOD, FAILED_OVER, COUNT(*)
FROM V$SESSION
GROUP BY MACHINE, FAILOVER_TYPE, FAILOVER_METHOD, FAILED_OVER;

The output before failover resembles the following:

MACHINE              FAILOVER_TYPE FAILOVER_M FAI   COUNT(*)
-------------------- ------------- ---------- --- ----------
sales1               NONE          NONE       NO          11
sales2               SELECT        PRECONNECT NO           1

The output after failover is:

MACHINE              FAILOVER_TYPE FAILOVER_M FAI   COUNT(*)
-------------------- ------------- ---------- --- ----------
sales2               NONE          NONE       NO          10
sales2               SELECT        PRECONNECT YES          1

Note: You can monitor each step of TAF using an appropriately
configured OCI TAF CALLBACK  function.
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Specifying the Instance Role for Primary and Secondary Instance
Configurations

The INSTANCE_ROLE parameter is an optional parameter for the CONNECT_DATA
section of a connect descriptor. It enables you to specify a connection to the primary
or secondary instance of Oracle9i Real Application Clusters and Oracle9i Real
Application Clusters Guard configurations.

This parameter is useful when:

■ You want to explicitly connect to a primary or secondary instance. The default
is the primary instance.

■ You want to use TAF to preconnect to a secondary instance.

INSTANCE_ROLE supports the following values:

primary  — Specifies a connection to the primary instance

secondary  — Specifies a connection to the secondary instance

any  — Specifies a connection to whichever instance has the lowest load,
regardless of primary or secondary instance role

Example: Connection to Instance Role Type
In the following example, net service name sales_primary  enables connections
to the primary instance, and net service name sales_secondary  enables
connections to the secondary instance.

sales_primary=
 (DESCRIPTION=
  (ADDRESS=
       (PROTOCOL=tcp)
       (HOST=sales1-server)
       (PORT=1521))
  (ADDRESS=
       (PROTOCOL=tcp)
       (HOST=sales2-server)
       (PORT=1521))

See Also:

■ Oracle Call Interface Programmer’s Guide

■ Oracle9i Database Reference for more information about the
V$SESSION view
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  (CONNECT_DATA=
     (SERVICE_NAME=sales.us.acme.com)

(INSTANCE_ROLE=primary) ))
sales_secondary=
 (DESCRIPTION=
  (ADDRESS=
       (PROTOCOL=tcp)
       (HOST=sales1-server)
       (PORT=1521))
  (ADDRESS=
       (PROTOCOL=tcp)
       (HOST=sales2-server)
       (PORT=1521))
  (CONNECT_DATA=
     (SERVICE_NAME=sales.us.acme.com)

(INSTANCE_ROLE=secondary) ))

Example: Connection To a Specific Instance
There are times when Oracle Enterprise Manager and other system management
products need to connect to a specific instance regardless of its role to perform
administrative tasks. For these types of connections, configure (INSTANCE_
NAME=instance_name )  and (INSTANCE_ROLE=any) to connect to the instance
regardless of its role.

In the following example, net service name sales1  enables connections to the
instance on sales1-server  and sales2  enables connections to the instance on
sales2-server . (SERVER=dedicated)  is specified to force a dedicated server
connection.

sales1=
 (DESCRIPTION=
  (ADDRESS=
       (PROTOCOL=tcp)
       (HOST=sales1-server)
       (PORT=1521))
  (CONNECT_DATA=
     (SERVICE_NAME=sales.us.acme.com)

(INSTANCE_ROLE=any)
     (INSTANCE_NAME=sales2)
     (SERVER=dedicated)))
sales2=
 (DESCRIPTION=
  (ADDRESS=
       (PROTOCOL=tcp)
       (HOST=sales2-server)
       (PORT=1521))
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  (CONNECT_DATA=
     (SERVICE_NAME=sales.us.acme.com)

(INSTANCE_ROLE=any)
     (INSTANCE_NAME=sales2)
     (SERVER=dedicated)))

Example: TAF Pre-Establishing a Connection
If Transparent Application Failover (TAF) is configured, a backup connection can be
pre-established to the secondary instance. The initial and backup connections must
be explicitly specified. In the following example, Oracle Net connects to the listener
on sales1-server  and preconnects to sales2-server , the secondary instance.
If sales1-server  fails after the connection, the TAF application fails over to
sales2-server , the secondary instance, preserving any SELECT statements in
progress.

sales1.acme.com=
 (DESCRIPTION=
  (ADDRESS=
       (PROTOCOL=tcp)
       (HOST=sales1-server)
       (PORT=1521))
  (CONNECT_DATA=
     (SERVICE_NAME=sales.us.acme.com)

(INSTANCE_ROLE=primary)
     (FAILOVER_MODE=
       (BACKUP=sales2.acme.com)
       (TYPE=select)
       (METHOD=preconnect))))
sales2.acme.com=
 (DESCRIPTION=
  (ADDRESS=
       (PROTOCOL=tcp)
       (HOST=sales2-server)
       (PORT=1521))
  (CONNECT_DATA=
     (SERVICE_NAME=sales.us.acme.com)

(INSTANCE_ROLE=secondary) ))
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Configuring Session Data Unit
Before sending data across the network, Oracle Net buffers and encapsulates data
into the SDU. Oracle Net sends the data stored in this buffer when the buffer is full,
flushed, or when RDBMS tries to read data. When large amounts of data are being
transmitted or when the message size is consistent, adjusting the size of the SDU
buffers can improve performance, network utilization, or memory consumption.

The SDU size can range from 512 bytes to 32 KB. The default SDU for the client and
the database is 2 KB.

Optimal SDU size depends on the maximum segment size (MSS) and message
fragmentation. For TTC connections, configuring an SDU size larger than the 2 KB
default requires configuring the SDU on both the client and server computers.
When the configured values do not match, the lower of the two values will be used.

To minimize packet header overhead and message fragmentation, set the SDU size
as a multiple of the MSS. When Oracle Advanced Security encryption is not used,
increase the SDU size by one (1). For example, the TCP/IP version 4 MSS on
Ethernet is 1460 bytes. Use a multiple of 1460 for the SDU size if encryption is used.
If encryption is not used, increase the SDU size to 1461.

The packet header overhead and message fragmentation can be measured using a
network sniffer or by analyzing Oracle Net trace files.

Client Configuration
To configure the client, set the SDU size with the SDU parameter in a connect
descriptor as follows:

net_service_name =
 (DESCRIPTION=

(SDU=2920)
   (ADDRESS=...)
   (ADDRESS=...)
   (CONNECT_DATA=
     (SERVER_NAME=sales.us.acme.com)))
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Database Server Configuration
Database server configuration depends upon whether or not the database is
configured to use shared server or dedicated server processes.

Shared Server Configuration
If using shared server processes, set the SDU size in the DISPATCHERS parameter
as follows:

DISPATCHERS="(DESCRIPTION=(ADDRESS=(PROTOCOL=tcp))(SDU=2920) )"

Ensure that the SDU size matches the value configured for the client.

Dedicated Server Configuration
If using dedicated server processes for a database that is dynamically registered
with the listener through service registration, then the SDU size cannot be set.
Instead, the 2 KB default is used.

If using dedicated server processes for a database that is registered with the listener
through static configuration in the listener.ora  file, then set the SDU size in the
SID_DESC section of the listener.ora  file as follows:

SID_LIST_ listener_name =
  (SID_LIST=
    (SID_DESC=

(SDU=2920)
     (SID_NAME=sales)))

Ensure that the SDU size matches the value configured for the client.
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Configuring Connections to Non-Oracle Database Services
The following topics describe how to configure connections to non-Oracle database
services:

■ Configuring Oracle Net Services for External Procedures

■ Configuring Oracle Net Services for Oracle Heterogeneous Services

■ Configuring Oracle Net Services for an Oracle Rdb Database

Configuring Oracle Net Services for External Procedures
An external procedure is a procedure called from another program, but written in a
different language. An example would be a PL/SQL program calling one or more C
routines that are required to perform special-purpose processing.

You can configure the listener to listen for external procedure calls. When an
application calls an external procedure, the listener starts an external procedure
agent named extproc . Using the network connection established by the listener,
the application passes the following information to the agent:

■ DLL or shared library name

■ External procedure name

■ Any parameters

The agent then loads the DLL and runs the external procedure and passes back to
the application any values returned by the external procedure.

The agent must reside on the same computer as the application making the external
procedure call.

This section contains the following topics:

■ Default Configuration for External Procedures

■ Modifying Configuration of External Procedures for Higher Security

Default Configuration for External Procedures
Oracle Net Configuration Assistant configures a listener to accept connections for
both the database and external procedures during a database server installation. In
addition, Oracle Net Configuration Assistant configures a net service name for the
external procedures in tnsnames.ora  file on the database server. The external
procedure agent will only be able to load DLLS from $ORACLE_HOME/lib  on
UNIX operating systems and ORACLE_HOME\bin  on Windows NT.
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Figure 15–5 shows the default configuration in the listener.ora  file.

Figure 15–5 listener.ora File with Default External Procedure Setup

LISTENER=
  (DESCRIPTION=
    (ADDRESS_LIST=
      (ADDRESS=(PROTOCOL=tcp)(HOST=sale-server)(PORT=1521))

(ADDRESS=(PROTOCOL=ipc)(KEY=extproc) )))
SID_LIST_LISTENER=
  (SID_LIST=
    (SID_DESC=
      (GLOBAL_DBNAME=sales.us.acme.com)
      (ORACLE_HOME=/oracle9i)
      (SID_NAME=sales))

(SID_DESC=
      (SID_NAME=plsextproc)
      (ORACLE_HOME=/oracle9i)
      (PROGRAM=extproc)) )

Figure 15–6 shows the default configuration in the tnsnames.ora  file.

Figure 15–6 tnsnames.ora File with Default External Procedure Setup

EXTPROC_CONNECTION_DATA=
 (DESCRIPTION=
   (ADDRESS=(PROTOCOL=ipc)(KEY=extproc))
   (CONNECT_DATA=
    (SID=extproc)))

Modifying Configuration of External Procedures for Higher Security
To achieve a higher level of security in a production environment, modify the
default configuration by performing the following tasks:

1. Configure and run a separate listener dedicated to servicing external procedure
requests.

The extproc  agent spawned by the listener inherits the operating system
privileges of the listener. Therefore, configure this listener to run with operating
system privileges lower than those of the listener for the database.

2. Restrict the DLLs that the extproc  agent can load by listing them explicitly in
the listener.ora  file.

The details of these tasks follow.
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To modify the default configuration for a higher level of security:

1. Remove the external procedure entries for the default listener configured by
Oracle Net Configuration Assistant.

For most installation types, this listener is named LISTENER.

a. Start Oracle Net Manager.

b. In the navigator pane, expand Local > Listeners.

c. Select the listener configured by Oracle Net Configuration Assistant.

d. From the list in the right pane, select Listening Locations.

e. Click the Address 2 tab containing the protocol address for the external
procedures.

f. Click Remove Address.

g. From the list in the right pane, select Other Services.

h. Click the Service 2 tab containing the service information for external
procedures.

i. Click Remove Service.

2. Create another listener to exclusively handle external procedures:

a. In the navigator pane, select Listeners.

b. Click plus (+) from the toolbar or select Edit > Create.

The Choose Listener Name dialog box appears.

c. Enter a unique listener name, such as LISTENEREXTPROC, in the Listener
Name field.

d. Click OK.

3. Configure an IPC protocol address.

a. Select the newly-created listener.

b. From the list in the right pane, select Listening Locations.

c. Click Add Address.

See Also: "Starting Oracle Net Manager" on page 5-3
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A new Address tab appears.

d. From the Protocol list, select IPC, and enter a value for the Key. Oracle
Corporation recommends a key value of extproc .

4. Add service information about extproc  in the listener.ora  file, including
the parameters described in Table 15–7 on page 15-34.

Note: If the computer has more than one Oracle home or more
than one listener, each listener must specify a unique KEY. For
example, you can use extproc1 for the first listener, extproc2 for
the second listener, and so on.

See Also: "Configuring Listening Protocol Addresses" on
page 12-6 for more information about configuring listener protocol
addresses
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Table 15–7 External Procedures Settings in listener.ora

Oracle Net Manager
Field

listener.ora
Parameter

Description

Program Name PROGRAM Specify the name of the external procedure agent executable.

Note: On Windows NT, the executable must reside in the ORACLE_
HOME\bin  directory.

Environment ENVS Specify the EXTPROC_DLLS environment variable to restrict the DLLs
that extproc  is allowed to load. Without the EXTPROC_DLLS
environment variable, extproc  loads DLLs from $ORACLE_
HOME/lib  on UNIX operating systems and ORACLE_HOME\bin  on
Windows NT.

Set EXTPROC_DLLS to one of the following values:

■ Colon-separated list of the DLLs

Syntax: " DLL: DLL"

Description: This value allows extproc  to load the specified
DLLs and the DLLs from $ORACLE_HOME/lib  on UNIX
operating systems and ORACLE_HOME\bin on Windows NT. You
must enter the complete directory path and file name of the
DLLs.

■ ONLY (Recommended for maximum security)

Syntax: "ONLY: DLL: DLL"

Description: This value allows extproc  to load only the
specified DLLs. You must enter the complete directory path and
file name of the DLLs.

■ ANY

Syntax: "ANY"

Description: This value allows extproc  to load any DLL. ANY
disables DLL checking.

Examples:

"EXTPROC_DLLS=/home/xyz/mylib.so:/home/abc/urlib.so,LD_LIBRARY_
PATH=/private/xpm/lib:/private/mylibs,
MYPATH=/usr/ucb:/usr/local/packages,APL_ENV_FILE=/apl/conf/env.txt"

"EXTPROC_DLLS=ONLY:/home/xyz/mylib.so:/home/abc/urlib.so,LD_
LIBRARY_PATH=/private/xpm/lib:/private/mylibs,
MYPATH=/usr/ucb:/usr/local/packages,APL_ENV_FILE=/apl/conf/env.txt"

"EXTPROC_DLLS=ANY,LD_LIBRARY_PATH=/private/xpm/lib:/private/mylibs,
MYPATH=/usr/ucb:/usr/local/packages,APL_ENV_FILE=/apl/conf/env.txt"
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To configure service information about extproc  in the listener.ora  file:

a. From the list in the right pane, select Other Services.

b. Click Add Service.

A new Service tab appears.

SID SID_NAME Specify a system identifier for the external procedure agent by any
name.

Oracle Home Directory ORACLE_HOME Specify the Oracle home location of the agent.

Oracle Net Manager
Field

listener.ora
Parameter

Description
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c. Enter extproc  in the Program Name field, the EXTPROC_DLLS
environment variable in the Environment Variable field, a system
identifier, such as extproc , in the SID field, and the Oracle home where
the extproc  executable resides in the Oracle Home Directory field.

5. Choose File > Save Network Configuration.

The listener.ora  file updates with information for external procedures, as
shown in the following output:

LISTENEREXTPROC=
 (DESCRIPTION=
  (ADDRESS=
     (PROTOCOL=ipc)(KEY=extproc)))
SID_LIST_LISTENEREXTPROC=
  (SID_LIST=
    (SID_DESC=
     (PROGRAM=extproc)
     (ENVS="EXTPROC_DLLS=ONLY:/home/xyz/mylib.so:/home/abc/urlib.so,
      LD_LIBRARY_PATH=/private/xpm/lib:/private/mylibs,
      MYPATH=/usr/ucb:/usr/local/packages,APL_ENV_FILE=/apl/conf/env.txt")
     (SID_NAME=extproc)
     (ORACLE_HOME=/oracle9i)))

6. Start the listener for external procedures from a user account with lower
privileges than the oracle  user.

Ensure that this user account does not have general access to oracle -owned
files. Specifically, this user should not have permission to read or write to
database files or to the Oracle server address space. In addition, this user
should have read access to the listener.ora  file, but must not have write
access to it.

Running the listener with lower privileges also prevents you from using
Listener Control utility SET commands to alter the configuration of this listener
in the listener.ora  file. For this reason, Oracle Corporation recommends
that you complete listener.ora  file configuration prior to running the
listener.

See Also:

■ "Task 3: Start the Listener" on page 16-5 for instructions on
using the Listener Control utility START command to start the
listener

■ Oracle9i Application Developer’s Guide - Fundamentals for
instruction on enabling external procedure calls
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Configuring Oracle Net Services for Oracle Heterogeneous Services
Heterogeneous Services are an integrated component within the Oracle database
server, and provides the generic technology for accessing non-Oracle systems from
the Oracle database server. Heterogeneous Services enable you to:

■ Use Oracle SQL to transparently access data stored in non-Oracle systems as if
the data resides within an Oracle database server

■ Use Oracle procedure calls to transparently access non-Oracle systems, services,
or application programming interfaces (APIs), from your Oracle distributed
environment

While Heterogeneous Services provides the generic technology in the Oracle
database server, a Heterogeneous Service agent is required to access a particular
non-Oracle system.

To initiate a connection to the non-Oracle system, the Oracle database server starts
an agent process through the listener on the gateway. For the Oracle database server
to be able to connect to the agent, perform the following steps:

1. Configure the listener on the gateway to listen for incoming requests from the
Oracle database server and spawn Heterogeneous Services agents by
configuring the parameters described in Table 15–8 in the listener.ora  file.

Table 15–8 Heterogeneous Services Settings in listener.ora

To configure the SID , ORACLE_HOME, and PROGRAM parameters:

a. Start Oracle Net Manager.

b. In the navigator pane, expand Local > Listeners.

c. Select a listener.

d. From the list in the right-pane, select Other Services.

e. Click Add Service.

Oracle Net Manager
Field

listener.ora Parameter Description

SID SID_NAME Specify the Oracle System Identifier (SID).

Oracle Home ORACLE_HOME Specify the Oracle home location of the agent executable.

Program Name PROGRAM Specify the name of the agent executable.

See Also: "Starting Oracle Net Manager" on page 5-3
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A new Service tab appears.

f. Enter the program name in the Program Name field that will be executed to
create a gateway, the Oracle home where the agent executable resides in the
Oracle Home Directory field, and the SID or service name of the
non-Oracle system in the SID field.

g. Choose File > Save Network Configuration.

The listener.ora  file updates information about the Heterogeneous
Services, as shown in the following:

SID_LIST_LISTENER=
 (SID_LIST=
  (SID_DESC=
   (SID_NAME=sybase_gtw)
   (ORACLE_HOME=/oracle9i)
   (PROGRAM=tg4sybs)) )

See Also: Oracle9i Heterogeneous Connectivity Administrator’s
Guide
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2. On the computer where the Oracle database resides, set up a net service name
to connect to the listener on the gateway. The connect descriptor must also
include the HS=ok clause to make sure the connection uses Heterogeneous
Services:

a. Start Oracle Net Manager.

b. Create a net service name that can be used for connections from the Oracle
database server to a non-Oracle system.

c. In the navigator pane, expand Local > Service Naming.

d. Select the net service name.

e. Click Advanced in the Service Identification group box.

The Advanced Service Options dialog box appears.

f. Click Use for Heterogeneous Services, and then click OK.

g. Choose File > Save Network Configuration.

See Also: "Starting Oracle Net Manager" on page 5-3

See Also: "Task 1: Configure Net Service Names" on page 9-6 for
net service name creation for local naming
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The tnsnames.ora  file updates with the new net service name configured
for Heterogeneous Services, as shown in the following:

sybase_gtw=
 (DESCRIPTION=
  (ADDRESS=(PROTOCOL=tcp)(HOST=gate_server)(PORT=1521))
  (CONNECT_DATA=
    (SERVICE_NAME=sybase_gtw)

(HS=ok) ))

Configuring Oracle Net Services for an Oracle Rdb Database
Oracle Rdb is a database for Digital’s 64-bit operating systems. Because Oracle Rdb
has its own listener, the client interacts with Rdb in the same manner as it does with
an Oracle database.

To initiate a connection to an Oracle Rdb, set up a net service name to connect to the
Oracle Rdb database using the parameters described in Table 15–9.

Table 15–9 Oracle RDB Database Settings in a Connect Descriptor

Oracle Net Manager
Field

tnsnames.ora Parameter Description

Rdb Database RDB_DATABASE Specify the file name of an Oracle Rdb database.

Type of Service TYPE_OF_SERVICE Specify the type of service to use for an Oracle Rdb
database. It is used by Rdb interface tools. This feature
should only be used if the application supports both
Oracle Rdb and Oracle database services, and you want
the application to load balance between the two.

Global Database Name GLOBAL_NAME (Optional) Specify the Oracle Rdb database.

See Also: Oracle Rdb documentation
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To configure a client for an Oracle Rdb database, use Oracle Net Manager:

1. Start Oracle Net Manager.

2. Create a net service name that can be used for connections from the Oracle
server to a non-Oracle system.

3. In the navigator pane, expand Directory or Local > Service Naming.

4. Select the net service name.

5. Click Advanced in the Service Identification group box.

The Advanced Service Options dialog box appears.

6. Enter the file name of an Oracle Rdb database in the Rdb Database field.

7. Optionally, enter the global database name in the Global Database Name field,
and, if needed, specify the type of service in the Type of Service field, and then
click OK.

See Also: "Starting Oracle Net Manager" on page 5-3

See Also: "Task 1: Configure Net Service Names" on page 9-6 for
net service name creation for local naming

See Also: Table 15–9 on page 15-40 for a description of the Oracle
Rdb fields
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8. Choose File > Save Network Configuration.

The tnsnames.ora  file updates with the new net service name configured for
the Oracle Rdb database, as shown in the following:

alpha5=
  (DESCRIPTION=
    (ADDRESS=...)
    (CONNECT_DATA=
      (SERVICE_NAME=generic)

(RDB_DATABASE=[.mf]mf_personnel.rdb)
(GLOBAL_NAME=alpha5) ))

In the following example, TYPE_OF_SERVICE is used to load balance between
an Oracle Rdb database service and an Oracle database service:

alpha5=
 (DESCRIPTION_LIST=
  (DESCRIPTION=
    (ADDRESS=...)
    (CONNECT_DATA=
     (SERVICE_NAME=generic)

(RDB_DATABASE=[.mf]mf_personnel.rdb)
(GLOBAL_NAME=alpha5) ))

  (DESCRIPTION=
   (ADDRESS=...)
    (CONNECT_DATA=
     (SERVICE_NAME=sales.us.acme.com))

 (TYPE_OF_SERVICE=oracle9_database) )

See Also: Oracle Rdb documentation



Part III
 Testing and Troubleshooting Oracle Net

Services

Part III describes how to establish connections, and identify and diagnose problems
with Oracle Net Services.

This part contains these chapters:

■ Chapter 16, "Establishing a Connection and Testing the Network"

■ Chapter 17, "Troubleshooting Oracle Net Services"
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16
Establishing a Connection and Testing the

Network

Once you have completed configuring the network, you should make a connection
and test each component to ensure that the network is functioning properly. Oracle
Net Services provide a variety of tools to help you start, test, and control an Oracle
Names server, listener, and Oracle Connection Manager.

This chapter outlines procedures to make a connection and test network
components. This chapter contains these topics:

■ Connecting to a Database

■ Testing the Network
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Connecting to a Database
Connecting to a database involves starting network components and entering a
connect string with a net service name, such as the following:

CONNECTusername / password @connect_identifier

This section contains these topics:

■ Starting Oracle Net Services Components

■ Entering a Connect String

■ Connect Identifier and Connect Descriptor Syntax Characteristics

■ Absolute Name Specification for Directory Naming

■ Initiating Connections

Starting Oracle Net Services Components
Client workstations and other servers connect to a listener with a net service name
when logging onto an Oracle database server.

After installing and configuring all the network components, you need to start them
to make the network functional. Following is an outline of the tasks you should
perform to start the network components.

Task 1: Start Oracle Names Servers

Task 2: Start Oracle Names Client Cache

Task 3: Start the Listener

Task 4: Start the Database

Task 5: Start Oracle Connection Manager

Note: If the Oracle Names servers use a database to store the
network information, you need to start the database and the
listener prior to starting the Oracle Names servers.
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Task 1: Start Oracle Names Servers
Start Oracle Names servers using either Oracle Net Manager or Oracle Names
Control utility on the computers where Oracle Names server software is installed
and configured. To start Oracle Names servers, use either Oracle Net Manager or
Oracle Names Control utility:

On Windows NT, an Oracle Names server can also be started through the Control
Panel:

1. Select the Services icon in the Control Panel window.

2. Select the Oracle HOME_NAMENamesonames_server  service.

3. Click Start.

4. In the Services window, click Close.

Use Oracle Net Manager... Use Oracle Names Control utility...

1. Start Oracle Net Manager.

See Also: "Starting Oracle Net Manager"
on page 5-3

2. In the navigator pane, expand Oracle
Names servers.

3. Select the Oracle Names server.

4. From the list in the right pane, select
Manage Server.

5. Click the Control tab.

6. Click Start.

7. Click Apply.

The following message appears:

Server started successfully.

On Windows NT, a service called
Oracle HOME_NAMENamesonames_
server  is created.

From the command line, enter:

namesctl

NAMESCTL> START

The START command of the Oracle Names
Control utility loads the Oracle Names server
into memory and tells it to begin executing.
At startup, the Oracle Names server loads its
configuration and data.
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Task 2: Start Oracle Names Client Cache
To avoid clients looking up address information in an Oracle Names server each
time, create a client cache of the information.

To create a client cache:

1. Ensure discovery of Oracle Names servers has been performed, as described in
"Task 4: Configure Clients and Database Servers To Use Oracle Names Servers"
on page 9-38. The information gathered during discovery is used for a client’s
cache.

2. Create and start the client cache on the client:

namesctl
NAMESCTL> START_CLIENT_CACHE

On Windows NT, the client cache can also be started through the Control Panel:

1. Select the Services icon in the Control Panel window.

2. Select the Oracle HOME_NAMEClientCache  service.

3. Click Start.

4. In the Services window, click Close.

See Also: "Task 5: (Optional) Configure Client Caches" on
page 9-42 for more information about client caches
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Task 3: Start the Listener
For Oracle Net to accept connections on the database server, start the listener with
the Listener Control utility on the server:

1. Determine the status of the listener. From the command line, enter:

lsnrctl
LSNRCTL> STATUS [ listener_name ]

where listener_name  is the name of the listener defined in the
listener.ora  file. It is not necessary to identify the listener if you are using
the default listener, named LISTENER.

If the STATUS command indicates that the listener is running, go to Step 2. If
the listener is not running, go to Step 3.

Even if the listener is running, stop the listener, and start it again before
proceeding to Step 2. To stop the listener, enter:

LSNRCTL> SET PASSWORDpassword
LSNRCTL> STOP [listener_name ]

SET PASSWORD is only required if the password is set in the listener.ora
file. The password defaults to ORACLE.

2. Start the listener. Enter:

LSNRCTL> START [ listener_name ]

The Listener Control utility will display a status message indicating that the
listener has started successfully. Check that all expected services for that listener
are listed in the services summary in the status message.

3. Exit from the Listener Control utility. Enter:

LSNRCTL> EXIT

On Windows NT, the listener can also be started through the Control Panel:

1. Select the Services icon in the Control Panel window.

2. Select the Oracle HOME_NAMETNSListener  service—the service name if you
are using the default listener name LISTENER—or Oracle HOME_
NAMETNSListener lsnr , where lsnr  is the nondefault listener name.

3. Click Start to start the service.

4. In the Services window, click Close.
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Task 4: Start the Database
Use the tool of choice, such as SQL*Plus, to start the database:

1. Start SQL*Plus without connecting to the database:

sqlplus /nolog

2. Connect to Oracle as SYSDBA:

SQL> CONNECTusername / password  as sysdba

3. When you enter a STARTUP command, specify the database name and full path
of the parameter file:

SQL> STARTUPdatabase_name  pfile= file

If you do not specify the PFILE  option, the Oracle database uses the standard
initialization parameter file located in the $ORACLE_BASE/admin/ db_
name/pfile/ sid  directory on UNIX platforms, and ORACLE_
BASE\admin\ db_name\pfile\ sid  directory on Windows NT. If you do not
specify a database name, then the database uses the value of the DB_NAME
parameter specified in the initialization parameter file.

See Also:  Oracle9i Database Administrator’s Guide for further
information about starting the database
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Task 5: Start Oracle Connection Manager
If Oracle Connection Manager is installed and configured, start it with the Oracle
Connection Manager Control utility, entering commands in the following order:

1. From the command line, enter:

CMCTL
CMCTL> START CMAN

Oracle Connection Manager displays a status message indicating that Oracle
Connection Manager has started successfully.

2. Exit from the Oracle Connection Manager Control utility. Enter:

CMCTL> EXIT

On Windows NT, Oracle Connection Manager also be started through the Control
Panel:

1. Select the Services icon in the Control Panel window.

2. If you are using Oracle Names, select the Oracle HOME_NAMECMAdmin service
to acquire information about available Oracle Names Servers, and then click
Start. If you are not using Oracle Names, do not start this service.

3. Select the Oracle HOME_NAMECManservice to start Oracle Connection Manager,
and then click Start.

4. In the Services window, click Close.
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Entering a Connect String
After the network components are started, as described in "Connecting to a
Database" on page 16-2, you should be able to make a connection across the
network. How you make a connection depends upon the naming method you
configured in Chapter 9, "Configuring Naming Methods", and the tool used for the
connection.

The connect string takes the following basic form:

CONNECTusername / password @connect_identifier

On most operating systems, you can define a default connect identifier. This way, a
connect identifier does not need to be specified in the connect string. To define a
default connect identifier, use the TWO_TASK environment variable on UNIX
platforms or the LOCAL environment variable or registry entry on Windows NT.

For example, if the TWO_TASK environment variable is set to sales , you can
connect to a database from SQL*Plus with CONNECTusername / password  rather
than CONNECT username/password@sales . Oracle Net checks if TWO_TASK is
set and uses the value sales  as the connect identifier. If it exists, Oracle Net
connects.

Further information about connect string format is provided in the following topics:

■ Connect Identifier and Connect Descriptor Syntax Characteristics

■ Absolute Name Specification for Directory Naming

See Also: Oracle operating system-specific documentation for
instructions on setting TWO_TASK and LOCAL
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Connect Identifier and Connect Descriptor Syntax Characteristics
Connect identifiers used in a connect string cannot contain spaces, unless enclosed
within single quotes (’) or double quotes ("). In the following examples, a connect
identifier and a connect descriptor that contain spaces are enclosed within single
quotes:

CONNECT scott/tiger@’(DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)
(PORT=1521))(CONNECT_DATA=(SERVICE_NAME=sales.us.acme.com)))’

CONNECT scott/tiger@’cn=sales, cn=OracleContext, dc=us, dc=acme, dc=com’

Single quotes (’) are required if a double quote (") is used in a connect identifier. For
example:

CONNECT scott/tiger@'sales@Good"Fast"Food.com'

Likewise, double quotes (") are required if a single quote (’) is used in a connect
identifier. For example:

CONNECT scott/tiger@"cn=sales, cn=OracleContext, ou=Mary's Dept, o=acme"

Absolute Name Specification for Directory Naming

This section describes how to configure absolute names for the following
namespaces:

■ Absolute Names for X.500 Namespaces

■ Absolute Names for Domain Component Namespaces

Note: JDBC OCI Drivers support absolute naming. JDBC Thin
Drivers support absolute naming only when the complete DN is
used. See the Oracle9i JDBC Developer’s Guide and Reference for
further information.
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Absolute Names for X.500 Namespaces For X.500 namespaces, the default
directory entry defined for the client must be in one of the following formats:

[ou],o

[ou],o,c

where [ou]  represents an optional organizationalUnitName.

The absolute name the client uses as the connect identifier must be in one of the
following formats:

cn[.ou].o

cn[.ou].o.c

where [cn]  represents the Oracle Net entry.

For example, consider a client that has been configured with a default Oracle
Context of cn=OracleContext,ou=acctg,o=acme,c=us .

The directory contains database object sales  with a DN of
cn=sales,cn=OracleContext,ou=mktg,o=acme,c=jp . In this scenario, the
client requires a connect identifier of sales.mktg.acme.jp  (cn.ou.o.c ).
Figure 16–1 depicts this example.

Figure 16–1 Absolute Name for X.500 Namespaces

o=acme

ou=mktg

cn=OracleContext

CONNECT scott/tiger@ sales.mktg.acme.jp
Connect String=

c=jp

cn=sales
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Absolute Names for Domain Component Namespaces For domain component
namespaces, the default directory entry defined for the client must be in one of the
following formats:

dc[,dc][...]

ou,dc[,dc][...]

where [dc]  represents an optional domain component and [...]  represents
additional domain component entries.

The absolute name the client must use in the connect identifier must be in one of the
following formats:

cn.dc[.dc][...]

cn[.ou]@dc[.dc][...]

where [cn]  represents the Oracle Net entry.

Example 1 Consider a client that has been configured with a default Oracle Context
of cn=OracleContext,dc=us,dc=acme,dc=com .

The directory server contains an entry for database object sales  with a DN of
cn=sales,cn=OracleContext,dc=jp,dc=acme,dc=com . In this scenario, the
client requires a connect identifier of sales.jp.acme.com  (cn.dc.dc.dc ).
Figure 16–2 on page 16-12 depicts this example.

Example 2 Consider the same default directory entry as Example 1. The directory
server contains database object sales  with a DN of
cn=sales,cn=OracleContext,ou=mktg,dc=jp,dc=acme,dc=com . Notice
ou=mktg . Because domain components must be separated from organization units,
the client requires a connect identifier of sales.mktg@jp.acme.com
(cn.ou@dc.dc.dc ). Figure 16–2 on page 16-12 depicts this example.
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Figure 16–2 Absolute Name for Domain Component Namespaces

cn=OracleContext

cn=sales

CONNECT scott/tiger@ sales.jp.acme.com
Connect String=

dc=jp, dc=acme, dc=com

ou=mktg

cn=OracleContext

cn=sales

CONNECT scott/tiger@ sales.mktg@jp.acme.com
Connect String=

dc=jp, dc=acme, dc=com
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Initiating Connections
There are a number of ways to initiate a connection to an Oracle server. Commonly
used methods are described in these topics:

■ Connecting from the Operating System to Test a Client

■ Connecting from the Tool Logon Screen to Test a Client

■ Connecting from 3GL to Test a Client

■ Connecting Using Special Commands Within Tools

The specifics of use are slightly different in each case. Each of the general methods
listed is briefly covered here. To identify the method used in a specific tool, refer to
the user guide for the tool.

Connecting from the Operating System to Test a Client
The general form of connecting an application to a database server from the
command line is:

tool username / password @connect_identifier

For example:

SQLPLUS system/ password @sales

To prevent the password from displaying during a logon, you can leave out the
password parameter on the command line. For example:

SQLPLUS system@sales

You will be prompted to enter your password without it showing on screen.

Most Oracle tools can use the operating system command line to connect; some
provide alternatives.

Connecting from the Tool Logon Screen to Test a Client
Some tools provide a logon screen as an alternative form of logon. A user can log on
to a database server by identifying both the username and connect identifier
(username @connect_identifier ) in the username field of the tool logon
screen, and entering the password as usual in the password field.
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Connecting from 3GL to Test a Client
In applications written using 3GL, the program must establish a connection to a
server using the following syntax:

exec sql connect : username  identified by : password

In this connection request, : username  and : password  are 3GL variables that can
be set within the program either statically or by prompting the user. When
connecting to a database server, the value of the : username variable is in the form:

username @net_service_name

The : password  variable contains the password for the database account to which
you are connecting.

Connecting Using Special Commands Within Tools
Some Oracle tools have commands for database connections, once the tool has been
started, to allow an alternative username to be specified without leaving the tool.
SQL*Plus allows the CONNECT command using the following syntax:

SQL> CONNECTusername/password@net_service_name

For example:

SQL> CONNECT scott/tiger@serverx

This is very similar to the operating system command line method, except that it is
entered in response to the tool prompt instead of the operating system prompt.

Other Oracle tools use slightly different methods specific to their function or
interface. For example, Oracle CDE tools use logon buttons and a pop-up window
with the username, password, and remote database ID field.
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Testing the Network
The preferred sequence for testing the network is as follows:

1. Start and test each Oracle Names server (if included in your network layout).

2. Start and test each listener.

3. Start and test each Oracle Connection Manager (if included in your network
layout).

4. Test the server with a loopback test.

5. Test client with a connection.

This section contains these topics:

■ Testing a Listener

■ Testing Oracle Connection Manager

■ Testing Configuration on the Database Server

■ Testing Network Connectivity from the Client

■ Testing an Oracle Names Server

■ Testing Network Objects with Oracle Net Manager or Oracle Names Control
Utility



Testing the Network

16-16 Oracle9i Net Services Administrator’s Guide

Testing a Listener
To test a listener, initiate a connection from a client to any active database controlled
by that listener, as described in "Testing Configuration on the Database Server" on
page 16-16.

Testing Oracle Connection Manager
To test Oracle Connection Manager, initiate a connection from a client to any active
database for which a source route address has been created.

Testing Configuration on the Database Server
Once you have configured the network, test the configuration by performing a
loopback test on the database server.

A loopback test uses Oracle Net to go from the database server back to itself,
bypassing the Interprocess Communication (IPC). Performing a successful loopback
verifies that Oracle Net is functioning on the database server.

To perform the loopback test, use Oracle Net Manager:

1. Start Oracle Net Manager.

2. In the navigator, expand Directory or Local > Service Naming.

3. Select the net service name or database service.

4. Choose Command > Test Net Service.

Testing assumes the database and listener are running. If they are not, see
"Starting Oracle Net Services Components" on page 16-2 to start components.

During testing, a Connection Test dialog box appears, providing status and test
results. A successful test results in the following message:

The connection test was successful.

If the test was successful, proceed to Step 5.

If the test was not successful:

a. Ensure that the database and listener are running, and then click Test.

b. Click Change Login to change the username and password for the
connection, and then click Test.

5. Click Close to dismiss the Connect Test dialog box.

See Also: "Starting Oracle Net Manager" on page 5-3
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Testing Network Connectivity from the Client
To test several different clients in your network, initiate a connection to a database
server from each of them by following the instructions in "Entering a Connect
String" on page 16-8.

Oracle Net also provides the following tools to help evaluate network connectivity:

■ TNSPING Utility

■ TRCROUTE Utility

■ Oracle Net Manager

TNSPING Utility
The TNSPING utility determines whether or not a service (for example, an Oracle
database, an Oracle Names server, or any other Oracle service) on a Oracle Net
network can be successfully reached.

If you can connect successfully from a client to a server (or a server to another
server) using the TNSPING utility, it displays an estimate of the round trip time (in
milliseconds) it takes to reach the Oracle Net service.

If it fails, it displays a message describing the error that occurred. This enables you
to see the network error that is occurring without the overhead of a database
connection.

Using TNSPING To invoke the TNSPING utility, enter the following:

tnsping net_service_name [ count ]

■ net_service_name : must exist in tnsnames.ora  file or the name service in
use, such as NIS or DCE’s CDS.

■ count (optional): determines how many times the program attempts to reach
the server.

If the net service name specified is a database name, TNSPING attempts to contact
the corresponding listener. It does not actually determine whether or not the
database itself is running. Use SQL*Plus to attempt a connection to the database.

Following are some examples of TNSPING.

Note: Different platforms may have different interfaces, but the
program accepts the same arguments. Invoke TNSPING for the
display of the proper interface requirements.
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Example: Reaching a Database with TNSPING To connect to a database using a net
service name of sales , the following is entered:

TNSPING sales

This produces the following message:

TNS Ping Utility for Solaris: Version 9.2.0.1.0 - Production on 25-JAN-2002
14:46:28

Copyright (c) 1997 Oracle Corporation.  All rights reserved.

Used parameter files:
Used TNSNAMES adapter to resolve the alias
Attempting to contact (DESCRIPTION = (ADDRESS_LIST = (ADDRESS = (PROTOCOL =
TCP)(HOST = sales-server)(PORT = 1521))) (CONNECT_DATA = (SERVICE_NAME =
sales.us.acme.com)))
OK (10 msec)

To determine whether a connection can be made to the sales  database, and to
specify that TNSPING try to connect eight times and then give up, use the
following syntax:

tnsping sales 8

This command produces the following message:

TNS Ping Utility for Solaris: Version 9.2.0.1.0 - Production on 25-JAN-2002
14:49:26

Copyright (c) 1997 Oracle Corporation.  All rights reserved.

Used parameter files:

Used TNSNAMES adapter to resolve the alias
Attempting to contact (DESCRIPTION = (ADDRESS_LIST = (ADDRESS = (PROTOCOL =
TCP)(HOST = sales-server)(PORT = 1521))) (CONNECT_DATA = (SERVICE_NAME =
sales.us.acme.com)))
OK (10 msec)
OK (0 msec)
OK (10 msec)
OK (0 msec)
OK (10 msec)
OK (10 msec)
OK (10 msec)
OK (0 msec)
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Example: Invalid Net Service Name with TNSPING Below is an example of TNSPING
attempting to connect to an invalid net service name:

tnsping badname

This attempt produces the following message:

TNS Ping Utility for Solaris: Version 9.2.0.1.0 - Production on 25-JAN-2002
14:51:12

Copyright (c) 1997 Oracle Corporation.  All rights reserved.

Used parameter files:

TNS-03505: Failed to resolve name

Example: Valid Net Service Name with TNSPING Following is an example of using
TNSPING to connect to a name that is valid, but that resolves to an address where
no listener is located (for example, the listener may not be started):

TNS Ping Utility for Solaris: Version 9.2.0.1.0 - Production on 25-JAN-2002
14:46:28

Copyright (c) 1997 Oracle Corporation.  All rights reserved.

Used parameter files:
Used TNSNAMES adapter to resolve the alias
Attempting to contact (DESCRIPTION = (ADDRESS_LIST = (ADDRESS = (PROTOCOL =
TCP)(HOST = sales-server)(PORT = 1521))) (CONNECT_DATA = (SERVICE_NAME =
sales.us.acme.com)))
TNS-12541: TNS:no listener
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Example: Reaching an Oracle Names Server with TNSPING To check whether a Oracle
Names server can be reached, use a command using the protocol address as in the
following:

tnsping ’(ADDRESS=(PROTOCOL=tcp)(HOST=onames-server)(PORT=1575))’

A message similar to the following will be returned to the user:

TNS Ping Utility for Solaris: Version 9.2.0.1.0 - Production on 25-JAN-2002
15:28:37

Copyright (c) 1997 Oracle Corporation.  All rights reserved.

Attempting to contact (address=(protocol=tcp)(host=onames-server)(port=1575))
OK (60 msec)

TRCROUTE Utility
The Trace Route Utility (TRCROUTE) enables administrators to discover the path or
route a connection is taking from a client to a server. If TRCROUTE encounters a
problem, it returns an error stack to the client instead of a single error. These
additional error messages make troubleshooting easier.

TRCROUTE is different from TNSPING in that it travels as a special type of connect
packet, and is routed as such. As it travels toward its destination, the TRCROUTE
connect packet collects the TNS addresses of every node it travels through. If an
error occurs, TRCROUTE collects error information that shows where the error
occurred. The Trace Route Utility displays the information collected on the client
screen. You can redirect the TRCROUTE output to a file, and print it if you wish.

The Trace Route Utility uses minimal resources. It gathers information in the
connect data of a special connect packet; standard connect packets are not affected.

The server is not affected by TRCROUTE. The listener receives and processes the
TRCROUTE connect packet. It returns the information to the client by putting it into
a refuse packet. The server does not need to start up any new processes or deal with
dummy connections.
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Using TRCROUTE To invoke TRCROUTE, enter the following from the command
line:

trcroute net_service_name

The following are two examples of trace route output.

Example: Successful Trace Route

The following example shows a successful Trace Route packet that traveled from a
client to a listener.

trcroute sales
Trace Route Utility for Solaris: Version 9.2.0.1.0 - Production on 25-JAN-2002
14:35:05

Copyright (c) 1999 Oracle Corporation.  All rights reserved.

Route of TrcRoute:
------------------

Node: Client            Time and address of entry into node:
-------------------------------------------------------------
25-JAN-2002 14:35:05 ADDRESS= PROTOCOL=TCP  HOST=sales-server  PORT=1521

Node: Server            Time and address of entry into node:
-------------------------------------------------------------
25-JAN-2002 14:35:06
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Example: Trace Route with Error

The following examples shows an unsuccessful Trace Route packet that could not
reach the listener because the listener was not up.

trcroute sales
Trace Route Utility for Solaris: Version 9.2.0.1.0 - Production on 25-JAN-2002
14:43:05

Copyright (c) 1999 Oracle Corporation.  All rights reserved.

Route of TrcRoute:
------------------

Node: Client            Time and address of entry into node:
-------------------------------------------------------------
25-FEB-2002 14:43:05 ADDRESS= PROTOCOL=TCP  HOST=sales-server  PORT=1521

TNS-12203: TNS:unable to connect to destination
TNS-12541: TNS:no listener
TNS-12560: TNS:protocol adapter error
TNS-03601: Failed in route information collection
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Oracle Net Manager
To verify connectivity for a client computer, use Oracle Net Manager:

1. Start Oracle Net Manager.

2. In the navigator, expand Directory or Local > Service Naming.

3. Select the net service name or database service.

4. Choose Command > Test Net Service.

Testing assumes that the database and listener are running. If they are not, see
"Starting Oracle Net Services Components" on page 16-2 to start components.

During testing, a Connection Test dialog box appears, providing status and test
results. A successful test results in the following message:

The connection test was successful.

If the test was successful, proceed to Step 5.

If the test was not successful:

a. Ensure that the database and listener are running, and then click Test.

b. Click Change Login to change the username and password for the
connection, and then click Test.

5. Click Close to dismiss the Connect Test dialog box.

See Also: "Starting Oracle Net Manager" on page 5-3
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Testing an Oracle Names Server
To test an Oracle Names server, use the Oracle Names Control utility PING
command. Following are two ways to PING the Oracle Names server labrador  in
the us.acme  domain.

From the Oracle Names Control utility prompt, enter:

NAMESCTL> PING labrador.us.acme

You can test several Oracle Names servers with the same PING command. For
example:

NAMESCTL> PING huey.jp.acme duey.jp.acme louie.jp.acme

PING responds with the time it takes to contact the Oracle Names server and return
an acknowledgment. If PING fails, make sure the Oracle Names server is started or
double-check the configured address of the Oracle Names server.
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Testing Network Objects with Oracle Net Manager or Oracle Names Control Utility
The information stored in an Oracle Names server can be queried to verify
registration with the QUERY command.

To use the QUERY command, use either Oracle Net Manager or Oracle Names
Control utility:

Use Oracle Net Manager... Use Oracle Names Control utility...

1. Start Oracle Net Manager.

See Also: "Starting Oracle Net Manager" on
page 5-3

2. In the navigator pane, expand Oracle Names
Servers.

3. Select an Oracle Names server.

4. From the list in the right pane, select Manage
Data.

5. Click the Advanced tab.

6. Select Query.

7. Enter the name of the object to query in the Name
field.

8. Optionally, enter the record type of the object in
the Name field:

-A.SMD: Network address of a database object

-CNAME.SMD: Alias

-DL.RDBMS.OMD: Global database link

-DLCR.RDBMS.OMD: Link qualifier

-NS.SMD: Oracle Names server. System data used
to communicate between Oracle Names servers

-V1ADD.NPO.OMD: SQL*Net Version 1 connect
descriptor

9. Click Execute.

10. Choose File > Save Network Configuration.

For a Oracle Names server in the administrative
region, create and register an alias with the Oracle
Names server:

To display all data:

namesctl
NAMESCTL> QUERYname *

The record type of an object may also be requested.
Common record types include:

-A.SMD: Network address of a database object

-CNAME.SMD: Alias

-DL.RDBMS.OMD: Global database link

-DLCR.RDBMS.OMD: Link qualifier

-NS.SMD: Oracle Names server. System data used to
communicate between Oracle Names servers

-V1ADD.NPO.OMD: SQL*Net Version 1 connect
descriptor

To display the database address for a net service
name:

namesctl
NAMESCTL> QUERYname a.smd

The following example shows a query of the net
service name sales :

namesctl
NAMESCTL> QUERY sales a.smd

The QUERYcommand returns the amount of time the
transaction took and information about the network
object.
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17
Troubleshooting Oracle Net Services

Oracle Net Services provides methods for understanding and resolving network
problems through the use of log and trace files. These files keep track of the
interaction between network components as errors occur. Evaluating this
information will help you to diagnose and troubleshoot even the most complex
network problems.

This chapter describes common network errors and outlines procedures for
resolving them. It also describes methods for logging and tracing error information
to diagnose and troubleshoot more complex network problems. This chapter
contains these topics:

■ Diagnosing Oracle Net Services

■ Resolving the Most Common Error Messages for Oracle Net Services

■ Troubleshooting Tips from the Field for Oracle Net Services

■ Troubleshooting Network Problems Using Log and Trace Files

■ Logging Error Information for Oracle Net Services

■ Oracle Net Services Tracing Error Information

■ Contacting Oracle Support Services
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Diagnosing Oracle Net Services
If an attempt to make a basic peer-to-peer (single protocol network) connection
returns an ORAError , this section may help you diagnose the cause of the problem.

Any underlying fault, noticeable or not, is reported by Oracle Net Services with an
error number or message that is not always indicative of the actual problem. This
section helps you determine which parts of Oracle Net Services do function
properly rather than the parts that do not work. It also helps you to decide in which
of the following categories the fault belongs:

■ Oracle software

■ Operating system layer

■ Other network layers

Testing the various network layers progressively should in most cases uncover any
problem.
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Server Diagnostics

Answer the following questions:

■ Is any other system (workstation/server) able to connect to the server using
Oracle Net?

■ Has the server, database, or listener configuration remained the same for some
time?

If you answered YES to any of the preceding questions/statements, then skip this
section and continue to "Client Diagnostics" on page 17-4.

If you are unsure, or answered NO to any of the preceding questions, then continue.

Diagnosing Oracle Net Services on the server involves the following tasks:

■ Task 1: Verify the Database Is Running

■ Task 2: Perform a Loopback Test

Task 1: Verify the Database Is Running
To check that the database is up, login to the database and connect with a valid
username and password. For example:

SQLPLUS system/manager

A message appears, confirming that you are connected with the database. If you
receive the following errors, ask your Database Administrator to assist you:

■ ORA-1017: invalid U/P

■ ORA-1034: Oracle not available

Note: You may need assistance from your server administrator to
follow the instructions in this section.
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Task 2: Perform a Loopback Test
To perform a loopback test from the server to the database:

1. Ensure that the listener.ora , tnsnames.ora , and sqlnet.ora  files exist
in the correct locations, as described in "Localized Configuration File Support"
on page 3-2.

2. Follow the instructions in "Testing Configuration on the Database Server" on
page 16-16 to perform a loopback test.

■ If the loopback test continues to fail, continue to the next step.

■ If the loopback test passes, skip to "Client Diagnostics".

3. Check the Problem/Solution Database Web site at
http://support.oracle.com  for more specific information on the error
received, or contact Oracle Worldwide Support.

Client Diagnostics
At this point, you know the serverside listener works properly, because you could
verify at least one of the following statements:

■ The database server passed a loopback test, showing that the connection
worked.

■ Other computers connect also using Oracle Net Services to this same database.

■ Connections from this workstation worked previous to making changes on this
computer, such as the installation of a new product or a modification to the
network configuration.
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To perform diagnostics on the client:

1. Check that you have installed the same protocol support as was installed on the
database server.

On UNIX you can use the ADAPTERS utility to verify protocol support. On the
database server, run the adapters ’which oracle’  command from
$ORACLE_HOME/bin to display the protocol support, naming methods, and
security options linked with the oracle  executable. The adapters  utility
displays output similar to the following:

Oracle Net transport protocols linked with ./oracle are:

    IPC
    BEQ
    TCP/IP
    SSL
    RAW

Oracle Net naming methods linked with ./oracle are:

    Local Naming (tnsnames.ora)
    Oracle Directory Naming
    Oracle Host Naming
    Oracle Names Server Naming
    NIS Naming

Oracle Advanced Security options linked with ./oracle are:

    RC4 40-bit encryption
    RC4 56-bit encryption
    RC4 128-bit encryption
    RC4 256-bit encryption
    DES40 40-bit encryption
    DES 56-bit encryption
    3DES 112-bit encryption
    3DES 168-bit encryption
    AES 128-bit encryption
    AES 192-bit encryption
    AES 256-bit encryption
    MD5 crypto-checksumming
    SHA crypto-checksumming (for FIPS)
    SHA-1 crypto-checksumming
    Kerberos v5 authentication
    CyberSAFE authentication
    RADIUS authentication
    ENTRUST authentication
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On the client, run the adapters  command from $ORACLE_HOME/bin to
display the configured Oracle protocol support, naming methods, and security
options. The ADAPTERS utility displays output similar to the following:

Installed Oracle Net transport protocols are:

    IPC
    BEQ
    TCP/IP
    SSL
    RAW

Installed Oracle Net naming methods are:

    Local Naming (tnsnames.ora)
    Oracle Directory Naming
    Oracle Host Naming
    Oracle Names Server Naming
    NIS Naming

Installed Oracle Advanced Security options are:

    RC4 40-bit encryption
    RC4 56-bit encryption
    RC4 128-bit encryption
    RC4 256-bit encryption
    DES40 40-bit encryption
    DES 56-bit encryption
    3DES 112-bit encryption
    3DES 168-bit encryption
    AES 128-bit encryption
    AES 192-bit encryption
    AES 256-bit encryption
    MD5 crypto-checksumming
    SHA-1 crypto-checksumming
    Kerberos v5 authentication
    CyberSAFE authentication
    RADIUS authentication

Note: RAW is an internal protocol used by Oracle Net.

See Also: Oracle UNIX operating system-specific Administrator’s
Reference for further information about the adapters  utility
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2. Check base connectivity for underlying network transport. Oracle Net
technology depends on the underlying network for a successful connection.

3. To ensure that both the Oracle Net foundation layer and the appropriate Oracle
protocol support are present, verify that all Oracle Net Services software for the
client has been installed.

4. Ensure that the client computer has the tnsnames.ora  and the sqlnet.ora
files exist in the correct locations.

If you have any other working client computers connecting to the selected
Oracle database, back up your existing files and copy both the working
tnsnames.ora  and sqlnet.ora  files from the working computer onto the
non-working client workstations. This eliminates the possibility of errors in the
files.

5. Test the Oracle Net foundation layer.

Protocol Verify that you can...

TCP/IP Use terminal emulation or file transfer utilities, (PING, FTP,
TELNET) from the client to the database server.

Named Pipes ■ See other computers or servers on the Microsoft network.

■ Ensure that you are able to share drives within the
network.

See Also: "Localized Configuration File Support" on page 3-2

See Also: "Testing Network Connectivity from the Client" on
page 16-17

Note: Do not use the TNSPING utility. The TNSPING utility
works like the TCP/IP PING utility and does not create and open a
socket, nor does it connect with the listener. It ensures that the
listener is present on the database server.
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6. If the connection still fails:

■ Use tracing, as described in section "Troubleshooting Network Problems
Using Log and Trace Files" on page 17-23

■ Check the Problem/Solution Database Web site at
http://support.oracle.com  for a specific diagnostics bulletin on the
error received

■ Contact Oracle Support Services
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Resolving the Most Common Error Messages for Oracle Net Services
Due to the complexity of network communications, network errors may originate
from a variety of sources, for a variety of reasons. If an error occurs, applications
such as SQL*Plus, that depend on network services from Oracle Net Services, will
normally generate an error message.

A list of the most common network error messages follows:

■ ORA-12154: TNS:could not resolve service name

■ ORA-12198: TNS:could not find path to destination

■ ORA-12203: TNS:unable to connect to destination

■ ORA-12224: TNS:no listener

■ ORA-12514: TNS:listener could not resolve SERVICE_NAME
given in connect descriptor

■ ORA-12520: TNS:listener could not find available handler
for requested type of server

■ ORA-12521: TNS:listener could not resolve INSTANCE_NAME
given in connect descriptor

■ ORA-12533: TNS:illegal ADDRESS parameters

■ ORA-12545: TNS:name lookup failure

■ ORA-12560: TNS:protocol adapter error

■ ORA-3113: TNS:End of file on communication channel

■ ORA-3121: No interface driver connection - function not
performed

See Also: Oracle9i Database Error Messages for a complete listing of
error messages
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ORA-12154: TNS:could not resolve service name
Cause:  Oracle Net could not locate the net service name specified in the
tnsnames.ora  configuration file.

Action: Perform these steps:

1. Verify that a tnsnames.ora  file exists.

2. Verify that there are not multiple copies of the tnsnames.ora  file.

3. In the tnsnames.ora  file, verify that the net service name specified in
your connect string is mapped to a connect descriptor.

4. Verify that there are no duplicate copies of the sqlnet.ora  file.

5. If you are using domain names, verify that your sqlnet.ora  file contains
a NAMES.DEFAULT_DOMAIN parameter. If this parameter does not exist,
you must specify the domain name in your connect string.

6. If you are not using domain names, and this parameter exists, delete it or
disable it by commenting it out.

7. If you are connecting from a login dialog box, verify that you are not
placing an "@" symbol before your connect net service name.

8. Activate client tracing and repeat the operation.

Cause:  Oracle Net could not locate the database service name or net service
name specified in the directory server.

Action: Perform these steps:

1. Verify that the database service or net service name entry exists in the
directory that this computer was configured to use.

2. Verify that the sqlnet.ora  file includes the following entry:

NAMES.DIRECTORY_PATH=(ldap, other_naming_methods )

See Also: "Localized Configuration File Support" on page 3-2 for
configuration file location information

See Also: Chapter 8, "Setting Up Directory Server Usage" for
directory setup instructions
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ORA-12198: TNS:could not find path to destination
ORA-12203: TNS:unable to connect to destination

Cause: The client cannot find the desired database.

Action: Perform these steps:

1. Verify that you have entered the net service name you wish to reach
correctly.

2. Verify that the net service name ADDRESS parameters in the connect
descriptor.

3. If using local naming, verify that the tnsnames.ora  file is stored in the
correct directory.

4. Verify that the listener on the remote node has started and is running. Enter:

lsnrctl
LSNRCTL> STATUS [ listener_name ]

listener_name  is the name of the listener defined in the listener.ora
file. It is not necessary to identify the listener if you are using the default
listener, named LISTENER.

If the output indicates the listener is not running, try starting it with the
command:

LSNRCTL> START [ listener_name ]

5. If you are connecting from a login box, verify that you are not placing an
"@" symbol before your connect net service name.

See Also: "Localized Configuration File Support" on page 3-2 for
configuration file location information
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ORA-12203: TNS:unable to connect to destination
Cause: ORA-12203  error is a generic error that often shields secondary errors.

Action: Check the latest sqlnet.log  file for secondary ORA messages.

Cause: An invalid net service name was supplied in the connect string.

Action: Verify that the net service name supplied in the connect string exists in
the tnsnames.ora  file or directory server and the ADDRESS information for
that net service name is valid. Ask yourself the following questions:

■ Is the SERVICE_NAME correct?

■ Is the HOST correct?

■ Is the PORT specified correct?

Cause: The tnsnames.ora  file is not located in the proper directory.

Action: Make sure that the tnsnames.ora  file is in the proper location.

Cause: The (HOST=server_name )  parameter for TCP/IP addresses is not
consistent on the client and server computers.

Action: Ensure that the values for these parameter are the same on the server
and client.

For TCP/IP, make sure that the HOST parameter in listener.ora  on the
server and in the tnsnames.ora file on the client point to the same name, or at
least to names that are then translated to the same IP address by each system.
This is especially important for servers with multiple IP addresses assigned to
the various network interfaces on the server.

See Also: "Localized Configuration File Support" on page 3-2 for
configuration file location information
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Cause: The destination system's listener is not listening.

Action: Verify that the remote system's listener is running. Enter:

lsnrctl
LSNRCTL> STATUS [listener_name ]

listener_name  is the name of the listener defined in the listener.ora  file.
It is not necessary to identify the listener if you are using the default listener,
named LISTENER.

If the output indicates the listener is not running, try starting it with the
command:

LSNRCTL> START [listener_name ]

Cause: There are underlying network transport problems.

Action: Use the utilities supplied with the underlying networking protocol to
verify that the protocol itself is functional. For example, with TCP/IP, try to
ping  the remote system.

Cause: The incorrect Oracle protocol for the selected networking protocol is
installed. A missing protocol support driver usually produces the following
errors in the sqlnet.log  or any client trace file:

– ORA-12203

– ORA-12538

– ORA-00508

Action: Check that you have installed the appropriate Oracle protocol. On
UNIX, you can run the ADAPTERS utility.

See Also: "Client Diagnostics" on page 17-4
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ORA-12224: TNS:no listener
Cause: The connection request could not be completed because the listener is
not running.

Action: Perform these steps:

1. Ensure that the supplied destination address matches one of the addresses
used by the listener.

2. Verify that this is not a version compatibility problem.

ORA-12533: TNS:illegal ADDRESS parameters
Cause: The protocol specific parameters in the ADDRESS section of the
designated connect descriptor are incorrect.

Action: Correct the protocol address.

ORA-12514: TNS:listener could not resolve SERVICE_NAME given in connect
descriptor
Cause: The service name specified in the connect descriptor is incorrect, or the
database service is not registered with the listener.

Action: Perform these steps:

1. Check to make sure the SERVICE_NAME specified in the connect descriptor
is correct.

2. Ensure the database instance is running. If the instance not running, start it
so that it can register with the listener. You can use the Listener Control
utility SERVICES command to see what services are currently registered
with the listener.

See Also: Oracle9i Net Services Reference Guide for correct protocol
syntax

See Also: "SERVICES Command" on page 12-25
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ORA-12520: TNS:listener could not find available handler for requested type of
server
Cause: The type of service handler requested by the client is incorrect or not
registered for the requested SERVICE_NAME/INSTANCE_NAME, or the database
instance is not registered with the listener.

Action: If you suspect the problem is the wrong type of service handler,
perform these steps:

1. If (SERVER=value ) is set is in the connect descriptor, ensure that the value
is set to the appropriate service handler type for the database, that is,
dedicated  for dedicated server or shared  for dispatchers. You can use
the Listener Control utility SERVICES command to see what service
handlers are currently registered with the listener.

2. If USE_DEDICATED_SERVER is set to on  in the sqlnet.ora  file, then
ensure the database is configured to use dedicated servers. If it is not, set
this parameter to off .

3. Ensure that the database instance is running. If the instance not running,
start it so that it can register with the listener.

ORA-12521: TNS:listener could not resolve INSTANCE_NAME given in connect
descriptor
Cause: The INSTANCE_NAME in the connect descriptor is incorrect, or the
database instance is not registered with the listener.

Action: Perform these steps:

1. Check to make sure the service name specified in the connect descriptor is
correct.

2. Ensure the database instance is running. If the instance not running, start it
so that it can register with the listener. You can use the Listener Control
utility SERVICES command to see what instances are currently registered
with the listener.

See Also: "SERVICES Command" on page 12-25

See Also: "SERVICES Command" on page 12-25
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ORA-12545: TNS:name lookup failure
Cause: The listener on the remote node cannot be contacted.

Action: Perform these steps:

1. Verify that the ADDRESS in the tnsnames.ora  file and the
listener.ora  file is correct.

2. Verify that the listener on the remote node has been started. Enter:

lsnrctl
LSNRCTL> STATUS [ listener_name ]

listener_name  is the name of the listener defined in the listener.ora
file. It is not necessary to identify the listener if you are using the default
listener, named LISTENER.

If the output indicates the listener is not running, try starting it with the
command:

LSNRCTL> START [ listener_name ]

ORA-12560: TNS:protocol adapter error
Action: The listener was unable to start a process connecting the user to the
database server.

Cause: Perform these steps:

1. Turn on tracing and repeat the operation.

2. Evaluate the contents of the trace file to diagnose the problem.

See Also: "Oracle Net Services Tracing Error Information" on
page 17-42
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ORA-3113: TNS:End of file on communication channel
Cause: An error has occurred on the database server.

Action: Check the alert_ sid .log  on the server. The location of alert_
sid .log  is specified by the BACKGROUND_DUMP_DEST initialization
parameter.

Cause: An unexpected end of file was processed on the communication
channel. This may be an indication that the communications link may have
gone down at least temporarily; it may indicate that the server has gone down.

Action: You may need to modify your retransmission count.

ORA-3121: No interface driver connection - function not performed
Cause: A SQL*Net version 1 prefix was erroneously used in the connect string.

Action: Do not use the following prefixes in the connect string.

■ T:

■ X:

■ P:

Cause: The username and password were specified from a client computer that
had no local Oracle database installed.

Action: Specify a connect string.

See Also:  Oracle operating system-specific documentation for
more information about troubleshooting this error
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Troubleshooting Directory Naming Errors
Directory naming issues associated with connectivity errors such as ORA-12154 ,
ORA-12203 , or ORA-12224  for database service or net service name entries in a
directory server require analysis of the data. You can analyze the data contained
within a directory server with the ldifwrite  command line tool.

ldifwrite  enables you to convert all or part of the information residing in a
directory server to LDAP Data Interchange Format (LDIF). The ldifwrite  tool
performs a subtree search, including all entries following the specified
distinguished name (DN), including the DN itself.

The ldifwrite  tool syntax is as follows:

ldifwrite -c net_service_name/database_service  -b base_DN -f ldif_file

Table 17–1 ldapwrite Arguments

The following example writes all the directory naming entries under
dc=us,dc=acme,dc=com  to the output1.ldi  file:

ldifwrite -c ldap -b "dc=us,dc=acme,dc=com" -f output.ldif

Argument Description

-c net_service_
name/database_service

Specify the net service name or database service name
that will connect you to the directory server.

-b base_DN Specify the base of the subtree to be written out in LDIF
format.

-f ldif_file Specify the input file name.
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Oracle Names LDAP Proxy Server Error Reporting
Errors in the region load operation will be reported in the Oracle Names server log
file (names.log ). These errors may range from failure to contact the directory
server to errors with the query for all, some, or one of the records.

Some directories, such as Oracle Internet Directory, have limits on ldapsearch
operations. There are settings in the directory server that limit the number of objects
returned by the search and the amount of time spent performing a search.

Increasing Search Size Limit
The size limit specifies how many objects can be returned from a search. The default
limit is 1000. If this limit is exceeded, you will see the following errors in the
names.log  file:

NNO-00062: cannot load domain data from configuration database
NNO-00850: Error: LDAP query returns 4

You can also use the ldapsearch  command line tool to mimic what the Oracle
Names server will do when it loads its region. The following syntax shows loading
data from DN (dn:dc=acme,dc=com) :

ldapsearch -p 389 -h host  -b "dc=acme,dc=com"
"(objectclass=orclNetService)(objectclass=orclService)"

After returning the allowed number of object, ldapsearch  returns the following
error message:

ldapsearch: Sizelimit exceeded

You can modify the size limit using the following sample LDIF file output. Enter the
appropriate DN. In addition, set orclsizelimit  high enough to allow for the
number of databases defined in the region in the directory server, with a little room
for future expansion.

dn:
changetype: modify
replace: orclsizelimit
orclsizelimit: 5000
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Increasing the Search Time Limit
The time limit specifies the amount of time that can be spent performing a search.
The default time limit is 10 seconds. Ten seconds is sufficient to query for roughly
1,000 object, which is sufficient for most searches. If the query exceeds the time
limit, you will see the following errors in the names.log  file:

NNO-00062: cannot load domain data from configuration database
NNO-00850: Error: LDAP query returns 105

You can modify the time limit using the following sample LDIF file output. Enter
the appropriate DN.

dn:
changetype: modify
replace: orcltimelimit
orcltimelimit: 20

The time limit is applied at both the directory server and API levels. Therefore, in
addition to resetting the directory server time limit, you will also need to set the
TIMEOUT subparameter of NAMES.ADMIN_REGION. For example:

NAMES.ADMIN_REGION=
 (REGION=
  (TIMEOUT=20)
  (TYPE=ldap)
  (HOST=ldap_server)
  (PORT=389)
  (SUBTREE=(BASE=dc=acme,dc=com)))
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Troubleshooting Tips from the Field for Oracle Net Services
Here are some tips you may find helpful when you are having difficulty diagnosing
network problems:

■ Use the node or network address during configuration instead of the name of
the server computer

This eliminates any internal lookup problems and make the connection slightly
faster.

■ If you are using TCP/IP addresses, use the IP address rather than host name

For example, change the
(HOST=server_name ) line in the tnsnames.ora  file with the internet
address, for example (HOST=198.32.3.5 ).

■ Perform a loopback test

Perform a loopback test on the server as described in "Testing Configuration on
the Database Server" on page 16-16. If the test passes, ftp  the tnsnames.ora
and sqlnet.ora  files to the client.

■ Check what is between you and the server

If it is a wide area network (WAN), identify any intermediate systems that may
not work correctly. If all computers are fine, the problem may be a timing issue.

■ Verify Whether or Not There Is a Timing Issue

Timing issues are associated with ORA-12203 , ORA-12535 , or ORA-12547
errors in the client log files.

To resolve this, try speeding up the connection by using exact addresses instead
of names and increase the CONNECT_TIMEOUT_listener_name  parameter in
the listener.ora  file. The default value for this parameter is 10 seconds.

■ Determine which Oracle applications are failing

SQL*Plus may work, but CASE tools may not. If you determine the problem is a
data volume issue, try to transfer a large (5 MB) file with the base connectivity.
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Questions to Ask When Troubleshooting Oracle Net Services
Here are some questions to ask yourself when diagnosing a problem:

■ Do all computers have a problem, or is it just one?

If one computer works and another does not, and you are confident that the
same software (Oracle and third-party products) is installed, on each computer,
swap out the network cables, if they are close enough, to see if the problem
moves. If it does move, it indicates that the problem has something to do with
the client/server connection and is not local to the PC.

■ What kind of links exist between the client and the server, for example, X.25,
ISDN, Token Ring, or leased line?

Sniffers and LAN analyzers are useful for intermittent failing connections or
detecting time-outs and re-sent packets. You can also see what side of the
conversation is waiting for a response.



Logging Error Information for Oracle Net Services

Troubleshooting Oracle Net Services 17-23

Troubleshooting Network Problems Using Log and Trace Files
Oracle Net Services provide detailed information about the source and context of
problems as they arise. This information is generated and stored in log and trace
files. The process of logging and tracing error information will help you to diagnose
and resolve network problems.

Logging Error Information for Oracle Net Services
All errors encountered in Oracle Net Services are appended to a log file for
evaluation by a network or database administrator. The log file provides additional
information for an administrator when the error message on the screen is
inadequate to understand the failure. The log file, by way of the error stack, shows
the state of the software at various layers.

To ensure that all errors are recorded, logging cannot be disabled on clients or
Names Servers. Furthermore, only an administrator may replace or erase log files.
The log file for the listener also includes Audit Trail information about every client
connection request, as well as most listener control commands.

This section contains these topics:

■ Oracle Net Error Stacks

■ Oracle Net Services Log File Names

■ Setting Logging Parameters

■ Setting Oracle Net Log Settings During Runtime of Control Utilities

■ Using Log Files

■ Listener Log Audit Trail Information

■ Analyzing Oracle Connection Manager Logs
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Oracle Net Error Stacks
Log files provide information contained in an error stack. An error stack refers to
the information that is produced by each layer in an Oracle communications stack
as the result of a network error. Figure 17–1 depicts the relationship among error
stack components and Oracle Net.

Figure 17–1 Error Stack Components Mapped to Oracle Net

The error stack components in Figure 17–1 are described in Table 17–2.

Table 17–2 Error Stack Components

:

Error Stack
Component

Description

NI Network Interface. This layer provides a generic interface for
Oracle clients, servers, or external processes to access Oracle
Net functions. The NI layer handles the "break" and "reset"
requests for a connection.

NI uses the Network Routing (NR) layer to obtain network
route information for pre-Oracle9i clients, and the Network
Naming (NN) layer to resolve names to connect descriptors. For
Oracle9i clients, NI goes directly to the Network Session (NS)
layer.

NN Network Naming (Oracle Names). This layer resolves connect
identifiers to connect descriptors.

NNNR

NANS(2)

NI

NS Main

NT(2)

NT Main

Network Protocol

NT OS

Oracle Net
Foundation

Layer

Network Protocol

Oracle Protocol
Support
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Example: Error Stack
As an example, suppose that a user of a client application tries to establish a
connection with a database server using Oracle Net and TCP/IP, and the user
enters:

sqlplus scott/tiger@hrserver.com

The following error displays:

ORA-12203: TNS:Unable to connect to destination

This message indicates that the connection to the server failed because the database
could not be contacted. Although the application displays only a one-line error
message, an error stack that is much more informative is recorded in the log file by
the network layer.

NS Network Session (main and secondary layers). These layers
receive requests from NI, and settle all generic computer-level
connectivity issues, such as: the location of the server or
destination (open, close functions); whether one or more
protocols will be involved in the connection (open, close
functions); and how to handle interrupts between client and
server based on the capabilities of each (send, receive
functions).

NS uses NR to route the network session to the destination and
Network Authentication (NA) to negotiate any authentication
requirements with the destination.

NR Network Routing. This layer routes the network session to the
destination.

NA Network Authentication. This layer negotiates authentication
and encryption requirements.

NT Network Transport (main, secondary, and operating system
layers). This layer maps Oracle Net foundation layer
functionality to industry-standard protocols.

Error Stack
Component

Description
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On the client side, a sqlnet.log  file (Figure 17–2) contains an error stack
corresponding to the ORA-12203  error.

Figure 17–2 sqlnet.log File

***********************************************************

Fatal OSN connect error 12203, connecting to:
 (DESCRIPTION=(CONNECT_DATA=(SID=trace)(CID=(PROGRAM=)
   (HOST=lala)(USER=sviavant)))(ADDRESS_LIST=(ADDRESS=
   (PROTOCOL=ipc)(KEY=trace))(ADDRESS=(PROTOCOL=tcp)
   (HOST=lala)(PORT=1521))))

VERSION INFORMATION:
TNS for SunOS:
Oracle Bequeath NT Protocol Adapter for SunOS:
Unix Domain Socket IPC NT Protocol Adaptor for SunOS:
TCP/IP NT Protocol Adapter for SunOS:
  Tracing to file: /home/sviavant/trace_admin.trc
  Tns error struct:
    nr err code: 12203
    TNS-12203: TNS:unable to connect to destination
    ns main err code: 12541
    TNS-12541: TNS:no listener
    ns secondary err code: 12560
    nt main err code: 511
    TNS-00511: No listener
    nt secondary err code: 61
    nt OS err code: 0
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Oracle Net Services Log File Names
Each Oracle Net Services component produces its own log file. Table 17–3 provides
the default log file names and lists the components that generate the log files.

Table 17–3 Oracle Net Log Files

Setting Logging Parameters
Parameters that control logging, including the type and amount of information
logged, as well as the location where the files are stored, are set in the configuration
file of each network component as described in Table 17–4.

Table 17–4 Oracle Net Log Parameters

Log File Component

sqlnet.log Client or database server

listener.log Listener

names.log Oracle Names Server

cman_pid .log  on UNIX

cmanpid .log  on Windows NT

Oracle Connection Manager CMGW process

cmadm_pid .log  on UNIX

cmadmpid .log  on Windows NT

Oracle Connection Manager CMADMIN process

Network Component Configuration Files

Client sqlnet.ora

Database Server sqlnet.ora

Listener listener.ora

Oracle Names Server names.ora

Oracle Connection Manager cman.ora
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This section contains these topics:

■ sqlnet.ora Log Parameters

■ listener.ora Log Parameters

■ names.ora Log Parameters

■ cman.ora Log Parameters

■ Setting Logging Parameters in Configuration Files

sqlnet.ora Log Parameters
Table 17–5 describes the log parameters settings that can be set in the sqlnet.ora
file.

Table 17–5 sqlnet.ora Log Parameters

See Also: Oracle9i Net Services Reference Guide for more
information about these parameters

sqlnet.ora Parameter Oracle Net Manager
Field

Description

LOG_DIRECTORY_CLIENT Client Information:
Log Directory

Establishes the destination directory for the client log
file. By default, the client directory is the current
working directory.

LOG_FILE_CLIENT Client Information:
Log File

Sets the name of the log file for the client. By default
the log name is sqlnet.log .

LOG_DIRECTORY_SERVER Server Information:
Log Directory

Establishes the destination directory for the database
server log files. By default the server directory is
$ORACLE_HOME/network/log  on UNIX and
ORACLE_HOME\network\log  on Windows NT.

LOG_FILE_SERVER Not applicable Sets the name of the log file for the database server.
By default the log name is sqlnet.log .
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listener.ora Log Parameters
Table 17–6 describes the log parameters settings that can be set in the
listener.ora  file.

Table 17–6 listener.ora Log Parameters

names.ora Log Parameters
Table 17–7 describes the log parameters settings that can be set in the names.ora
file.

Table 17–7 names.ora Log Parameters

listener.ora Parameter Oracle Net Manager
Field

Description

LOG_DIRECTORY_listener_
name and

LOG_FILE_listener_name

Log File Establishes the destination directory and file for the
log file that is automatically generated for listener
events. By default the directory is $ORACLE_
HOME/network/log  on UNIX and ORACLE_
HOME\network\log  on Windows NT, and the file
name is defaulted to listener.log .

names.ora Parameter Oracle Net Manager
Field

Description

NAMES.LOG_DIRECTORY Log Directory Establishes the destination directory for log files. By
default, the directory is $ORACLE_
HOME/network/log  on UNIX and ORACLE_
HOME\network\log  on Windows NT.

NAMES.LOG_FILE Log File Sets the name of the log file for the client. By default
the log name is names.log .
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cman.ora Log Parameters
Table 17–8 describes the log parameters settings that can be set in the cman.ora
file.

Table 17–8 cman.ora Log Parameters

Setting Logging Parameters in Configuration Files
Logging parameters for the sqlnet.ora  file, listener.ora  files and
names.ora file can be set with the Oracle Net Manager. The cman.ora file logging
parameters must be set manually.

To set logging parameters:

1. Start Oracle Net Manager.

2. Specify the log parameters:

cman.ora Parameter Description

LOG_LEVEL Establishes the level of logging. Five levels are supported:

■ 0—No log output

■ 1—Basic reporting

■ 2—RULE_LIST matching lookup reporting

■ 3—Relay blocking reporting

■ 4—Relay I/O counts reporting

The CMGW gateway process creates a log file called
cman_pid .log  on UNIX and cmanpid .log  on
Windows NT. The CMADMIN administrative process
creates a log file called cmadm_pid .log  on UNIX and
cmadmpid .log  on Windows NT.

See Also: Oracle9i Net Services Reference Guide

See Also: "Starting Oracle Net Manager" on page 5-3
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3. Choose File > Save Network Configuration.

Setting Oracle Net Log Settings During Runtime of Control Utilities
Logging can be set during runtime of control utilities. Note that setting logging with
a control utility will not set parameters in the *.ORA  files; the setting is only valid
for the session of the control utility:

■ For a listener, use the SET LOG_FILE and SET LOG_DIRECTORY commands
from the Listener Control utility.

■ For an Oracle Connection Manager, use the SET LOG_LEVEL command from
the Oracle Connection Manager control utility.

■ For an Oracle Names server, use the SET LOG_FILE_NAME command from the
Oracle Names Control utility, or set logging settings through Oracle Net
Manager.

Log File Set logging parameters here...

sqlnet.log 1. In the navigator pane, expand Local > Profile.

2. From the list in the right pane, select General.

3. Click the Logging tab.

4. Specify the settings.

listener.log 1. In the navigator pane, expand Local > Listeners.

2. Select a listener.

3. From the list in the right pane, select General.

4. Click the Logging and Tracing tab.

5. Specify the settings.

names.log 1. In the navigator pane, expand Oracle Names Servers.

2. Select an Oracle Names server.

3. From the list in the right pane, select Configure Server.

4. Click the Adv. tab.

5. Specify the log directory and file name.

See Also: Oracle9i Net Services Reference Guide
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To set tracing for an Oracle Names server with Oracle Net Manager:

1. Start Oracle Net Manager.

2. In the navigator, expand the Oracle Names Servers.

3. Select an Oracle Names server.

4. From the list in the right pane, select Manage Server.

5. Click the Logging tab.

6. Specify the log directory and file name.

7. Choose File > Save Network Configuration.

Using Log Files
To use a log file to diagnose a network error:

1. Review the log file for the most recent error number you received from the
application. Note that this is almost always the last entry in the log file.

2. Starting from the bottom of the file, locate the first nonzero entry in the error
report. This is usually the actual cause.

3. If that error does not provide the desired information, review the next error in
the stack until you locate the correct error information.

4. If the cause of the error is still not clear, turn on tracing and repeat the statement
that produced the error message.

See Also: "Starting Oracle Net Manager" on page 5-3
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Analyzing Listener Log Files
This section describes what is recorded in the listener log file, including:

■ Listener Log Audit Trail Information

■ Listener Service Registration Event Information

■ Listener Direct Hand-Off Information

Listener Log Audit Trail Information
The listener log file contains audit trail information that enables you to gather and
analyze network usage statistics, as well as information indicating the following:

■ A client connection request

■ A RELOAD, START, STOP, STATUS, or SERVICES command issued by the
Listener Control utility

Format of the Listener’s Log Audit Trail

The Audit Trail formats text into the following fields:

Timestamp * Connect Data * [Protocol Info] * Event * [SID | Service] * Return
Code

Properties of the Audit Trail are as follows:

■ Each field is delimited by an asterisk (* ).

■ Protocol address information and SID or service name information appear only
when a connection is attempted.

■ A successful connection or command returns a code of zero.

■ A failure produces a code that maps to an error message.

See Also: "Resolving the Most Common Error Messages for
Oracle Net Services" on page 17-9 for the most common Oracle Net
errors or Oracle9i Database Error Messages for a complete listing of
error messages
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Example: Listener Log Event for Successful Reload Request

Typical output to the log file upon a RELOAD request follows.

14-JAN-2002 00:29:54 *
(connect_
data=(cid=(program=)(host=sales-server)(user=jdoe))(command=stop)(arguments=64)(
service=listener)(version=135290880))
* stop * 0

Example: Listener Log Event for Successful Connection Request

Typical output to the log file upon a connection request follows.

14-JAN-2002 15:28:58 *
(connect_data=(service_name=sales.us.acme.com)(cid=(program=)(host=sales-server)
(user=jdoe)))
* (address=(protocol=tcp)(host=144.25.185.246)(port=41349)) * establish
* sales.us.acme.com * 0

Using Audit Trail Information

You can use Audit Trail information to view trends and user activity by first storing
it in a table and then collating it into a report format. To import the data into a table,
use an import utility such as SQL*Loader.

Listener Service Registration Event Information
The listener records service registration events. During service registration, the
instance background process PMON process provides the listener with information
about the following:

■ Service names for each running instance of the database

■ Instance names of the database

■ Service handlers (dispatchers or dedicated servers) available

■ Dispatcher, instance, and node load information

■ Dynamic listening endpoints
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The following service registration-related events are recorded in the
listener.log  file:

Table 17–9 Service Registration Event Log Information

Format of the Listener Service Registration Information

The service registration events are formatted into the following fields:

Timestamp * Event *  Instance Name * Return Code

Properties of service registration fields are as follows:

■ Each field is delimited by an asterisk (* ).

■ It is normal for the events to appear multiple times in a row for one instance.

■ A successful registration returns a code of zero, meaning the client can connect
to the instance.

■ A failure produces a code that maps to an error message.

Event Description

service_register The listener received registration information for an instance.

service_update The listener received updated registration information for a
particular instance, such as dispatcher or instance load
information.

service_died The listener lost its connection to PMON. All registration
information for the instance is discarded. Clients will be
unable to connect to the instance until PMON registers it
again.

See Also:

■ "Resolving the Most Common Error Messages for Oracle Net
Services" on page 17-9 for the most common Oracle Net errors

■ Oracle9i Database Error Messages for a complete listing of error
messages
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Example: Listener Log with Service Registration Events

The following example shows a log file with service registration events. Notice how
the listener is able to receive a client request after a successful service_register
event, but is unable to receive client requests after a service_died  event.

-------------------------------
14-JAN-2002 15:28:43 * service_register * sales * 0
14-JAN-2002 15:28:43 * service_register * sales * 0
14-JAN-2002 15:28:58 *
(connect_data=(service_name=sales.us.acme.com)(cid=(program=)(host=sales-server)
(user=jdoe)))
* (address=(protocol=tcp)(host=144.25.185.246)(port=41349)) * establish
* sales.us.acme.com * 0
14-JAN-2002 15:38:44 * service_update * sales * 0
14-JAN-2002 15:38:44 * service_update * sales * 0
14-JAN-2002 15:48:45 * service_update * sales * 0
14-JAN-2002 15:48:45 * service_update * sales * 0
14-JAN-2002 15:50:57 *
(connect_data=(service_
name=sales.us.acme.com)(cid=(program=)(host=sales-server)(u
ser=jdoe)))
* (address=(protocol=tcp)(host=144.25.185.246)(port=41365)) * establish
* sales.us.acme.com * 0
14-JAN-2002 15:51:26 * service_died * sales * 12537
14-JAN-2002 15:51:26 * service_died * sales * 12537
14-JAN-2002 15:52:06 *
(connect_data=(service_
name=sales.us.acme.com)(cid=(program=)(host=sales-server)(u
ser=jdoe)))
* (address=(protocol=tcp)(host=144.25.185.246)(port=41406)) * establish
* sales.us.acme.com * 12514
TNS-12514: TNS:listener could not resolve SERVICE_NAME given in connect
descriptor
--------------------------------
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Listener Direct Hand-Off Information
The listener records direct hand-off events to dispatchers. These events are
formatted into the following fields:

Timestamp * Presentation * Handoff  * Error Code

Properties of direct hand-off fields are as follows:

■ Each field is delimited by an asterisk (* ).

■ A successful connection or command returns a code of zero.

■ A failure produces a code that maps to an error message.

Example: Listener Log Event for Direct Hand-Off

A direct hand-off event in the log file is shown in the following example.

21-JAN-2002 10:54:55 * oracle.aurora.net.SALESHttp2 * handoff * 0

See Also: "Resolving the Most Common Error Messages for
Oracle Net Services" on page 17-9 for the most common Oracle Net
errors or Oracle9i Database Error Messages for a complete listing of
error messages
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Analyzing Oracle Connection Manager Logs
Oracle Connection Manager generates two types of log files: one for its CMGW
gateway process (cman_pid .log ) and one for its CMADMIN administrative
process (cmadm_pid .log ).

Figure 17–3 and Figure 17–4 show examples of the log files.

Figure 17–3 cman_pid.log

(TIMESTAMP=20-JAN-2002 18:03:10)(EVENT=10)(VERSION=8.1.6.0.0)
(TIMESTAMP=20-JAN-2002 18:03:10)(EVENT=36)(rule_list=
(rule=(src=spcstn)(dst=x)(srv=x)(act=accept)))
(TIMESTAMP=20-JAN-2002 18:03:10)(EVENT=32)(PARAMETER_LIST=(MAXIMUM_
RELAYS=1024)(RELAY_STATISTICS=no)(AUTHENTICATION_LEVEL=0)(LOG_LEVEL=1)(SHOW_TNS_
INFO=no)(ANSWER_TIMEOUT=0)(MAXIMUM_CONNECT_DATA=1024)(USE_ASYNC_
CALL=yes)(TRACING=no)(TRACE_DIRECTORY=default)(MAX_FREELIST_BUFFERS=0))
(TIMESTAMP=20-JAN-2002 18:03:10)(EVENT=34)(ADDRESS_LIST=
(ADDRESS=(PROTOCOL=tcp)(HOST=)(PORT=1610)(QUEUESIZE=32)))
(TIMESTAMP=20-JAN-2002 18:03:12)(EVENT=38)(COMMAND=2)
(TIMESTAMP=20-JAN-2002
18:03:27)(EVENT=26)(RLYNO=0)(SRC=(ADDRESS=(PROTOCOL=tcp)(HOST=spcstn.us.acme.c
om)(PORT=34758)))(DST=(ADDRESS=(PROTOCOL=tcp)(HOST=144.25.187.89)(PORT=1581)))
(TIMESTAMP=20-JAN-2002 18:03:43)(EVENT=28)(RLYNO=0)(SINCE=20-JAN-2002
18:03:27)(STATISTICS=(IN=(BYTES=0)(PACKETS=0)(DCDS=0)(OUT=(BYTES=0)(PACKETS=0)(D
CDS=0)))

Figure 17–4 cmadm_pid.log

(TIMESTAMP=20-JAN-2002 18:03:09)(EVENT=Sent Admin Status to UI)
(TIMESTAMP=20-JAN-2002 18:03:10)(EVENT=CMan Registration)

See Also: "Analyzing Listener Log Files" on page 17-26
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cman_pid.log Event Codes
The cman_pid .log  on UNIX and cmanpid .log  on Windows NT reports events
using event code numbers. The event code reported depends upon the log level set
with the LOG_LEVELparameter in the cman.ora file or with the Oracle Connection
Manager Control utility command SET LOG_LEVEL. This section explains what
each of these event codes represents.

Table 17–10 cman_pid.log Log Level 1 Event Codes

Code Description

10 Gateway is starting up

12 Gateway is shutting down

14 Listening on TNS address(es)

18 Answer failed
See Also: "Reasons for Event Code 18" on page 17-40

20 Refusing in-coming call

See Also: "Reasons for Event Code 20" on page 17-40

26 Relay is now open

28 Relay is now closed

30 Statistics report

32 <PARAMETER_LIST>

34 <ADDRESS_LIST>

36 <RULE_LIST>

38 Oracle Connection Manager Control utility command

40 Oracle Connection Manager Control utility command
refused because the gateway is busy

42 Dead connection detected

44 Relay has timed out

11 Bad <ADDRESS_LIST> argument

13 Bad <PARAMETER_LIST> argument

15 Bad <RULE_LIST> argument

23 Bad Oracle Connection Manager Control utility record
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Reasons for Event Code 18 The answer can fail due to the following:

Reasons for Event Code 20 The incoming call can be refused if:

25 Command line argument is too long

27 Memory allocation failure

29 TNS error

31 TNS error while processing Oracle Connection Manager
Control utility requests

Code Description

1 Timed out

2 Connect data buffer is too small

3 Refused by TNS

4 TNS packet checksum error

Code Description

1 Gateway is shutting down

1 Gateway is offline

3 No connect data on in-coming call

4 Bad connect data on in-coming call

5 All relays are in use

6 Unable to get relay buffers

7 Fatal TNS error

8 No available Oracle Advanced Security service

9 Reject from rule filtering

10 Out-going call failed

11 Refused by Oracle Net/TNS

12 Listener is not running

Code Description
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Table 17–11 cman_pid.log Log Level 2 Event Codes

Table 17–12 cman_pid.log Log Level 3 Event Codes

Reasons for Event Code 204 The relay can be blocked due to the following:

13 Listener is not reachable

14 Host name lookup failure

15 Protocol adapter (and probably the protocol stack) not
loaded

16 No SOURCE_ROUTE set

17 Reject from rule or bad connect string data

Code Description

102 Answering in-coming call

104 Making out-going call

105 Accepting in-coming call

106 Rule match report

Code Description

202 Call will block (no asynchronous TNS support)

204 Relay blocked

See Also: "Reasons for Event Code 204"

206 Buffer contains leftover data

Code Description

1 Waiting for writer to be ready

2 Waiting for writer to clear backlog

3 WOULDBLOCK error on receive

4 WOULDBLOCK or PARTIAL error on send

5 Repeated WOULDBLOCK or PARTIAL send
error

Code Description



Oracle Net Services Tracing Error Information

17-42 Oracle9i Net Services Administrator’s Guide

Table 17–13 cman_pid.log Log Level 4 Event Codes

Oracle Net Services Tracing Error Information
Tracing produces a detailed sequence of statements that describe network events as
they are executed. Tracing an operation enables you to obtain more information on
the internal operations of the components of Oracle Net Services than is provided in
a log file. This information is output to files that can be evaluated to identify the
events that led to an error.

This section contains topics:

■ Oracle Net Trace Services File Names

■ Setting Tracing Parameters

■ Setting Tracing Settings During Runtime of Control Utilities

■ Evaluating Oracle Net Services Traces

■ Using the Trace Assistant to Examine Trace Files

Code Description

302 Read this many bytes

304 Wrote this many bytes

306 Wrote this many bytes on retry

CAUTION: Tracing uses a large amount of disk space and may
have a significant impact upon system performance. Therefore,
you should enable tracing only when necessary.
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Oracle Net Trace Services File Names
Each Oracle Net component produces its own trace file. Table 17–14 provides the
default trace file names and lists the components that generate the trace files.

Table 17–14 Oracle Net Trace Files

Setting Tracing Parameters
Parameters that control tracing, including the type and amount of information
trace, as well as the location where the files are stored, are set in the configuration
file of each network component as described in Table 17–15.

Table 17–15 Oracle Net Trace Parameters

Trace File Component

sqlnet.trc Client

svr_ pid .trc Database server

listener.trc Listener

names.trc Oracle Names Server

cman_pid .trc  on UNIX

cmanpid .trc  on Windows NT

Oracle Connection Manager CMGW gateway
process

cmadm_pid .trc  on UNIX

cmadmpid .trc  on Windows NT

Oracle Connection Manager CMADMIN
administrative process

Trace Parameters Configuration Files

Client sqlnet.ora

Server sqlnet.ora

Listener listener.ora

Oracle Names Server names.ora

Oracle Connection Manager
processes

cman.ora
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This sections contains these topics:

■ sqlnet.ora Trace Parameters

■ listener.ora Trace Parameters

■ names.ora Trace Parameters

■ cman.ora Trace Parameters

■ Setting Tracing Parameters in Configuration Files

sqlnet.ora Trace Parameters
Table 17–16 describes the trace parameters settings that can be set in the
sqlnet.ora  file.

Table 17–16 sqlnet.ora Trace Parameters

See Also: Oracle9i Net Services Reference Guide for more
information about these parameters

sqlnet.ora Parameter Oracle Net Manager
Field

Description

TRACE_DIRECTORY_CLIENT Client Information:
Trace Directory

Establishes the destination directory for the client
trace file. By default, the client directory is $ORACLE_
HOME/network/trace  on UNIX and ORACLE_
HOME\network\trace  on Windows NT.

TRACE_DIRECTORY_SERVER Server Information:
Trace Directory

Establishes the destination directory for the database
server trace file. By default, the server directory is
$ORACLE_HOME/network/trace  on UNIX and
ORACLE_HOME\network\trace  on Windows NT.

TRACE_FILE_CLIENT Client Information:
Trace File

Sets the name of the trace file for the client. By default
the trace name is sqlnet.trc .

TRACE_FILE_SERVER Server Information:
Trace File

Sets the name of the trace file for the client. By default
the trace name is svr_ pid .trc .

TRACE_FILELEN_CLIENT Not Applicable Specifies the size of the client trace files in kilobytes
(KB). When the size is met, the trace information is
written to the next file. The number of files is
specified with the TRACE_FILENO_CLIENT
parameter.

TRACE_FILELEN_SERVER Not Applicable Specifies the size of the database server trace files in
kilobytes (KB). When the size is met, the trace
information is written to the next file. The number of
files is specified with the TRACE_FILENO_CLIENT
parameter.
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TRACE_FILENO_CLIENT Not Applicable Specifies the number of trace files for client tracing.
When this parameter is set along with the TRACE_
FILELEN_CLIENT  parameter, trace files are used in a
cyclical fashion. The first file is filled first, then the
second file, and so on. When the last file has been
filled, the first file is re-used, and so on.

The trace file names are distinguished from one
another by their sequence number. For example, if the
default trace file of sqlnet.trc  is used, and this
parameter is set to 3, the trace files would be named
sqlnet1_ pid .trc , sqlnet2_ pid .trc  and
sqlnet3_ pid .trc .

In addition, trace events in the trace files are preceded
by the sequence number of the file.

TRACE_FILENO_SERVER Not Applicable Specifies the number of trace files for database server
tracing. When this parameter is set along with the
TRACE_FILELEN_SERVER parameter, trace files are
used in a cyclical fashion. The first file is filled first,
then the second file, and so on. When the last file has
been filled, the first file is re-used, and so on.

The trace file names are distinguished from one
another by their sequence number. For example, if the
default trace file of svr_ pid .trc  is used, and this
parameter is set to 3, the trace files would be named
svr1_ pid .trc , svr2_ pid .trc  and svr3_
pid .trc .

In addition, trace events in the trace files are preceded
by the sequence number of the file.

TRACE_LEVEL_CLIENT Client Information:
Trace Level

Specifies the level of detail the trace facility records
for the client.

The trace level value can either be a value within the
range of 0 (zero) to 16  (where 0 is no tracing and 16
represents the maximum amount of tracing) or a
value of off , admin , user , or support .

■ off  (equivalent to 0) provides no tracing

■ user  (equivalent to 4) traces to identify
user-induced error conditions

■ admin  (equivalent to 6) traces to identify
installation-specific problems

■ support  (equivalent to 16) provides trace
information for troubleshooting information for
Oracle Support Services

sqlnet.ora Parameter Oracle Net Manager
Field

Description
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TRACE_LEVEL_SERVER Server Information:
Trace Level

Indicates the level of detail the trace facility records
for the database server. The trace level value can
either be a value within the range of 0 (zero) to 16
(where 0 is no tracing and 16  represents the
maximum amount of tracing) or a value of off ,
admin , user , or support .

■ off  (equivalent to 0) provides no tracing

■ user  (equivalent to 4) traces to identify
user-induced error conditions

■ admin  (equivalent to 6) traces to identify
installation-specific problems

■ support  (equivalent to 16) provides trace
information for troubleshooting information for
Oracle Support Services

TRACE_TIMESTAMP_CLIENT Not Applicable Adds a time stamp in the form of dd-mon-yyyy
hh:mi:ss:mil to every trace event in the client trace
file, sqlnet.trc .

TRACE_TIMESTAMP_SERVER Not Applicable Adds a time stamp in the form of dd-mon-yyyy
hh:mi:ss:mil to every trace event in the client trace
file, sqlnet.trc .

TRACE_UNIQUE_CLIENT Client Information:
Unique Trace File
Name

Determines whether or not a unique trace file is
created for each client trace file. If the value is set to
on , a process identifier is appended to the name of
each trace file generated, so that several files can
coexist. If the value is set to off , when a new trace
file is created for a client, it overwrites the existing
file.

This parameter creates unique trace files named
sqlnet pid .trc

sqlnet.ora Parameter Oracle Net Manager
Field

Description
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You can also manually add the following TNSPING utility tracing parameters
described in Table 17–17 to sqlnet.ora . The TNSPING utility determines whether
or not a service (such as a database, an Oracle Names Server, or other TNS services)
on a Oracle Net network can be successfully reached.

Table 17–17 TNSPING Trace Parameters

sqlnet.ora Parameter Description

TNSPING.TRACE_LEVEL Indicates the level of detail the trace facility records for the
TNSPING utility.

The trace level value can either be a value within the range
of 0 (zero) to 16  (where 0 is no tracing and 16  represents
the maximum amount of tracing) or a value of off ,
admin , user , or support .

■ off  (equivalent to 0) provides no tracing

■ user  (equivalent to 4) traces to identify user-induced
error conditions

■ admin  (equivalent to 6) traces to identify
installation-specific problems

■ support  (equivalent to 16) provides trace
information for troubleshooting information for
Oracle Support Services

TNSPING.TRACE_DIRECTORYEstablishes the destination directory for TNSPING trace
file. By default, the directory is $ORACLE_
HOME/network/trace  on UNIX and ORACLE_
HOME\network\trace  on Windows NT.
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listener.ora Trace Parameters
Table 17–18 describes the trace parameters settings that can be set in the
listener.ora  file.

Table 17–18 listener.ora Trace Parameters

listener.ora Parameter Oracle Net
Manager Field

Description

TRACE_LEVEL_

listener_name
Trace Level Indicates the level of detail the trace facility

records for the listener.

The trace level value can either be a value
within the range of 0 (zero) to 16  (where 0 is
no tracing and 16  represents the maximum
amount of tracing) or a value of off , admin ,
user , or support .

■ off  (equivalent to 0) provides no tracing

■ user  (equivalent to 4) traces to identify
user-induced error conditions

■ admin (equivalent to 6) traces to identify
installation-specific problems

■ support  (equivalent to 16) provides
trace information for troubleshooting
information for Oracle Support Services

TRACE_DIRECTORY_

listener_name

TRACE_FILE_

listener_name

Trace File Establishes the destination directory and file
for the trace file. By default the directory is
$ORACLE_HOME/network/trace  on UNIX
and ORACLE_HOME\network\trace  on
Windows NT, and the file name is
listener.trc .

TRACE_FILELEN_

listener_name
Not Applicable Specifies the size of the listener trace files in

kilobytes (KB). When the size is met, the trace
information is written to the next file. The
number of files is specified with the TRACE_
FILENO_listener_name  parameter
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TRACE_FILENO_

listener_name
Not Applicable specifies the number of trace files for listener

tracing. When this parameter is set along
with the TRACE_FILELEN_listener_name
parameter, trace files are used in a cyclical
fashion. The first file is filled first, then the
second file, and so on. When the last file has
been filled, the first file is re-used, and so on.

The trace file names are distinguished from
one another by their sequence number. For
example, if the default trace file of
listener.trc  is used, and this parameter
is set to 3, the trace files would be named
listener1.trc , listener2.trc  and
listener3.trc .

In addition, trace events in the trace files are
preceded by the sequence number of the file.

TRACE_TIMESTAMP_

listener_name
Not Applicable Adds a time stamp in the form of

dd-mon-yyyy hh:mi:ss:mil  to every
trace event in the listener trace file.

listener.ora Parameter Oracle Net
Manager Field

Description
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names.ora Trace Parameters
Table 17–19 describes the trace parameters settings that can be set in the
names.ora  file.

Table 17–19 names.ora Trace Parameters

names.ora Parameter Oracle Net Manager
Field

Description

NAMES.TRACE_DIRECTORY Trace Directory Establishes the destination directory for trace files. By
default, the directory is $ORACLE_
HOME/network/trace  on UNIX and ORACLE_
HOME\network\trace  on Windows NT.

NAMES.TRACE_FILE Trace File Sets the name of the trace file. By default the trace
name is names.trc .

NAMES.TRACE_LEVEL Not applicable Indicates the level of detail the trace facility records
for the Oracle Names server.

The trace level value can either be a value within the
range of 0 (zero) to 16  (where 0 is no tracing and 16
represents the maximum amount of tracing) or a
value of off , admin , user , or support .

■ off  (equivalent to 0) provides no tracing

■ user  (equivalent to 4) traces to identify
user-induced error conditions

■ admin  (equivalent to 6) traces to identify
installation-specific problems

■ support  (equivalent to 16) provides trace
information for troubleshooting information for
Oracle Support Services

NAMES.TRACE_UNIQUE Make Trace File
Unique

If set to on , creates a unique file name for each trace
session, allowing multiple trace files to coexist. A
process identifier is appended to the name of the
trace file generated.

This parameter creates unique trace files named
namespid .trc .
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cman.ora Trace Parameters
Table 17–20 describes the trace parameters settings that can be set in the cman.ora
file.

Table 17–20 cman.ora Trace Parameters

cman.ora Parameter Description

TRACE_DIRECTORY Establishes the destination directory for trace files

By default, the directory is $ORACLE_
HOME/network/trace  on UNIX and ORACLE_
HOME\network\trace  on Windows NT.

TRACE_FILELEN Specifies the size of the trace file in kilobytes (KB). When
the size is met, the trace information is written to the next
file. The number of files is specified with the TRACE_
FILENO parameter.

TRACE_FILENO Specifies the number of trace files for tracing. When this
parameter is set along with the TRACE_FILELEN
parameter, trace files are used in a cyclical fashion. The
first file is filled first, then the second file, and so on. When
the last file has been filled, the first file is reused, and so
on.

The trace file names are distinguished from one another by
their sequence number. For example, if this parameter is
set to 3, the CMGW gateway trace files would be named
cman1_pid .trc , cman2_pid .trc  and cman3_
pid .trc and the CMADMIN administrative trace files
would be named cmadm1_pid .trc , cmadm2_pid .trc
and cmadm3_pid .trc .

In addition, trace events in the trace files are preceded by
the sequence number of the file.

TRACE_LEVEL Determines whether or not tracing is enabled for the
Oracle Connection Manager

yes  enables tracing for the Oracle Connection Manager.
The proxy processes, the CMON process, and the listener
process create trace files called cman_pid .trc , cman_
mon.trc , and cman_lsnr.trc , respectively.

TRACE_TIMESTAMP Adds a time stamp in the form of dd-mon-yyyy
hh:mi:ss:mil  to every trace event in the trace file.
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Setting Tracing Parameters in Configuration Files
sqlnet.ora , listener.ora and names.ora logging parameters can be set with
the Oracle Net Manager. The cman.ora  tracing parameters must be set manually.

To set tracing parameters:

1. Start Oracle Net Manager.

2. Specify the trace parameters:

3. Choose File > Save Network Configuration.

See Also: Oracle9i Net Services Reference Guide

See Also: "Starting Oracle Net Manager" on page 5-3

Trace File Instruction

sqlnet.trc  (for the
client)

svr_ pid .trc  (for the
server)

1. In the navigator pane, expand General > Profile.

2. From the list in the right pane, select General.

3. Click the Tracing tab.

4. Specify the settings.

listener.trc 1. In the navigator pane, expand Local > Listeners.

2. Select a listener.

3. From the list in the right pane, select General.

4. Click the Logging and Tracing tab.

5. Specify the settings:

names.trc 1. In the navigator pane, expand the Oracle Names
Servers.

2. Select an Oracle Names server.

3. From the list in the right pane, select Configure Server.

4. Click the Adv. tab.

5. Specify the trace directory and file name.
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Setting Tracing Settings During Runtime of Control Utilities
Tracing can be set during a runtime of a control utility. Note that setting tracing
with a control utility will not set parameters in the *.ora  files; the setting is valid
only for the session of the control utility:

■ For the listener, use the SET TRC_FILE , SET TRC_DIRECTORY and SET TRC_
LEVEL commands from the Listener Control utility.

■ For Oracle Connection Manager, use the SET TRACE_LEVEL and SET TRACE_
DIRECTORY commands from the Oracle Connection Manager Control utility.

■ For an Oracle Names server, use the SET TRACE_FILE_NAME and SET
TRACE_LEVEL commands from the Oracle Names Control utility, or set tracing
settings through Oracle Net Manager.

To set tracing for an Oracle Names server with Oracle Net Manager:

1. Start Oracle Net Manager.

2. In the navigator pane, expand Oracle Names Servers.

3. Select an Oracle Names server.

4. From the list in the right pane, select Manage Server.

5. Click the Logging tab.

6. Specify the trace level, directory and file name.

7. Choose File > Save Network Configuration.

See Also: Oracle9i Net Services Reference Guide

See Also: "Starting Oracle Net Manager" on page 5-3
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Evaluating Oracle Net Services Traces
Trace files can help Oracle Support Service diagnose and troubleshoot network
problems.

This section explains how to perform basic analysis of trace files. The topics
discussed include:

■ Flow of Data Packets Between Network Nodes

■ Oracle Net Data Packet Formats

■ Pertinent Oracle Net Trace Error Output

Flow of Data Packets Between Network Nodes
Oracle Net performs its functions by sending and receiving data packets.By
specifying a trace level of support , you can view the actual contents of the Oracle
Net packet in your trace file. The order of the packet types sent and received will
help you to determine how your connection was established.

Oracle Net Data Packet Formats
Each line in the trace file begins with a procedure followed by a message. Following
each procedure is a line of hexadecimal data representing actual data. The actual
data that flows inside the packet is sometimes viewable to the right of the
hexadecimal data.

Next is a list of the Oracle Net packet keywords and descriptions of the types of
packets they represent:

Keyword Packet Type

NSPTCN Connect

NSPTAC Accept

NSPTRF Refuse

NSPTRS Resend

NSPDA Data

NSPCNL Control

NSPTMK Marker
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For example, the following line describes a procedure called "nscon " sending a
NSPTCN packet over the network:

nscon: sending NSPTCN packet

Each packet has a keyword that denotes the packet type. All packet types begin
with the prefix "nsp ". It is helpful to remember this when reviewing trace files for
specific packet information

Figure 17–5 provides typical packet information.

Figure 17–5 Packet Information

nscon: entry
nscon: doing connect handshake...
nscon: sending NSPTCN packet
nspsend: entry
nspsend: plen=187, type=1
nspsend: 187 bytes to transport
nspsend:packet dump
nspsend:00 BB 00 00 01 00 00 00  |........|
nspsend:01 33 01 2C 0C 01 08 00  |.3.,....|
nspsend:7F FF 7F 08 00 00 00 01  |........|
nspsend:00 99 00 22 00 00 08 00  |..."....|
nspsend:01 01 28 44 45 53 43 52  |..(DESCR|
nspsend:49 50 54 49 4F 4E 3D 28  |IPTION=(|
nspsend:43 4F 4E 4E 45 43 54 5F  |CONNECT_|
nspsend:44 41 54 41 3D 28 53 49  |DATA=(SI|
nspsend:44 3D 61 70 33 34 37 64  |D=ap347d|
nspsend:62 31 29 28 43 49 44 3D  |b1)(CID=|
nspsend:28 50 52 4F 47 52 41 4D  |(PROGRAM|
nspsend:3D 29 28 48 4F 53 54 3D  |=)(HOST=|
nspsend:61 70 32 30 37 73 75 6E  |ap207sun|
nspsend:29 28 55 53 45 52 3D 6D  |)(USER=m|
nspsend:77 61 72 72 65 6E 29 29  |warren))|
nspsend:29 28 41 44 44 52 45 53  |)(ADDRES|
nspsend:53 5F 4C 49 53 54 3D 28  |S_LIST=(|
nspsend:41 44 44 52 45 53 53 3D  |ADDRESS=|
nspsend:28 50 52 4F 54 4F 43 4F  |(PROTOCO|
nspsend:4C 3D 74 63 70 29 28 48  |L=tcp)(H|
nspsend:4F 53 54 3D 61 70 33 34  |OST=ap34|
nspsend:37 73 75 6E 29 28 50 4F  |7sun)(PO|
nspsend:52 54 3D 31 35 32 31 29  |RT=1521)|
nspsend:29 29 29 00 00 00 00 00  |))).....|
nspsend: normal exit
nscon: exit (0)
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Pertinent Oracle Net Trace Error Output
When there is a problem a connection, the error code is logged in the trace file.
Figure 17–6 depicts typical trace file output for a failed SQL*Plus connection to a
database server.

Figure 17–6 Trace Example

[22-JAN-2002 13:34:07:687] nsprecv: entry
[22-JAN-2002 13:34:07:687] nsbal: entry
[22-JAN-2002 13:34:07:687] nsbgetfl: entry
[22-JAN-2002 13:34:07:687] nsbgetfl: normal exit
[22-JAN-2002 13:34:07:687] nsmal: entry
[22-JAN-2002 13:34:07:687] nsmal: 44 bytes at 0x132d90
[22-JAN-2002 13:34:07:687] nsmal: normal exit
[22-JAN-2002 13:34:07:687] nsbal: normal exit
[22-JAN-2002 13:34:07:687] nsprecv: reading from transport...
[22-JAN-2002 13:34:07:687] nttrd: entry
[22-JAN-2002 13:35:09:625] nttrd: exit
[22-JAN-2002 13:35:09:625] ntt2err: entry
[22-JAN-2002 13:35:09:625] ntt2err: Read unexpected EOF ERROR on 10
[22-JAN-2002 13:35:09:625] ntt2err: exit
[22-JAN-2002 13:35:09:625] nsprecv: transport read error
[22-JAN-2002 13:35:09:625] nsprecv: error exit
[22-JAN-2002 13:35:09:625] nserror: entry
[22-JAN-2002 13:35:09:625] nserror: nsres: id=0, op=68, ns=12537,
ns2=12560;
nt[0]=507, nt[1]=0, nt[2]=0; ora[0]=0, ora[1]=0, ora[2]=0
[22-JAN-2002 13:35:09:625] nscon: error exit
[22-JAN-2002 13:35:09:625] nsdo: nsctxrnk=0
[22-JAN-2002 13:35:09:625] nsdo: error exit
[22-JAN-2002 13:35:09:625] nscall: unexpected response
[22-JAN-2002 13:35:09:625] nsclose: entry
[22-JAN-2002 13:35:09:625] nstimarmed: entry
[22-JAN-2002 13:35:09:625] nstimarmed: no timer allocated
[22-JAN-2002 13:35:09:625] nstimarmed: normal exit
[22-JAN-2002 13:35:09:625] nsdo: entry
[22-JAN-2002 13:35:09:625] nsdo: cid=0, opcode=98, *bl=0, *what=0,
uflgs=0x440, cflgs=0x2
[22-JAN-2002 13:35:09:625] nsdo: rank=64, nsctxrnk=0
[22-JAN-2002 13:35:09:625] nsdo: nsctx: state=1, flg=0x4201, mvd=0
[22-JAN-2002 13:35:09:625] nsbfr: entry
[22-JAN-2002 13:35:09:625] nsbaddfl: entry
[22-JAN-2002 13:35:09:625] nsbaddfl: normal exit
[22-JAN-2002 13:35:09:625] nsbfr: normal exit
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[22-JAN-2002 13:35:09:625] nsbfr: entry
[22-JAN-2002 13:35:09:625] nsbaddfl: entry
[22-JAN-2002 13:35:09:625] nsbaddfl: normal exit
[22-JAN-2002 13:35:09:625] nsbfr: normal exit
[22-JAN-2002 13:35:09:625] nsdo: nsctxrnk=0
[22-JAN-2002 13:35:09:625] nsdo: normal exit
[22-JAN-2002 13:35:09:625] nsclose: closing transport
[22-JAN-2002 13:35:09:625] nttdisc: entry
[22-JAN-2002 13:35:09:625] nttdisc: Closed socket 10
[22-JAN-2002 13:35:09:625] nttdisc: exit
[22-JAN-2002 13:35:09:625] nsclose: global context check-out (from slot 0)
complete
[22-JAN-2002 13:35:09:703] nsnadisc: entry
[22-JAN-2002 13:35:09:703] nadisc: entry
[22-JAN-2002 13:35:09:703] nacomtm: entry
[22-JAN-2002 13:35:09:703] nacompd: entry
[22-JAN-2002 13:35:09:703] nacompd: exit
[22-JAN-2002 13:35:09:703] nacompd: entry
[22-JAN-2002 13:35:09:703] nacompd: exit
[22-JAN-2002 13:35:09:703] nacomtm: exit
[22-JAN-2002 13:35:09:703] nas_dis: entry
[22-JAN-2002 13:35:09:703] nas_dis: exit
[22-JAN-2002 13:35:09:703] nau_dis: entry
[22-JAN-2002 13:35:09:703] nau_dis: exit
[22-JAN-2002 13:35:09:703] naeetrm: entry
[22-JAN-2002 13:35:09:703] naeetrm: exit
[22-JAN-2002 13:35:09:703] naectrm: entry
[22-JAN-2002 13:35:09:703] naectrm: exit
[22-JAN-2002 13:35:09:703] nagbltrm: entry
[22-JAN-2002 13:35:09:703] nau_gtm: entry
[22-JAN-2002 13:35:09:703] nau_gtm: exit
[22-JAN-2002 13:35:09:703] nagbltrm: exit
[22-JAN-2002 13:35:09:703] nadisc: exit
[22-JAN-2002 13:35:09:703] nsnadisc: normal exit
[22-JAN-2002 13:35:09:703] nsbfr: entry
[22-JAN-2002 13:35:09:703] nsbaddfl: entry
[22-JAN-2002 13:35:09:703] nsbaddfl: normal exit
[22-JAN-2002 13:35:09:703] nsbfr: normal exit
[22-JAN-2002 13:35:09:703] nsmfr: entry
[22-JAN-2002 13:35:09:703] nsmfr: 2256 bytes at 0x130508
[22-JAN-2002 13:35:09:703] nsmfr: normal exit
[22-JAN-2002 13:35:09:703] nsmfr: entry
[22-JAN-2002 13:35:09:703] nsmfr: 484 bytes at 0x1398a8
[22-JAN-2002 13:35:09:703] nsmfr: normal exit
[22-JAN-2002 13:35:09:703] nsclose: normal exit
[22-JAN-2002 13:35:09:703] nscall: connecting...
[22-JAN-2002 13:35:09:703] nsclose: entry
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[22-JAN-2002 13:35:09:703] nsclose: normal exit
[22-JAN-2002 13:35:09:703] nladget: entry
[22-JAN-2002 13:35:09:734] nladget: exit
[22-JAN-2002 13:35:09:734] nsmfr: entry
[22-JAN-2002 13:35:09:734] nsmfr: 144 bytes at 0x132cf8
[22-JAN-2002 13:35:09:734] nsmfr: normal exit
[22-JAN-2002 13:35:09:734] nsmfr: entry
[22-JAN-2002 13:35:09:734] nsmfr: 156 bytes at 0x138e70
[22-JAN-2002 13:35:09:734] nsmfr: normal exit
[22-JAN-2002 13:35:09:734] nladtrm: entry
[22-JAN-2002 13:35:09:734] nladtrm: exit
[22-JAN-2002 13:35:09:734] nscall: error exit
[22-JAN-2002 13:35:09:734] nioqper:  error from nscall
[22-JAN-2002 13:35:09:734] nioqper:    nr err code: 0
[22-JAN-2002 13:35:09:734] nioqper:    ns main err code: 12537
[22-JAN-2002 13:35:09:734] nioqper:    ns (2)  err code: 12560
[22-JAN-2002 13:35:09:734] nioqper:    nt main err code: 507
[22-JAN-2002 13:35:09:734] nioqper:    nt (2)  err code: 0
[22-JAN-2002 13:35:09:734] nioqper:    nt OS   err code: 0
[22-JAN-2002 13:35:09:734] niomapnserror: entry
[22-JAN-2002 13:35:09:734] niqme: entry
[22-JAN-2002 13:35:09:734] niqme: reporting NS-12537 error as ORA-12537
[22-JAN-2002 13:35:09:734] niqme: exit
[22-JAN-2002 13:35:09:734] niomapnserror: returning error 12537
[22-JAN-2002 13:35:09:734] niomapnserror: exit
[22-JAN-2002 13:35:09:734] niotns: Couldn't connect, returning 12537
[22-JAN-2002 13:35:10:734] niotns: exit
[22-JAN-2002 13:35:10:734] nsbfrfl: entry
[22-JAN-2002 13:35:10:734] nsbrfr: entry
[22-JAN-2002 13:35:10:734] nsbrfr: nsbfs at 0x132d90, data at 0x132dc8.
[22-JAN-2002 13:35:10:734] nsbrfr: normal exit
[22-JAN-2002 13:35:10:734] nsbrfr: entry
[22-JAN-2002 13:35:10:734] nsbrfr: nsbfs at 0x1248d8, data at 0x132210.
[22-JAN-2002 13:35:10:734] nsbrfr: normal exit
[22-JAN-2002 13:35:10:734] nsbrfr: entry
[22-JAN-2002 13:35:10:734] nsbrfr: nsbfs at 0x12d820, data at 0x1319f0.
[22-JAN-2002 13:35:10:734] nsbrfr: normal exit
[22-JAN-2002 13:35:10:734] nsbfrfl: normal exit
[22-JAN-2002 13:35:10:734] nigtrm: Count in the NI global area is now 1
[22-JAN-2002 13:35:10:734] nigtrm: Count in the NL global area is now 1

The most efficient way to evaluate error codes is to find the most recent nserror
entry logged, as the session layer controls the connection. The most important error
messages are the ones at the bottom of the file. They are the most recent errors and
the source of the problem with the connection.
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For information about the specific return codes, use the Oracle UNIX error tool
oerr , by entering the following at any command line:

oerr tns error_number

As an example, consider the following nserror  entry logged in the trace file
shown in Figure 17–6 on page 17-56:

[22-JAN-2002 13:35:09:625] nserror: nsres: id=0, op=68, ns= 12537 ,
ns2=12560;
nt[0]= 507 , nt[1]=0, nt[2]=0; ora[0]=0, ora[1]=0, ora[2]=0

Using oerr , you can find out more information about return codes 12537 and 507.
(Bold denotes user input.)

oerr tns 12537
12537, 00000, "TNS:connection closed"
// *Cause: "End of file" condition has been reached; partner has
disconnected.
// *Action: None needed; this is an information message.

oerr tns 507
00507, 00000, "Connection closed"
// *Cause: Normal "end of file" condition has been reached; partner has
// disconnected.
// *Action: None needed; this is an information message.
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Using the Trace Assistant to Examine Trace Files
Oracle Net Services provides a tool called the Trace Assistant to help you
understand the information provided in trace files by converting existing lines of
trace file text into a more readable paragraph. Note that the Trace Assistant runs
against only a level 16  (support ) Oracle Net Services trace file.

This section contains the following topics:

■ Trace Assistant Syntax

■ Packet Examples

■ Two-Task Common Packet Examples

■ Connection Example

■ Statistics Example
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Trace Assistant Syntax
To run the Trace Assistant, enter the following at any command line prompt:

trcasst [ options ] < filename >

The options are described in Table 17–21.

Table 17–21 Trace Assistant Syntax

Option Description

-e level Displays error information. After the -e , zero or one error decoding level may follow:

■ 0 or nothing translates the NS error numbers dumped from the nserror
function plus lists all other errors

■ 1 displays only the NS error translation from the nserror  function

■ 2 displays error numbers without translation

-la If a connection ID exists in the NS connect packet, then the output displays the
connection IDs. Connection IDs are displayed as hexadecimal, eight-byte IDs. A
generated ID is created by Trace Assistant if the packet is not associated with any
connection, that is, the connect packet is overwritten in the trace file. This can occur
with cyclic trace files.

For each ID, the output lists the following:

■ Socket ID, if the connection has one

■ Connect packet send or receive operation

■ Current setting of the MULTIPLEX attribute of the DISPATCHERS parameter in
the initialization parameter file. When MULTIPLEX is set to ON, session
multiplexing is enabled.

■ Session ID, if MULTIPLEX is set to ON

■ Connect data information

Notes:

■ Do not use this option with other options.

■ The IDs generated by the Trace Assistant do not correlate with client/server trace
files.

-li ID Displays the trace for a particular ID from the -la  output

Note: Only use this option with output from the -la  option.



Oracle Net Services Tracing Error Information

17-62 Oracle9i Net Services Administrator’s Guide

If no options are provided, then the default is -odt -e0 -s , providing detailed
connectivity and TTC events, error level zero (0), and statistics in the trace file.

-o type Displays the amount and type of information to be output. After the -o  the following
options can be used:

■ c  to display summary connectivity information

■ d to display detailed connectivity information

■ u to display summary Two-Task Common (TTC) information

■ t  to display detailed TTC information

■ q to display SQL commands enhancing summary TTC information. Use this
option with u, such as -ouq .

Note: As output for d contains the same information as displayed for c , do not
submit both c  and d. If you submit both, then only output d will be processed.

-p Oracle internal use only

-s Displays the following statistical information:

■ Total number of bytes sent and received

■ Maximum open cursors

■ Currently open cursors

■ Count and ratio of operations

■ Parsing and execution count for PL/SL

■ Total calls sent and received

■ Total, average, and maximum number of bytes sent and received

■ Total number of transports and sessions present

■ Timestamp information, if any

■ Sequence numbers, if any

Option Description
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Figure 17–7 shows how the Trace Assistant converts trace file information into a
more readable format.

Figure 17–7 Trace File with Error

ntus2err: exit
ntuscni: exit
ntusconn: exit
nserror: entry
-<ERROR>- nserror: nsres: id=0, op=65, ns=12541, ns2=12560; nt[0]=511, nt[1]=2,
nt[2]=0

Figure 17–8 shows how the Trace Assistant converts the trace file information into a
more readable format with the -e1  option.

Figure 17–8 trcasst -e1 Output

    *************************************************************************
    *                        Trace Assistant                                *
    *************************************************************************

ntus2err: exit
ntuscni: exit
ntusconn: exit
nserror: entry
-<ERROR>- nserror: nsres: id=0, op=65, ns=12541, ns2=12560; nt[0]=511, nt[1]=2,
nt[2]=0
///////////////////////////////////////////////////////////////
Error found. Error Stack follows:
              id:0
  Operation code:65
      NS Error 1:12541
      NS Error 2:12560
NT Generic Error:511
  Protocol Error:2
        OS Error:0
 NS & NT Errors Translation
12541, 00000 "TNS:no listener"
 // *Cause: The connection request could not be completed because the listener
 // is not running.
 // *Action: Ensure that the supplied destination address matches one of
 // the addresses used by the listener - compare the TNSNAMES.ORA entry with
 // the appropriate LISTENER.ORA file (or TNSNAV.ORA if the connection is to
 // go by way of an Interchange). Start the listener on the remote machine.
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/
12560, 00000 "TNS:protocol adapter error"
 // *Cause: A generic protocol adapter error occurred.
 // *Action: Check addresses used for proper protocol specification. Before
 // reporting this error, look at the error stack and check for lower level
 // transport errors.For further details, turn on tracing and reexecute the
 // operation. Turn off tracing when the operation is complete.
/
00511, 00000 "No listener"
 // *Cause: The connect request could not be completed because no application
 // is listening on the address specified, or the application is unable to
 // service the connect request in a sufficiently timely manner.
 // *Action: Ensure that the supplied destination address matches one of
 // the addresses used by the listener - compare the TNSNAMES.ORA entry with
 // appropriate LISTENER.ORA file (or TNSNAV.ORA if the connection is to go
 // by way of an Interchange. Start the listener on the remote machine.
/
///////////////////////////////////////////////////////////////
    *************************************************************************
    *                    Trace Assistant has completed                      *
    *************************************************************************

However, other errors may also exist within the trace file that were not logged from
the nserror  function.
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Packet Examples
Trace Assistant also enables you to view data packets from both the Oracle Net and
TTC communication layers. Trace Assistant offers you two options to view these
packets:

■ Summary connectivity (using option -oc )

■ Detailed connectivity (using option -od )

Example: Summary Data Packets Sent in a Connection

Figure 17–9 shows summary information from the -oc  option. The output shows....

Figure 17–9 trcasst -oc Output

    *************************************************************************
    *                        Trace Assistant                                *
    *************************************************************************

---> Send 198 bytes - Connect packet
Connect data length: 140
Connect Data:
    (DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=sales-server)(PORT=1521))
    (CONNECT_DATA=(SERVICE_NAME=sales.us.acme.com)(CID=(PROGRAM=)
    (HOST=sales-server)(USER=joe))))

<--- Received 76 bytes - Redirect packet
Redirect data length: 66
Redirect Data:
    (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=1521))

---> Send 198 bytes - Connect packet
Connect data length: 140
Connect Data:
    (DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=sales-server)(PORT=1521))
    (CONNECT_DATA=(SERVICE_NAME=sales.us.acme.com)(CID=(PROGRAM=)
    (HOST=sales-server)(USER=joe))))

<--- Received 32 bytes - Accept packet
Connect data length: 0
---> Send 153 bytes - Data packet
        Native Services negotiation packet

<--- Received 127 bytes - Data packet
        Native Services negotiation packet
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---> Send 32 bytes - Data packet

<--- Received 140 bytes - Data packet

    *************************************************************************
    *                    Trace Assistant has completed                      *
    *************************************************************************

Note that the packets being sent or received have a prefix of "--->  Send nnn
bytes " or "<---  Received nnn  bytes " showing that this node is sending or
receiving a packet of a certain type and with nnn  number of bytes. This prefix
enables you to determine if the node is the client or the database server. The
connection request is always sent by the client, but received by the database server
(or listener).
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Example: Detailed Data Packets Sent in a Connection

Figure 17–10 shows detailed information from the -od option. The output shows all
of the details sent along with the connect data in negotiating a connection.

Figure 17–10 trcasst -od Output

    *************************************************************************
    *                        Trace Assistant                                *
    *************************************************************************
--->  Send   241 bytes - Connect packet
Current NS version number is: 311.
Lowest NS version number can accommodate is: 300.
Global options for the connection:

can receive attention
no attention processing
Don't care
Maximum SDU size:2048
Maximum TDU size:32767
NT protocol characteristics:

Test for more data
Test operation
Full duplex I/O
Urgent data support
Generate SIGURG signal
Generate SIGPIPE signal
Generate SIGIO signal
Handoff connection to another

Line turnaround value :0
Connect data length :183
Connect data offset :58
Connect data maximum size :512

Native Services wanted
NAU doing O3LOGON - DH key foldedin
Native Services wanted
NAU doing O3LOGON - DH key foldedin

Cross facility item 1: 0
Cross facility item 2: 0
Connection id : Ox000059F70000004C

(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=sales-server)(PORT=1521))
(CONNECT_DATA=(SERVICE_NAME=sales.us.acme.com)(SRVR=SHARED)(CID=(PROGRAM=)
(HOST=sales-server)(USER=joe))))
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<--- Received 76 bytes - Redirect packet
Redirect data length: 66

(ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=1521))

--->  Send   241 bytes - Connect packet
Current NS version number is: 311.
Lowest NS version number can accommodate is: 300.
Global options for the connection:

can receive attention
no attention processing
Don't care
Maximum SDU size:2048
Maximum TDU size:32767
NT protocol characteristics:
Test for more data
Test operation
Full duplex I/O
Urgent data support
Generate SIGURG signal
Generate SIGPIPE signal
Generate SIGIO signal
Handoff connection to another

Line turnaround value :0
Connect data length :183
Connect data offset :58
Connect data maximum size :512

Native Services wanted
NAU doing O3LOGON - DH key foldedin
Native Services wanted
NAU doing O3LOGON - DH key foldedin

Cross facility item 1: 0
Cross facility item 2: 0
Connection id : Ox000059F70000007A
(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=sales-server)(PORT=1521))
(CONNECT_DATA=(SERVICE_NAME=sales.us.acme.com)(SRVR=SHARED)(CID=(PROGRAM=)
(HOST=sales-server)(USER=joe))))
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<--- Received 32 bytes - Accept packet
Accepted NS version number is: 310.

Global options for the connection:
no attention processing
Don't care
Accepted maximum SDU size: 2048
Accepted maximum TDU size: 32767
Connect data length: 0

Native Services wanted
NAU doing O3LOGON - DH key foldedin
Native Services wanted
NAU doing O3LOGON - DH key foldedin

--->  Send   153 bytes - Data packet
Native Services negotiation packet version#: 150999040

Service data packet #0 for Supervisor has 3 subpackets
Subpacket #0:  Version #150999040
Subpacket #1: 0000000000000000
Subpacket #2: DEADBEEF0003000000040004000100010002

Service data packet #1 for Authentication has 3 subpackets
Subpacket #0:  Version #150999040
Subpacket #1: UB2: 57569
Subpacket #2: FCFF

Service data packet #2 for Encryption has 2 subpackets
   Subpacket #0:  Version #150999040
   Subpacket #1: 000000000000000000
Service data packet #3 for Data Integrity has 2 subpackets

Subpacket #0:  Version #150999040
Subpacket #1: 000000

<--- Received 127 bytes - Data packet
Native Services negotiation packet version#: 135290880

Service data packet #0 for Supervisor has 3 subpackets
Subpacket #0:  Version #135290880

   Subpacket #1: 0000
Subpacket #2: DEADBEEF00030000000200040001

Service data packet #1 for Authentication has 2 subpackets
Subpacket #0:  Version #135290880

   Subpacket #1: FBFF
Service data packet #2 for Encryption has 2 subpackets

Subpacket #0:  Version #135290880
   Subpacket #1: UB1: 0
Service data packet #3 for Data Integrity has 2 subpackets
   Subpacket #0:  Version #135290880
   Subpacket #1: UB1: 0
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....

--->  Send   11 bytes - Marker packet
      One data byte.
      Hex character sent over to the server: 2

<--- Received 11 bytes - Marker packet
 One data byte.

     Hex character sent over to the server: 2

<--- Received 155 bytes - Data packet

--->  Send   25 bytes - Data packet

<--- Received 11 bytes - Data packet

--->  Send   13 bytes - Data packet

<--- Received 11 bytes - Data packet

--->  Send   10 bytes - Data packet
Data Packet flags:
End of file

    *************************************************************************
    *                    Trace Assistant has completed                      *
    *************************************************************************
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Two-Task Common Packet Examples
TTC handles requests such as open cursor, select rows, and update rows that are
directed to the database server. All requests are answered by the database server. If
you request to logon, a response is returned from the database server that the
request was completed.

Example: Two-Task Common Summary Information with Summary TTC Information

Summary information for TTC from the -ou  option is different from other displays
in that it shows two packets on each line, rather than one. This is done to mirror the
request/response pairings process by which TTC operates.

Figure 17–11 shows all of the details sent along with the connect data in negotiating
a connection.

Figure 17–11 trcasst -ou Output

    *************************************************************************
    *                        Trace Assistant                                *
    *************************************************************************

Bytes Bytes
Sent Rcvd

Send operation(TTIPRO) 32 140
Send operation(TTIDTY) 33 22
Get the session key (OSESSKEY) 229 145
Generic authentication call (OAUTH) 368 1001
Send operation(TTIPFN) 44 144
Send operation(TTIPFN) 36 16
Parse a statement (OSQL) # 1 SELECT USER FROM ... 47 100
Fast upi calls to opial7 (OALL7) # 1 130 111
Fetch row (OFETCH) # 1 21 137
Close cursor (OCLOSE) # 1 17 11
New v8 bundled call (OALL8) # 0 !Keep Parse BEGI... 156 145
Send operation(TTIPFN) 51 16
Parse a statement (OSQL) # 1 SELECT ATTRIBUTE,... 186 100
Fast upi calls to opial7 (OALL7) # 1 246 111
Fetch row (OFETCH) # 1 21 126
Close cursor (OCLOSE) # 1 17 11
Send operation(TTIPFN) 36 16
Parse a statement (OSQL) # 1 SELECT CHAR_VALUE... 208 100
Fast upi calls to opial7 (OALL7) # 1 130 111
Fetch row (OFETCH) # 1 21 126
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Close cursor (OCLOSE) # 1 17 11
Send operation(TTIPFN) 36 16
Fast upi calls to opial7 (OALL7) # 1 !Keep Parse BEGI... 183 41
Send operation(TTIRXD) 20 111
Close cursor (OCLOSE) # 1 17 11
New v8 bundled call (OALL8) # 0 Parse Fetch SELE... 165 278
Send operation(TTIPFN) 51 16
Parse a statement (OSQL) # 1 commit 31 100
Execute statement (OEXEC) # 1 number of rows: 1 25 100
Close cursor (OCLOSE) # 1 17 11
Send operation(TTIPFN) 36 16
Fast upi calls to opial7 (OALL7) # 1 !Keep Parse BEGI... 183 41
Send operation(TTIRXD) 60 111
Close cursor (OCLOSE) # 1 17 11
Send operation(TTIPFN) 36 16
Fast upi calls to opial7 (OALL7) # 1 !Keep Parse BEGI... 183 41
Send operation(TTIRXD) 20 111
Close cursor (OCLOSE) # 1 17 11
New v8 bundled call (OALL8) # 0 Parse Fetch sele... 144 383
New v8 bundled call (OALL8) # 1 !Keep Fetch 121 315
Logoff off of Oracle (OLOGOFF)                                         13     11

    *************************************************************************
    *                    Trace Assistant has completed                      *
    *************************************************************************

Output is displayed in the following format:

description TTC_message cursor_number SQL_statement bytes_sent bytes_received

On each line of the output, the first item displayed is the actual request made. The
second item shows on what cursor that operation has performed. The third item is
either a listing of the SQL command or flag that is being answered. The number of
bytes sent and received are displayed at the far right. A flag can be one of the
following:

!PL/SQL = Not a PL/SQL request
COM = Commit
IOV = Get I/O Vector
DEFN = Define
EXEC = Execute
FETCH = Fetch
CAN = Cancel
DESCSEL = Describe select
DESCBND = Describe Bind
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BND = Bind
PARSE = Parse
EXACT = Exact

Example: Detailed SQL Information on Top of Summary Two-Task

Figure 17–12 shows detailed SQL information from the -ouq  option.

Figure 17–12 trcasst -ouq Output

    *************************************************************************
    *                        Trace Assistant                                *
    *************************************************************************

Bytes Bytes
Sent Rcvd

Send operation(TTIPRO) 32 140
Send operation(TTIDTY) 33 22
Get the session key (OSESSKEY) 229 145
Generic authentication call (OAUTH) 368 1001
Send operation(TTIPFN) 44 144
Send operation(TTIPFN) 36 16
Parse a statement (OSQL) # 1 47 100
          SELECT USER FROM DUAL

Fast upi calls to opial7 (OALL7) # 1 130 111
Fetch row (OFETCH) # 1 21 137
Close cursor (OCLOSE) # 1 17 11
New v8 bundled call (OALL8) # 0 !Keep Parse 156 145
          BEGIN DBMS_OUTPUT.DISABLE; END;

Send operation(TTIPFN) 51 16
Parse a statement (OSQL) # 1 186 100
          SELECT ATTRIBUTE,SCOPE,NUMERIC_VALUE,CHAR_VALUE,DA
          TE_VALUE FROM SYSTEM.PRODUCT_PRIVS WHERE (UPPER(’S
          QL*Plus’) LIKE UPPER(PRODUCT)) AND (UPPER(USER) LI
          KE USERID)

Fast upi calls to opial7 (OALL7) # 1 246 111
Fetch row (OFETCH) # 1 21 126
Close cursor (OCLOSE) # 1 17 11
Send operation(TTIPFN) 36 16
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Parse a statement (OSQL) # 1 208 100
          SELECT CHAR_VALUE FROM SYSTEM.PRODUCT_PRIVS WHERE
          (UPPER(’SQL*Plus’) LIKE UPPER(PRODUCT)) AND ((UPPE
          R(USER) LIKE USERID) OR (USERID = ’PUBLIC’)) AND (
          UPPER(ATTRIBUTE) = ’ROLES’)

Fast upi calls to opial7 (OALL7) # 1 130 111
Fetch row (OFETCH) # 1 21 126
Close cursor (OCLOSE) # 1 17 11
Send operation(TTIPFN) 36 16
Fast upi calls to opial7 (OALL7) # 1 !Keep Parse 183 41
          BEGIN DBMS_APPLICATION_INFO.SET_MODULE(:1,NULL); E
          ND;

Send operation(TTIRXD) 20 111
Close cursor (OCLOSE) # 1 17 11
New v8 bundled call (OALL8) # 0 Parse Fetch 165 278
          SELECT DECODE(’A’,’A’,’1’,’2’) FROM DUAL

Send operation(TTIPFN) 51 16
Parse a statement (OSQL) # 1 31 100
          commit

Execute statement (OEXEC) # 1 number of rows: 1 25 100
Close cursor (OCLOSE) # 1 17 11
Send operation(TTIPFN) 36 16
Fast upi calls to opial7 (OALL7) # 1 !Keep Parse 183 41
          BEGIN DBMS_APPLICATION_INFO.SET_MODULE(:1,NULL); E
          ND;

Send operation(TTIRXD) 60 111
Close cursor (OCLOSE) # 1 17 11
Send operation(TTIPFN) 36 16
Fast upi calls to opial7 (OALL7) # 1 !Keep Parse 183 41
          BEGIN DBMS_APPLICATION_INFO.SET_MODULE(:1,NULL); E
          ND;

Send operation(TTIRXD) 20 111
Close cursor (OCLOSE) # 1 17 11
New v8 bundled call (OALL8) # 0 Parse Fetch 144 383
          select * from dept
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New v8 bundled call (OALL8) # 1 !Keep Fetch 121 315
Logoff off of Oracle (OLOGOFF) 13 11

    *************************************************************************
    *                    Trace Assistant has completed                      *
    *************************************************************************

Example: Two-Task Common Summary Information with Detailed TTC Information

Figure 17–13 shows detailed TTC information from the -ot  option.

Figure 17–13 trcasst -ot Output

    *************************************************************************
* Trace Assistant *

    *************************************************************************

Set protocol (TTIPRO)
Operation 01 (con) Send protocol version=6
Originating platform: SVR4-be-8.1.0

Set protocol (TTIPRO)
Operation 01 (con) Receive protocol version=6
Destination platform: SVR4-be-8.1.0

Set datatypes (TTIDTY)

Set datatypes (TTIDTY)

Start of user function (TTIFUN)
      (OSESSKEY)

Return opi parameter (TTIRPA)

Start of user function (TTIFUN)
(OAUTH)

Return opi parameter (TTIRPA)

Start of user function (TTIFUN)
      session operations 71 (O71SESOPN) (switch session)

Return opi parameter (TTIRPA)
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Start of user function (TTIFUN)
Get Oracle version/date string in new format (OVERSION)

Return opi parameter (TTIRPA)
Oracle9i Enterprise Edition Release 9.2.0.1.0 - Production
With the Partitioning option
JServer Release 9.2.0.1.0 - Production

Start of user function (TTIFUN)
session operations 71 (O71SESOPN) (switch session)

Return opi parameter (TTIRPA)

Start of user function (TTIFUN)
      Open a cursor (OOPEN)

Return opi parameter (TTIRPA)
Cursor #: 1

Start of user function (TTIFUN)
      Parse a statement (OSQL) Cursor # 1
SELECT USER FROM DUAL
    *************************************************************************
    *                    Trace Assistant has completed                      *
    *************************************************************************
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Connection Example
Figure 17–14 shows output from the -la  option. The output shows the following
information:

■ Connect IDs received

■ Socket ID on which this connection has come

■ Operation

Receive identifies the trace as a database server trace; Send identifies the trace
as a client trace. In this output, Receive  is the operation.

■ MULTIPLEX attribute of the DISPATCHERS parameter is set to ON

■ 32-bit session ID

■ Connect data information received

Figure 17–14 trcasst -la Output

    *************************************************************************
    *                        Trace Assistant                                *
    *************************************************************************

Connection ID: 00000B270000000B
        Socket Id: 15
        Operation: Receive
        Multiplex: ON
        Session Id: 8362785DE4FC0B19E034080020F793E1
        Connect Data:
        (DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=sales-server)(PORT=1521))
        (CONNECT_DATA=(SERVER=shared)
        (SERVICE_NAME=sales.us.acme.com)(CID=(PROGRAM=)(HOST=sales-server)
        (USER=oracle))))
Connection ID: 00000B240000000B
        Socket Id: 15
        Operation: Receive
        Multiplex: ON
        Session Id: 8362785DE4FB0B19E034080020F793E1
        Connect Data:
        (DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=sales-server)(PORT=1521))
        (CONNECT_DATA=(SERVER=shared)
        (SERVICE_NAME=sales.us.acme.com)(CID=(PROGRAM=)(HOST=sales-server)
        (USER=oracle))))
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Connection ID: 00000B1F00000008
        Socket Id: 15
        Operation: Receive
        Multiplex: ON
        Session Id: 8362785DE4F90B19E034080020F793E1
        Connect Data:
        (DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=sales-server)(PORT=1521))
        (CONNECT_DATA=(SERVER=shared)
        (SERVICE_NAME=sales.us.acme.com)(CID=(PROGRAM=)(HOST=sales-server)
        (USER=oracle))))
    *************************************************************************
    *                    Trace Assistant has completed                      *
    *************************************************************************

Figure 17–15 shows output for connection ID 00000B1F00000008  from the -li
00000B1F00000008  option.

Figure 17–15 trcasst -li Output

    *************************************************************************
    *                               Trace Assistant                         *
    *************************************************************************
<--- Received 246 bytes - Connect packet
Current NS version number is: 310.
Lowest NS version number can accommodate is: 300.
Global options for the connection:
        Can receive attention
        No attention processing
        Don’t care
        Maximum SDU size: 2048
        Maximum TDU size: 32767
        NT protocol characteristics:
                Test for more data
                Test operation
                Full duplex I/O
                Urgent data support
                Generate SIGURG signal
                Generate SIGPIPE signal
                Generate SIGIO signal
                Handoff connection to another
        Line turnaround value: 0
        Connect data length: 188
        Connect data offset: 58
        Connect data maximum size: 512
                Native Services wanted
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                NAU doing O3LOGON - DH key foldedin
                Native Services wanted
                NAU doing O3LOGON - DH key foldedin
        Cross facility item 1: 0
        Cross facility item 2: 0
        Connection id: Ox00000B1F00000008
    (DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=sales-server)(PORT=1521))
    (CONNECT_DATA=(SERVER=shared)(SERVICE_NAME=sales.us.acme.com)
    (CID=(PROGRAM=)(HOST=sales-server)(USER=oracle))))

---> Send 114 bytes - Accept packet
Accepted NS version number is: 310.
Global options for the connection:
        No attention processing
        Don’t care
        Accepted maximum SDU size: 2048
        Accepted maximum TDU size: 32767
        Connect data length: 0
                Native Services wanted
                NAU doing O3LOGON - DH key foldedin
                Native Services wanted
                NAU doing O3LOGON - DH key foldedin
        Connection Time out: 1000
        Tick Size: 100
        Reconnect Data: (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=34454))
        Session Id: 8362785DE4F90B19E034080020F793E1
<--- Received 164 bytes - Data packet
        Native Services negotiation packet version#: 135290880
                 Service data packet #0 for Supervisor has 3 subpackets
                        Subpacket #0:  Version #135290880
                        Subpacket #1: 0000000000000000
                        Subpacket #2: DEADBEEF0003000000040004000100010002
                 Service data packet #1 for Authentication has 3 subpackets
                        Subpacket #0:  Version #135290880
                        Subpacket #1: UB2: 57569
                        Subpacket #2: FCFF
                 Service data packet #2 for Encryption has 2 subpackets
                        Subpacket #0:  Version #135290880
                        Subpacket #1: 0000000000
                 Service data packet #3 for Data Integrity has 2 subpackets
                        Subpacket #0:  Version #135290880
                        Subpacket #1: 0000
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---> Send 143 bytes - Data packet
        Native Services negotiation packet version#: 135290880
                 Service data packet #0 for Supervisor has 3 subpackets
                        Subpacket #0:  Version #135290880
                        Subpacket #1: 0000
                        Subpacket #2: DEADBEEF00030000000200040001
                 Service data packet #1 for Authentication has 2 subpackets
                        Subpacket #0:  Version #135290880
                        Subpacket #1: FBFF
                 Service data packet #2 for Encryption has 2 subpackets
                        Subpacket #0:  Version #135290880
                        Subpacket #1: UB1: 0
                 Service data packet #3 for Data Integrity has 2 subpackets
                        Subpacket #0:  Version #135290880
                        Subpacket #1: UB1: 0
<--- Received 48 bytes - Data packet
Set protocol (TTIPRO)
        Operation 01 (con) Receive protocol version=6
        Destination platform: SVR4-be-8.1.0
---> Send 156 bytes - Data packet
Set protocol (TTIPRO)
        Operation 01 (con) Send protocol version=6
        Originating platform: SVR4-be-8.1.0
<--- Received 49 bytes - Data packet
Set datatypes (TTIDTY)
---> Send 38 bytes - Data packet
Set datatypes (TTIDTY)
<--- Received 245 bytes - Data packet
Start of user function (TTIFUN)
        Get the session key (OSESSKEY)
---> Send 161 bytes - Data packet
Return opi parameter (TTIRPA)
...
    *************************************************************************
    *                    Trace Assistant has completed                      *
    *************************************************************************
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Statistics Example
The type of statistics gathered is approximately on how many TTC calls, packets
and bytes were sent and received between the network partners. Figure 17–16
shows typical trace file statistics from the -s  option.

Figure 17–16 trcasst -s Output

    *************************************************************************
    *                               Trace Assistant                         *
    *************************************************************************
----------------------
Trace File Statistics:
----------------------
Total number of Sessions: 3

DATABASE:
  Operation Count:    0 OPENS,    21 PARSES,    21 EXECUTES,     9 FETCHES
    Parse Counts:
       9 PL/SQL,     9 SELECT,      0 INSERT,     0 UPDATE,     0 DELETE,
       0 LOCK,       3 TRANSACT,    0 DEFINE,     0 SECURE,     0 OTHER
    Execute counts with SQL data:
       9 PL/SQL,     0 SELECT,      0 INSERT,     0 UPDATE,     0 DELETE,
       0 LOCK,       0 TRANSACT,    0 DEFINE,     0 SECURE,     0 OTHER

  Packet Ratio: 6.142857142857143 packets sent per operation
  Currently opened Cursors: 0
  Maximum opened Cursors  : 0

ORACLE NET SERVICES:
  Total Calls  :       129 sent,        132 received,          83 oci
  Total Bytes  :     15796 sent,      13551 received
    Average Bytes:       122 sent per packet,        102 received per packet
    Maximum Bytes:      1018 sent,        384 received

  Grand Total Packets:    129  sent,     132 received

    *************************************************************************
    *                    Trace Assistant has completed                      *
    *************************************************************************
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Contacting Oracle Support Services
If you are still unable to resolve your problems, or if you are requested to contact
Oracle Support Services to report the error, please have the following information at
hand:

■ The hardware and operating system release number on which the application is
running

■ The up-to-five-digit release number of all the Oracle networking products
involved in the current problem

■ The third-party vendor and version you are using

■ If you encountered one or more error codes or messages, the exact code
numbers and message texts in the order they appeared

■ The kind of links that exist between the client and server

■ A description of what does work

■ The exact error message, if there is one

■ An Oracle Net Services trace, if possible; if not, the log file is sufficient
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Glossary

A
access control list (ACL)

The group of access directives that you define. The directives grant levels of access
to specific data for specific clients or groups of clients.

ACL

See access control list (ACL).

access control

A feature of Oracle Connection Manager that sets rules for denying or allowing
certain clients to access designated servers.

address

See protocol address.

administrative region

An organizational entity for administering Oracle Network Services’ components.
Each administrative region includes:

■ One or more domains

■ One or more Oracle Names servers

■ One or more databases and listeners
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alias

An alternative name for a network object in an Oracle Names server. An alias
stores the name of the object is referencing. When a client requests a lookup of an
alias, Oracle Names completes the lookup as if it is the referenced object.

application gateway

A host computer that runs the Oracle Net Firewall Proxy. An application gateway
looks and acts like a real server from the client’s point of view, and a real client from
the server’s point of view. An application gateway sits between the Internet and
company’s internal network and provides middleman services (or proxy services)
to users on either side.

ASCII character set

American Standard Code for Information Interchange character set, a convention
for representing alphanumeric information using digital data. The collation
sequence used by most computers with the exception of IBM and IBM-compatible
computers.

attribute

A piece of information that describes some aspect of a directory entry. An entry
comprises a set of attributes, each of which belongs to an object class. Moreover,
each attribute has both a type—which describes the kind of information in the
attribute—and a value—which contains the actual data.

authentication method

A security method that enables you to have high confidence in the identity of users,
clients, and servers in distributed environments. Network authentication methods
can also provide the benefit of single sign-on for users. The following authentication
methods are supported in Oracle9i, depending on whether or not Oracle Advanced
Security is installed:

■ CyberSafe

■ RADIUS

■ Kerberos

■ SSL

■ Windows NT native authentication
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C
cache

Memory that stores recently-accessed data to so that subsequent requests to access
the same data can be processed quickly.

CDS

See Cell Directory Services (CDS).

Cell Directory Services (CDS)

An external naming method that enables users to use Oracle tools transparently
and applications to access Oracle databases in a Distributed Computing
Environment (DCE) environment.

central administration

An Oracle Names network where network management consists of one
administrative region for the entire network. All Oracle Names servers know about
one another and about all the services in the network. Contrast with delegated
administration.

client

A user, software application, or computer that requests the services, data, or
processing of another application or computer. The client is the user process. In a
network environment, the client is the local user process and the server may be local
or remote.

client load balancing

Load balancing, whereby if more than one listener services a single database, a
client can randomly choose between the listeners for its connect requests. This
randomization enables all listeners to share the burden of servicing incoming
connect requests.

client profile

The properties of a client, which may include the preferred order of naming
methods, client and server logging and tracing, the domain from which to request
names, and other client options for Oracle Names and Oracle Advanced Security.
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client/server architecture

Software architecture based on a separation of processing between two CPUs. One
CPU acts as the client in the transaction, requesting and receiving services. The
other acts as the server that provides the requests.

cman.ora file

A configuration file that specifies protocol addresses for incoming requests and
administrative commands, as well as Oracle Connection Manager parameters and
access control rules.

CMADMIN process

An Oracle Connection Manager administrative process responsible for all
administrative functions of Oracle Connection Manager.

CMGW process

An Oracle Connection Manager gateway process that receives client connections
and evaluates against a set of rules whether to deny or allow access. If access is
allowed, the gateway process forwards the requests to the next hop, typically the
database server. In addition to allowing or denying access, the CMGW process can
also multiplex or funnel multiple client connections through a single protocol
connection.

configuration files

Files that are used to identify and characterize the components of a network.
Configuration is largely a process of naming network components and identifying
relationships among those components.

connect data

A portion of the connect descriptor that defines the destination database service
name or Oracle System Identifier (SID). In the following example, SERVICE_NAME
defines a database service called sales.us.acme.com :

(DESCRIPTION=
  (ADDRESS=(PROTOCOL=tcp)(HOST=sales-server)(PORT=1521)
  (CONNECT_DATA=

(SERVICE_NAME=sales.us.acme.com) ))

connect descriptor

A specially formatted description of the destination for a network connection. A
connect descriptor contains destination service and network route information.
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The destination service is indicated by using its service name for Oracle9i or
Oracle8i databases or its Oracle System Identifier (SID) for Oracle release 8.0
databases. The network route provides, at a minimum, the location of the listener
through use of a network address.

connect identifier

A connect descriptor or a name that maps to a connect descriptor. A connect
identifier can be a net service name, database service name, alias, or net service
alias. Users initiate a connect request by passing a username and password along
with a connect identifier in a connect string for the service to which they wish to
connect:

CONNECTusername / password @connect_identifier

connect string

Information the user passes to a service to connect, such as username, password,
and connect identifier:

CONNECTusername / password @net_service_name

connect-time failover

A client connect request is forwarded to a another listener if a listener is not
responding. Connect-time failover is enabled by service registration, because the
listener knows if an instance is running to attempting a connection.

connection

An interaction between two processes on a network. Connections are originated by
an initiator (client) that requests a connection with a destination (server).

connection load balancing

Load balancing, whereby the number of active connections among various
instances and dispatchers for the same service are balanced. This enables listeners to
make their routing decisions based on how many connections each dispatcher has
and on how loaded the nodes that the instances run.

connection pooling

A resource utilization and user scalability feature that enables you to maximize the
number of sessions over a limited number of protocol connections to a shared
server.

connection request

A notification sent by an initiator and received by a listener that indicates that the
initiator wants to start a connection.
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D
data packet

See packet.

database administrator (DBA)

(1) A person responsible for operating and maintaining an Oracle Server or a
database application. (2) An Oracle username that has been given DBA privileges
and can perform database administration functions. Usually the two meanings
coincide. Many sites have multiple DBAs.

Database Configuration Assistant

A tool that enables you to create, delete, and modify a database.

database link

A pointer that defines a one-way communication path from an Oracle database
server to another database server. The link pointer is actually defined as an entry in
a data dictionary table. To access the link, you must be connected to the local
database that contains the data dictionary entry.

A database link connection is one-way in the sense that a client connected to local
database A can use a link stored in database A to access information in remote
database B, but users connected to database B cannot use the same link to access
data in database A. If local users on database B want to access data on database A,
then they must define a link that is stored in the data dictionary of database B.

The following database links types are supported:

■ A private database link in a specific schema of a database. Only the owner of a
private database link can use it.

■ A public database link for a database. All users in the database can use it.

■ A global database link defined in an Oracle Names server. Anyone in the
network can use it.

decentralized administration

See delegated administration.

dedicated server

A server process that is dedicated to one client connection. Contrast with shared
server process.
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default domain

The domain within which most client requests take place. It could be the domain
where the client resides, or it could be a domain from which the client requests
network services often. Default domain is also the client configuration parameter
that determines what domain should be appended to unqualified network name
requests. A name request is unqualified if it does not have a "." character within it.

delegated administration

A network where network management is delegated to one or more administrative
regions under the root administrative region. Also referred to as distributed or
decentralized administration. Contrast with central administration.

delegated administrative region

A region hierarchically under the root administrative region. Any region other than
the root administrative region.

destination

The client that is the endpoint of a connection. The initiator of the connection
requires some data or service of the destination.

directory information tree (DIT)

A hierarchical tree-like structure in a directory server of the distinguished names
(DNs) of the entries.

directory naming

A naming method that resolves a database service, net service name, or net service
alias to a connect descriptor stored in a central directory server. A directory server
provides central administration of directory naming objects, reducing the work
effort associated with adding or relocating services.

directory server

A directory server that is accessed with the Lightweight Directory Access Protocol
(LDAP). Support of LDAP-compliant directory servers provides a centralized
vehicle for managing and configuring a distributed Oracle network. The directory
server can replace clientside and serverside localized tnsnames.ora  files.
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dispatcher

A process that enables many clients to connect to the same server without the need
for a dedicated server process for each client. A dispatcher handles and directs
multiple incoming network session requests to shared server processes. See also
shared server.

distinguished name (DN)

Name of entry in a directory server. The DN specifies where the entry resides in the
LDAP directory hierarchy, much the way a directory path specifies the exact
location of a file.

distributed administration

See delegated administration.

distributed processing

Division of front-end and back-end processing to different computers. Oracle
Network Services support distributed processing by transparently connecting
applications to remote databases.

domain

Any tree or subtree within the Domain Name System (DNS) namespace. Domain
most commonly refers to a group of computers whose host names share a common
suffix, the domain name.

domain hint

A NAMES.DOMAIN_HINTS parameter in the names.ora  file that contains the name
of the domain and at least one address of an Oracle Names server in that domain.
This enables an Oracle Names server to forward the client requests to a specific
address, reducing network traffic.

Domain Name System (DNS)

A system for naming computers and network services that is organized into a
hierarchy of domains. DNS is used in TCP/IP networks to locate computers
through user-friendly names. DNS resolves a friendly name into an IP address,
which is understood by computers.

For Oracle Network Services, DNS translates the host name in a TCP/IP address
into an IP address.
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domestic domains

The set of domains that are managed within a given administrative region.
Domains are domestic only in relation to a region; they are never domestic in any
absolute sense. Also referred to as local domains.

DNS

Domain Name System. See Domain Name System (DNS).

E
error message

A message from a computer program informing you of a potential problem or
condition preventing program or command execution.

enterprise role

An enterprise role is analogous to a regular database role, except that it spans
authorization on multiple databases. An enterprise role is a category of roles that
define privileges on a particular database. An enterprise role is created the database
administrator of a particular database. An enterprise role can be granted to or
revoked to one or more enterprise users. The information for granting and revoking
these roles is stored in the directory server.

enterprise user

A user that has a unique identity across an enterprise. Enterprise users connect to
individual databases through a schema. Enterprise users are assigned enterprise
roles that determine their access privileges on databases.

entry

The building block of a directory server, it contains information about an object of
interest to directory users.

external naming

A naming method that uses a third-party naming service, such as NIS or CDS.

external procedure

Function or procedure written in a third-generation language (3GL) that can be
called from PL/SQL code. Only C is supported for external procedures.
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F
failover

See connect-time failover.

firewall support

See access control.

flat naming model

An Oracle Names infrastructure in which there is only one domain. All names must
be unique within that domain.

foreign domains

The set of domains not managed within a given administrative region. Domains are
foreign only in relation to a region; they are not foreign in any absolute sense. A
network administrator typically defines foreign domains relative to a particular
region to optimize Names Server caching performance.

FTP protocol

File Transfer Protocol. A client/server protocol which allows a user on one
computer to transfer files to and from another computer over a TCP/IP network.

G
global database link

A database link that is centrally stored in an Oracle Names server. A global
database link that is the same as the global database name is automatically
registered with an Oracle Names server. You can use a global database link to access
an object in the database. For example, if the global database name is
sales.us.acme.com , a global database link of sales.us.acme.com  is created
and registered with an Oracle Names server. You can then use
sales.us.acme.com  to perform a SELECT statement on a table, for example:

SQL> SELECT * FROM emp@sales.us.acme.com
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global database name

The full name of the database which uniquely identifies it from any other database.
The global database name is of the form "database_name . database_domain ,"
for example, sales.us.acme.com .

The database name portion, sales , is a simple name you wish to call your
database. The database domain portion, us.acme.com , specifies the database
domain in which the database is located, making the global database name unique.
When possible, Oracle Corporation recommends that your database domain mirror
the network domain.

The global database name is the default service name of the database, as specified
by the SERVICE_NAMES parameter in the initialization parameter file.

H
Heterogeneous Services

An integrated component that provides the generic technology for accessing
non-Oracle systems from the Oracle database server. Heterogeneous Services
enables you to:

■ Use Oracle SQL to transparently access data stored in non-Oracle systems as if
the data resides within an Oracle server.

■ Use Oracle procedure calls to transparently access non-Oracle systems, services,
or application programming interfaces (APIs), from your Oracle distributed
environment.

hierarchical naming model

An infrastructure in which names are divided into multiple hierarchically-related
domains. For Oracle Names, hierarchical naming model can be used with either
central or delegated administration.

host naming

A naming method resolution that enables users in a TCP/IP environment to resolve
names through their existing name resolution service. This name resolution service
might be Domain Name System (DNS), Network Information Service (NIS), or
simply a centrally-maintained set of /etc/hosts  files. Host Naming enables users
to connect to an Oracle database server by simply providing the server computer's
host name or host name alias. No client configuration is required to take advantage
of this feature. This method is recommended for simple TCP/IP environments.
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HTTP protocol

Hypertext Transfer Protocol. A protocol that provides the language that enables
Web browsers and application Web servers to communicate.

I
initialization parameter file

File that contains information to initialize the database and instances.

instance

The combination of the System Global Area (SGA) and the Oracle background
processes. When a database is started on a database server (regardless of the type of
computer), Oracle allocates a memory area called the SGA and starts one or more
Oracle processes. The memory and processes of an instance efficiently manage the
associated database's data and serve the database users. You can connect to any
instance to access information within a cluster database.

instance name

A name of an Oracle database instance. The instance name is identified by the
INSTANCE_NAME parameter in the database initialization parameter file.
INSTANCE_NAME corresponds to the Oracle System Identifier (SID) of the
instance. Clients can connect to a specific instance by specifying the INSTANCE_
NAME parameter in the connect descriptor.

The instance name is included in the connect data part of the connect descriptor.

Interprocess Communication

A protocol used by client applications that resides on the same node as the listener
to communicate with the database. IPC can provide a faster local connection than
TCP/IP.

IP address

Used to identify a node on a network. Each computer on the network is assigned a
unique IP address, which is made up of the network ID, and a unique host ID. This
address is typically represented in dotted-decimal notation, with the decimal value
of each octet separated by a period, for example 144.45.9.22.

IPC

See Interprocess Communication.
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J
Java Database Connectivity (JDBC) Driver

A driver that provides Java applications and applets access to an Oracle database.

JDBC OCI Driver

A Type II driver for use with client/server Java applications. This driver requires an
Oracle client installation.

JDBC Thin Driver

A Type IV driver for Oracle JDBC applets and applications. Because it is written
entirely in Java, this driver is platform-independent. It does not require any
additional Oracle software on the client side. The Thin driver communicates with
the server using Two-Task Common (TTC), a protocol developed by Oracle to
access the database server.

K
keyword-value pair

The combination of a keyword and a value, used as the standard unit of
information in connect descriptors and many configuration files. Keyword-value
pairs may be nested; that is, a keyword may have another keyword-value pair as its
value.

L
latency

Networking round-trip time.

Lightweight Directory Access Protocol (LDAP)

A standard, extensible directory access protocol. It is a common language that
LDAP clients and servers use to communicate. The framework of design
conventions supporting industry-standard directory servers.

LDAP Data Interchange Format (LDIF)

The set of standards for formatting an input file for any of the LDAP command line
utilities.
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ldap.ora file

A file created by Oracle Net Configuration Assistant that contains the following
directory server access information:

■ Type of directory server

■ Location of the directory server

■ Default directory entry that the client or server will use to look up or configure
connect identifiers for connections to database services

The ldap.ora  file resides in $ORACLE_HOME/network/admin  on UNIX and
ORACLE_HOME\network\admin  on Windows operating systems.

link qualifier

A qualifier appended to a global database link to provide alternate settings for the
database username and password credentials. For example, a link qualifier of
fieldrep  can be appended to a global database link of sales.us.acme.com .

SQL> SELECT * FROM emp@sales.us.acme.com@fieldrep

listener

A process that resides on the server whose responsibility is to listen for incoming
client connection requests and manage the traffic to the server.

When a client requests a network session with a database server, a listener receives
the actual request. If the client information matches the listener information, then
the listener grants a connection to the database server.

listener.ora file

A configuration file for the listener that identifies the following for a listener:

■ Unique name

■ Protocol addresses that it is accepting connection requests on

■ Services it is listening for

The listener.ora  file typically resides in $ORACLE_HOME/network/admin  on
UNIX platforms and ORACLE_HOME\network\admin  on Windows NT.

Oracle9i does not require identification of the database service because of service
registration. However, static service configuration is required for if you plan to use
Oracle Enterprise Manager.
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Listener Control utility

A utility included with Oracle Network Services to control various listener
functions, such as to starting, stopping, and getting the status of the listener.

load balancing

A feature by which client connections are distributed evenly among multiple
listeners, dispatchers, instances, and nodes so that no single component is
overloaded.

Oracle Network Services support client load balancing and connection load
balancing.

local naming

A naming method that locates network addresses by using information configured
and stored on each individual client’s tnsnames.ora file. Local naming is most
appropriate for simple distributed networks with a small number of services that
change infrequently.

location transparency

A distributed database characteristic that enables applications to access data tables
without knowing where they reside. All data tables appear to be in a single
database, and the system determines the actual data location based on the table
name. The user can reference data on multiple nodes in a single statement, and the
system automatically and transparently routes (parts of) SQL statements to remote
nodes for execution if needed. The data can move among nodes with no impact on
the user or application.

logging

A feature in which errors, service activity, and statistics are written to a log file. The
log file provides additional information for an administrator when the error
message on the screen is inadequate to understand the failure. The log file, by way
of the error stack, shows the state of the software at various layers.

See also tracing.

loopback test

A connection from the server back to itself. Performing a successful loopback
verifies that Oracle Net is functioning on the database server.
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M
map

Files used by the Network Information Service (NIS) ypserv  program to handle
name requests.

Microsoft Active Directory

An LDAP-compliant directory server included with the Windows 2000 Server. It
stores information about objects on the network, and makes this information
available to users and network administrators. Active Directory also provides
access to resources on the network using a single logon process.

Active Directory can be configured as a directory naming method to store service
information that clients can access.

N
names.ora file

A configuration file that contains parameter settings for an Oracle Names server.

Named Pipes protocol

A high-level interface protocol providing interprocess communications between
clients and servers using distributed applications. Named Pipes enables
client/server conversation over a network using Named Pipes.

naming context

A subtree that resides entirely on one directory server. It is a contiguous subtree,
that is, it must begin at an entry that serves as the top of the subtree, and extend
downward to either leaf entries or references to subordinate naming contexts. It can
range in size from a single entry to the entire directory information tree (DIT).

An Oracle Context can be created under a naming context.

naming method

The resolution method used by a client application to resolve a connect identifier to
a connect descriptor when attempting to connect to a database service. Oracle Net
provides five naming methods:

■ local naming

■ directory naming
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■ Oracle Names

■ host naming

■ external naming

naming model

The set and structure of domains within which names can be allocated.

In a flat naming model, there is a single domain.

In a hierarchical naming model, the highest level is the root domain, and all other
domains are hierarchically related.

net service alias

An alternative name for a directory naming object in a directory server. A directory
server stores net service aliases for any defined net service name or database
service. A net service alias entry does not have connect descriptor information.
Instead, it only references the location of the object for which it is an alias. When a
client requests a directory lookup of a net service alias, the directory determines that
the entry is a net service alias and completes the lookup as if it was actually the
entry it is referencing.

net service name

A simple name for a service that resolves to a connect descriptor. Users initiate a
connect request by passing a username and password along with a net service name
in a connect string for the service to which they wish to connect:

CONNECTusername / password @net_service_name

Depending on your needs, net service names can be stored in a variety of places,
including:

■ Local configuration file, tnsnames.ora , on each client

■ Directory server

■ Oracle Names server

■ External naming service, such as NIS or CDS

network

A group of two or more computers linked together through hardware and software
to allow the sharing of data and peripherals.
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network administrator

The person who performs network management tasks such as installing,
configuring, and testing network components. The administrator typically
maintains the configuration files, connect descriptors and service names, aliases,
and public and global database links.

network character set

As defined by Oracle, the set of characters acceptable for use as values in
keyword-value pairs (that is, in connect descriptors and configuration files). The set
includes alphanumeric upper- and lowercase, and some special characters.

Network Information Service (NIS)

Sun Microsystems' Yellow Pages (yp ) client/server protocol for distributing system
configuration data such as user and host names between computers on a network.

Network Interface (NI)

A network layer that provides a generic interface for Oracle clients, servers, or
external processes to access Oracle Net functions. The NI layer handles the "break"
and "reset" requests for a connection.

network listener

See listener.

network object

Any service that can be directly addressed on a network; for example, a listener or a
Oracle Names server.

network protocol

See Oracle protocol support.

Network Program Interface (NPI)

An interface for server-to-server interactions that performs all of the functions that
the OCI does for clients, allowing a coordinating server to construct SQL requests
for additional servers.

Network Session (NS)

A session layer that is used in typical Oracle Net connections to establish and
maintain the connection between a client application and a database server.
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NI

Network Interface

NIS

See Network Information Service (NIS).

NN

Network Naming (Oracle Names)

node

A computer or terminal that is part of a network

NPI

See Network Program Interface (NPI).

NR

Network Routing

NS

Network Session. See Network Session (NS).

NT

Network Transport. See transport.

O
object class

In a directory server, a named group of attributes. When you want to assign
attributes to an entry, you do so by assigning to that entry the object classes that
hold those attributes.

All objects associated with the same object class share the attributes of that object
class.

OCI

Oracle Call Interface. See Oracle Call Interface (OCI).

OPI

See Oracle Program Interface (OPI).
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Open Systems Interconnection (OSI)

A model of network architecture developed by ISO as a framework for international
standards in heterogeneous computer network architecture.

The OSI architecture is split between seven layers, from lowest to highest:

1. Physical layer

2. Data link layer

3. Network layer

4. Transport layer

5. Session layer

6. Presentation layer

7. Application layer

Each layer uses the layer immediately following it and provides a service to the
layer preceding.

Oracle Advanced Security

A product that provides a comprehensive suite of security features to protect
enterprise networks and securely extend corporate networks to the Internet. Oracle
Advanced Security provides a single source of integration with network encryption
and authentication solutions, single sign-on services, and security protocols. By
integrating industry standards, it delivers unparalleled security to the network.

Oracle Call Interface (OCI)

An application programming interface (API) that enables you to create applications
that use the native procedures or function calls of a third-generation language to
access an Oracle database server and control all phases of SQL statement execution.
OCI supports the datatypes, calling conventions, syntax, and semantics of a number
of third-generation languages including C, C++, COBOL and FORTRAN.

Oracle Connection Manager

A router through which a client connection request may be sent either to its next
hop or directly to the database server. Clients who route their connection requests
through an Oracle Connection Manager can then take advantage of the session
multiplexing, access control, or protocol conversion features configured on that
Oracle Connection Manager.
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Oracle Connection Manager Control utility

A utility included with Oracle Network Services to control various functions, such
as starting, stopping, and getting the status of the Oracle Connection Manager.

Oracle Context

A RDN of cn=OracleContext  in a directory information tree (DIT) that is
located under a naming context or an unpublished directory entry. An Oracle
Context contains entries for use with Oracle features, such as Oracle Net directory
naming and Oracle Advanced Security enterprise user security. There can be one
or more Oracle Contexts in a directory server. Oracle Internet Directory
automatically creates an Oracle Context at the root of the DIT structure. This root
Oracle Context has a DN of dn:cn=OracleContext .

Oracle Internet Directory

A directory server implemented as an application on the Oracle database. It enables
retrieval of information about dispersed users and network resources. It combines
Lightweight Directory Access Protocol (LDAP) Version 3, the open Internet
standard directory server access protocol, with the high performance, scalability,
robustness, and availability of the Oracle database.

Oracle Names

An Oracle directory service made up of a system of Oracle Names servers that
provide name-to-address resolution for each service on the network.

Oracle Names Control utility

A utility included with Oracle Names to control various functions for Oracle Names
servers, such as starting, stopping, and getting the status of an Oracle Names server.

Oracle Names LDAP Proxy server

Oracle Names servers that have been configured to proxy for directory servers.
Upon startup, Oracle Names LDAP Proxy servers obtain network object
information from a directory server. This provides a single point of definition for all
data in a directory server and does not require that both Oracle Names servers and
directory servers be maintained separately and simultaneously.

Oracle Names server

A computer that uses Oracle Names software to store network address information
for a service along with its simple name so that client applications can request
connections with simple names rather than lengthy addresses.
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Oracle Net

Communication software that enables a network session from a client application to
an Oracle database server. Once a network session is established, Oracle Net acts as
a data courier for the client application and the database server. It is responsible for
establishing and maintaining the connection between the client application and
database server, as well as exchanging messages between them. Oracle Net is able
to perform these jobs because it is located on each computer in the network.

Oracle Net Configuration Assistant

A post-installation tool that configures basic network components after installation,
including:

■ Listener names and protocol addresses

■ Naming methods the client will use to resolve connect identifiers

■ Net service names in a tnsnames.ora  file

■ Directory server usage

Oracle Net Firewall Proxy

Product offered by some firewall vendors that supplies Oracle Connection
Manager functionality.

Oracle Net foundation layer

A networking communication layer that is responsible for establishing and
maintaining the connection between the client application and server, as well as
exchanging messages between them.

Oracle Net listener

See listener.
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Oracle Net Manager

A graphical user interface tool that combines configuration abilities with
component control to provide an integrated environment for configuring and
managing Oracle Net Services.

You can use Oracle Net Manager to configure the following network components:

■ Naming

Define connect identifiers and map them to connect descriptors to identify the
network location and identification of a service. Oracle Net Manager supports
configuration of connect descriptors in a local tnsnames.ora  file, centralized
LDAP-compliant directory server, or an Oracle Names server.

■ Naming Methods

Configure the different ways in which connect identifiers are resolved into
connect descriptors.

■ Listeners

Create and configure listeners to receive client connections.

Oracle Net Services

A suite of networking components that provide enterprise-wide connectivity
solutions in distributed, heterogeneous computing environments. Oracle Net
Services is comprised of Oracle Net, listener, Oracle Connection Manager, Oracle
Net Configuration Assistant, and Oracle Net Manager.

Oracle Program Interface (OPI)

A networking layer responsible for responding to each of the possible messages
sent by OCI. For example, an OCI request to fetch 25 rows would have an OPI
response to return the 25 rows once they have been fetched.

Oracle protocol support

A software layer responsible for mapping Transparent Network Substrate (TNS)
functionality to industry-standard protocols used in the client/server connection.

Oracle Rdb

A database for Digital’s 64-bit platforms. Because Oracle Rdb has its own listener,
the client interacts with Rdb in the same manner as it does with an Oracle database.
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Oracle schema

A set of rules that determine what can be stored in a directory server. Oracle has its
own schema that is applied to many types of Oracle entries, including Oracle Net
Services entries. The Oracle schema for Oracle Net Services’ entries includes the
attributes the entries may contain.

Oracle System Identifier (SID)

A name that identifies a specific instance of a running pre-release 8.1 Oracle
database. For any database, there is at least one instance referencing the database.

For pre-release 8.1 databases, SID is used to identify the database. The SID is
included in the connect descriptor of a tnsnames.ora file and in the definition of the
listener in the listener.ora file.

Oracle XML DB

A high-performance XML storage and retrieval technology provided with Oracle
database server. It is based on the W3C XML data model.

Oracle9 i Real Application Clusters

An architecture that allows multiple instances to access a shared database of
datafiles. Real Application Clusters is also a software component that provides the
necessary cluster database scripts, initialization files, and datafiles needed for the
Oracle Enterprise Edition and Real Application Clusters.

Oracle9 i Real Application Clusters Guard

A failover protection feature. Oracle Real Application Clusters Guard is an integral
component of Real Application Clusters. Oracle Real Application Clusters Guard
provides the following functions:

■ Automated, fast recovery and bounded recovery time from failures that fail the
Oracle instance

■ Automatic capture of diagnostic data when certain types of failures occur

■ Enforced primary/secondary configuration. Clients connecting through Oracle
Net Services are properly routed to the primary node even if connected to
another node in the cluster

■ Elimination of delays that clients experience when reestablishing connections
after a failure
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ORACLE_HOME

An alternate name for the top directory in the Oracle directory hierarchy on some
directory-based operating systems.

OSI

See Open Systems Interconnection (OSI).

P
packet

A block of information sent over the network each time a connection or data
transfer is requested. The information contained in packets depends on the type of
packet: connect, accept, redirect, data, and so on. Packet information can be useful
in troubleshooting.

PMON process

A process monitor database process that performs process recovery when a user
process fails. PMON is responsible for cleaning up the cache and freeing resources
that the process was using. PMON also checks on dispatcher and server processes
and restarts them if they have failed. As a part of service registration, PMON
registers instance information with the listener.

preferred Oracle Names server

The Oracle Names servers preferred by a client for names resolution; usually the
Oracle Names Server that is physically closest to the client, or available over the
least expensive network link.

presentation layer

A networking communication layer that manages the representation of information
that application layer entities either communicate or reference in their
communication. Two-Task Common (TTC) is an example of presentation layer.

private database link

A database link created by one user for his or her exclusive use.

See also database link, global database link, and public database link.
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profile

A collection of parameters that specifies preferences for enabling and configuring
Oracle Net Services’ features on the client or server. A profile is stored and
implemented through the sqlnet.ora  file.

protocol

A set of rules that defines how data is transported across the network.

protocol address

An address that identifies the network address of a network object.

When a connection is made, the client and the receiver of the request, such as the
listener, Oracle Connection Manager, or Oracle Names server, are configured with
identical protocol addresses. The client uses this address to send the connection
request to a particular network object location, and the recipient "listens" for
requests on this address. It is important to install the same protocols for the client
and the connection recipient, as well as to configure the same addresses.

protocol conversion

A feature of Oracle Connection Manager that enables a client and server with
different networking protocols to communicate with each other. This feature
replaces functionality previously provided by the Oracle Multi-Protocol Interchange
with SQL*Net version 2.

protocol stack

Designates a particular presentation layer and session layer combination.

proxy server

A server that substitutes for the real server, forwarding client connection requests to
the real server or to other proxy servers. Proxy servers provide access control, data
and system security, monitoring, and caching.

public database link

A database link created by a DBA on a local database that is accessible to all users
on that database.

See also database link, global database link, and private database link.
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R
RDBMS

Relational Database Management System

RDN

See relative distinguished name (RDN).

relative distinguished name (RDN)

The local, most granular level entry name. It has no other qualifying entry names
that would serve to address the entry uniquely. In the example,
cn=sales,dc=us,dc=acme,dc=com , cn=sales  is the RDN.

region

See administrative region.

region database

Tables in an Oracle database that store Oracle Names information.

root administrative region

The highest level administrative region in a distributed installation. The root
administrative region contains the root domain.

root domain

The highest level domain in a hierarchical naming model.

RPC

Remote Procedure Call

S
Secure Sockets Layer (SSL)

An industry standard protocol designed by Netscape Communications Corporation
for securing network connections. SSL provides authentication, encryption, and
data integrity using public key infrastructure (PKI).

server process

Database processes that handle a client request on behalf of a database.
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service

Work done for others. The database is a service that stores and retrieves data for
clients.

service handler

A process that acts a connection point from the listener to the database server. A
service handler can be a dispatcher or dedicated server.

service name

A logical representation of a database, which is the way a database is presented to
clients. A database can be presented as multiple services and a service can be
implemented as multiple database instances. The service name is a string that is the
global database name, that is, a name comprised of the database name and domain
name, entered during installation or database creation. If you are not sure what the
global database name is, you can obtain it from the value of the SERVICE_NAMES
parameter in the initialization parameter file.

The service name is included in the connect data part of the connect descriptor.

service registration

A feature by which the PMON process automatically registers information with a
listener. Because this information is registered with the listener, the listener.ora
file does not need to be configured with this static information.

Service registration provides the listener with information about:

■ Service names for each running instance of the database

■ Instance names of the database

■ Service handlers (dispatchers and dedicated servers) available for each
instance

These enable the listener to direct a client request appropriately.

■ Dispatcher, instance, and node load information

This load information enables the listener to determine which dispatcher can best
handle a client connection request. If all dispatchers are blocked, the listener can
spawn a dedicated server for the connection.
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service replication

A process that fully replicates a directory system on the network. New services
need to register with only one Oracle Names server. The service replication process
automatically distributes the new registration to all other active Oracle Names
servers on the network.

session data unit (SDU)

A buffer that Oracle Net uses to place data before transmitting it across the
network. Oracle Net sends the data in the buffer either when requested or when it is
full.

session layer

A network layer that provides the services needed by the protocol address entities
that enable them to organize and synchronize their dialogue and manage their data
exchange. This layer establishes, manages, and terminates network sessions
between the client and server. An example of a session layer is Network Session
(NS).

session multiplexing

Combining multiple sessions for transmission over a single network connection in
order to conserve the operating system’s resources.

shared server

A database server that is configured to allow many user processes to share very few
server processes, so the number of users that can be supported is increased. With
shared server configuration, many user processes connect to a dispatcher. The
dispatcher directs multiple incoming network session requests to a common queue.
An idle shared server process from a shared pool of server processes picks up a
request from the queue. This means that a small pool of server processes can serve a
large number of clients. Contrast with dedicated server.

shared server process

A process type used with shared server configuration.

SID

See Oracle System Identifier (SID).
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SID_LIST_listener_name

A section of the listener.ora file that defines the Oracle System Identifier (SID)
of the database served by the listener. This section is valid only for version 8.0
Oracle databases, as Oracle9i and Oracle8i instance information is automatically
registered with the listener. Static configuration is also required for other services,
such as external procedure calls and Heterogeneous Services, and some
management tools, including Oracle Enterprise Manager.

single sign-on

The ability for a user to log in to different servers using a single password. This
permits the user to authenticate to all servers the user is authorized to access.

sqlnet.ora file

A configuration file for the client or server that specifies:

■ Client domain to append to unqualified service names or net service names

■ Order of naming methods the client should use when resolving a name

■ Logging and tracing features to use

■ Route of connections

■ Preferred Oracle Names servers

■ External naming parameters

■ Oracle Advanced Security parameters

The sqlnet.ora  file typically resides in $ORACLE_HOME/network/admin  on
UNIX platforms and ORACLE_HOME\network\admin  on Windows operating
systems.

SSL

See Secure Sockets Layer (SSL).

System Global Area (SGA)

A group of shared memory structures that contain data and control information for
an Oracle instance.

system or topology data

Data used by the Oracle Names server to control regular functioning or
communicate with other Oracle Names servers. Includes interchanges, Oracle
Names servers in a root region, and Oracle Names servers in any delegated region.
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T
TCP/IP protocol

Transmission Control Protocol/Internet Protocol. The de facto standard
communication protocol used for client/server conversation over a network.

TCP/IP with SSL protocol

A protocol that enables an Oracle application on a client to communicate with
remote Oracle databases through the TCP/IP protocol and Secure Sockets Layer
(SSL).

tick

The amount of time it takes for a message to be sent and processed from the client
to the server or from the server to the client

Thin JDBC Driver

Thin JDBC driver is Oracle's Type 4 driver designed for Java applet and Java
application developers. The JDBC driver establishes a direct connection to the
Oracle database server over Java sockets. Access to the database is assisted with a
lightweight implementation of Oracle Net and Two-Task Common (TTC).

TNS

See Transparent Network Substrate (TNS).

tnsnames.ora file

A configuration file that contains one or more domains mapped to connect
descriptors. This file is used for the local naming method. The tnsnames.ora  file
typically resides in $ORACLE_HOME/network/admin  on UNIX platforms and
ORACLE_HOME\network\admin .

tracing

A facility that writes detailed information about an operation to an output file. The
trace facility produces a detailed sequence of statements that describe the events of
an operation as they are executed. Administrators use the trace facility for
diagnosing an abnormal condition; it is not normally turned on.

See also logging.
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Transparent Application Failover (TAF)

A runtime failover for high-availability environments, such as Oracle9i Real
Application Clusters and Oracle Fail Safe, that refers to the failover and
re-establishment of application-to-service connections. It enables client applications
to automatically reconnect to the database if the connection fails, and, optionally,
resume a SELECT statement that was in progress. This reconnect happens
automatically from within the Oracle Call Interface (OCI) library.

Transparent Network Substrate (TNS)

A foundation technology, built into the Oracle Net foundation layer that works
with any standard network transport protocol.

transport

A networking layer that maintains end-to-end reliability through data flow control
and error recovery methods. The Oracle Net foundation layer uses Oracle protocol
support for the transport layer.

TTC

See Two-Task Common (TTC).

Two-Task Common (TTC)

A presentation layer type that is used in a typical Oracle Net connection to provide
character set and data type conversion between different character sets or formats
on the client and server.

U
UPI

User Program Interface

V
virtual circuit

A piece of shared memory used by the dispatcher for client database connection
requests and replies. The dispatcher places a virtual circuit on a common queue
when a request arrives. An idle shared server picks up the virtual circuit from the
common queue, services the request, and relinquishes the virtual circuit before
attempting to retrieve another virtual circuit from the common queue.
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W
WebDAV protocol

World Wide Web Distributed Authoring and Versioning. A protocol with a set of
extensions to the HTTP protocol which allows users to manage files on remote Web
servers.

well-known Oracle Names server

Addresses for one or more Oracle Names servers hard coded into both the Oracle
Names server and its clients. Oracle Names servers then become available at these
well known addresses, so that clients do not need to be told, by way of
configuration files, where to find the server.

Windows NT native authentication

An authentication method that enables a client single login access to a Windows
NT server and a database running on the server.
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OCI drivers, 3-14, 16-9
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with Oracle Connection Manager, 1-20, 13-14
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Always Use Dedicated Server option in Oracle Net

Manager, 11-7
application layer, 4-3
application Web servers, 1-6 to 1-8
architecture

listener, 4-10
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B
BACKGROUND_DUMP_DEST initialization

parameter, 17-17
BACKUP networking parameter, 15-21
BASE networking parameter, 10-21
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Bequeath protocol, 2-13
BEQUEATH_DETACH networking

parameter, 11-10
buffer flushing, described, 7-13

C
CDS. See Cell Directory Service (CDS)
Cell Directory Services (CDS) external

naming, 2-17, 11-6
configuring, 9-64

Cell Name field in Oracle Net Manager, 11-12
centralized naming, 3-2

advantages and disadvantages, 7-11
described, 2-17
establishing a connection with, 3-2
recommended for, 7-11

CHANGE_PASSWORD command, 12-13
Check TCP/IP client access rights option in Oracle

Net Manager, 11-8
ckpcch.ora file, 9-25
ckpcfg.ora file, 9-25
ckpdom.ora file, 9-25
ckptop.ora file, 9-25, 10-18
client cache process, 9-42
client configuration

connect-time failover, 2-8
default domains, 11-3
discovering Oracle Names servers, 9-38
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15-4
local naming, 9-11
log files, 17-28
net service names, 6-5 to 6-7
Oracle Connection Manager address, 13-5
Oracle Rdb connections, 15-41
overriding shared server configuration, 14-10
preferred Oracle Names servers, 11-11
shared server, 14-9
sqlnet.log file, 17-28
trace files, 17-44
Transparent Application Failover (TAF), 2-8

client connections
methods, 16-13
syntax, 16-9

client load balancing
configuring, 15-4
described, 2-9

Client Registration ID field in Oracle Net
Manager, 11-9

client testing
connectivity, 16-17
from 3GL, 16-14
from applications, 16-13
from Oracle Net Manager, 16-23
from SQL, 16-14
from the operating system, 16-13

client troubleshooting, 17-4
Clients allowed to access field in Oracle Net

Manager, 11-8
Clients excluded from access field in Oracle Net

Manager, 11-8
cmadm_pid.log file, 17-27
cmadm_pid.trc file, 17-43
CMADMIN process, 4-17
cmadmpid.log file, 17-27
cmadmpid.trc file, 17-43
CMAN networking parameter, 13-4
CMAN_ADMIN networking parameter, 13-4
cman_pid.log file, 17-27, 17-38
cman_pid.trc file, 17-43
CMAN_PROFILE networking parameter, 13-4
CMAN_RULES networking parameter, 13-4
cman.ora file

parameters
CMAN, 13-4, 13-15
CMAN_ADMIN, 13-4
CMAN_PROFILE, 13-4
CMAN_RULES, 13-4, 13-14
LOG_LEVEL, 17-30
TRACE_DIRECTORY, 17-51
TRACE_FILELEN, 17-51
TRACE_FILENO, 17-51
TRACE_LEVEL, 17-51
TRACE_TIMESTAMP, 17-51

setting up, 13-3
cmanpid.log file, 17-27
cmanpid.trc file, 17-43
CMGW process, 4-17
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configuring
access control, 11-8, 13-14
aliases, 9-52
clients

client load balancing, 15-4
connect-time failover, 2-8, 15-4
default domains, 11-3
local naming, 9-11
naming methods in profile, 11-5
net service names, 6-5 to 6-7
Oracle Names, 9-38
session data unit (SDU), 15-28
Transparent Application Failover (TAF), 2-8

connection load balancing, 15-10 to 15-17
connection pooling, 14-8
connection requests in a profile, 11-7
database servers

session data unit (SDU), 15-29
shared server, 14-2
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domains, default, 11-11
external naming, 9-64 to 9-67
external procedure connections, 15-30
Heterogeneous Services connections, 15-37
host naming, 9-60 to 9-63
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listeners, 12-1 to 12-27

directory naming, 9-17
external procedures, 15-32
Heterogeneous Services, 15-38
host naming, 9-61
local naming, 9-11
Oracle JServer, 12-8
Oracle Names, 9-45
queue size, 12-9
service information, 12-10
session data unit (SDU), 15-29

local naming, 9-5 to 9-11
localized management, 3-2
multiple domains in Oracle Names, 9-31, 9-36
multiple protocol addresses, 15-2
naming methods, 9-1 to 9-67
net service aliases, 9-20

net service names
directory naming, 9-14
external naming, 9-64
local naming, 9-6
Oracle Names, 9-46

network domain, default, 11-3
Oracle Advanced Security, 11-13
Oracle Names, 9-23 to 9-57
Oracle Names servers, 9-28
Oracle Rdb database connections, 15-40
primary and secondary instances, 15-25
protocol addresses, 12-6
protocol conversion support, 13-15
quick reference, 5-19 to 5-22
region database for Oracle Names, 9-27, 9-32
replicated data among Oracle Names

servers, 9-33
servers

session data unit (SDU), 15-29
shared server, 14-2

session data unit (SDU), 15-28
session multiplexing, 13-13

connect identifiers, 16-9
connect strings, 16-2
connection load balancing, 15-10

configuring
dedicated server, 15-15
shared server, 15-12

described, 2-9
service registration, 12-3

connection pooling
advantages relative to session multiplexing, 7-4
configuring, 14-8
defined, 1-14
using with shared server, 14-8

connections, 2-7
adjusting listener queue size to avoid

errors, 7-7, 7-12, 12-9
bequeath, 2-13
concurrent, increasing number of, 12-9
connect strings, entering, 16-2, 16-8
dedicated servers, 11-7
directory naming, 9-18
external procedures, 15-30
Heterogeneous Services, 15-37
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host naming, 9-63
local naming, 9-11
methods, 16-13
Network Information Service (NIS) external

naming, 9-64
Network Information Service external

naming, 9-64
Oracle Connection Manager, 11-7
Oracle Names, 9-57
Oracle Rdb databases, 15-40
startup of components, 16-2

CONNECTIONS (CON or CONN) attribute, 14-3
connect-time failover

configuring, 15-4
GLOBAL_DBNAME networking parameter in

listener.oa, 12-10, 15-4
service registration, 12-3

Create additional or upgrade existing Oracle
Context option in Oracle Net Configuration
Assistant, 8-9

Create Alias dialog box, 9-21
Create or upgrade the Oracle Schema option in

Oracle Net Configuration Assistant, 8-9

D
data link layer, 4-2
data transfer, maximizing, 7-13
Database Configuration Assistant

directory naming, 3-12
shared server configuration, 14-2

database links, 3-28, 9-49
global database link, 3-28
private database, 3-28
public database, 3-28

database server configuration
allocating resources with shared server, 14-9
creating a repository for Oracle Names, 3-26
discovering Oracle Names servers, 9-38
local naming, 9-6
log files, 17-28
loopback tests, 17-4
region database for Oracle Names, 9-27
shared server, 14-2
starting the database, 6-4, 16-6
trace files, 17-44

database server connections
methods, 16-13
syntax, 16-9

database server testing, 16-16
Database Services tab in Oracle Net

Manager, 12-11
dead connection timeout. See terminated connection

timeout, 11-9
dedicated servers

architecture, 1-13
bequeathed sessions, 2-13
connect descriptor configuration, 2-7
defined, 1-12
described, 2-13 to 2-15
difference with shared server, 1-12
routing connections, 11-7

Default Domain field in Oracle Net Manager, 9-41
DELAY networking parameter, 15-21
DELEGATE_DOMAIN command, 9-54
delegated administrative regions

diagram, 3-33
domains to, 9-53
in Oracle Names, 3-32
under root, 3-34

DESCRIPTION parameter, 9-5
diagnosing. See troubleshooting
direct hand-off

described, 2-10
events in listener.log, 17-37

directory configuration
adding users to the OracleNetAdmins

group, 8-12
after installation, 8-6
choosing a directory server, 8-7
default configuration, 8-2
exporting

aliases in Oracle Names to net service aliases
in a directory, 10-12

net service names from a tnsnames.ora
file, 10-2

objects from Oracle Names, 10-6
for clients and servers, 9-13
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migrating
aliases in Oracle Names to net service aliases

in a directory, 10-12
net service names from a tnsnames.ora

file, 10-2
objects from Oracle Names, 10-6

Oracle Context creation, 8-9
Oracle schema creation, 8-9
setting up for first-time usage, 8-8

directory information tree (DIT), defined, 3-7
directory naming, 17-18

absolute naming, 3-16
advantages and disadvantages, 7-10
architecture, 3-7
authentication methods

native, 3-18
simple, 3-18
SSL, 3-18
strong, 3-18

configuring, 9-12 to 9-18
connecting to database services, 3-14
connecting with, 9-18
connections

using an entry’s absolute name, 3-16
using an entry’s relative name, 3-15

Database Configuration Assistant, 3-12
establishing a connection with, 9-18
exporting

aliases in Oracle Names to net service aliases
in a directory, 10-12

net service names from a tnsnames.ora
file, 10-2

objects from Oracle Names, 10-6 to 10-16
Java Database Connectivity (JDBC)

OCI drivers, 3-14, 16-9
Thin drivers, 3-14, 16-9

Java Database Connectivity (JDBC) Thin
drivers, 3-6, 3-16

ldap_search limitations, 17-19
ldap.ora file

creating, 8-3
described, 3-14

ldapwrite tool, 17-18
listener configuration for, 9-17

migrating
net service names from a tnsnames.ora

file, 10-2
objects from Oracle Names, 10-6 to 10-16

object classes, 3-21
objects

database services, 3-7
global database links, 10-6
net service aliases, 3-9
net service names, 3-7

Oracle Context, 3-8
Oracle Names LDAP Proxy servers, 10-17
Oracle Net Configuration Assistant, 3-13
Oracle Net Manager, 3-12
Oracle schema, 3-21
OracleContextAdmins group, 3-13, 3-19, 8-8, 8-9
OracleDBCreators group, 3-13, 3-20, 8-8, 8-9
OracleNetAdmins group, 3-20, 8-8, 8-9, 8-12,

9-14, 9-19, 9-20
overview, 3-4
recommended for, 7-10
security, 3-17
troubleshooting, 17-18
with relative naming, 3-15

Directory Server Migration Wizard, 5-12, 10-5
directory servers

attributes, 3-7
directory information tree (DIT), 3-7
distinguished name (DN), 3-7
entry, 3-7
ldap_search tool, 17-19
ldapwrite tool, 17-18
Microsoft Active Directory, 3-6
Oracle Context, 3-8
Oracle Internet Directory, 3-6
overview, 1-11
performance, 3-17
relative distinguished name (RDN), 3-7
security, 3-17

Directory Usage configuration option in Oracle Net
Configuration Assistant, 5-15

Directory Usage Configuration page in Oracle Net
Configuration Assistant, 8-7

Disable Out-of-Band Break option in Oracle Net
Manager, 11-10

DISABLE_OOB networking parameter, 11-10
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discovering Oracle Names servers
described, 3-37
procedure, 9-37

dispatchers, 1-12, 4-13
described, 1-12, 2-10 to 2-12, 4-13
number to start, 14-6
setting the number of, 14-6

DISPATCHERS (DIS or DISP) attribute, 14-3
DISPATCHERS initialization parameter, 14-2

ADDRESS attribute, 14-2
configuring connection pooling, 14-8
CONNECTIONS attribute, 14-3
DISPATCHERS attribute, 14-3
LISTENER attribute, 12-15, 12-17, 14-4
MULTIPLEX attribute, 14-4
POOL attribute, 14-5
PROTOCOL attribute, 14-2
SERVICE attribute, 14-5
SESSIONS attribute, 14-5
setting initially, 14-6
TICKS attribute, 14-6

DISPATCHERS parameter
MULTIPLEX attribute, 13-13
PROTOCOL attribute, 13-13

distinguished name (DN), defined, 3-7
DLCR.RDBMS.OMD Oracle Names record, 16-25
domain hints, 9-55
domains

default network, 3-30
delegating, 9-53
described, 3-25, 9-24
multiple hierarchically, 9-31, 9-36
multiple hierarchically related, 3-31
required by root administrative regions, 3-32
with a single domain naming structure,

diagram, 3-29
duties of a network administrator, 5-19 to 5-22
Dynamic Discovery Option, 3-35

E
enterprise user security, 3-8
entry, defined, 3-7
Environment field in Oracle Net Manager, 15-34
ENVS networking parameter, 15-34

error messages
contacting Oracle Support Services, 17-82
in trace file, 17-56
NNL-00018, 9-32
NNL-00024, 9-32
NNO-00062, 17-19, 17-20
NNO-00850, 17-19, 17-20
ORA-00508, 17-13
ORA-1017, 17-3
ORA-1034, 17-3
ORA-12154, 17-10
ORA-12198, 17-11
ORA-12203, 17-11, 17-12, 17-13, 17-21

sample error stack, 17-25
ORA-12224, 17-14
ORA-12514, 17-14
ORA-12520, 17-15
ORA-12521, 17-15
ORA-12533, 17-14
ORA-12535, 17-21
ORA-12538, 17-13
ORA-12545, 17-16
ORA-12547, 17-21
ORA-12560, 17-16
ORA-3113, 17-17
ORA-3121, 17-17
resolving, 17-1 to 17-82
using log file to track, 17-32

error stack
described, 17-24
entries in log files, 17-32
sample, 17-25
typical layers in, 17-24

establishing a session
using centralized naming, 2-17

exporting
net service names from a tnsnames.ora file to a

directory, 10-2
objects from Oracle Names to a

directory, 10-6 to 10-16
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external naming
advantages and disadvantages, 7-12
Cell Directory Services (CDS), 2-17, 9-64, 11-6
configuring, 9-64 to 9-67
Network Information Service (NIS), 2-17, 9-64,

11-6
recommended for, 7-12

external procedures
configuring connections to, 15-30
described, 15-30
extproc agent, 15-30

extproc agent, 15-30
EXTPROC_DLLS environment variable, 15-34

F
failover

connect-time, 2-8, 15-4
Transparent Application Failover (TAF), 2-8,

15-18
FAILOVER networking parameter, 15-4, 15-14,

15-17
FAILOVER_MODE networking parameter, 15-18,

15-21
features, new

client load balancing, xl
connection load balancing, xli
connection load balancing for dedicated server

configurations, xxxvii
connect-time failover, xl
creating multiple Oracle Contexts, xxxvii
direct hand-off, xli
directory naming, xl
directory naming access control, xxxv
dynamic update of LOCAL_LISTENER

parameter, xxxv
dynamic update of REMOTE_LISTENER

parameter, xxxv
global database link support in directory

server, xxxiv
instance role specification for primary/secondary

configurations, xli

name changes
CIRCUITS initialization parameter, xxxvi
DISPATCHERS initialization

parameter, xxxvi
MAX_DISPATCHERS initialization

parameter, xxxvi
MAX_SHARED_SERVERS initialization

parameter, xxxvi
Oracle Net, xxxvi
Oracle Net Configuration Assistant, xxxvi
Oracle Net foundation layer, xxxvi
Oracle Net Manager, xxxvi
shared server, xxxvi
SHARED_SERVER_SESSIONS initialization

parameter, xxxvii
SHARED_SERVERS initialization

parameter, xxxvi
V$SHARED_SERVER_MONITOR

view, xxxvii
net service alias support in directory

server, xxxiv
Oracle Names LDAP Proxy servers, xxxvii
Oracle Net Configuration Assistant, xli
service naming, xli
service registration, xli
SERVICE_NAME parameter, xlii
TCP/IP with SSL, xlii
Trace Assistant, xxxv

FILE networking parameter, 10-22
FTP presentation, 4-9

dedicated server configuration, 4-15
shared server configuration, 4-14

FTP protocol, 1-8

G
global database links, 3-28, 9-49

adding link qualifiers, 9-50
directory naming limitation, 10-6
Oracle Names, 9-49

global database name
configuring on the listener, 12-10, 12-15
defined, 9-3
described, 12-10, 12-15
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Global Database Name field in Oracle Net
Manager, 12-10, 15-8, 15-40

GLOBAL_DBNAME networking parameter, 12-10
GLOBAL_NAME networking parameter, 15-8,

15-40

H
Heterogeneous Services

configuring connections to, 15-37
described, 15-37

hierarchical naming model
described, 3-30
diagram, 3-30

host naming
advantages and disadvantages, 7-11
configuring, 9-60 to 9-63
connecting with, 9-63
establishing a connection with, 9-63
listener configuration for, 9-61
recommended for, 7-11
requirements, 9-60

HOST networking parameter, 10-21
hosts file, 3-35
HS networking parameter, 15-8
HTTP presentation, 4-9

dedicated server configuration, 4-15
shared server configuration, 4-14

HTTP protocol, 1-6

I
Identix authentication, xxxviii
Initial Preallocated Requests field in Oracle Net

Manager, 9-41
initialization parameter file

BACKGROUND_DUMP_DEST
parameter, 17-17

DISPATCHERS parameter, 14-2
INSTANCE_NAME parameter, 2-4
LOCAL_LISTENER parameter, 12-7, 12-16
REMOTE_LISTENER parameter, 12-17
SERVICE_NAMES parameter, 2-2, 9-3, 14-5

installation
default configuration

directory naming, 8-2
listeners, 12-4
local naming, 9-6
profiles, 11-2

Oracle Names, 9-24
Instance Name field in Oracle Net Manager, 15-8
instance role configuration, 15-25

connections in TAF, 15-27
connections to primary and secondary

instances, 15-25
connections to specific instances, 15-26

INSTANCE_NAME networking parameter, 2-4,
9-3, 15-8, 15-25

J
Java Database Connectivity (JDBC)

described, 1-5
drivers, 1-5
OCI drivers, 4-8

absolute naming support, 3-14, 16-9
relative naming support, 3-14

Thin drivers, 4-8
absolute naming support, 16-9
directory naming support, 3-6, 3-16
relative naming support, 3-14

JavaNet, 4-8
JavaNet layer, 1-8
JavaTTC, 4-8
JDBC. See Java Database Connectivity (JDBC)

L
ldap_search tool limitations, 17-19
ldap.ora file

creating, 3-14, 8-3
described, 3-2

ldapwrite tool, 17-18
LISTENER (LIS or LIST) attribute, 12-15, 12-17,

14-4
Listener configuration option in Oracle Net

Configuration Assistant, 5-15
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Listener Control utility
commands

SERVICES, 6-5, 12-25
SET PASSWORD, 16-5
START, 6-4, 16-5
STATUS, 12-22, 16-5
STOP, 16-5

starting a listener, 12-22
stopping a listener, 12-22
using, 5-16

listener.log file, 17-27
listener.ora file

described, 3-2
parameters

ENVS, 15-34
GLOBAL_DBNAME, 12-10
LOG_DIRECTORY_listener_name, 17-29
LOG_FILE_listener_name, 17-29
ORACLE_HOME, 12-10, 15-35, 15-37
PASSWORDS_listener_name, 12-13
PROGRAM, 15-34, 15-37
SID_NAME, 12-10, 15-35, 15-37
STARTUP_WAITTIME_listener_name, 17-48
TRACE_FILE_listener_name, 17-48
TRACE_FILELEN_listener_name, 17-48
TRACE_FILENO_listener_name, 17-49
TRACE_LEVEL_listener_name, 17-48

listeners, 2-6, 15-37
adjusting queue size for, 12-9
client load balancing, 2-9
configuring, 12-1 to 12-27

address for Oracle Connection
Manager, 13-7

address list, 15-2
directory naming method, 9-17
external procedures, 15-32
global database name, 12-10, 12-15
Heterogeneous Services, 15-38
Heterogeneous Services connections, 15-37
host naming method, 9-61
local naming method, 9-11
multihomed hosts, 12-7
nondefault address, 12-15
Oracle Enterprise Manager, 12-10
Oracle JServer access, 12-8

Oracle Names, 9-45
Oracle System Identifier, 12-10
protocol addresses, 12-6
service information, 12-10
session data unit (SDU), 15-29
SID, 12-10

connection load balancing, 2-9, 15-10
connect-time failover, 2-8
default address, 12-15
default configuration, 12-4
described, 1-28
direct hand-off, 2-10
handling concurrent connections, 12-9
increasing queue size, 12-9
log files, 12-27, 17-29, 17-33

audit trail, 17-33
direct hand-off event information, 17-37
service registration event information, 17-34

monitoring, 12-22, 12-25, 12-27
multihomed hosts, 12-7
multiple, 12-5
multiple addresses, 15-2
passwords, setting, 12-13
queue size, 7-7, 7-12
redirect connections, 2-10
security, 12-13
starting, 6-4, 16-5, 16-6
testing configuration, 16-16
trace files, 17-48
Transparent Application Failover (TAF), 2-8

listener.trc file, 17-43
load balancing

client, 2-9
connection, 2-9, 15-10

LOAD_BALANCE networking parameter, 15-4
LOAD_TNSNAMES command, 9-48
LOCAL environment variable, 16-8
local naming

advantages and disadvantages, 7-10
client configuration, 9-11
configuring, 9-5 to 9-11
connecting with, 9-11
database server configuration, 9-6
default configuration, 9-6
establishing a connection with, 9-11
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listener configuration for, 9-11
recommended for, 7-10

Local Net Service Name configuration option in
Oracle Net Configuration Assistant, 5-15

LOCAL registry entry, 16-8
LOCAL_LISTENER initialization parameter, 12-7,

12-16, 14-4
log files, 12-27, 17-28, 17-33

cmadm_pid.log, 17-27, 17-30
cmadmpid.log, 17-27, 17-30
cman_pid.log, 17-27, 17-30, 17-38
cmanpid.log, 17-27, 17-30
default names for, 17-27
listener.log, 17-27, 17-29
names.log, 17-27, 17-29
sqlnet.log, 17-27
sqlnet.log for clients and database servers, 17-28
using to track errors, 17-32

LOG_DIRECTORY_CLIENT networking
parameter, 17-28

LOG_DIRECTORY_listener_name networking
parameter, 17-29

LOG_DIRECTORY_SERVER networking
parameter, 17-28

LOG_FILE_CLIENT networking parameter, 17-28
LOG_FILE_listener_name networking

parameter, 17-29
LOG_FILE_SERVER networking parameter, 17-28
LOG_LEVEL networking parameter, 17-30
loopback test, 17-4
LU6.2 protocol, xl

M
maximizing data transfer, by adjusting SDU

size, 7-13
Maximum Open Connections field in Oracle Net

Manager, 9-41
Maximum Wait Each Attempt field in Oracle Net

Manager, 9-41
Meta Map field in Oracle Net Manager, 11-12
METHOD networking parameter, 15-21
Microsoft Active Directory, 3-6

migrating
net service names from a tnsnames.ora file to a

directory, 10-2
objects from Oracle Names to a directory

server, 10-6 to 10-16
multihomed hosts, 12-7
multiple addresses, 15-4

configuring client load balancing, 15-6
configuring connect-time failover, 15-6

multiple listeners, 12-5
multiple protocol addresses, 15-2
MULTIPLEX (MUL or MULT) attribute, 13-13,

14-4

N
Named Pipes protocol

described, 4-6
Names Wizard, 5-13, 9-28, 9-33
NAMES.ADDRESSES networking parameter, 9-29,

9-34
NAMES.ADMIN_REGION networking

parameter, 10-20
NAMES.ADMIN_REGION parameter, 9-29
NAMESCTL utility

discovering Oracle Names servers, 9-39
NAMES.DCE.PREFIX networking

parameter, 11-12
NAMES.DEFAULT_DOMAIN networking

parameter, 9-41, 11-2, 11-4
NAMES.DIRECTORY_PATH networking

parameter, 11-6
cds, 11-6
hostname, 11-5
ldap, 11-5
nis, 11-6
onames, 11-5
tnsnames, 11-5

NAMES.DOMAIN_HINTS networking
parameter, 9-29, 9-34, 9-55

NAMES.DOMAINS networking parameter, 9-29,
9-31, 9-34, 9-36

NAMES.DOMAINS parameter, 9-31, 9-36
namesini.sql script, 9-27
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NAMES.INITIAL_RETRY_TIMEOUT networking
parameter, 9-41

names.log file, 17-27
NAMES.LOG_DIRECTORY networking

parameter, 17-29
NAMES.LOG_FILE networking parameter, 17-29
NAMES.MAX_OPEN_ CONNECTIONS

networking parameter, 9-41
NAMES.MESSAGE_POOL_ START_SIZE

networking parameter, 9-41
NAMES.NIS.META_MAP networking

parameter, 11-12
names.ora file

described, 3-2
parameters

BASE, 10-21
FILE, 10-22
HOST, 10-21
NAMES.ADMIN_REGION, 10-20
NAMES.LOG_DIRECTORY, 17-29
NAMES.LOG_FILE, 17-29
NAMES.TRACE_DIRECTORY, 17-50
NAMES.TRACE_FILE, 17-50
NAMES.TRACE_LEVEL, 17-50
NAMES.TRACE_UNIQUE, 17-50
PASSWORD, 10-21
PORT, 10-21
SCOPE, 10-21
SUBTREE, 10-21
SUBTREE_LIST, 10-21
TIMEOUT, 10-21
TYPE, 10-21, 10-22
USERID, 10-21

namespid.trc file, 17-50
NAMES.PREFERRED_SERVERS networking

parameter, 11-11, 11-12
NAMES.REQUEST_RETRIES networking

parameter, 9-41
NAMES.SERVER_NAME networking

parameter, 9-29, 9-34
NAMES.TRACE_DIRECTORY networking

parameter, 17-50
NAMES.TRACE_FILE networking

parameter, 17-50
NAMES.TRACE_LEVEL networking

parameter, 17-50

NAMES.TRACE_UNIQUE networking
parameter, 17-50

names.trc file, 17-43
namesupg.sql script, 9-27
naming methods

Cell Directory Services (CDS), 2-17, 9-64
centralized, 3-2
choosing, 7-6, 7-10
described, 2-16
directory naming, 9-12 to 9-18
external naming, 9-64 to 9-67
host naming, 9-60 to 9-63
local naming, 9-5 to 9-11
localized, 3-2
Network Information Service (NIS), 2-17, 9-64
Oracle Names, 2-17, 9-23 to 9-57
overview, 1-11
prioritizing order, 11-5

Naming Methods configuration option in Oracle
Net Configuration Assistant, 5-15

naming models
hierarchical, 3-30
single domain, 3-29

native authentication for directory naming, 3-18
NDS. See Novell Directory Services (NDS)
net service aliases

configuring, 9-20
described, 3-9
directory naming, 3-9
exporting aliases from Oracle Names, 10-12
migrating aliases from Oracle Names, 10-12
uses of, 3-9

Net Service Name Wizard, 5-11, 9-7, 9-14, 13-5
net service names

adding an address, 15-2
configure an Oracle Connection Manager

address, 13-5
configuring, 6-5 to 6-7
creating in Oracle Names, 9-47
directory naming, 9-14
external naming, 9-64
local naming, 9-6
multiple addresses, 15-2, 15-4
Oracle Names, 9-46
prioritizing naming methods, 11-5
testing with TNSPING, 16-19
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Net8 OPEN, xxxix
network administrator duties, 5-19 to 5-22
Network Authentication (NA)

layer in error stacks, 17-25
network availability, determining, 6-3
network configuration

centralized management, 3-2
localized management, 3-2

network domain, default
in Oracle Names, 3-30

network domain, default configuring, 11-3
Network Information Service (NIS) external

naming, 2-17, 11-6
configuring, 9-64
connecting with, 9-64
establishing a connection with, 9-64
maps, 9-65

Network Interface (NI)
layer in error stacks, 17-24

network layer, 4-2
Network Naming (NN)

layer in error stacks, 17-24
network performance, improving

by adjusting SDU size, 7-13
client load balancing, 2-9
listener queue size, 7-7, 7-12

network planning
session data unit (SDU) size, 7-13

Network Routing (NR)
layer in error stacks, 17-25

Network Session (NS), layer in error stacks, 17-25
Network Transport (NT), layer in error

stacks, 17-25
networking configuration files

ldap.ora file, 3-2
listener.ora file, 3-2
names.ora file, 3-2
sqlnet.ora file, 3-3
tnsnames.ora file, 3-3

networking planning
internal networks

availability, 7-5
client load balancing, 7-5
connection pooling, 7-3
connect-time failover, 7-5

JDBC drivers, 7-6
listener queue size, 7-7
naming methods, 7-6
protocol conversion, 7-7
scalability, 7-3
security, 7-6
session data unit (SDU) size, 7-7
session multiplexing, 7-3
tuning and performance, 7-7

Internet networks
access control, 7-9
availability, 7-9
JDBC drivers, 7-9
naming methods, 7-9
scalability, 7-9
security, 7-9
tuning and performance, 7-10

new features
client load balancing, xl
connection load balancing, xli
connection load balancing for dedicated server

configurations, xxxvii
connect-time failover, xl
creating multiple Oracle Contexts, xxxvii
direct hand-off, xli
directory naming, xl
directory naming access control, xxxv
dynamic update of LOCAL_LISTENER

parameter, xxxv
dynamic update of REMOTE_LISTENER

parameter, xxxv
global database link support in directory

server, xxxiv
instance role specification for primary/secondary

configurations, xli
name changes

CIRCUITS initialization parameter, xxxvi
DISPATCHERS initialization

parameter, xxxvi
MAX_DISPATCHERS initialization

parameter, xxxvi
MAX_SHARED_SERVERS initialization

parameter, xxxvi
Oracle Net, xxxvi
Oracle Net Configuration Assistant, xxxvi
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Oracle Net foundation layer, xxxvi
Oracle Net Manager, xxxvi
shared server, xxxvi
SHARED_SERVER_SESSIONS initialization

parameter, xxxvii
SHARED_SERVERS initialization

parameter, xxxvi
V$SHARED_SERVER_MONITOR

view, xxxvii
net service alias support in directory

server, xxxiv
Oracle Names LDAP Proxy servers, xxxvii
Oracle Net Configuration Assistant, xli
service naming, xli
service registration, xli
SERVICE_NAME parameter, xlii
TCP/IP with SSL, xlii
Trace Assistant, xxxv

NIS. See Network Information Service (NIS)
NNL-00018 error message, 9-32
NNL-00024 error message, 9-32
NNO-00062 error message, 17-19, 17-20
NNO-00850 error message, 17-19, 17-20
nodes, described, 4-4
Novell Directory Services (NDS)

authentication, xxxviii
Novell Directory Services (NDS) external

naming, xxxviii
NS.SMD Oracle Names record, 16-25

O
object classes

described, 3-21
orclDBServer, 3-21
orclNetAddress, 3-21
orclNetAddressList, 3-21
orclNetDescription, 3-21
orclNetDescriptionList, 3-21
orclNetService, 3-21
orclNetServiceAlias, 3-21

ONRS_CONFIG table, 9-25

Open Systems Interconnection (OSI)
application layer, 4-3
data link layer, 4-2
described, 4-2
network layer, 4-2
Oracle Net foundation layer, 4-4
physical layer, 4-2
presentation layer, 4-3
session layer, 4-3
transport layer, 4-3

ORA-00508 error message, 17-13
ORA-1017 error messages, 17-3
ORA-1034 error messages, 17-3
ORA-12154 error message, 17-10
ORA-12198 error message, 17-11
ORA-12203 error message, 17-11, 17-12, 17-13,

17-21
sample error stack, 17-25

ORA-12224 error message, 17-14
ORA-12514 error message, 17-14
ORA-12520 error message, 17-15
ORA-12521 error message, 17-15
ORA-12533 error message, 17-14
ORA-12535 error message, 17-21
ORA-12538 error message, 17-13
ORA-12545 error message, 17-16
ORA-12547 error message, 17-21
ORA-12560 error message, 17-16
ORA-3113 error message, 17-17
ORA-3121 error message, 17-17
Oracle Advanced Security

authentication, 1-23, 1-24
configuring with Oracle Net Manager, 11-13
overview, 1-31
single sign-on, 1-23

Oracle Call Interface (OCI) layer, described, 4-4
Oracle Connection Manager

CMADMIN process, 4-17
CMGW process, 4-17
configuring

access control, 13-14
clients, 13-5, 13-6
database server, 13-12
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Oracle Connection Manager
computer, 13-3 to 13-4

protocol address for listener, 13-7
protocol address for Oracle Connection

Manager, 13-5
protocol conversion support, 13-15
session multiplexing, 13-13

log files, 17-30
cmadm_pid.log, 17-27
cmadmpid.log, 17-27
cman_pid.log, 17-27
cmanpid.log, 17-27
understanding, 17-38

overview, 1-29
processes, 4-16
routing connections, 11-7
shared server, 13-2
starting, 16-7
testing, 16-16
trace files, 17-51

cmadm_pid.trc, 17-43
cmadmpid.trc, 17-43
cman_pid.trc, 17-43
cmanpid.trc, 17-43
configuring, 17-52

Oracle Connection Manager Control utility
commands

START, 16-7
using, 5-17

Oracle Context
creating, 8-4, 8-9
defined, 3-8

Oracle Enterprise Manager
SID_LIST_listener_name networking parameter in

listener.ora, 12-10
Oracle Home Directory field in Oracle Net

Manager, 12-10, 15-35, 15-37
Oracle Internet Directory, 3-6
Oracle JServer connections, 12-8
Oracle Names, 2-17

administrative regions, 3-25
advantages and disadvantages, 7-11
architecture, 3-22
client cache, 9-42, 16-4

configuring, 9-23 to 9-57
clients and servers, 9-38
region database, 9-27

connecting with, 9-57
creating Oracle Names servers, 9-25
database as a repository for information, 3-26
delegated

administrative regions, 3-34
described, 3-23
differences between versions, 3-34
discovering Oracle Names servers, 9-37, 9-38
discovery, 3-37
domains, 3-25

administering multiple, 9-31, 9-36
delegated, 9-53
hints to remote, 9-55

Dynamic Discovery Option, 3-35
establishing a connection with, 9-57
exporting

aliases to net service aliases in a
directory, 10-12

objects to a directory server, 10-6 to 10-16
hierarchical naming model, 3-30
installing, 9-24
listener configuration for, 9-45
log files, 17-29
migrating

aliases to net service aliases in a
directory, 10-12

objects to a directory server, 10-6 to 10-16
multiple domains, 3-31
multiple regions, 3-31
namesini.sql script, 9-27
namesupg.sql script, 9-27
naming network components, 3-29
network domain, default, 3-30
querying objects, 16-25
recommended for, 7-11
region database, 3-26
regions, 3-25
registering

aliases, 9-52
global database links, 9-49
net service names, 9-46
objects, 9-46
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replicated data, 3-26, 9-33
root administrative region, 3-32
.sdns.ora file, 3-37
sdns.ora file, 3-37
single domain naming mode, 3-29
starting

from Oracle Net Manager, 16-25
from the command line, 16-25

starting from the command line, 16-25
storing

aliases, 3-28
database global database names and

addresses, 3-27
database links, 3-28
net service names, 3-27
other Oracle Names server names and

addresses, 3-27
trace files, 17-50
version 1, 3-34
version 2, 3-35
version 8, 3-36

Oracle Names Control utility
commands

QUERY, 9-37, 16-25
START, 9-37
START_CLIENT_CACHE, 9-43, 16-4

delegating domains, 9-54
discovering Oracle Names servers, 9-37, 9-39
loading tnsnames.ora file into Oracle

Names, 9-48
net service names, 9-47
querying objects, 16-25
REORDER_NS, 9-37
starting an Oracle Names server, 16-3
testing network objects with, 16-25
using, 5-18

Oracle Names LDAP Proxy servers
configuring, 10-17
described, 10-7
error reporting, 17-19
generating topology for, 10-18
NAMES.ADMIN_REGION networking

parameter, 10-20
starting, 9-58, 10-20

Oracle Names servers
ckpcch.ora file, 9-25
ckpcfg.ora file, 9-25
ckpdom.ora file, 9-25
ckptop.ora file, 9-25, 10-18
client cache, 9-42, 16-4
configuring

multiple domains, 9-31, 9-36
creating, 9-25

region database, 9-28
replicated data, 9-33

data stored in, 3-27
default configuration, 9-26
delegated administrative regions, 3-32
delegated domains, 9-53
deleting, 9-58
described, 3-23
discovery, 9-37
domain hints, 9-55
log files, 17-29
preferred, 3-34, 11-11
registering

aliases, 9-52
global database link qualifiers, 9-50
global database links, 9-49
net service names, 9-46
objects, 9-46

removing, 9-58
replicated data, 9-33
root administrative regions, 3-32
starting, 9-32, 16-3

client cache, 9-42, 16-4
from Oracle Net Manager, 16-25
from the command line, 16-25

storing
aliases, 3-28
database global database names and

addresses, 3-27
database links, 3-28
net service names, 3-27
other Oracle Names server names and

addresses, 3-27
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testing, 16-24
QUERY command, 16-25
TNSPING utility, 16-20

trace files, 17-50
well-known, 3-35

Oracle Net
buffers, 7-13
components, 1-28
defined, 1-26, 1-28
Oracle Net foundation layer, 1-26
Oracle protocol support, 1-27
overview, 1-3 to 1-31
scalability features, 1-12
understanding, 1-3 to 1-31

Oracle Net Configuration Assistant
described, 5-14
directory usage configuration

Choose a directory server and complete setup
for first time usage of that directory
option, 8-8

Create additional or upgrade existing Oracle
Context option, 8-9

Create or upgrade Oracle Schema option, 8-9
Select the directory server you want to use

option, 8-7
Directory Usage configuration option, 5-15
Directory Usage Configuration page, 8-7
listener configuration, 12-4
Listener configuration option, 5-15
local naming method, 9-10
Local Net Service Name configuration

option, 5-15
Naming Methods configuration option, 5-15
net service names, 9-10
OracleContextAdmins group, 3-19, 8-8, 8-9
OracleDBCreators group, 3-13, 3-20, 8-8, 8-9
OracleNetAdmins group, 3-20, 8-8, 8-9
servers

listener configuration, 5-15
Oracle Context creation, 3-13

starting, 5-14
Welcome page, 5-14

Oracle Net foundation layer, 1-26, 4-4
Oracle Net listener. See listeners

Oracle Net Manager
adding addresses, 15-2
Address List Options dialog box, 15-6
clients

client load balancing, 15-4
connect-time failover, 15-4
default network domains, 11-3
local naming method, 9-7
Oracle Connection Manager, 13-5

Create Alias dialog box, 9-21
Default Domain field, 9-41
delegating domains to administrative

regions, 9-54, 9-58
described, 5-2
directory naming, 3-12
Directory Server Migration Wizard, 10-5
discovering Oracle Names servers, 9-39
external procedure connections, 15-30
Heterogeneous Services connections, 15-37
Instance Name field, 15-8
listeners

Database Services tab, 12-11
Environment field, 15-34
Global Database Name field, 12-10, 15-8
nondefault through Oracle Names, 12-20
Oracle Home Directory field, 12-10, 15-35,

15-37
Program Name field, 15-34, 15-37
protocol addresses, 12-6
SID field, 12-10, 15-35, 15-37
static service information, 12-10

local naming method, 9-7
menus

Command, 5-9
Edit, 5-8
File, 5-8
Help, 5-10

multiple address options, 15-4
Names Wizard, 9-28, 9-33
navigating, 5-4 to 5-10
navigator pane, 5-5
net service aliases, 9-20, 9-21
Net Service Name Wizard, 9-7, 9-14, 13-5
net service names, 9-7
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Oracle Names
Attempts Per Names Server field, 9-41
Default Domain field, 9-41
discovering, 9-39
global database link qualifiers, 9-50
global database links, 9-49
Initial Preallocated Requests field, 9-41
Maximum Open Connections field, 9-41
Maximum Wait Each Attempt field, 9-41
net service names, 9-47
nondefault listener, 12-20
preferred Oracle Names servers, 11-11
querying network objects, 16-25
region database, 9-28
starting, 16-3

Oracle Rdb Database field, 15-8
Oracle Rdb databases, 15-41

Global Database Name field, 15-40
Rdb Database field, 15-40
Type of Service field, 15-40

profiles, 11-13
advanced options, 11-9
Always Use Dedicated Server option, 11-7
Cell Name field, 11-12
Check TCP/IP client access rights

option, 11-8
Client Registration ID field, 11-9
Clients allowed to access field, 11-8
Clients excluded from access field, 11-8
Disable Out-of-Band Break option, 11-10
Meta Map field, 11-12
Prefer Connection Manager Routing

option, 11-7
preferred Oracle Names servers, 11-11
TNS Time Out Value option, 11-9
Turn Off UNIX Signal Handling

option, 11-10
right pane, 5-6
routing connection requests, 11-7
Session Data Unit (SDU) field in Oracle Net

Manager, 15-8
specifying naming methods, 11-5
starting, 5-3
starting Oracle Names servers, 9-37, 16-25

testing
client configuration, 16-23
server configuration, 16-16

toolbar, 5-7
Type of Service field, 15-8
Use for Heterogeneous Services option, 15-8,

15-39
Use Oracle8i Release 8.0 Compatible

Identification option, 15-8
wizards, 5-10 to 5-13

Oracle Net Services
components

listener, 1-28
Oracle Connection Manager, 1-29
Oracle Net, 1-26

described, 1-26
Oracle protocol support

described, 1-27, 4-6
Named Pipes, 4-6
TCP/IP, 4-6
TCP/IP with SSL, 4-6

Oracle Rdb database
configuring for connection to, 15-40
described, 15-40

Oracle Rdb Database field in Oracle Net
Manager, 15-8

Oracle schema
creating, 8-9
described, 3-21

Oracle Support Services, contacting, 17-82
Oracle System Identifier, configuring on the

listener, 12-10
ORACLE_HOME networking parameter, 12-10,

15-35, 15-37
Oracle9i Real Application Clusters

connect-time failover, 2-8, 15-4
FAILOVER networking parameter, 15-4
FAILOVER_MODE networking

parameter, 15-21
Transparent Application Failover (TAF), 15-18

OracleContextAdmins group, 3-13, 3-19, 8-8, 8-9
OracleDBCreators group, 3-13, 3-20, 8-8, 8-9
OracleHOME_NAMEClientCache service, 16-4
OracleHOME_NAMECMAdmin service, 4-16, 16-7
OracleHOME_NAMECMan service, 4-16, 16-7



Index-18

OracleHOME_NAMENamesonames_server
service, 16-3

OracleHOME_NAMETNSListener service, 16-5
OracleNetAdmins group, 3-20, 8-8, 8-9, 8-12, 9-14,

9-19, 9-20
orclDBServer object class, 3-21
orclNetAddress object class, 3-21
orclNetAddressList object class, 3-21
orclNetDescription object class, 3-21
orclNetDescriptionList object class, 3-21
orclNetService object class, 3-21
orclNetServiceAlias object class, 3-21
OSI. See Open Systems Interconnect (OSI)

P
packets

examining trace data, 17-65, 17-77
types of, 17-55

PASSWORD networking parameter, 10-21
PASSWORDS_listener_name parameter, 12-13
physical layer, 4-2
PING utility, 16-24

testing Oracle Names servers with, 16-24
planning

internal networks
availability, 7-5
connection pooling, 7-3
connect-time failover, 7-5
JDBC drivers, 7-6
listener queue size, 7-7
naming methods, 7-6
protocol conversion, 7-7
scalability, 7-3
security, 7-6
session data unit (SDU) size, 7-7
session multiplexing, 7-3
tuning and performance, 7-7

Internet networks
access control, 7-9
availability, 7-9
JDBC drivers, 7-9
naming methods, 7-9
scalability, 7-9
security, 7-9
tuning and performance, 7-10

session data unit (SDU) size, 7-13

PMON process, 12-2
POOL (POO) attribute, 14-5
port 1521

if not using, 12-15
port 1575, 3-37, 9-33
port 1630, 4-17, 13-15
PORT networking parameter, 10-21
ports

privileged, 12-7
Prefer Connection Manager Routing option in

Oracle Net Manager, 11-7
preferred Oracle Names servers, 3-34
presentation layer, 4-3

FTP, 4-9
HTTP, 4-9
JavaTTC, 4-8
Two-Task Common (TTC), 4-4
WebDAV, 4-9

prespawned dedicated servers, xxxix
primary and secondary instances, 15-25
private database links, 3-28
privileged ports, 12-7
profiles (sqlnet.ora)

configuring
advanced options, 11-9
default domains, 11-3

configuring preferred Oracle Names
servers, 11-11

default configuration, 11-2
naming methods, specifying, 11-5
prioritizing naming methods, 11-5
routing connection requests, 11-7

Program Name field in Oracle Net Manager, 15-34,
15-37

PROGRAM networking parameter, 15-34, 15-37
PROTOCOL (PRO or PROT) attribute, 13-13, 14-2
protocol address, 2-6
protocol conversion support

configuring, 13-15
described, 1-29

protocol.ora file, xxxix
protocols

FTP, 1-8
HTTP, 1-6, 1-8
Named Pipes, 4-6
Oracle support for, 1-27
TCP/IP, 4-6
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TCP/IP with SSL, 4-6
WebDAV, 1-8

proxy server, 13-2
public database links, 3-28

Q
QUERY command, 9-37, 16-25

A.SMD Oracle Names record, 12-21
DLCR.TDBMS.OMD Oracle Names

record, 16-25
NS.SMD Oracle Names record, 16-25
V1ADD.NPO.OMD Oracle Names record, 16-25

queue size, 7-7, 7-12, 12-9
QUEUESIZE parameter, 12-9

for adjusting listener queue size, 7-7, 7-12, 12-9

R
randomizing requests among listeners, 2-9
Rdb Database field, 15-40
RDB_DATABASE networking parameter, 15-8,

15-40
redirect connection, 2-10
region database

configure database server, 9-27, 9-32
create Oracle Names server, 9-28
defined, 3-26

regions
delegated administrative, 3-32
delegated administrative under root, 3-34
delegated administrative, diagram, 3-33
in Oracle Names, 3-25, 3-31
organizing multiple administrative

network, 3-31
root administrative, 3-32

REGISTER command, 9-47
registering

aliases with Oracle Names, 9-52
global database links with Oracle Names, 9-49
net service names with Oracle Names, 9-46
objects with Oracle Names, 9-46

relative distinguished name (RDN), 3-7

relative naming
directory naming, 3-15
Java Database Connectivity (JDBC)

OCI drivers, 3-14
Thin drivers, 3-14

REORDER_NS command, 9-37, 9-39, 11-11
replicated data in Oracle Names, 3-26
replication of data in Oracle Names, 9-33
resolving

errors. See troubleshooting
RETRIES networking parameter, 15-21
root administrative regions

described, 3-32
domain requirements, 3-32
requirements, 3-32

root administrative regions, described, 3-32
root domains, described, 3-32
routing connections, 11-7

S
SAVE_CONFIG command, 12-13
scalability, of networks, 7-3
SCOPE networking parameter, 10-21
.sdns.ora file, 3-37
sdns.ora file, 3-37
SDU networking parameter, 15-8, 15-28
SDU. See session data unit (SDU)
SecurID authentication, xxxviii
security

internal networks, 7-6
Internet networks, 7-9
listeners, 12-13

Select the directory server you want to use option in
Oracle Net Configuration Assistant, 8-7

Select the directory server you want to use, and
configure the directory server for Oracle usage
option in Oracle Net Configuration
Assistant, 8-8

server configuration
allocating resources with shared server, 14-9
creating a repository for Oracle Names, 3-26
discovering Oracle Names servers, 9-38
local naming, 9-6
log files, 17-28
loopback tests, 17-4
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region database for Oracle Names, 9-27
shared server, 14-2
starting, 6-4
starting the database, 16-6
trace files, 17-44

server connections
methods, 16-13
syntax, 16-9

SERVER networking parameter, 2-7
server testing, 16-16
server troubleshooting, 17-3
SERVICE (SER or SERV) attribute, 14-5
service handlers

dedicated servers, 2-13 to 2-15
dispatchers, 2-10 to 2-12

service name
described, 2-2, 2-3, 9-2

service registration
benefits, 12-3
configuring, 12-3
connection load balancing, 2-9, 12-3, 15-10
connect-time failover, 12-3
defined, 2-6
events in listener.log, 17-34
service_died listener log event, 17-35
service_register listener log event, 17-35
service_update listener log event, 17-35

service_died listener log event, 17-35
SERVICE_NAME networking parameter, 9-3
SERVICE_NAMES initialization parameter, 2-2,

9-3, 14-5
service_register listener log event, 17-35
service_update listener log event, 17-35
SERVICES command, 12-25

of Listener Control utility, 6-5
session data unit (SDU), 7-13

adjusting to improve network
performance, 7-13

configuring, 15-28
Session Data Unit (SDU) Size field in Oracle Net

Manager, 15-8
session layer, 4-3
session multiplexing, 1-16, 13-13

advantages relative to connection pooling, 7-4
overview, 1-17

SESSIONS (SES or SESS) attribute, 14-5
SET PASSWORD command

of Listener Control utility, 16-5
shared server

allocating resources, 14-9
architecture, 1-13
compared with dedicated server, 1-12
configuring dispatchers, 14-6
connect descriptor configuration

parameters, 2-7
connection load balancing, 2-9, 15-10
defined, 1-12
described, 4-13
dispatchers, 1-12, 2-10 to 2-12, 4-13
using with connection pooling, 14-8
using with Oracle Connection Manager, 13-2
virtual circuits, 4-13

SID field in Oracle Net Manager, 12-10, 15-35,
15-37

SID, configuring on the listener, 12-10
SID_LIST_listener_name parameter

external procedures, 15-33
Heterogeneous Services, 15-37
Oracle Enterprise Manager requirements, 12-10

SID_NAME networking parameter, 12-10, 15-35,
15-37

simple authentication for directory naming, 3-18
single domain naming model, 3-29
single sign-on

Oracle Advanced Security, 1-23
SOURCE_ROUTE networking parameter, 13-5,

13-10, 15-4, 15-6
SPX protocol, xl
SQLNET.CLIENT_REGISTRATION networking

parameter, 11-9
SQLNET.EXPIRE_TIME networking

parameter, 11-9
sqlnet.log file, 17-27
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sqlnet.ora file
described, 3-3
parameters

LOG_DIRECTORY_CLIENT, 17-28
LOG_DIRECTORY_SERVER, 17-28
LOG_FILE_CLIENT, 17-28
LOG_FILE_SERVER, 17-28
NAMES.DCE.PREFIX, 11-12
NAMES.DEFAULT_DOMAIN, 11-3
NAMES.DIRECTORY_PATH, 11-5
NAMES.NIS.META_MAP, 11-12
NAMES.PREFERRED_SERVERS, 11-11
TCP.EXCLUDED_NODES, 11-8
TCP.INVITED_NODES, 11-8
TCP.VALIDNODE_CHECKING, 11-8
TNSPING.TRACE_LEVEL, 17-47
TRACE_DIRECTORY_CLIENT, 17-44
TRACE_DIRECTORY_SERVER, 17-44
TRACE_FILE_CLIENT, 17-44
TRACE_FILE_SERVER, 17-44
TRACE_FILELEN_CLIENT, 17-44
TRACE_FILENO_SERVER, 17-45
TRACE_LEVEL_CLIENT, 17-45
TRACE_TIMESTAMP_CLIENT, 17-46
TRACE_UNIQUE_CLIENT, 17-46
USE_CMAN, 11-7, 13-5
USE_DEDICATED_SERVER, 11-7

parameters TNSPING.TRACE_
DIRECTORY, 17-47

sqlnet.trc file, 17-43
SSL authentication for directory naming, 3-18
START command

of Listener Control utility, 6-4, 12-22, 16-5
of Oracle Connection Manager Control

utility, 16-7
of Oracle Names Control utility, 9-32, 9-37,

10-18, 10-24, 16-3
START_CLIENT_CACHE command, 9-43, 16-4
starting

an instance with dispatchers, 14-6
database server, 6-4
database servers, 16-6
databases, 6-4, 16-6
listeners, 6-4, 16-5, 16-6
Oracle Connection Manager, 16-7

Oracle Names client cache, 9-42, 16-4
Oracle Names LDAP Proxy servers, 9-58, 10-20
Oracle Names servers, 9-32, 16-3
Oracle Net Configuration Assistant, 5-14
Oracle Net Manager, 5-3
Oracle Net Services components, 16-2

STARTUP_WAITTIME_listener_name networking
parameter, 17-48

STATUS command
of Listener Control utility, 12-22, 16-5

STOP command
of Listener Control utility, 12-22, 16-5
of Oracle Names Control utility, 10-20

strong authentication for directory naming, 3-18
SUBTREE networking parameter, 10-21
SUBTREE_LIST networking parameter, 10-21
svr_pid.trc file, 17-43
syntax

for connect identifiers, 16-9
for Listener Control utility, 5-16
for Oracle Connection Manager Control

utility, 5-17
for Oracle Names Control utility, 5-18

T
TAF. See Transparent Application Failover (TAF)
TCP.EXCLUDED_NODES networking

parameter, 11-8
TCP.INVITED_NODES networking

parameter, 11-8
TCP/IP protocol

described, 4-6
TCP/IP with SSL protocol

described, 4-6
TCP.VALIDNODE_CHECKING networking

parameter, 11-8
terminated connection detection

configuring, 11-9
limitations, 11-9
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testing
client configuration

from 3GL, 16-14
from applications, 16-13
from Oracle Net Manager, 16-23
from SQL, 16-14
from the operating system, 16-13
with TCROUTE, 16-20
with TNSPING, 16-17

listener configuration, 16-16
network connectivity, 16-17
network objects, 16-25
Oracle Connection Manager, 16-16
Oracle Names servers, 16-24
server configuration, 16-16
with control utilities, 5-16

TICKS (TIC or TICK) attribute, 14-6
TIMEOUT networking parameter, 10-21
TNS. See Transparent Network Substrate (TNS)
TNS Time Out Value option in Oracle Net

Manager, 11-9
TNS_ADMIN environment variable, 3-3
TNS_ADMIN registry entry, 3-3
tnsnames.ora file

described, 3-3
exporting entries to directory server, 10-2
migrating entries to directory server, 10-2
parameters

BACKUP parameter, 15-21
DELAY, 15-21
FAILOVER, 15-4
FAILOVER_MODE, 15-21
GLOBAL_NAME, 15-8
HS, 15-8
INSTANCE_NAME, 15-8, 15-25
LOAD_BALANCE, 15-4
METHOD, 15-21
RDB_DATABASE, 15-8
RETRIES, 15-21
SDU, 15-8, 15-28
SOURCE_ROUTE, 13-5, 13-10, 15-4, 15-6
TYPE, 15-21
TYPE_OF_SERVICE, 15-8

TNSPING utility, 16-17
compared to TRCROUTE utility, 16-20

TNSPING.TRACE_DIRECTORY networking
parameter, 17-47

TNSPING.TRACE_LEVEL networking
parameter, 17-47

Trace Assistant
examining trace files with, 17-60
functions of, 17-60
option reference, 17-61
trace data for IDs, 17-77
trace data for packets, 17-65
trace data statistics, 17-81

trace files
analyzing with Trace Assistant, 17-60
cmadm_pid.trc, 17-43
cmadmpid.trc, 17-43
cman_pid.trc, 17-43
cmanpid.trc, 17-43
default names for, 17-43
error message information, 17-56
examining with Trace Assistant, 17-60
listener.trc, 17-43, 17-48
namespid.trc, 17-50
names.trc, 17-43, 17-50
sqlnet.trc, 17-43
sqlnet.trc for clients, 17-44
svr_pid.trc, 17-43
svr_pid.trc for servers, 17-44

TRACE_DIRECTORY networking
parameter, 17-51

TRACE_DIRECTORY_CLIENT networking
parameter, 17-44

TRACE_DIRECTORY_SERVER networking
parameter, 17-44

TRACE_FILE_CLIENT networking
parameter, 17-44

TRACE_FILE_listener_name networking
parameter, 17-48

TRACE_FILE_SERVER networking
parameter, 17-44

TRACE_FILELEN networking parameter, 17-51
TRACE_FILELEN_CLIENT networking

parameter, 17-44
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TRACE_FILELEN_listener_name networking
parameter, 17-48

TRACE_FILENO networking parameter, 17-51
TRACE_FILENO_listener_name networking

parameter, 17-49
TRACE_FILENO_SERVER networking

parameter, 17-45
TRACE_LEVEL networking parameter, 17-51
TRACE_LEVEL_CLIENT networking

parameter, 17-45
TRACE_LEVEL_listener_name networking

parameter, 17-48
TRACE_LEVEL_SERVER networking

parameter, 17-46
TRACE_TIMESTAMP networking

parameter, 17-51
TRACE_TIMESTAMP_CLIENT networking

parameter, 17-46
TRACE_UNIQUE_CLIENT networking

parameter, 17-46
Transparent Application Failover (TAF)

configuring, 15-18
GLOBAL_DBNAME networking parameter in

listener.ora, 12-10, 15-22
overview, 2-8
with instance role, 15-27

Transparent Network Substrate (TNS)
benefits, 4-4
described, 4-4

transport layer, 4-3
TRCROUTE utility

described, 16-20
troubleshooting, 17-1 to 17-82

client, 17-4
contacting Oracle Support Services, 17-82
log files, 17-23
loopback tests, 17-4
questions, 17-22
server, 17-3
trace files, 17-23
using log file, 17-32

TTC. See Two-Task Common (TTC)
Turn Off UNIX Signal Handling option in Oracle

Net Manager, 11-10
TWO_TASK environment variable, 16-8

Two-Task Common (TTC) presentation
dedicated server configurations, 4-15
described, 4-4
shared server configurations, 4-14

TYPE networking parameter, 10-21, 10-22, 15-21
Type of Service field in Oracle Net Manager, 15-8,

15-40
TYPE_OF_SERVICE networking parameter, 15-8,

15-40

U
UNREGISTER command, 9-58
Use for Heterogeneous Services option in Oracle Net

Manager, 15-8, 15-39
Use Options Compatible with Net8 8.0 Clients

option, 15-6
Use Oracle8i Release 8.0 Compatible Identification

option, 15-8
USE_CMAN networking parameter, 11-7, 13-5
USE_DEDICATED_SERVER networking

parameter, 11-7
USERID networking parameter, 10-21

V
V$SESSION table, 15-25
V1ADD.NPO.OMD Oracle Names record, 16-25
virtual circuits, 4-13

W
WebDAV presentation, 4-9

dedicated server configurations, 4-15
shared server configurations, 4-14

WebDAV protocol, 1-8
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